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Introduction 

Product Overview 

AirMagnet Survey is a powerful, easy-to-use survey tool for planning, collecting and 

analyzing WLAN site RF (radio frequency) data crucial for successful WLAN deployment. 

Wireless network installation is a complex and daunting task that involves many invisible 

and unpredictable variables such as RF signal strength, noise level, data rate, channel 

allocation, user density, and so on. Since all these factors ultimately affect WLAN network 

performance, it is necessary to perform RF site surveys to fully understand the behavior of 

radio waves within a facility before installing wireless network access points. Operating at 

the RF level, AirMagnet Survey enables WLAN professionals to quickly and easily determine 

the optimal number and placement of WLAN infrastructure devices to provide the best 

coverage and throughput required by the users in a cost-effective way. 

AirMagnet Planner is a wireless network planning tool that accounts for building materials, 

obstructions, access point configurations, antenna patterns and a host of other variables to 

provide a reliable predictive map of Wi-Fi signal and performance. The solution offers 

superior predictive modeling to determine ideal quantity, placement and configuration of 

APs for optimal security, performance and compliance. 

AirMagnet Planner includes built-in automated tools to help users with their migration 

strategy from existing legacy 802.11a/b/g/n networks to 802.11ac/ax technology. 

AirMagnet Planner can be purchased as a separate product or as a fully integrated feature of 

AirMagnet Survey. When integrated with AirMagnet Survey, users have a powerful solution 

that combines state-of-the-art predictive modeling with real-world performance data. 

  

Copyright 

© 2004-2020 NetAlly 

This User Guide is furnished under license and may be used or copied only in accordance 

with the terms specified in the license. The content of this document is for information only 

and should not be construed as a commitment on the part of NetAlly. 

No part of this document may be reproduced, transmitted, stored in a retrievable system, or 

translated into any language in any form or by any means without the prior written consent 

of NetAlly. Further, NetAlly reserves the right to modify the content of this document 

without notice. 

NETALLY SHALL NOT BE HELD LIABLE FOR ERRORS OR OMISSIONS CONTAINED HEREIN; 

NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THIS 

CONTENT. 

AirMagnet® and AirWISE® are registered trademarks, of AirMagnet, Inc. All the other 

product names mentioned herein are trademarks or registered trademarks of their 

respective companies. 
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This product features Autodesk RealDWG technology. www.autodesk.com/autodeskrealdwg 

This product includes software developed by David Young. Copyright 2003, 2004. All rights 

reserved. 

This product includes software developed by Atsushi Onoe. Copyright 2001. All rights 

reserved. 

This product includes software developed by Sam Leffler, Errno Consulting. Copyright 2002-

2005. All rights reserved. 

This product includes software developed by Bill Paul <wpaul@ctr.columbia.edu>. Copyright 

1997, 1998, 1999. All rights reserved. 

This product includes software developed by the University of California, Lawrence Berkeley 

Laboratory and its contributors. 

This product includes software derived from the RSA Data Security, Inc. MD4 Message-

Digest Algorithm. © 1990-1992 RSA Data Security, Inc. All rights reserved. 

AirMagnet® and AirWISE® are registered trademarks, and the AirMagnet logo is a 

trademark, of AirMagnet, a NetAlly company. All the other product names mentioned herein 

are trademarks or registered trademarks of their respective companies. 

This product includes software derived from Iperf Performance Test: 

iPerf2 - Copyright 1999-2007, The Board of Trustees of the University of Illinois. All rights 

reserved.  

iPerf3 - Copyright 2014-2020, The Regents of the University of California, through Lawrence 

Berkeley National Laboratory. All rights reserved.  

  

Powered by NetAlly. 

NetAlly 

2075 Research Parkway 

Colorado Springs, CO 80920  

Compiled in the United States of America. 

Version 10.1, Released 11/2020  

AirMagnet Survey PRO vs. Survey Express 

AirMagnet Survey comes in two versions: PRO and Express. The table below highlights the 

similarities and differences between the two. 

  Product Features Survey PRO Survey Express 

Site Survey 

scenarios 

Indoor site survey Yes Yes 

Outdoor site survey Yes No 

http://www.autodesk.com/autodeskrealdwg
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Coverage 

maps 

RF signal coverage Yes Yes 

Data rate Yes Yes 

Channel interference Yes Yes 

802.11n/ac/ax (AP 

operating mode, Channel 

width, Max MCS) 

Yes No 

Packet loss/retry Yes Yes 

Floor-based 

deployments 

Single-floor data display 

and analysis 
Yes Yes 

Multi-floor data display and 

analysis 
Yes No 

802.11 deployments 802.11a/b/g/n/ac/ax 802.11a/b/g/n/ac/ax 

Surveying 

capabilities 

Passive surveys Yes Yes 

Active surveys Yes Yes 

Active Iperf surveys Yes No 

Data simulation Yes Yes 

Active tools Yes Yes 

200+ channel deployment Yes No 

Reporting 

capabilities 
Survey Reports Multiple reports One Report* 

Network 

design 

verification 

Network design verification Yes No 

VoWLAN deployment 

verification 
Yes No 

RF spectrum 

analysis 

Spectrum XT integration Yes No 

RF spectrum heatmaps Yes No 

Cisco Prime 

NCS/WCS 

Survey Integration Yes No 

Planner Integration Yes 

With purchase of 

AirMagnet Planner 

Module. 

Network 

Planning 
AirMagnet Planner Yes 

With purchase of 

AirMagnet Planner 

Module. 

* AirMagnet Survey Express has one default report: ‘Overall Coverage Report by Channel’. 

Additional Notes regarding AirMagnet Survey PRO and AirMagnet Survey Express: 

• If you are installing AirMagnet Survey PRO, you should see the words “Survey PRO” 

across the top of the sticker bearing the serial number and serial key; if you are 

installing AirMagnet Survey Express, you’ll see the word “Survey Express”. 

• AirMagnet Survey PRO offers more features than AirMagnet Survey Express. If you 

are using AirMagnet Survey Express and wish to upgrade to AirMagnet Survey PRO, 

contact your AirMagnet product reseller or AirMagnet Technical Support. 
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• An AirMagnet Spectrum XT Adapter is required in order to view spectrum data on 

AirMagnet Survey PRO. Those who want to take advantage of this feature must 

purchase AirMagnet Spectrum XT separately at their own expense. 

Key Features and Benefits 

AirMagnet Survey offers the following key features and benefits (Note that some of the 

features are available in Survey PRO only): 

• AirMapper™ eliminates the need for laptops, dongles, or tethered devices to 

conduct site surveys. You can perform a survey with the AirMapper application on 

your NetAlly AirCheck G2 or EtherScope nXG and analyze the data with AirMagnet 

Survey PRO.  

There are two options to transfer survey data from a NetAlly AirCheck G2 or 

EtherScope nXG: 

Link-Live Download 

1. When saving an AirMapper survey, select Link-Live as the destination. 

2. Login to your Link-Live account. 

3. You can download AirMapper projects to your PC with AirMagnet Survey PRO 

v10.0 (or later) using the Export for Survey PRO option on Link-Live. 

USB Transfer 

1. When saving the survey on the AirCheck G2 or EtherScope nXG, select Local 

as the destination. 

2. Plug a USB thumb drive into one of the USB-A ports on your handheld tester. 

3. Transfer the AirMapper (.amp) file that was saved to the USB thumb drive. 

4. Remove the USB thumb drive from the handheld tester and plug it into a PC 

with AirMagnet Survey PRO v10.0 (or later). 

5. Open the AirMagnet Survey PRO application. 

6. Go to File and select the Open Project option. 

7. Browse to the location of the .amp file. 

8. Select the .amp file and click the Open button. 

9. When asked where to save the new project, browse to preferred destination 

and click on the OK button. 

After the import has been completed a new Survey Project (.svp) file will be created 

using the data collected by the AirMapper application. You will be able to use all 

AirMagnet Survey functionality to analyze your AirMapper survey data, including:  

o Heatmaps 

▪ Signal Strength 

▪ Noise 

▪ SNR 

▪ Interference 
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▪ Predictive PHY Data Rates 

▪ Max MCS 

▪ AP Operating Mode 

▪ Channel Width 

o Simulation Mode 

o MultiView 

o DiffView 

o AirWISE 

o Reports 

Please be aware of the following while using this new functionality: 

o You will not be able to import an AirMapper (.amp) file into an existing Survey 

Project (.svp) project, a new project will always be created. Still, after the 

new project has been created you will be able to import the .svdx file in that 

project into other projects. 

o A converted AirMapper project will have the same name as the .amp file. 

o The Adapter Name under Survey Properties will say AirMapper. 

o Open Space Office will be used as the Environment by default, but it can be 

changed through the Project Properties screen. Signal Propagation 

Assessment will match the value used on the AirMapper application. 

o The AP Default Power will be set as 100.0 mWatts, but it can be changed if 

needed through the Project Properties screen. Note: This setting is only used 

by the Simulation tool. 

o An AirMapper (.amp) project cannot be directly imported into MultiView, but 

you can import it after converting it into a Survey Project (.svp). 

• GPS support allows you to use any AirMagnet-supported GPS device for large-scale, 

outdoor WLAN site surveys. The program can automatically calibrate GPS location 

information (longitude and latitude) of any given point on the site and place APs in 

their optimal locations. It can also automatically collect site data as you are moving 

(walking/driving) along the survey path. Available in AirMagnet Survey PRO only. 

• Integration with AirMagnet Spectrum XT, which comes with AirMagnet’s 

advanced spectrum sensing hardware and analysis software, brings the AirMagnet 

Survey to a higher level by offering wireless network professionals a powerful tool for 

spectrum monitoring as the basis for network planning and deployment, in-depth 

and localized trouble-shooting, and network optimization. Available in AirMagnet 

Survey PRO only. Requires AirMagnet Spectrum XT application installed on same 

machine including a valid license and AirMagnet Spectrum XT Adapter. 

• AirWISE Integration incorporates AirMagnet’s AirWISE technology into the Survey 

product to help wireless LAN planners and administrators make well-informed 

decisions regarding the requirements for their WLAN deployment and maintenance 

using real data collected from a site survey. It is geared towards helping identify 

critical issues in WLAN performance and providing straightforward actionable 

solutions to the issues that are identified. For example, one of the policies can help 

you determine WLAN readiness for "Cisco Location-based Services." Available in 

AirMagnet Survey PRO only. 
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• Comprehensive survey data reports let you turn your survey data and simulation 

results into various data reports. The reports contain comprehensive information on 

channel allocation and usage, WLAN SSID coverage and throughput, AP coverage, RF 

interference and noise, etc. The reports can be exported in popular file formats 

(Acrobat PDF, HTML, Microsoft Word (RTF), Microsoft Excel 97-2000 (XLS) and XML). 

The reports can be saved on your hard drive. A translation feature enables report 

templates to be localized for multiple languages. Available in AirMagnet Survey PRO 

only. 

• Multi-floor site survey and data analysis feature allows you to conduct RF surveys 

on a per-floor basis. Each survey on an individual floor is treated as a separate 

project. You can then view them individually or collectively to see how they perform 

in terms of signal coverage across the floors. Available in AirMagnet Survey PRO 

only. 

• A powerful, comprehensive, and easy-to-use WLAN deployment utility 

integrates functionalities such as site survey, data analysis, channel and power 

simulation, data merging and filtering, calculation, and network connectivity 

troubleshooting all in one package. 

• Three survey options—active, passive, and active Iperf—allow you to gather 

complete site RF data, including signal strength, channel allocation, noise level, 

signal-to-noise ratio, coverage, media type, transmission speed, packet loss/retry 

rate, etc. In an active survey, AirMagnet Survey can associate with a specific AP or 

SSID; in a passive survey, it can “pick up” any RF data that exist in a WLAN 

environment, including data from neighboring WLANs. Active Iperf Surveys allow the 

system to gather information for PHY data rates for both uplink and downlink 

connections. 

• Two display options enable you to view and analyze site RF data by channel or by 

SSID. You can easily identify WLAN deficiencies in terms of AP coverage, roaming 

boundary, channel allocation/interference, noise impact, etc. 

• Support for Intel® Centrino® Mobile Technologies allows customers to take 

advantage of the advanced performance and security features offered by the latest 

Intel® Centrino™ mobile technology products. 

• Easy-to-use Simulation tool allows you to conduct simulations on AP channel 

allocation, output power, and SSID assignment right from your desktop and get the 

results in a matter of seconds. You can conduct various “tests” to find the best AP 

channel allocation with maximum signal strength and minimum co-channel or 

adjacent channel interference; analyze the impact of AP repositioning to select the 

optimal AP deployment location and provide the most efficient signal coverage; 

analyze the impact of adding or reducing the number of APs at a site to determine 

the optimal number of APs for desired signal coverage; and visually compare the 

results before and after the simulations, etc. 

• Data filtering capability allows you to zero in on specific APs for detailed analyses 

and to experiment with different AP deployment scenarios. 

• Data merging gives you a holistic view of all factors affecting your wireless LAN 

deployment. You can experiment and simulate with different AP deployment options 

for maximum signal coverage and minimum interference. 

• Diagnostic tools let the you analyze signal distribution patterns and conduct end-

to-end connectivity tests with DHCP and Ping tools at any time. 

• Built-in wireless calculator allows you to calculate various parameters important 

to WLAN performance. They include System Operating Margin, Free Space Loss, 
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Fresnel Zone, Downtilt Angle and Distance, and Downtilt Coverage. So you can make 

informed decisions for your WLAN deployment and/or upgrade. 

• Graphical data display with color spectrum and gradient makes it easy to 

understand and differentiate RF data from various sources (that is, APs or SSIDs and 

channels). This allows you to base your WLAN decisions on “facts” rather than 

“hypotheses”. 

• Support for all wireless LAN PHY standards, that is, 802.11a/b/g/n/ac/ax. 

• Survey comparison view helps users visualize the differences between two 

surveys taken of the same area. This can be most useful for users who wish to see 

how a wireless environment changed over time by comparing two surveys taken 

months apart. 

• Passive survey speed data calculation generates speed data for passive or 

simulated data, allowing users to view the predicted transmission rates for APs 

without having to conduct an active survey for each device. 

• Profile management makes storing configuration settings for any given site easy. 

Users can implement profiles for each site surveyed and quickly switch back and 

forth between profiles, eliminating the need to manually adjust configuration settings 

at each location. 

• Cisco Prime NCS/WCS are network management tools. Integrated with AirMagnet 

Survey, it allows you to import AirMagnet Survey and AirMagnet Planner files into 

Cisco Prime NCS/WCS. It also lets you export a Cisco Prime NCS/WCS project into 

AirMagnet Survey. 

• Survey Mobile app is a mobile and easy to carry platform for conducting site 

surveys using an Android phone or tablet. Because it integrates seamlessly with 

AirMagnet Survey PRO, you can conduct the survey using Survey Mobile, and then 

share the projects with other users of AirMagnet Survey PRO. Simply email the 

project from your handheld device and open the project (.svd file) in AirMagnet 

Survey PRO for deeper survey analysis and reporting. 

The Survey Mobile app .apk file can be found in your installation directory. To load 

the app onto your device, connect your Android device to your PC and enable USB 

mass-storage mode. You can then drag and drop the file onto your Android device. 

Then, using a file manager, such as Astro or ES File Explorer, locate the file on your 

Android device and install it. 

• Multi Floor Planner enables you to view how signal propagation occurs between 

floors in a multi-floor building. With Multi Floor Planner, you can create a new project 

for one or more floors and you can also import individual AirMagnet Planner projects 

for one or more floors as well. By creating a single building project in this way, you 

can see predictive heatmap visualizations, for example, of how APs on one floor may 

propagate signal strength coverage to other floors. It includes support for 

802.11a/b/g/n/ac/ax APs. 

System Requirements 

Note:  

Laptop/Notebook PC/Tablet PC 
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Operating Systems: Microsoft Windows 8.1 Pro/Enterprise 64-bit or Microsoft Windows 10 

Pro/Enterprise 64-bit 

Note: 64-bit Operating System supported on Windows 8 and 8.1 for certain wireless 

adapters. Refer to “Supported Adapter” section at 

https://airmagnet.netally.com/my_airmagnet/public/documents/#3rdpartydriver  

• Intel® Core™ 2 Duo 2.00 GHz (Intel® Core™ i5 or higher recommended) 

• 4 GB memory or higher. 

• 800 MB free hard disk space 

• AirMagnet-supported wireless network adapter(s) 

• Cardbus, ExpressCard slot, USB port or mini PCI slot for external adapter use. 

• When using multiple adapters. AirMagnet recommends the use of its multi-adapter 

kit. Otherwise, multiple slots/ports in the PC are required. 

• Optional AirMagnet Spectrum XT adapter and license for integrated spectrum survey 

on Survey PRO. Required for viewing spectrum data and heatmap. 

• A site map in a supported format. Refer to Supported Image File Formats. 

• Google Earth must be installed in order to export the GPS data for outdoor surveys 

to Google Earth (Survey PRO only). 

Apple® MacBook® Pro: 

• Operating Systems: MAC OS X v10.5 (Leopard™) running a supported Windows OS 

(as noted under Laptop/Notebook PC/Tablet PC section) using Boot Camp®. 

• Intel®-based CPU 1.6 GHz or higher. 

• 4 GB memory or higher. 

• 800 MB free hard disk space. 

• Cardbus, ExpressCard slot, USB port or mini PCI slot (whichever applicable for your 

adapter). 

• Built-in Atheros-based Airport Extreme 802.11n wireless adapter or any AirMagnet-

supported wireless network adapter (whichever applicable). 

• Optional AirMagnet Spectrum XT adapter and license for integrated spectrum survey 

on Survey PRO. Required for viewing spectrum data and heatmap. 

• A site map in a format supported by AirMagnet Survey. Refer to Supported Image 

File Formats. 

• Google Earth must be installed in order to export the GPS data for outdoor surveys 

to Google Earth (Survey PRO only). 

• When using multiple adapters, AirMagnet recommends the use of its multi-adapter 

kit. Otherwise, multiple slots/ports in the Macbook® Pro are required. 

Guideline for Use of Wi-Fi Adapters 

AirMagnet Survey/Planner requires that a Wi-Fi adapter be installed on the same computer 

running the application to capture Wi-Fi data. 

AirMagnet mobile products categorize Wi-Fi adapters into the following types: 

https://airmagnet.netally.com/my_airmagnet/public/documents#3rdpartydriver
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Preferred Adapters: These adapters have been tested by AirMagnet and are 

recommended for use with AirMagnet products. Drivers have been customized for extended 

feature support. For a complete, up-to-date listing of AirMagnet Preferred wireless adapters, 

visit 

Other Adapters: These adapters can be used with AirMagnet Survey PRO but have not 

been tested by AirMagnet. Drivers have not been customized, will provide limited features, 

and could provide inaccurate data. Note: When installing Intel® and USB adapters, it is 

important that you uncheck the option to install the adapter’s client utility in addition to the 

driver software. 

Limitations of Other Network Adapters 

Any 802.11 adapter supported by Windows other than the Preferred Adapters falls into the 

Other network adapters category. They can be used with AirMagnet Survey PRO to perform 

a survey but have not been tested by AirMagnet. These adapters’ drivers have not been 

customized, provide limited feature support, and could provide inaccurate information. It is 

important to note that NetAlly is not responsible for the quality of the test results collected 

using these adapters. The following are noted limitations of generic adapters in AirMagnet 

Survey. 

• No ability to scan specific channels: all channels are scanned. There is no Scan or 

802.11 tab under the File>Configure menu. 

• No noise or signal-to-noise ratio (SNR) measurements. 

• Measured PHY data rates in the uplink and downlink directions are not separated. 

Only a single PHY data rate for the connection is reported. 

• No packet retries and loss measurements on active and iPerf surveys. 

• iPerf throughput performance may vary, depending on the model of the generic 

adapter in use. 

• Limitations in the wireless channels that they scan: They may only be able to scan 

channels that are approved for wireless use in a specific country, and unable to scan 

channels assigned as Dynamic Frequency Selection (DFS) channels. 

• Only one non-preferred adapter can be used when utilizing multiple adapters. Refer 

to “Utilizing Multiple Adapters” in the AirMagnet Survey User Guide. 

• There is no roaming control for active and iPerf surveys. 

• Due to the inability to disable roaming on the adapter, only the “by SSID” (not by 

AP) method is available for active and iPerf surveys. 

A complete, up-to-date listing of AirMagnet-supported wireless adapters is located here: 

https://www.netally.com/products/airmagnet-survey-pro/#SupportedAdapters  

Wi-Fi Adapter Driver Packages 

The supported driver packages for preferred adapters is located in your My AirMagnet 

account under the Documents/Drivers section. 

Supported GPS Devices 

https://www.netally.com/wp-content/uploads/2020/03/AMM-Preferred-Adapters.pdf
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When conducting a GPS outdoor survey, the GPS device must be compatible with AirMagnet 

Survey PRO by satisfying the following requirements: 

• Must be NMEA compliant 

• Capable of generating serial data which can be verified via Hyperterminal. 

• Recognized by the laptop as a COM port 

If your GPS device is not an NMEA compliant, you may use a 3rd party software solution 

that will allow the GPS USB to be detected as a COM port. You will then need to verify that 

the data is converted to NMEA format. Software solutions such as this have worked on 

many GPS models; however, AirMagnet cannot ensure that it works with all GPS devices. 

Supported Image File Formats 

A digital site map of the facility or location needs to be in one of the supported file formats. 

Having a site map allows you to accurately mark AP locations and coverage areas. However, 

if no digital site map is available, you may create one using a drawing software application. 

You can also sketch a map by hand and then have it scanned and saved in one of the 

supported image file formats. 

File Format Description 

.BMP The standard Bit-Mapped Graphics format used in the Windows environment. 

.DIB Device-Independent Bitmap, a variant of a bitmap (bmp) file. 

.DWF 

DWF is an Autodesk Design Web Format file. This file format is highly 

compressed for efficient distribution.  

Note: Project exports are not supported with this file type. 

.DWG 

DWG is file format for AutoCAD drawing files in MS-DOS and Windows. DWG 

is now being supported by certain non-AutoCAD systems in the same manner 

that DXF is supported by non-AutoCAD systems. See .DXF below. Versions 

up to CAD 2014 are supported. 

.DXF 
Data Exchange Format is a format for storing vector data in ASCII or binary 

files used by AutoCAD and other CAD software for data interchange. 

.EMF 

(Enhanced MetaFile) and WMF (Windows MetaFile) are the major display 

formats of the Windows operating environment and the native graphics 

formats for MS Office applications. 

.GIF 
Graphics Interchange Format is a variation of the bitmap image format for 

pictures with up to 256 distinct colors. 

.JPG 
Short for .JPEG (Joint Photographics Experts Group); a file format widely 

used for web images. 

.PNG 
Portable Network Graphics is a bitmapped image format that uses lossless 

data compression. 

.VSD Microsoft Visio 2010 image file. 

.WMF Windows MetaFile. See .EMF above. 

.VDX Visio drawing. 

Note: One image file format is not favored over another. You are encouraged to consult a 

reference book on digital imaging for the pros and cons of each of these image formats. 
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Also, make sure that the map is legible and is as accurate as possible. A good site map 

should be clear enough when viewed at a normal scale (1:1) on the view without zooming. 

By default, a floor map is displayed in an 8.5”x 11” or 21.6 cm x 28 cm dimension. 

Furthermore, try to keep your map image file within a reasonable size. A large-sized image 

may take longer to upload, and, in some cases, may even cause the program to crash. 

Consider slicing a map image into sections if it is too large. 

Survey Viewer License 

The Survey Viewer license is available to customers who have AllyCare Support. 

The Survey Viewer license replaces the “Display-Only Mode” implemented in previous 

releases of the software. Users can download one Viewer license from their MyAirMagnet 

page after registering the Survey product. You can obtain two additional Viewer licenses by 

contacting Technical Support. The Viewer license can then be installed and bound to another 

machine or wireless card, just as with a normal Survey installation. 

Note: The Viewer license is bound in the same manner as any license, and as such can 

only be associated with one machine or wireless card. 

The main restriction of the Viewer license is that installations in Viewer mode cannot 

conduct surveys or use "Tools". Additionally, the Viewer license is based on the master 

Survey license you purchased, and has the same limitations as the master license. For 

example, if you own a Survey Express license, the associated Viewer license allows access 

to the Display, Simulation, and Calculator screens. 

Product Registration 

By registering your purchased software, you are entitled to a free My AirMagnet account 

with the following benefits: 

• Download software updates to the software when available. 

• Access product documentation, like Release Notes and User Guides. 

• Download wireless adapter drivers. 

• Access training videos. 

To register your product, open the following URL: 

https://airmagnet.netally.com/support/register_product/  

Technical Support 

AllyCare Product Support 

NetAlly's AllyCare is our comprehensive support and maintenance program that offers 

expanded coverage for the products. 

For more information, visit https://www.netally.com/support/. 

https://airmagnet.netally.com/support/register_product/
https://www.netally.com/support/
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Contact Us 

Call toll-free in North America: 1-844-TRU-ALLY (1-844-878-2559) 

Visit https://www.netally.com/contact-us/ for additional phone numbers. Scroll down and 

select your region to complete a web form and have a NetAlly representative contact you.  

Accessing Help 

Context-sensitive help documentation can be displayed by pressing the F1 key. If context 

sensitive help is available for the user interface view in focus, the topic will be displayed. 

Alternatively, you can access help options from the Help menu. 

 

  

Sharing Projects 

You can share your Survey and AirMagnet Planner projects among other users who have the 

associated products or viewer software installed on their computers.   

Here’s what to do to share a project: 

1. Locate the project folder. The folder was created when you created your new project. 

The folder name is the “project name” you gave your project. 

2. Zip the folder and send it to the recipient. 

3. The recipient needs to unzip the folder, launch the application and select File>Open. 

Browse to the folder. The correct project file will be the only file available to open. 

https://www.netally.com/contact-us/
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Installation 

Checking Product Package Contents 

Before you start, make sure that the following items are included in the product package: 

• Compliance Guide 

• A software certificate with the serial number and serial key 

• If a support contract was purchased, a support contract with a support serial number 

and serial key. 

In case any items are missing or damaged, contact your authorized reseller or AirMagnet 

Technical Support immediately. 

Preparing for Software Installation 

AirMagnet strongly recommended that you review this information before starting product 

installation. 

Verify System Requirements 

Be sure to install the software on a computer that complies with the system requirements. 

Before You Begin 

Consider the following before installing, launching and using the software: 

• Be sure to have active Internet connection when launching the software for the first 

time. 

• You must have administrative rights on the computer running the product software. 

• Be aware certain firewall settings or antivirus software may interfere with the 

product software. 

• Network software that uses a wireless adapter may cause a conflict with the product 

software. 

Product Upgrades 

If the computer running the software application has an active Internet connection and a 

product upgrade is available, a notification dialog will be displayed during product launch 

indicating that a newer version of the software is available. Click Yes to proceed to your 

MyAirMagnet account where you can access the software upgrade download. The product 

upgrade will be listed in Registered Products > Downloads section under Software 

Download. 

An active support contract is required in order to upgrade from an older version to a newer 

version of the product. All existing customers wishing to install a newer release of the 

product should verify the status of their product support contract before starting the 

installation. 
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You can view the status of your support contract under the Registered Products section of 

your MyAirMagnet account. 

You can also manually check for product updates by selecting Check Update from the Help 

menu. 

Software License 

You are required to install a unique software license in order to successfully run the 

software application. You will be prompted to install the license when the product is 

launched for the first time. 

Obtaining a Software License 

Your Software License Certificate includes a Serial Number (S/N) and a Keycode (Serial 

Key). When the application is launched for the first time, you will be required to supply this 

information to proceed. This Serial Number / Serial Key combination enables you to obtain a 

software license compatible with the software version of your product and in accordance 

with your support contract. 

Once you enter the Serial Number and Serial Key, you will be prompted to obtain the 

license: 

License Download: If the machine is connected to the Internet, you may choose to obtain 

the license by download. In this case the system will automatically download the license and 

install it. 

Browse to License: If the license is accessible on your network (previously downloaded), 

you may choose to browse to it. The name of the license file is “serial number.lic” 

For example: A4018-04280450.lic. 

The license will be copied to your AirMagnet product directory. 

For example: c:\Program Files\AirMagnet Inc\AirMagnet Surveyor. 

Binding the License to a MAC address 

One software license per MAC address is permitted. The license can be bound to a specific 

computer (laptop) or to a removable wireless adapter. This provides flexibility in how the 

product may be used and shared. 

During product installation, you will be prompted to choose which option to use. Depending 

on your choice, the application automatically captures the MAC address of the machine or 

adapter. 

Note: If you choose to bind the software license to a removable adapter, the adapter 

must be active on the computer at the time you launch the application. 

MAC Address Reset 

https://airmagnet.netally.com/my_airmagnet
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Should you desire to reset the MAC address to a different computer or adapter, you can 

request a MAC address reset by choosing “MAC Address Reset” from your MyAirMagnet 

account. 

Backing-up the License File 

AirMagnet strongly recommends that you register your product, download the license file 

and save it in a safe location. Having a backup license file makes it easy to reinstall the 

application anytime, if needed because you can just browse to the file to install it. 

Support Contract Activation 

If you purchased an AllyCare support contract for your product, the license file contains 

information that indicates whether support has been pre-activated. 

If no pre-activation occurred, you will be presented with a dialog to supply a support 

contract Serial Number and Serial Key.  

Installing Product Software 

If you have a current support contract, the download will be the most current version of the 

product, otherwise it will be the version you are entitled to download. 

1.  From the Registered Products page of your My AirMagnet account, click the software 

download, and run or save the file.  

If the file was saved, double-click the .exe file to begin running the installer. 

2. Agree to the Software License Agreement to proceed with installation. Refer to 

Software License Agreement. 

3. Set the installation destination folder. Accept the Program Files default, or browse to 

a different location. 

4. Click Finish to complete the installation. At this point, you can select another option 

from the installer, or click Exit to close the installer. 

Uninstalling Product Software 

1. From the Windows Settings (accessible from the left side of the Start menu), 

select Apps. 

2. Click Apps. The list of installed applications is displayed. 

3. Select the desired application.  

4. Select Uninstall. 

5. You will be prompted to choose whether to keep your license file and 

created/modified files after uninstalling the product: 

• Yes: The license file and created/modified files will not be deleted. 

• No: The license file and created/modified files will be deleted. 
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The following is a list of files affected by the selection chosen: 

• Antenna patterns - User-created antenna files 

• Wall/Area configuration - Areas and Walls - AreaList.txt and WallList.txt 

• Floor Material - FloorMaterials.xml 

• OUI to vendor mappings - LanCardVendors.txt 

• Custom Report Templates - No change to current behavior.  Currently pre-defined 

template will be replaced and customer created one is kept 

• AP Groupings - Predefined Rules.csv 

• APAlias.map - APAlias.map 

• Profiles from File\Configure - User-created profiles 

• AirWISE Policies and Areas - For policies, user-created policies.  For Areas, saved to 

project folder, so no action on those files 

• Phonebook - Phonebook.xml and profiles.xml 

• Speed table - SpeedMap.txt 

If you choose to re-install the product software and if you preserved the files, the installer 

will merge-in the new files (for example, new antenna patterns) but will not replace any 

files from the above groups if they already exist on the target system.  This will apply to all 

files in all groups.     

Launching the Application for the First Time 

Note: Do not attempt to launch the application during a Microsoft Windows update. If this 

occurs, the following error message may be displayed, "The application has failed to start 

because its side-by-side configuration is incorrect." 

When you launch the application for the first time, you will need to validate your license and 

install it. 

License Method 

Choose which method to use for installing the software license: 

• Download the license: You must be connected to the Internet and have an active 

Internet connection. The license will be downloaded from the NetAlly website. 
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• Browse to a license: You will be prompted to browse to the file. The license must 

have been previously downloaded from the NetAlly website. 

Serial Number, Serial Key and MAC Address Binding 

When launching the software for the first time, you be required to supply a valid serial 

number and serial key. You also need to bind the license to the MAC address of an internal 

or external network adapter. 

 

License Activation Notes: 

If the license file does not support the installed version of the product, an error message will 

be displayed such as “Invalid License File” or “This serial number is currently out of support” 

or “Invalid Product Code.” 

If you receive an error when attempting to install the software license. Here are a couple 

reasons the license selection may produce an error message along with what you can do: 

• Your license does not support a newer version of the product: In this case, 

you can purchase a support contract that entitles you to run the newer software. 

• Invalid Product Code: The license file you chose is for a different product. Verify 

that the license file name has the same serial number as the serial number for your 

product. 

If you believe the error message to be incorrect about the status of your product or license, 

contact your sales representative or Technical Support. You will be asked to provide the 

serial number and serial key for the product in question. 

When Using USB Adapters 
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• It is best to always use the same USB port for the adapter. When using any of 

the USB wireless adapters, wireless profiles may need to be re-created when the 

adapter is plugged into a different USB port—as profiles are stored based on the 

port, not the adapter itself. 

• When installing the new Intel® and USB adapters, it is important that users uncheck 

the option to install the adapter’s client utility in addition to the driver software. 

• In order to run AirMagnet Survey using a USB preferred adapter, you must install the 

adapter using the installer found at 

https://airmagnet.netally.com/my_airmagnet/public/documents/#3rdpartydr

iver.   

https://airmagnet.netally.com/my_airmagnet/public/documents#3rdpartydriver
https://airmagnet.netally.com/my_airmagnet/public/documents#3rdpartydriver
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Quick Start 

AirMagnet Survey Main View 

To open AirMagnet Survey: Open the Windows Start menu, and select AirMagnet 

Survey>Survey. The application will open in Survey mode showing a default blank Map 

view. 

 

To open an existing project: Click Open   or select Open Project from the File menu 

and navigate to the project file. If you select an AirMapperTM project file (.amp) you will be 

asked to specify a new location for the converted Survey project. 

Note: When opening an existing project, be sure the Windows "Regional and Language 

Options" settings match between the existing project and the computer on which you 

open the project. 

To start a new Survey or Planner project: Click Project Wizard . 

Additionally, some sample floor plans and sample projects are available from the Help 

menu. 

Note: Should you choose to open or start a new Planner project, be sure to change the 

view to Planner from the Navigation bar. 

  

Navigation Bar 
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The Navigation bar enables you to open the various functional views within the user 

interface. 

 

Note: The image above shows the Navigation Bar for AirMagnet Survey PRO. Since many 

advanced features in AirMagnet Survey PRO are not available in Survey Express, the 

toolbar in AirMagnet Survey Express has some tools disabled. Refer to the comparison 

chart below. 

Button Description 

Planner 
Simulate AP signal propagation for a site before deployment in order to 

determine optimal AP placement and configuration. 

Multi Floor 

Planner 
View how signal propagation occurs between floors in a multi-floor building. 

Survey 

Perform site surveys by collecting RF data on a WLAN site.  

Note: This view will not be available if the software is installed or operated in 

Viewer mode. 

Display View and analyze RF data collected during site surveys. 

Simulation Conduct data simulation on signal coverage. 

AirWISE 
Access advice about AP deployment based on the RF data collected during site 

surveys. 

Multi View 
Display and analyze RF data collected from sites with multiple floors so that you 

can visualize the interrelationship among the APs across the floors. 

DiffView 
Open the project in multiple frames enabling you to compare the results of two 

data files. 

Reports 

Generate reports based on Planner and Survey project data.  

Note: This function will not work until data are loaded. 

Comparison of functions available in AirMagnet Survey PRO vs. AirMagnet Survey Express. 

View/Tools AirMagnet Survey PRO AirMagnet Survey Express 

  Typical Viewer Typical Viewer 

Survey yes no yes no 

Display yes yes yes yes 

Simulation yes yes yes yes 

AirWISE yes yes no no 

Multi View yes yes no no 

Reports yes yes no* no 

Tools yes no yes no 

Calculator yes yes yes yes 

*AirMagnet Survey Express has one report: ‘Overall Coverage Report by Channel’. 

Utilizing Multiple Adapters 
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Note: The use of multiple adapters is supported in AirMagnet Survey Pro only. AirMagnet 

Survey Express can use only one single adapter at any given time. 

AirMagnet Survey supports up to two simultaneous adapters. If the machine running 

AirMagnet Survey has multiple AirMagnet-supported wireless adapters connected at the 

time the application is launched, you will be prompted to select the adapters that should be 

utilized by the survey process. 

 

Note: In some cases, you must have multiple different adapters inserted in order to 

utilize the multi-adapter functionality. Refer to the AirMagnet’s website for details on 

which adapters are supported in multi-adapter mode. Refer to Supported WiFi Adapters. 

When operating in multi-adapter mode, Survey’s user interface will adjust slightly on many 

screens to reflect the simultaneous use of multiple wireless adapters. 
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Each adapter is granted its own survey pane, allowing you to easily track the devices and 

signal levels detected by each independent device. You are granted further control over 

these adapters in Survey’s Scan configuration (File>Configure>Scan), where each device 

can be adjusted manually to specify the channels to be scanned. 

Note: When a selection is made in either of the drop-down menus for the survey type, 

the second menu will only display the types supported with the first selection. 

The table below indicates the possibilities for conducting simultaneous surveys using two 

adapters. If conducting the type of survey indicated in the far left column, the check marks 

indicate the type of simultaneous survey that may be conducted. For example, if conducting 

a VoFi survey, the only possible simultaneous option is a Passive survey. 

  Passive Active Vo-Fi Iperf 

Passive X X X X 

Active X X     

VoFi X       

Iperf X       

Note: Only one adapter can be a non-preferred adapter when using multiple adapters. In 

this case, the following options are available: 

- A preferred adapter performing a Passive Survey and a non-preferred adapter 

performing an Active Survey. 

- A preferred adapter performing a Passive Survey and a non-preferred adapter 

performing an Iperf Survey. 
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The illustration below shows the Survey Type drop-down menu for a Broadcom 802.11ac 

Network Adapter.  
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Using AirMagnet Survey 

Survey User Interface 

About Survey View 

The Survey view is used for conducting WLAN site surveys whose purposes are to collect RF 

data in the airwave over the site. Once a Survey project is created, it will be automatically 

opened on the Display view. The same thing happens when you open a Survey project that 

you have created earlier. You can open the Survey view simply by clicking   on 

the Navigation Bar. The figure below shows the application's Survey view. 

 

Note: The Survey view is NOT available for AirMagnet Survey that is installed or operated 

for display only. 

Media Type Button 

The  (Media Type) drop-down is located in the Data window of the Survey 

view. Click this button to display a drop-down menu of 802.11 media types that determine 

the type of data to be collected and displayed:  It offers the following options: 
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Note: Because certain non-preferred adapters automatically scan both bands, the Media 

Type button does not display when such an adapter is being used. 

• 2.4 GHz: Selecting 2.4 GHz allows the wireless network card to scan data from APs 

utilizing the 2.4 GHz band only (generally, 802.11b/g/n/ax media types). 

• 5.0 GHz: Selecting 5.0 GHz allows the wireless network card to scan data from APs 

utilizing the 5.0 GHz band only (generally, 802.11a/n/ac/ax media types). 

• 2.4/5.0 GHz: Selecting 2.4/5.0 GHz allows the wireless network card to scan data 

from APs utilizing either or both bands. 

Note: AirMagnet highly recommends that you select a media type before you start on a 

site survey. This will enable you to focus on APs using a specific type of media during the 

survey. 

Survey File Menu Options 

The figure below shows the options of the File menu on the Survey view. 

For keyboard shorcuts: Alt+F activates the menu. The activation letter (if any) is 

underlined. Any Ctrl+ option is noted as well. 

 

Option Description 

New 

Project... 

Opens the New Project Wizard window where you can create a new Survey 

project. It works in the same way as  (Project Wizard Ctrl+N) on the 

Toolbar. 
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Open... Opens an existing Survey project. It works in the same way as   (Open 

Project Ctrl+O) on the Toolbar. 

Save Saves changes made to the current project. It works in the same way as   

(Save Ctrl+S) on the Toolbar. 

Save 

Project 

As... 

Saves the current project under a different name. 

Close 

Project 
Close the current Survey project file. 

Configure... 

Opens the Survey Configuration dialog box where you can configure various 

parameters in AirMagnet Survey. It works in the same way as   

(Configuration) on the toolbar. 

Phonebook Used for managing VoFi profiles. Refer to Configuring a VoFi Phone Book. 

Print... Opens the Print dialog box where you can print the current image (Ctrl+P). 

Print 

Preview 
Allows you to preview what is going to be printed. 

Print 

Setup... 
Opens the Print Setup dialog box where you can select paper options. 

Recent 

Projects 
Lists the most recently opened Survey project files. 

Multi Floor 

Planner 
Launches Multi Floor Planner. Refer to Multi Floor Planner Introduction. 

Exit Exits AirMagnet Survey. 

Survey View Menu Options 

The figure below shows the View menu options on the Survey view. 

For keyboard shorcuts: Alt+F activates the menu. The activation letter (if any) is 

underlined. Any Ctrl+ option is noted as well. 
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Option Description 

Zoom In 
Enlarges the view of the current floor map in the map window. It works in 

the same way as  (Zoom In, Ctrl+Page up) on the toolbar. 

Zoom Out 
Reduces the view of current floor map in the map window. It works in the 

same way as   (Zoom Out, Ctrl+Page Down) on the toolbar. 

Zoom to Fit Fits the current floor map to the map window. It works in the way as   

(Zoom Fit) on the toolbar. 

Zoom to Actual 

Size 

Fits the current floor map to its actual print scale. It works in the same 

way as   (Survey Zoom) on the toolbar. 

Set Zoom... 
Opens the Set Zoom dialog box where you can specify the specific ratio at 

which the view of the map can be increased. 

Toolbars and 

Docking 

Windows 

Choose to show or hide the Legend and Status Bar (show is checked). 

Reset Toolbar: Dragging the Toolbar handles enables the Toolbar to be 

undocked or moved above or below the Navigation Bar. Clicking this 

option will reset the Toolbar to its default setting. 

Show Rulers Enables you to show or hide the rulers along the edge of the map window. 

Show Grids Enables you to show or hide grids in the map window. 

Invert Legend 

Colors 
Flips the legend color scheme vertically. Same as using F10. 

Project 

Properties... 

Opens the Project Properties window where you can adjust the physical 

properties of the floor map of the survey site. 
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AP/Path Name 

Font... 

Opens the Font window where you can modify the font properties of APs 

and survey paths on the floor map. 

 

Toolbar 

The figure below shows the Toolbar on the Survey view. It contains frequently used tools, 

some of which are also found in the File and View menus. 

 

Icon Name Description 

 

Project 

Wizard 

Opens the New Project Wizard where you can create a new Survey 

project. Refer to  File menu. 

 

Open Project Opens an existing Survey (.svp) file. Refer to File menu. 

 

Save Saves changes made to the current project. (Ctrl+S) 

 

Configuration Opens Survey Configuration window. Refer to File menu. 

 

GPS or 

Manual Mode 

Allows you to switch between GPS-aided survey or regular survey.  

Note: This option is available only in Survey PRO with GPS-aided 

Survey projects. 

 

Print 
Opens the Print dialog box where you can print the current floor 

plan  image (Ctrl+P). 

 

Measure 

Mode 
Re-calibrates site dimensions of a floor plan. 

 

Toggle 

Outline 

Enables you to view an outline of where a heatmap transitions from one 

legend value to the next value. 

 

Start Survey Starts the survey. 

 

Stop Survey Ends the current survey. 

 

Pause Stops the survey momentarily until you click to resume data collection. 

 

Retract 

Functions as an “Undo” command, reversing the most recent data point 

at each click of the button. Clicking this button repeatedly keeps erasing 

the survey path backwards. To resume the survey, click a new data 

point on the site map.  

Note: If the survey retract button is grayed out (unavailable), it 

probably means "Auto Position APs with signal greater than __ dBm" 

is enabled. Refer to How to Locate an AP. 

 

Zoom In Enlarges the view of the site map. 

 

Zoom Out Reduces the view of the site map. 

 

Zoom Fit Fits the site map to the Map Window. 
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Zoom Actual 

Size 
Fits the current floor map to its actual print scale. 

 

Survey Zoom 
Covers the view with the Map Window. To restore the default view, click 

the button again. 

Survey Project Window 

The Project Window displays all the components of the current Survey project opened on 

the Survey view, as shown in the figure below. 

A Data File items are as follows from the top: 

• Project file name. 

• Floor plan image file name used in the project. 

• Survey paths (surveys conducted) listed from first to last for this project. 

• Any APs and/or STA (stations) placed on the floor plan. 

 

  

Right-click Pop-up Menu 

The Project Window on the Survey view and Display view also includes a right-click menu. 

Some options are available in Survey view and others in Display view. Unavailable options 

are grayed-out. 

Right-click a survey data file to view the right-click menu options. 
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Menu Option Description 

Close Close this data file 

Delete Deletes the selected (right-clicked) item. 

Rename Rename this data file 

Data Merge... 

Allows you to merge two or more data files.  

Note: This option is available on Display view only. 

View Merged 

Source ... 
Shows the sources from which a merged data file was created. 

View Survey 

Properties ... 
Opens a window that displays information about the file. 

View Survey Properties 

From the Project Window, right-click a survey data file (.svdx), and select View Survey 

Properties from the pop-up menu. The Survey Properties dialog opens, as illustrated 

below.  

Note: This option replaces "View Raw Data" in Survey version 8.8 and higher. 

The Survey Properties dialog provides information about the selected survey data file. 
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View Survey Database 

The Survey Properties includes an option to view in-depth, database details included in the 

selected survey data file. 

To view the database, you will need a database viewer application such as "DB Browser for 

SQLite". This application may be downloaded at http://sqlitebrowser.org/ 

Click View Survey Database. You may be prompted by Windows to associate the database 

with the desired database viewer application. 

Right-Click to Show CAD Layers... 

From the Project Window, right-click a CAD image file, and select Show CAD Layers...  

http://sqlitebrowser.org/
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The Drawing Layers... dialog opens, as shown below.  

 

  

Data Window 

The Data Window displays real-time RF data as they are captured while a survey is in 

progress. Data start to appear in this window once you click  (Start Survey) on the 
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Toolbar. The contents displayed in the Data Window vary, depending on the survey mode 

(active vs. passive) you select. 

For information on active and passive surveys, Refer to Active Survey Data Window and 

Passive Survey Data Window. 

Active Survey Data Window 

The figure below shows the Data Window when AirMagnet Survey is set in active survey 

mode. (Availability of some configuration fields depends on adapter support.)  

 

Option Description 

Adapter The adapter used for the survey is noted at the top of the window. 

Survey Type Options are Active, Passive and Active IPERF. 

Media Type Options are 2.4, 5.0 and 2.4/5.0 GHz 

SSID/AP 

Enables you to associate to either a specific AP or SSID during the active 

survey. The associated drop-down enables you to choose a specific 

device to survey. 

Roaming  
Allows you to set the roaming criteria for the survey. Refer to Roaming 

Control. 

BSSID The name and MAC address of the AP being associated with. 

SSID The name of the network to which the associated AP belongs. 

Speed The rate (in terms of Mbps) at which packets are transmitted. 

Channel 

The radio channel the AP uses to send and receive RF signals, including 

the primary and secondary channels, channel bandwidth and the 

channel span. 
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Signal 
The signal strength for the received packets. The higher the value, the 

stronger the signal. 

Noise 
The level of background radio frequency energy in the 2.4-GHz or 5-GHz 

band. The lower the value, the less the noise. 

S/N 
The Signal/Noise ratio. Compares the Signal data to the amount of 

ambient Noise. 

Frame Size The size of the frame transmitted in terms of bytes. 

Delay The time (in microseconds) between successive transmissions. 

Bytes/s The number of bytes (of data) transmitted per second. 

Frames/s The number of packets (of data) transmitted per second. 

Lost 
The percentage and number of packets that were not transmitted 

successfully from the AP. 

Retry 
The percentage and number of packets that were not transmitted 

successfully from the AP. 

Setting Roaming Properties 

The  (Roaming Option)  button in the upper-right corner of the active survey window 

enables you to control the roaming capability of the wireless network adapter being used 

with AirMagnet Survey. It can help define precisely when the adapter roams, based on the 

properties that you have configured in the Set Roaming Criteria dialog box. See the figure 

below. 

A list of adapters that support this feature may be found under the "Supported Adapters" 

section of the AirMagnet website at https://www.netally.com/products/airmagnet-
survey-pro/#SupportedAdapters. Locate the desired adapter, and click "FEATURE 

DETAILS." Refer to the column labeled "Roaming Control for Active Surveys." 

You should configure the Roaming Control (Signal) feature when using a USB wireless 

network adapter to perform a site survey by SSID. 

Note: In order to test roaming during an active survey, you should set the Windows 

Wireless Profile to Automatically Connect and the other profiles to Manually Connect. 

Otherwise, Windows may activate the other profiles when the Roaming feature is enabled. 

To set the roaming properties of a wireless network adapter: 

1. From the Survey view, click . The Set Roaming Criteria dialog box appears. 

https://www.netally.com/products/airmagnet-survey-pro#SupportedAdapters
https://www.netally.com/products/airmagnet-survey-pro#SupportedAdapters
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2. Select Trigger roaming to a new AP if signal on currently connect AP drops below. 

3. Click the down arrows to select value of interest. 

4. Click OK. 

The wireless network adapter starts roaming when any one of these values is met. 

Configuring roaming based on signal strength will cause your computer to roam once it 

reaches a specific minimum signal strength. 

Passive Survey Data Window 

The figure below shows the Data Window during a survey when set in Passive Survey mode. 

(Availability of some configuration fields depends on adapter support.) 

Note: During a passive survey, if an AP is detected with a Hidden SSID, the AP name 

shown in the MAC Address column on the Survey page will be displayed in red, instead of 

the usual black.  This is to differentiate it from the other, broadcasting SSID APs. 
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Option Description 

Adapter The adapter used for the survey is noted at the top of the window. 

Survey Type Options are Active, Passive and Active IPERF. 

Media Type Options are 2.4, 5.0 and 2.4/5.0 GHz 

SSID/AP 

Enables you to detect devices by AP or SSID during the survey. The 

associated drop-down enables you to either choose a specific device to 

survey or choose "ANY" to capture data for all detected devices (SSID 

or AP). 

Channel  

The RF channel each AP is using as captured by the wireless network 

card. The Channel column displays the primary and secondary 

channels, channel bandwidth and the channel span. 

MAC Address 
The MAC addresses of each AP. It can display either "Best Name" or 

MAC address. Right-click the window to change the display type. 

Signal Strength  The signal strength of all received packets from the AP. 

Noise Level  
The level of background RF energy in the 2.4-GHz or 5-GHz band. The 

Lower the value, the less noise detected. 

Signal/Noise Ratio 

 

The signal strength compared to the noise level. A higher S/N ratio 

usually means better network performance, as there is less noise 

impacting the signal. 

SSID The name of the network to which an AP belongs. 

Current AP Count The total number of APs currently detected. 

Before beginning a passive survey, you may drag-and-drop APs from the Data Window onto 

the Map Window floor plan. Once the survey begins, this option is not available; however, 
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after concluding the survey, this option becomes available in the Display View. Refer to 

Channel/SSID List. 

Map Window 

The figure below shows the Map Window on the Survey view, with a site map displayed in it. 

A site map appears in the Map Window only when it is selected (checked) in the Project 

Window. Otherwise, this part of the view will be blank. 

 

By default, a site map automatically opens in the Map Window when you open a Survey 

project. As soon as a survey is started, information such as AP locations, survey paths, data 

collection points, and so on. start to appear on the map. Before starting a site survey, it is 

important to make sure that the project and site map match the location to be surveyed. 

Modifying Project Properties 

If desired, you can adjust the properties specified during project creation from the Survey 

view. This can be necessary if the dimensions of the site have changed, new infrastructure 

has been installed, or the image appears to be stretched after upgrading to a newer version 

of the AirMagnet Survey software. 
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To adjust project properties: 

1. Right-click the map window and select Project Properties…. (Alternatively, click 

View>Project Properties… from the menu bar.) The Project Properties window 

appears. 

2. Make any adjustments required, as described in the following Project Properties 

table. 

3. Click OK to save the changes. 

Field Description 

Dimensions 

Alter the width and length of the map as desired. Note that since the units 

of measurement are locked in during project creation, the Units field is 

grayed out. 

Environment 
This field allows the user to change the environment type, that is, from 

Open Space Office to Commercial. 
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Signal 

Propagation 

Assessment 

Adjusts the signal propagation assessment. The default value depends on 

the Environment selected when creating the project. 

AP Default 

Power 
Adjusts the default power setting for APs placed on the project. 

Description Click this button to enter a description for the project. 

Margins Allows the user to adjust the spacing padded around the site map. 

Mapping 
Adjusts the scale of the image; this setting can also be modified by using 

the Measure Mode tool. Refer to The Toolbar for more details. 

Project Path Directory location for the open project. 

Using Iperf Integration 

AirMagnet Survey’s integration with the open-source Iperf software provides you with a 

means of recording both upload and download transmit rates during an active survey. 

Although this requires some additional configuration when compared to active surveys, the 

ability to view both upload and download speed information can be invaluable when 

analyzing the wireless network environment. 

During an Iperf survey, the laptop which is being used to conduct the survey transmits 

custom Iperf data packets to a user-configured Iperf server. The server’s responses allow 

Survey to record the station’s download speed from the current location. 

In order to conduct an active Iperf survey, you must download and unzip the Iperf server 

software on a separate device. AirMagnet's legacy iPerf integration is designed to operate 

with Iperf Server version 1.7.0, 2.0.5, and 2.0.9. You can locate Iperf software by means of 

internet search on the term "iperf2". (See the For iPerf3 section below for information 

about using Survey's new iPerf3 integration in v9.3.)  

Note: AirMagnet recommends that you create an Iperf folder in the root directory to 

contain the files (that is, C:\Iperf). 

Starting the Iperf Server: 

After the Iperf server software has been downloaded and extracted, you must launch the 

application before starting an Iperf survey. 

1. Type ‘cmd’ in the Windows search field in the bottom Taskbar. 

2. Open the Windows command-line interface. 

3. Navigate to the Iperf folder (e.g., C:\Iperf) using the CHDIR command as needed. 

4. Type ‘Iperf -s’ and press Enter. A message appears describing the TCP port in use 

by the server. 

Note: In the command to start the Iperf server, the ‘-s’ parameter stands for ‘server’ and 

the ‘-p 5001 part tells the server to listen on port 5001. By default, AirMagnet Survey 

uses 5001 as the port for its transmissions during an active Iperf survey. If the Iperf 

server port is changed, you must change the port used by the Survey application as well. 
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To access IPerf configuration options, select Active IPerf as the Survey type, and select the 

Advanced button to open the IPerf Config dialog box. (See Choosing a Survey Mode and 

Active Survey Data Window.) 

Note: Ensure that the Client port set in the IPerf Config dialog is not blocked by an 

AP/controller/firewall, etc. The default client port for the down link is 9999. 

Once the Iperf server status message appears, the system is actively listening for Iperf 

transmission messages. The system is now ready for conducting an active Iperf survey. 

For iPerf 3 

Beginning with Survey version 9.3, iPerf 3 is supported for performing an iPerf survey, 

either via iPerf 3 server software installed on a PC or other machine, or using NetAlly's Test 

Accessory.  

• To download and install iPerf 3 software, visit https://iperf.fr/. 

• Learn more about the Test Accessory from NetAlly.com/products/TestAccessory. See 

the Test Accessory User Guide for instructions on adjusting the Test Accessory's 

settings. 

Note the following differences in functionality between iPerf 2 and iPerf 3: 

• While using iPerf 2, you will be able to run both upload and download throughput 

measurements at the same time. While using iPerf 3, you will only be able to run an 

upload or a download test. iPerf 3 does not support the option to run both tests at 

the same time. 

• You will have the option to perform an iPerf 3 throughput survey against your own 

iPerf 3 server, or you could use NetAlly’s Test Accessory (pocket sized iPerf server). 

You will not be able to perform an iPerf 2 survey against the NetAlly Test Accessory. 

• iPerf 3 surveys are only supported while using 802.11ac/ax adapters. You still will be 

able to use older Wi-Fi adapters while running an iPerf 2 survey.  

• For iPerf3 servers, the default port number is 5201. iPerf3 clients use an ephemeral 

port. 

Using an iPerf 3 Server 

See the "iPerf user docs" page at https://iperf.fr/. 

In the Active IPERF Survey Data Window, select IPerf 3 in the appropriate drop-down 

menu field. 

  

  

Site Surveys 

Creating an Indoor Survey Project 

https://iperf.fr/
http://netally.com/products/testaccessory
https://iperf.fr/
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Prior to starting a site survey, it is required that you create a Survey project which involves 

naming the project, importing a site map, specifying some physical properties of the site, 

and so on. This section explains the procedures for creating a Survey project for an indoor 

site survey. 

To create a new Survey project: 

1. Do one of the following: 

• From the Main Menu, select File>New Project..., or 

• From the Toolbar, click   (Project Wizard). 

The New Project Wizard view appears.   

 

2. Enter a unique name for the new project. 

Note: This section explains the procedures for creating a Survey project that is NOT 

intended for an outdoor GPS-aided site survey. Therefore, leave the GPS Project option 

unselected. For instructions on how to create a GPS-aided Survey project and how to 

conduct GPS-aided site surveys, Refer to Creating GPS-Aided Site Surveys. Keep in mind 

that the GPS feature is available only in AirMagnet Survey PRO. Users of AirMagnet 

Survey Express who wish to upgrade to AirMagnet Survey PRO should contact AirMagnet 

Sales for more information. 

3. Save the project using one of the following options: 

• To save the project to the default location, click Next. 

• To save the project to a location other than the default, click   to specify a 

location of your choice, and click Next. 

Note: By default, AirMagnet Survey automatically saves the project to the C drive on 

your computer, using the name you specify. Check “Set as default project directory” to 

ensure that subsequent Survey projects are saved to the same location, if desired. 
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4. Click   (Import Site Image) to locate and import the site map of the location 

where surveys will be conducted. 

5. For Unit of Measurement, select Feet or Meters. 

6. For Floor Plan Dimensions, enter the Width and Length of the floor plan. 

Note: “Floor Plan Dimensions” refers to the scale (in feet or meters)of the entire image 

area of the floor plan (including any white space margin included in the image). If you are 

not sure of the dimensions, you may or may not enter the approximate values here and 

then recalibrate the values more accurately later. Refer to Measuring and Calibrating the 

Floor Plan Scale. The floor plan must have calibration values whether entered here or by 

using Measure Mode before starting a survey. 

7. Click Next. 
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8. For Survey Environment, select an option that resembles the site environment 

where the survey is to be conducted. 

9. For Signal Propagation Assessment, do nothing (normally), since AirMagnet 

Survey can automatically assign the value according to the site environment you 

select. 

Note: AirMagnet Survey assigns the Signal Propagation Assessment value based on the 

estimate of the distance RF signals could travel in each of these typical site environments. 

Normally, it is recommended that you accept the default value the program assigns. 

However, if you want to set a value of your own, you must be aware that the value you 

enter will affect the way the program interpolates site data. 

10.  For AP Default Power, do nothing (normally). 

Note: If you know the default value of the AP power, enter it now. The value will be used 

when conducting data simulation. 

11.  Click Next. The New Project Wizard view refreshes.   
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12.  Enter a brief description of the project. (Optional.) 

13.  Click Finish. The newly created Survey project will automatically appear in the 

Project Window, and the site map will be displayed in the Map Window. 

Note: You can create as many projects as needed by following the same procedures 

outlined above. By default, a new project will automatically open on the Survey view as 

soon as it is created. 

Choosing a Survey Mode 

AirMagnet Survey can be operated in three survey modes: 

• Active Survey: In an active survey mode, the wireless network card actively 

associates itself with the selected AP or SSID, sending and receiving RF packets to 

and from the AP or SSID. Selecting a specific AP will let the wireless network card 

associate only with that AP, whereas selecting an SSID will let it associate with the 

AP that has the strongest RF signal within the SSID group as you’re roaming over 

the site. Refer to Enabling Active Survey Mode. 

• Active IPERF Survey: The Active Iperf Survey option refers to AirMagnet Survey’s 

integration with the open-source Iperf software, and is effectively a standard active 

survey with a bit more initial configuration that provides additional transmission data 

to the user. This setup allows you to gather transmission data for both uplink and 

downlink rates (as opposed to just the former). Refer to Using Iperf Integration for 

information on configuring and activating Iperf integration. 

• Passive Survey: In a passive survey mode, the wireless network card does not 

associate itself with any particular AP or SSID. Instead, it simply listens to the RF 

data moving through the site, detecting and recording all RF signals and noises in 

the environment. By default, AirMagnet Survey opens in the active survey mode 

when it is operated in Survey view. Refer also to Enabling Passive Survey Mode. 



Using AirMagnet Survey 

46 

Enabling Passive Survey Mode 

To set AirMagnet Survey in passive survey mode: 

1. From the Data Window, click the Survey Type drop-down list and select Passive 

Survey. 

2. Do one of the following 

• Leave the SSID field set to Any, or 

• Select a specific SSID or AP from the drop-down. 

Refer to Passive Survey Data Window. 

Enabling Active Survey Mode 

To set AirMagnet Survey in active survey mode: 

1. From the Data Window, click the Survey Type drop-down list and select Active 

Survey. 

2. Do one of the following: 

• Select AP from the drop-down list on the left and then choose a specific AP from 

the drop-down list on the right (if you want to perform an active survey on an 

individual AP). 

• Select SSID from the drop-down list on the left and then choose an SSID from the 

drop-down list on the right (if you want to perform a survey on an entire network. 

Refer to Active Survey Data Window. 

Conducting Indoor Site Surveys 

AirMagnet Survey can be used for both pre- and post-installation WLAN surveys to collect 

RF data on the site. The surveys can be performed without having APs permanently installed 

in their locations. Also, there is no need to adjust channels from the APs prior to a survey 

since AirMagnet Survey allows you to do channel separation when analyzing the data in the 

Display view, where you can change channel allocation once a suitable channel combination 

is identified through channel simulation. This undoubtedly saves both time and resources 

that would otherwise be required for a conventional site survey. 

When opening a Survey project,  make sure that the Survey project (.svp) file is located on 

the laptop PC you are using to conduct the site survey. Opening projects remotely (that is, 

over a network connection) can create problems when trying to save the data after 

conducting the survey if the network connection is no longer available. 

When performing a survey that may take a long time (for example, longer than 10-15 

minutes), Airmagnet recommends that you break the survey up into several smaller 

instances. This ensures that you will not lose all the survey data should a problem arise with 

the computer. After the multiple surveys have been completed, you can then merge the 

resulting data files together to create the same result as surveying the entire area at once. 

This section explains indoor site surveys that are usually small-scale surveys conducted 

inside a building, for example, an office complex, warehouse, and so on. 
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Pre-Installation Site Surveys 

A properly conducted pre-deployment survey can help ensure that the ultimate network 

installation operates at peak efficiency, with a minimum of extraneous or conflicting 

components. The process outlined below is designed to help users conduct a basic survey of 

the network environment prior to actually installing any network components. 

Note: The following steps are intended to outline the basic required steps for a proper 

survey; additional enhancements for improved results can be found later in this 

documentation. 

Pre-installation survey procedures can be summarized as follows: 

1. Conduct a passive survey of the entire site (broken up into several shorter surveys, if 

necessary) in order to collect data regarding ambient traffic, noise levels, and 

frequency usage. 

2. Use AirMagnet Planner to create a model of the new site, including anticipated 

layout, obstacles, and so on. 

Note: Users who do not have an AirMagnet Planner license will not be able to model the 

network using AirMagnet Planner. For steps on manually planning out the environment, 

Refer to “Manually Planning the Deployment”. It is important to note that a manually-

created plan can provide several advantages over a Planner-assisted one, since it is 

based on real-world data. After creating the manual plan, continue with these steps to 

complete the pre-installation survey process. 

3. Use the Planner Advisor function to allow Planner to automatically suggest optimal 

AP locations for the new site. Refer to “Using Planner Advisor” for more details. 

4. Use Survey’s Display view to analyze the Planner results (or the results from the 

manual plan) in order to verify that the projections meet the needs of the expected 

deployment. 

5. Set up the network as projected from the steps above. 

Manually Planning the Deployment 

Manually testing the new wireless site prior to deployment can take environmental variables 

into account and therefore provides more detailed information. The following survey is 

generally referred to as an AP-on-a-stick survey because you use a single AP to determine 

the potential placement of several APs. 

To manually plan the wireless deployment: 

1. Go to the likely location where you may want to deploy an access point (AP). 

2. Use a test AP to conduct as many active surveys as needed to ensure that the AP’s 

intended coverage area is fully covered by the surveys. 

Note: Since you should save the survey data at the end of each survey, you may end up 

having several active survey data files for the AP at one location. 
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3. Move the AP to the other potential AP locations and conduct several active surveys at 

each location in the same manner as described in Step 2. Remember to save the 

survey data at the end of each survey. 

4. Conduct one passive survey using the same AP, and save the survey data. 

5. Switch AirMagnet Survey to the Display view and merge all the active and passive 

survey data files. For instructions on how to merge data files, refer to Merging 

Survey Data. 

6. Display the merged data by channel or by SSID. Refer to Project Window and 

Channel/SSID List. 

Note: For better results, AimMagnet recommend that (1) you merge the active survey 

data files collected at each location first, (2) merge the merged active survey data files 

from all locations, and (3) merge the passive survey data file with the merged active 

survey data file that included active survey data from all locations. This will provide you 

with the most comprehensive RF data about the AP and the site environment. 

Post-Installation Site Surveys 

Regular post-deployment surveys can help you ensure that you keep abreast of changes in 

the wireless environment. Even when perfectly designed, a pre-installation site plan cannot 

account for changes in the network’s demands, unexpected interferers, along with a 

multitude of other dynamic factors in a wireless coverage area. You must conduct 

“refresher” surveys at regular intervals in order to verify that the deployment continues to 

meet enterprise requirements.  

Note: The following steps are intended to outline the basic required steps for a proper 

survey; additional enhancements for improved results can be found later in this 

documentation. 

Post-installation survey procedures can be summarized as follows: 

1. Conduct a passive survey of the entire deployed environment (broken up into several 

shorter surveys, if necessary) and compare the results to those generated during the 

planning stage of the pre-deployment process described above. 

2. Make any required adjustments that were not accounted for in the pre-installation 

portion in order to make the network meet the user and throughput requirements. 

Note: Step 2 is necessary due to the fact that some factors cannot be accounted for 

during the planning process. For example, having people moving through the wireless 

environment can cause interference that would not be there prior to installation. 

3. Conduct an active survey in order to verify that there are no gaps in the coverage 

area that were not discovered during the passive survey. This process also allows 

you to verify that the real-world network traffic (for example, PHY data rate, packet 

loss/retry, uplink/downlink data) meets user requirements. 

Note: It is important to note that although it is more complex, an active survey provides 

a variety of additional benefits over simply conducting a passive survey. Refer to 

“Choosing a Survey Mode” for more information. 

4. Repeat steps 1 through 3 at least every three months in order to keep up-to-date 

information about the wireless network on hand. 
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Tips for Improved Survey Accuracy 

The following tips are intended as guidelines that can help enhance the general survey 

procedures. 

• Focus on one band (2.4- or 5-GHz) at a time; attempting to do both may take less 

time, but can cause “gaps” in the data. 

• Plan the survey path ahead of time in order to conduct the most complete survey in 

minimal time. Planning and walking the path ahead of time can help the user identify 

obstacles, potential trouble spots, etc. 

• Be sure to survey from all areas of the network; don’t assume that coverage on one 

side of the APs will be identical on the opposite. 

• Moving faster can result in insufficient data collected; however, moving too slowly 

results in longer processing times due to an excess of information. 

• Active surveys give a much more comprehensive perspective of “real-world” 

performance, and as such are required for a complete survey process. 

Conducting a Passive Survey 

As described earlier in this documentation, the passive survey is a quick and easy survey 

method that gathers all available 802.11 information in the wireless environment. This 

allows you to view any traffic present, be it from a neighboring network or simply from 

ambient noise levels. The steps below detail the basic process of conducting a passive 

survey. 

When you start and conduct a survey, the application begins collecting data about the 

environment. The idea is to walk a path about which you desire to gain signal coverage 

information. 

Use the following suggestions for improving the accuracy of your survey: 

• Click your position on the image map each time you change direction. 

• Click at identifiable landmarks (such as doorways) that indicate your position on the 

image map. 

• Maintain a steady walking pace slower than a normal walk in order to gather plenty 

of data. 

Note: The steps below assume that the you have already created a survey project for the 

desired site. AirMagnet recommends that you have the Survey projects created ahead of 

time in order to make sure that the site map is accurate and of good resolution. 

To conduct a passive survey: 

1. From within AirMagnet Survey, click   (Open Project) from the Toolbar. 

2. Locate and open the Survey project (.svp) file of interest. The selected project file 

appears in the Project Window and the site map displays in the Map Window.   
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3. If the project has more than one site map, select the map you want to display in the 

Map Window (if it is not already opened). 

4. Click   (Media Type) and select a media type from the drop-down list. 

5. From the Data Window, click the Survey Type drop-down list and select Passive.   
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Note: For best results, AirMagnet recommends leaving the SSID field to “Any” while 

performing a passive survey. This will enable you to collect comprehensive RF signal data 

from the site environment. 

6. Click  (Start Survey) and walk through the planned survey path, clicking as 

necessary to indicate each step in the survey. Note that by default, AirMagnet 

Survey automatically spaces data points over time, so it is only necessary to click a 

point when starting the survey and changing direction. 

While conducting a survey, you must click from time-to-time to save the data as you 

travel along your survey path. The inactivity timer has been enhanced to 

automatically pause the survey if there is no click within the system specified time. 

If the system does not detect a click action within the allotted time, a warning 

message prompt appears that counts down the time available to click before the 

survey is automatically paused. 

Note: AirMagnet recommends that you maintain a steady pace slower than a normal walk 

in order to gather as much data as possible. 

7. Click  (Stop Survey) once enough data have been collected. 

8. Save the survey data when prompted. 

For instructions on how to view and analyze survey data, refer to Performing Data Analyses. 

Conducting an Active Survey 

As explained previously, active surveys are more difficult to set up and perform than 

passive surveys, but have the advantage of providing real-world data for PHY Data Rate, 



Using AirMagnet Survey 

52 

packet loss/retry, and uplink/downlink rates. Although active surveys require some 

configuration and initial setup prior to collecting data, these steps are required for users 

who wish to obtain the most accurate reflection of the network’s performance as it relates to 

the end-user. 

To conduct an active survey: 

1. From within AirMagnet Survey, click   (Open Project) from the Toolbar. 

2. Locate and open the Survey project (.svp) file of interest. The selected project file 

appears in the Project Window and the site map displays in the Map Window.   

 

3. If the project has more than one site map, select the map you want to display in the 

Map Window (if it is not already opened). 

4. Click   (Media Type) and select a media type from the drop-down list. 

5. From the Data Window, click the Survey Type drop-down list and select Active.   
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6. Use the first drop-down to select SSID (to associate to a specific SSID) or AP (to 

associate to a specific AP). 

7. Use the second drop-down to select the SSID or AP to which the application should 

associate. 

8. If the selected SSID or AP requires a specific authentication mechanism, configure 

this information via the 802.11 tab from the File>Configure… menu. Refer to 

“Configuring 802.11 Parameters” for more information. If no authentication is 

necessary, continue to Step 9. 

9. Click  (Start Survey) and walk through the planned survey path, clicking as 

necessary to indicate each step in the survey. Note that by default, AirMagnet 

Survey automatically spaces data points over time, so it is only necessary to click a 

point when starting the survey and changing direction. 

While conducting a survey, you must click from time-to-time to save the data as you 

travel along your survey path. The inactivity timer has been enhanced to 

automatically pause the survey if there is no click within the system specified time. 

If the system does not detect a click action within the allotted time, a warning 

message prompt appears that counts down the time available to click before the 

survey is automatically paused. 

Note: AirMagnet recommends that you maintain a steady pace slower than a normal walk 

in order to gather as much data as possible. 

10. Click  (Stop Survey) once enough data have been collected. 

11. Save the survey data when prompted. 
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For instructions on how to view and analyze survey data, Refer to Performing Data 

Analyses. 

Placing APs in the Survey 

Active Survey for a specific AP: When you Start an Active Survey for a specific AP (Click 

Start Survey ), you are prompted about whether you want to place the AP at its location 

on the floor plan. If you choose Yes, an AP appears on the floor plan and you may drag it to 

its actual location. 

Passive Survey: When you Start a Passive Survey (Click Start Survey ), detected AP(s) 

are listed in the Active Survey Data window. Before the first click, you can drag a desired AP 

listing on to the floor plan in order to indicate its actual location. You can do this one-at-a-

time for as many APs as desired. 

When you stop and save the survey, any APs on the floor plan will be contained in the 

associated Survey Data Files (.svdx) that have been saved in the project. This means that 

when you switch to Display view and open a Data File, any APs saved in the data file will be 

automatically placed on the floor plan. 

At this point, once a survey is stopped and saved, you can drag one or more APs on to the 

floor plan, however; these new APs will be in the next survey (since the last survey was 

saved and closed) or, if you do not conduct another survey, these APs will be in the survey 

project but not contained in a data file. 

Deleting APs from the Survey Project 

You can delete any APs from the survey project. From the Survey view, right click the 

desired AP listing in the Project Window and select Delete. However; any data file created 

(saved surveys) will still contain the placed APs. 

 

Deleting APs from a Data File 

If one or more APs were placed in the survey project and the survey was saved, the APs will 

appear in the data file in Display view (refer to Map Window). You can delete a placed AP 

from the data file. 

1. Select the desired data file (.svdx) in Display view to show its floor plan and 

heatmap in the Map window. 
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2. In the Map window, right-click the desired AP and select Delete location 

information for this AP. You are prompted to choose one of two options:  

• Delete from both the survey and project files: The AP location is deleted 

from both this survey data file and also from this opened survey project. 

• Delete from survey file only: The AP location is deleted from this survey 

data file only, but kept in the survey project. 

  

Merging Survey Data 

As mentioned earlier, when performing a site survey on a large site, you may want to break 

up the project into several small survey projects. Each small project covers only a part of 

the site. You save the survey data collected from each small area as a separate Survey 

(.svp) file. When the whole survey project is completed, you end up having several survey 

files, each covering a specific part of the site or network.  You then have to merge the 

individual Survey files together to get a Survey file containing data that cover the whole 

site. You will then use this consolidated (.svp) file to plan and enhance your wireless 

network. 

AirMagnet recommends the following steps when merging Survey data files: 

1. Merge all the active survey files collected at the same AP location. 

2. Merge the merged active files from all AP locations. 

3. Merge the merged active file from Step 2 with the passive survey file(s). 

 

 

Documenting Your Surveys and Analyses 

You can document the results of your site surveys and data analyses using AirMagnet 

AirMagnet Survey’s Copy and Print functions. 

Copying Your Data into Other Applications 

You can copy your survey data and the results of your analyses (displayed in the Map 

Window) into any software application that supports the copy-and-paste function. The 

copied data will contain whatever information displayed in the Map Window, including the 

site map, AP locations, survey paths, and the graph (if in Display screen). This is a great 

way to share your survey data. 

To copy data to another application: 

1. Display the data you want to show on the site map. 

2. Click Edit>Copy Heatmap Image. 

3. Open a file in a software application that supports copy-and-paste and paste it into 

the document. The following figure shows survey data copied and pasted into a 

Microsoft Outlook document. 



Using AirMagnet Survey 

56 

 

Printing Your AirMagnet Survey Data 

You can print your survey data using AirMagnet Survey’s printing capability. The data you 

print can be raw data collected from site surveys or the results of your data analyses, 

simulation, or filtering. It’s a great way to document your site surveys and WLAN 

infrastructure, as well as a way to share your work. 

To print your survey data: 

1)      Display the file in the Map Window. 

2)      Click File>Print Preview. The Print Preview window appears. 
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3)      If you are satisfied with what you see in the Preview window, click Print. The Print 

dialog box appears. 

4)      Make the desired selections, and click OK. 

Sharing a Survey Project 

An AirMagnet Survey project may be shared with other users who have AirMagnet Survey or 

AirMagnet Viewer installed on their computer along with a valid license. For viewer 

restrictions, refer to Survey Viewer License. 

To share your project with another user: 

1. Locate the survey project folder. The folder was created when you set up your new 

project. The folder name is the “project name” you gave your project. The default 

location is "My Documents." 

2. Compress the folder using a compression application (for example, ZIP) and send it 

to the recipient. 
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The recipient of the compressed file can do the following to open the shared AirMagnet 

Survey project: 

1. Decompress the folder. 

2. Launch AirMagnet Survey. 

3. Select File>Open and browse to the .svp file contained in the decompressed folder. 

GPS Surveys 

Creating a GPS-Aided Survey Project Using an Existing Site Map 

This section explains the procedures for creating GPS-aided Survey projects. GPS-aided site 

surveys usually cover large outdoor areas. Like creating an indoor Survey project, creating 

an outdoor GPS-aided Survey project also involves importing a site map which is done in 

the same way as you do when creating an indoor Survey project. 

To create a new site map using Bing Maps or Google Maps: 

1. Open Bing Maps or Google Maps in a web browser, and enter a location for your 

outdoor Survey, zooming in appropriately. 

2. Use a screenshot application (like Windows Snipping Tool) to create a .png or .jpg of 

the area. 

3. Open AirMagnet Survey, and create a new GPS Survey project (see details below). 

4. To view GPS coordinates (for later entry into the New Project Wizard dialog box 

GPS Coordination), in Bing Maps, right click at the desired map location. In Google 

Maps, left click at the desire map location. A pop-up will display the GPS coordinates 

of the spot where you clicked. 

To create an outdoor Survey project using an existing site map: 

1. Start AirMagnet Survey and click File> New Project.... The New Project Wizard 

view appears.   
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2. Specify the name of the new project, and click GPS Project. 

3. Type the directory path or browse to the location where the project file is to be 

stored, and click Next.   

Note: The following steps assume you want to import a site map (image file) from your 

local computer. 

4. Click the Import Outdoor Street/Campus Map (GPS) Image radio button. The 

"Select Type" drop-down appears that allows the user to browse for a map.  

5. To import a site map from the local computer, select "Browse" and open the desired 

image.   
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5. If you know the values of GPS coordinates, you can enter them now. Otherwise, you 

can use the calibration tool   to calibrate the data later. For more information 

about GPS calibration, refer to Performing a GPS-Aided Site Survey. 

6. Click Next. The New Project Wizard view refreshes.   
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7. For Survey Environment, check the outdoor option that best matches the 

environment to be surveyed. 

8. For Signal Propagation Assessment, do nothing (normally), since AirMagnet 

Survey can automatically assign the value according to the survey environment 

you’ve selected. 

Note: AirMagnet Survey assigns the Signal Propagation Assessment value based on the 

estimate of the distance RF signals could travel in each of those typical survey 

environments as shown in the figure above. Normally, AirMagnet recommends that you 

accept the default value the program assigns. However, if you want to set a value of your 

own, you must be aware that the value you specify will affect the way the program 

interpolates survey data. 

9. For AP Default Power, do nothing (normally). 

Note: If you know the value of AP power, you can enter it now. It will be used when 

conducting data simulation. 

10. Click Next. The New Project Wizard view refreshes. 

11. Enter a description of the project. Enter a brief description of the project in the 

space, and click Finish. The newly created Survey project will automatically open on 

the Display view, with the site map in the Map Window. 

Configuring GPS COM Port 
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Once a GPS-aided Survey project is created, the next step is to configure Survey’s GPS COM 

port so that it can communicate with the GPS device to which it is connected. 

To configure Survey’s GPS COM port: 

1. From your desktop, open the Device Manager. You can search for it using the 

Windows search field in the bottom Taskbar.  

Note: Accessing the Windows Device Manger procedure may differ somewhat depending 

on the Windows operating system. Refer to Windows Help>Device Manager. 

 

2. Click Ports (COM & LPT), and write down the COM port number listed after the 

device’s name. 

3. Close the Device Manager. 

4. From Survey’s Survey or Display view, click File>Configure.... The Survey 

Configuration dialog box appears. The Settings tab is default. 
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5. Check Enable GPS Port and click Configure GPS.... The GPS COM Configuration 

dialog box appears. 
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6. Under Connect to, select the COM port identical to the one you found in Step 2. 

7. Under Flow Control, select None, and click OK. 

8. Click OK to close the Survey Configuration dialog box. 

Note: A USB to Com port software may be needed when connecting a GPS device via a 

USB port rather than a Com port. This software is often provided by the GPS device 

manufacturer. 

Verifying GPS Device Connection 

To verify the connection to a GPS device: 

1. From the Navigation Bar, click Tools>GPS Information. Survey’s Tools dialog box 

appears. 
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Note: The view should be populated with valid GPS information if Survey is successfully 

connected to the GPS device. Otherwise, you may have to do some troubleshooting to 

make sure that the connection between Survey and the GPS device is established. No 

data will be collected if communication between AirMagnet Survey and the GPS device 

fails. 

2. Close the Survey Configuration dialog box. 

Performing a GPS-Aided Site Survey 

Once the communication between AirMagnet Survey and the GPS device is established, you 

can start performing a GPS-aided site survey. 

Note: To find coordinates without using GPS, you can open Bing or Google Maps in a web 

browser. In Bing Maps, right click at the desired map location. In Google Maps, left click 

at the desire map location. A pop-up window will display the GPS coordinates of the spot 

where you clicked. 
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To calibrate the GPS Coordinates: 

If you created the GPS survey project using a site map, you must first calibrate the GPS as 

described in the following steps. Otherwise skip to "Starting GPS Survey." 

1. Open a GPS-aided survey project that you have created. 

2. From the GPS map, determine the two locations where GPS coordinates are to be 

taken. 

Note: To ensure the accuracy of your GPS survey, it is highly recommended that you 

select two points with different GPS coordinates on the map. They should be in the north 

and west directions and be set far apart from each other. 

3. From the Toolbar, select  (Calibrate GPS) and click the first spot on the GPS 

map. AirMagnet Survey starts to recalibrate the GPS information. 

 

4. Click OK to close the view. 

5. Then move to the second location, click the corresponding point in the map. Survey 

will recalibrate the GPS coordinates for this location. 
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6. Click OK to close the view. A dialog box will appear asking if you wish to start the 

survey. 

7. Click Yes, or go to "Starting the GPS Survey" to do so manually. 

To Start the GPS Survey: 

1. From the Toolbar, click   (Start Survey) and start to move along the survey 

path. 

2. Click   (Stop Survey) when enough data have been collected. 

3. Save the project. 

Note: You can repeat the same procedures to conduct as many GPS surveys as needed. 

The figure below shows a sample GPS survey view. 
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Exporting GPS-Aided Site Survey Data to Google Earth 

You can export your survey data collected during a GPS-aided site survey to Google Earth 

so that you can view the data on a larger scale. 

Note: You must be working from the Display view in order to export data to Google 

Earth. 

To export into Google Earth: 

1. Download and install Google Earth software (if not already done) from 

http://earth.google.com/download-earth.html. 

2. Open the GPS project in the Display view, click File>Export to Google Earth. 

3. The Google Earth view opens, displaying your survey data superimposed over the 

map. 

http://earth.google.com/download-earth.html
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VoFi Surveys 

Conducting VoFi Surveys 

A VoFi survey is a critical part of planning any voice over WLAN deployment.  By conducting 

a VoFi survey, you can gain a comprehensive view of the wireless environment from the 
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perspective of a VoFi phone. Just as with a data network, any problems or wireless hazards 

that are present in an anticipated VoFi deployment will be significantly easier to remedy if 

they are identified before the network is fully operational.  As such, taking the time to 

properly survey and troubleshoot the pre-deployment environment can greatly improve the 

resulting installation. 

Note: You can verify that an existing wireless deployment is VoFi-ready by following the 

instructions provided with the AirWISE view. 

VoFi surveys gather data from an active connection between a wireless AP and a VoFi 

phone.  In order to establish this connection, you must establish a call between two phones 

(one of which must be a VoFi phone; the other may be VoFi or wired, but must remain 

stationary during the survey) before attempting to start the survey.  Once Survey detects 

the call, you can start collecting the survey data.  VoFi surveys can be helpful in 

troubleshooting problem areas in a VoFi deployment; they can provide details about the 

active call such as WiMOS, roaming frequency, and signal strength. 

Note: VoFi surveys require that you carry an actively connected VoFi phone along with 

the laptop during the survey process.  For best results, attach the phone to the laptop in 

an upright position (to best mimic the position of the phone during an actual call). Before 

starting a VoFi survey, you should note down the MAC address of the phone being used, 

as the phone must be selected from a list of active calls once the survey has started. 

To conduct a VoFi survey: 

1. Create a new survey project (click here for instructions). 

2. Configure Survey's VoFi phone book . 

3. From Survey's configuration window, click the Scan tab and specify the channels on 

which the VoFi APs operate.  This step helps the application quickly re-detect the 

phone during instances of roaming. 

4. From the Survey view, click the Survey Type drop-down list and select VoFi Phone 

Survey. 

5. Start a call with the VoFi phone and click   (Start Survey).  The VoFi Call List 

dialog box appears. 
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6. Select the phone's MAC address from the call list and click Begin Survey. 

7. Click regularly along the survey path to collect data, just as during a standard data 

survey.  A pop-up window will appear whenever the phone roams to indicate its 

roaming status. 

8. Once the survey is completed, click  (Stop Survey) and save the data. 

Note: After completing a VoFi survey, you can view the resulting picture of the wireless 

environment.  Refer to Analyzing VoFi Survey Data for additional details. 

Configuring a VoFi Phone Book 

Note: The VoFi phone book must be configured before attempting to conduct a VoFi 

survey. 

Due to the differences between individual VoFi phones, you must provide some 

configuration information in order to ensure that Survey can properly interpret the data 

received from VoFi surveys. This process consists of you creating VoFi phone profiles within 

Survey’s phonebook that correspond to the types of phones in use (or expected to be in 

use) on the VoFi deployment. The following sections provide you with a guide through this 

process. 

To access the VoFi Phonebook: 

1. Navigate to the Survey or Display view. 

2. Click File>Phonebook…. The Phonebook window appears. 
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Note: The phone book configuration process consists of two steps: create a VoFi phone 

profile and add the VoFi phones to the Phonebook. Click their respective links for more 

details. 

Creating VoFi Phone Profiles 

Phone profiles contain the required configuration information specific to individual types of 

phones. Phones provided by different vendors (or even different phone models from a single 

vendor) can have drastically different configurations, and without creating profiles within 

Survey that correspond to the phone types in use, the user may not obtain optimal results 

from VoFi surveys. 

To create a VoFi profile: 

1. From the Phonebook window, click Profiles…. The VoFi Profiles window appears. 
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2. Click Add… to open the Create Profile dialog box. 

3. Enter a name for the profile (AirMagnet recommends that this name match the 

vendor and model number of the phone). 

4. Fill in the remaining fields as required by the phone. See the table below for 

additional details. 

Field Description 

Codec Type 

A codec refers to an algorithm or specialized computer program that encodes 

or reduces the number of bytes consumed by large files and programs. Files 

encoded with a specific codec require the same codec for decoding.  Refer to 

the VoFi phone’s user manual to determine the codec it uses. 

Voice Frame 

Duration 

In contrast to most wireless transactions, VoFi data is normally transmitted in 

steady fixed-size packets.  The voice frame duration refers to the time (in 

milliseconds) that should be allocated for each frame.  This value should be 

available from the VoFi phone vendor’s website or documentation. 

Jitter Buffer 

The jitter buffer refers to the amount of memory allocated to buffering voice 

data to account for “jitter”, or packet delays, in the VoFi exchange.  Since 

seemingly small amounts of delay in a conversation can result in drastically 

reduced call quality, the phones include a built-in buffer to help smooth out 

portions of the call that experience unusually high jitter levels.  The phone’s 

specified jitter buffer value should be provided in its documentation or 

website. 

5. Click OK to save the new profile. 

6. Repeat Steps 1 through 5 for each type of phone in use on the VoFi deployment. 

When finished, click OK to close the VoFi Profiles window. 
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Note: Entering the incorrect values for a VoFi phone profile can result in Survey being 

unable to detect calls made from phones associated with the profile. 

Once all necessary profiles have been implemented, users can add the phones to their 

corresponding profiles, as described here. 

Adding Phones to VoFi Profiles 

After creating a VoFi phone profile, you must enter the VoFi phones in use in the 

deployment into Survey’s VoFi phone book and match each device with the appropriate 

phone profile. This step ensures that VoFi Survey is able to detect the call. 

To add phones to the phone book: 

1. From the Phonebook window, click Add…. The New Phonebook Entry dialog box 

appears. 

 

2. Enter the phone’s MAC address in standard MAC notation (for example, 

aa:bb:cc:dd:ee:ff, including colons). 

Note: If you have already conducted a passive survey of the wireless environment, the 

MAC Address drop-down list may already contain the phone’s MAC address information. 

In this case, use the drop-down to select the desired phone. 

3. Use the Profile Name drop-down list to select the desired profile and click OK to save 

the changes. 

4. Repeat steps 1 through 3 for all phones necessary. 
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Using AirMagnet Planner 

Planner User Interface 

Navigation Bar 

Serves as a launching pad of various screens and utilities. Options on the navigation bar 

vary, depending on the software license. 

 

Some options on the navigation bar refer to features unavailable when using AirMagnet 

Planner. 

Click Planner to open the Planner view. 

File Menu Options 

The File menu provides the following options in Planner view. 
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Menu Option Description 

New Project... 
Opens the New Project Wizard window where you can create a new Planner 

project. 

Open Project... Opens an existing Planner project. 

Save Saves changes made to the current project. 

Save Project 

As... 
Saves the current project under a different name. 

Close Project Closes the current Planner project file. 

Configure... 
Opens the Configuration dialog box where you can configure various 

parameters in AirMagnet Planner. 

New Plan... Creates a new plan in the current Planner project. 

Save Plan Saves the current plan within the Planner project. 

Save Plan As... 
Saves the current plan under a different name within the current Planner 

project. 
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Extract Wall 

Objects from 

CAD... 

If you imported a CAD image (.dwg) for your project, this option opens the 

Create Planner Wall Objects from CAD Drawing dialog where you can select 

layers and configure walls. 

Export to 

CAD... 

If you imported a CAD image (.dwg) for your project, this option enables 

you to export the image along with any APs and walls data. 

Antenna 

Manager... 

Opens the Antenna Manager dialog, allowing you to customize and modify 

antenna pattern templates. 

Planner 

Configuration... 

Opens the Planner Configuration dialog, allowing the user to customize 

various aspects of Planner’s display. 

Planner Object 

Manager... 

Opens the Planner Object Manager, allowing the user to view a list of wall 

and area types in the plan. 

Recent Projects 
Provides a list of previously open projects. Selecting a listing will open the 

project. 

Multi Floor 

Planner 
Opens Multi Floor Planner. 

Exit Exits AirMagnet Planner. 

View Menu Options 

The View menu provides the following options. 
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Menu Option Description 

Zoom In 
Enlarges the view of the current floor map in the map window. It works in 

the same way as  (Zoom In) on the toolbar. 

Zoom Out 
Reduces the view of current floor map in the map window. It works in the 

same way as   (Zoom Out) on the toolbar. 

Zoom to Fit Fits the current floor map to the map window. It works in the way as   

(Zoom Fit) on the toolbar. 

Zoom to Actual 

Size Fits the current floor map to its actual print scale. 

Set Zoom... 
Opens the Set Zoom dialog box where you can specify the specific ratio at 

which the view of the map can be increased. 

Show CAD 

Layers... 

Allows you to select which layers of a CAD image to display and, if the 

image has multiple layouts, which layout to display. This feature is also 

available when you right-click on the image in Display View.   
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Toolbars and 

Docking 

Windows 

Show or hide the Legend, Status Bar and reset the Toolbar to its default 

setting. 

Show Rulers Show or hide the rulers along the edge of the map window. 

Show Grids Show or hide grids in the map window. 

Invert Legend 

Colors 
Flips the color scheme of the legend vertically. 

Filter APs 

Once APs are placed on a floorplan, this option opens the Filter AP dialog 

where you may create a data file that includes or excludes APs from the 

heatmap generation. 

Overlap 

Same as the Overlap button. Indicates signal overlap or channel 

interference overlap. Based on the Data Type selected, overlap will filter out 

all information that does not overlap, and will display only the data that 

does overlap. 

Overall 
Same as the Overall button. The default heatmap indicates overall signal 

strength coverage. 

View Per 

Channel 

Active when the Channel/SSID View is set to Channel. Same as Per Channel 

option on the Toolbar. Displays data by channel. Displays each channel in a 

different color. When this option is enabled, the channel list assigns 

different colors to the channels. 

Per SSID 

Active when the Channel/SSID View is set to SSID. Same as Per SSID 

option on the Toolbar. Display data by SSID. Displays each SSID in a 

different color. When this option is enabled, the channel list assigns 

different colors to the SSIDs. 

Show AP List 
Displays a list of all APs contained within the current plan. This allows you 

to easily manage basic settings for each AP in the list. 

Re-Sequence 

AP Numbering 

Re-sequences the numbering of all APs placed on the map that fit the 

default numbering scheme (“AP-#”) to remove numbering gaps that may 

have occurred during the design process.  

Refresh 
Generates or refreshes the heatmap. Requires that one or more APs be 

placed on floor plan. 

 

Toolbar 

The Toolbar contains frequently used tools, some of which are identical to those found in the 

File and View menus. 

The following screen shot of the toolbar shows an undocked view. To undock the toolbar, 

drag the handle at the far left on the toolbar. 

 

Icon Tool Name Description 

 

Project Wizard Create a new project. 
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Open Project Browse to open a project. 

 

Save Save the open project. 

 

Configure Opens the project configuration window. 

 

Select 
Selects the cursor tool, allowing you to select and modify 

specific items. 

 

Zoom In Enlarges the view of the site map. 

 

Zoom Out Reduces the view of the site map. 

 

Zoom Fit Fits the site map to the Map Window. 

 

Actual Size Sets the zoom value to the actual size of the site map file. 

 

Create AP Allows you to create and place a new AP in the map. 

 

Measure Mode Allows you to recalibrate site dimensions to suit your location. 

 

Create Wall 
Allows you to select a wall type and draw the walls of your 

site. 

 

Create Rectangular 

Attenuation Area 

Allows you to select an area type (cubicle, office, etc.) and 

draw out a rectangular section of area. 

 

Create Arbitrary 

Attenuation Area 

Same as rectangular area, but is not restricted to drawing 

rectangles (draws like the Create Wall tool). 

 

Create Elliptical 

Attenuation Area 

Allows you to select an area type (cubicle, office, etc.) and 

draw out an elliptical area. 

 

Create Rectangular 

Coverage Area 

Allows you to draw a rectangular coverage area. This area is 

used by Planner Advisor only. 

 

Create Rectangular 

Excluded Area 

Allows you to draw a rectangular excluded area. This area is 

used by Planner Advisor only. 

 

Create Arbitrary 

Coverage Area 

Allows you to draw an arbitrary coverage area. This area is 

used by Planner Advisor only. 

 

Create Arbitrary 

Excluded Area 

Allows you to draw an arbitrary excluded area. This area is 

used by Planner Advisor only. 

 

Create Elliptical 

Coverage Area 

Allows you to draw an elliptical coverage area. This area is 

used by Planner Advisor only. 

 

Create Elliptical 

Excluded Area 

Allows you to draw an elliptical excluded area. This area is 

used by Planner Advisor only. 

 

Clear All Objects 
Opens a dialog allowing you to remove all placed objects, or all 

objects of a certain type (APs, attenuation areas, walls, etc.). 

 

Advisor Opens the Planner Advisor tool. 

 

Refresh Generate and refresh the heatmap 

 

Overlap 
Show or hide coverage overlap in the Map Window. Available 

in Display view. 

 

Filtering Filter AP data out of the Planner project. 

 

Tools Opens the Signal and DHCP tools. 

 

Calculator Opens the calculator tool. 
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Project Window 

The Project Window displays all the plans contained in the current project(s). 

 

The Project Window for the Planner view contains the following components: 

• Tools: contains buttons to add, delete, modify, and save the active plans contained 

in the current project file. 

• Plans: displays the active plans contained in the current project file. The selected 

plan is the one displayed on the view at any given time. 

• Right-Click Pop-Up Menu: See Right-Click Pop-Up Menu below. 

Right-Click Pop-Up Menu 

The Project Window on the Planner view also comes with a pop-up menu, which can be 

activated when you right-click a main entry. 

 

Menu 

Option 
Description 

New Opens the plan dialog box to create a new plan. 

Save As Allows you to save the current plan and rename it, if desired. 

Delete Deletes the selected (right-clicked) item. 

Properties... Allows you to modify the properties of the selected plan. 

Channel Tab 
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The image below shows the Data Window when the Channel tab is selected. By checking or 

unchecking specific APs or channels, you can change the display on the map to narrow the 

focus of your analysis. 

 

SSID Tab 

The image below shows the Data Window when the SSID tab is selected. By checking and 

unchecking specific SSIDs or APs, you may refine your analysis just as you can from the 

Channel tab. 

 

AP Data Properties 

AP properties (such as channel and media type) may be viewed using a few different 

methods, however, the properties can only be edited in the Planner view. 

• In the Planner view, right-click an AP located on the site map and select 

Properties. This option enables the properties to be edited. 

• Expand either the SSID or Channel tree in the Data window. Right-click an AP and 

select Properties. (Edit is available in Display view as well) 

• In the Display view, right click an AP located on the site map and select AP 

Properties. 

For a description about each property item, Refer to Adding APs to the Plan. 
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Map Window 

The image below shows the Map Window on the Planner view with a site map in it. A plan 

will be displayed if it is selected in the Project Window; thus, if you wish to change the plan 

you have displayed, just select it from the list at the top left. By default, a site map will 

automatically open in the Map Window when you open a Planner project. Before starting a 
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plan, it is important to make sure that the project and/or site map matches the location you 

wish to project. 

 

Planner Configuration 

The File drop-down in the menu bar contains a Planner Configuration selection that 

enables you to customize several aspects of AirMagnet Planner. The sections below describe 

each tab in the Planner Configuration menu. 

• Usability 

• Sampling Density 

Usability 

The Usability tab allows you to modify several settings that alter Planner’s behavior when 

generating and processing a site plan. 
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Option Description 

Clear signal 

distribution when 

switching tools 

Enabling this function causes Planner’s heatmap to reset whenever 

the user selects a new tool from the toolbar. 

Auto prompt after 

placing an AP 

Enabling this option causes Planner to open the AP Properties dialog 

whenever a new AP is placed on the map. 

Auto processing data 

after Advisor result 

Enabling this causes Planner to automatically generate a signal 

coverage heatmap once Planner Advisor has finished processing. 

Show AP label 
Enabling this displays labels beneath placed APs. These labels 

contain the AP’s name, media type, and channel. 

Undo buffer size 

This field allows the user to specify the number of operations that 

will be saved in Planner’s undo buffer.  By default, users can undo up 

to 20 operations by repeatedly pressing Ctrl+z; to adjust this value, 

simply enter the desired number. Redo is available using Ctrl+y. 

Sampling Density 

The Sampling Density tab allows you to control the precision Planner when processing signal 

data. As the slider approaches the “Low Density” end of the bar, processing signal data will 

take less time but will also be less comprehensive. Conversely, moving the slider towards 

“High Density” causes more detailed results that take more time to process.   

You can also check the “Use recommended sampling distance” option to have Planner 

automatically calculate a suggested value to use. This value is generated based on the size 

and complexity of the site plan in use. Larger maps will have a larger recommended value in 

order to reduce processing time. 
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Wall / Area Object Manager 

 Multi Floor Planner: Wall/Area Configuration 

Modify the wall and area types available in an AirMagnet Planner project. 

Click File>Planner Object Manager (In Multi Floor Planner: Tools>Configure 

Walls/Areas) 

 

Clicking in any field allows the user to modify the values for each wall. The buttons at the 

top right allow you to create and remove walls and areas from the list (depending on active 

tab selection Wall or Area). 
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Icon 
Tool 

Name 
Description 

 

Add Add a new area or wall type to the list. 

 

Delete Remove an existing area or wall type. 

 

Default 
Restore Planner’s default list. This will reset all values and remove any custom 

area or wall types created. 

For a brief explanation of the dB drop, refer to dB Drop. 

For information about the attenuation index, refer to Attenuation Index. 

Attenuation Index 

An area’s attenuation index refers to the rate of signal degradation experienced by RF traffic 

as it moves across the area. A larger value corresponds to a greater drop in signal strength; 

thus, an elevator shaft has a significantly higher index than a cubicle. It is important to note 

that while a higher attenuation index indicates a greater drop, this value is not identical to a 

dB drop value, nor is it a percentage. 

dB Drop Value 

While the dB drop value of a wall works similarly to the attenuation index used for areas, 

the values are quite different. A wall’s dB drop refers to the drop in strength a signal 

experiences when passing through the object. This value is measured in dB; users can enter 

their own wall types and easily find the dB drop for the wall. To do so, just measure signal 

strength on each side of the wall (using AirMagnet Survey, for example) and calculate the 

difference between the two sides. The resulting difference is the wall’s dB drop value. 

Working with the Antenna Manager 

AirMagnet Planner’s built-in antenna manager allows you to select the type of antenna your 

wireless device uses. It also contains an antenna pattern modification tool, so if your 

antenna doesn’t appear in the list, you can hand-draw the signal field that your antenna 

generates. 

• Viewing Included Antenna Properties 

• Creating a Custom Antenna Pattern 

Viewing Included Antenna Properties 

Generally, you will be able to find your antenna in the list of presets included with AirMagnet 

Planner. In order to view the properties of your antenna, follow the steps below. 

To view included antenna properties: 

1. Click File>Antenna Manager…. 

2. The Antenna Manager opens.   
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3. As shown above, there are several filter options listed at the top of the window to 

narrow your antenna search.  

Field Description 

Vendor 

Clicking this field allows you to check the different antenna vendors you wish to 

display. If your network only employs antennae from a specific company, you 

can narrow your search accordingly. N/A. 

Band 
This list allows you to select which media type you wish to narrow your search 

by. 
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Plane 
You may choose to view only antennas using the azimuth (top view) or elevation 

(side view) planes, or simply leave the setting at “All” to show everything. 

Create 
This field lets you specify whether the pattern you’re looking for is one you 

customized yourself or one that came pre-defined in AirMagnet Planner. 

4. To view a built-in antenna pattern, click the antenna you wish to view and click 

Display. The Antenna Pattern dialog appears. 

5. You may only alter the options you use to view this pattern in the “Tracker” box at 

the bottom right. The box contains three options: 

• Show Tracker: Enables you to turn off the visible points on the field and displays 

only the field line. The other two options will not be available unless this box is 

checked. 

• Show Handle: displays straight lines connecting the yellow points on the field, as 

well as the red curved fit line. These yellow points appear only on the lines radiating 

outward from the center of the circle, and allow you to make large changes to the 

field. 

• Show Assist: displays only the blue points, which are connected by the red curved 

line. These blue points allow you to fine-tune the field in-between the Handle points. 

You may also enable Show Handle to view the final field view. 

Note: You cannot modify the built-in antenna patterns. In order to modify the pattern, 

you must create your own antenna following the steps below. 

Creating a Custom Antenna Pattern 

If your antenna is not listed in the presets, you can create a customized antenna pattern. 

This will enable AirMagnet Planner to accurately project the desired pattern. 

Note: When planning to create a new antenna pattern, it might be easier to start by 

using an existing pattern that is similar to the one you are creating. To do so, select a 

similar pattern shape from the list of antenna patterns in the Antenna Manager and click 

New. The new antenna pattern will be based on the pattern you selected. 

To create a new antenna pattern: 

1. Click File>Antenna Manager…. 

2. From the Antenna Manager, click the New button (or locate a similar pattern and 

click New). The Antenna Pattern view appears.   
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3. For the Antenna Name, enter a unique name for the new antenna pattern. 

4. Configure the antenna properties as described in the following table: 
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Field Description 

Vendor Enter the name of your antenna’s vendor. 

Band Select 2.4 GHz or 5 GHz. 

Plane 
You may select either the Azimuth plane (horizontal) or the Elevation 

plane (vertical) depending on the type of pattern you are creating. 

Ring Count 

This value alters the number of concentric circles displayed in the 

field diagram. Count the number of rings in the product antenna 

pattern diagram and enter the number here (include the outer-most 

ring) 

0 dB Ring # 
Using the product antenna pattern diagram, count the number of 

rings from the center to the 0 dB ring and enter the value here. 

dB Interval 

Using the product antenna diagram, determine the dB interval 

between each ring and enter the value here. For example, if there is 

a 5 dB interval between each ring, the value to enter here is 5. 

0 Ring dB Gain 

Using the product antenna diagram, if the graph reaches the peak 

gain at any point, enter 0. If the graph does not reach the peak gain, 

enter the peak gain value provided in the antenna vendor's user 

documentation/data sheet. This is shown in the following examples 

where the 0 dB ring is highlighted in bold and shown by an arrow. In 

the first example it is not exceeded; in the second it is.  
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5. Adjust the antenna pattern drawing by dragging the Handle and Assist points as 

needed. Handle points (yellow points)allow for larger changes while the Assist points 

(blue points) enable fine-tuning the drawing. 

Note: A suggestion for drawing the antenna pattern: Obtain and open an electronic 

image of the product antenna pattern diagram. Size the image to the same size as the 

diagram (antenna drawing) in the Antenna Manager. Trace the outline of the product 

antenna pattern on a transparency. Overlay the transparency on the Antenna Manager. 

Drag the handles to conform to the trace image. 

  

Note: You may find it easiest to uncheck the Show Assist box to make large changes to 

the field. Re-check Show Assist to fine-tune the drawing.   

6. Click OK to save the new antenna pattern. The new antenna pattern appears as a 

selection in the Antenna Manager. 
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Note: To use the new antenna pattern, you must first place an AP on the floor plan. 

Double-click the AP to open its properties. Click Pattern in the AP Properties dialog. 

If you wish to delete the new pattern, select it and click Delete. Note that you cannot 

delete any of the pre-set patterns. 

Export to CAD 

If you imported a CAD image (.dwg) for your project, this option enables you to export the 

image along with any APs and walls data that was added to the image.  

Note: To use this feature, you must use a CAD image (DWG file format) for your 

AirMagnet Planner project.  

Note: If you chose to show or hide individual layers of the CAD image, these changes are 

reflected in your exported CAD file. Refer to the View Menu or Right-click Pop-up Menu. 

 

To export to CAD: 

1. From the File menu, select Export to CAD. This opens the Export to CAD dialog. 

2. Using the Folder text box, type the path to save your exported file. You may also 

use the Browse button to the right of the text box to set the path. 

3. In the File Name text box, use the auto-fill file name or revise the file name. The 

file extension must be .dwg. 

4. Use the Export option check boxes to set the AirMagnet Planner data to include in 

the file. The options are AP, AP Names and Walls. 

5. Fill Mode specifies whether you want the wall thickness filled or unfilled. Check 

Force True to cause the walls to be filled. 

6. The Color option enables you to set the color of AirMagnet Planner data. Click Set to 

change the default color. 
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7. Click Export to save the file. 

  

Planner Projects 

Product Features 

AirMagnet Survey provides the following main features: 

• Import site map feature enables you to import a pre-existing map image of your 

building to allow you to properly plan out specifications tailor-made to your site. 

• Drawing tools make tailoring your site map to match the office environment easy. 

You may select from a wide range of pre-set materials (cubicle, drywall, brick, etc.) 

with built-in Attenuation Indices or, for advanced users, you may also custom-build 

your own materials. 

• Antenna manager comes packaged with pre-set antenna field patterns. You may 

also custom-generate your own pattern and adjust AP height and the direction of the 

field. Not available in Multi Floor Planner. 

• Report generator will generate custom reports based on your planner findings. It 

will create a document detailing your project that you can export and print or email 

to others. 

• Adjustable Sampling density gives you the ability to customize the degree of 

precision your projection will employ for better and more accurate results. 

• Two display options enable you to view and analyze site RF data by channel or by 

SSID. You can easily identify WLAN deficiencies in terms of AP coverage, roaming 

boundary, channel allocation/interference, noise impact, etc. 

• Zoom options allow you to zoom in to a specific portion of your site to determine 

problem spots and how to fix them. 

• Graphical data display with color spectrum and gradient makes it easy to 

understand and differentiate RF data from various sources (that is, APs or SSIDs and 

channels). This allows you to base your WLAN decisions on “facts” rather than 

“hypotheses”. 

• Planner Advisor helps you determine the ideal arrangement of APs with a few 

simple layout modifications. Easy-to-use Advisor tools help generate a site plan that 

contains as much information as possible to assist Advisor in making an accurate 

assessment. 

• Planner Export lets you take an existing Cisco Prime NCS/WCS AirMagnet Planner 

project and import it into Cisco Prime NCS/WCS. Not available in Multi Floor Planner. 

Creating a Planner Project 

Prior to starting a site plan, it is required that you create a Planner project, which involves 

naming the project, importing a site map, specifying some physical properties of the site, 

and so on. This section contains the procedures on how to create a Planner project. 

To create a new Planner project: 



Using AirMagnet Planner 

96 

1. From the Main Menu, select File>New Project…. The New Project Wizard appears. 

 

2. In Specify Project Name, enter a unique name for the new project.  Save the 

project using one of the following options: 

• To save the project to the default location, simply click Next. The New Project 

Wizard view refreshes. 

• To save the project to a location other than the default, click Browse to specify a 

location of your choice, and then click Next. The New Project Wizard view refreshes. 

Note: By default, AirMagnet Planner automatically saves the project to the C drive on 

your computer, using the name you specify. 
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3. Click   (Import Site Image) to locate and import the site map of the location. 

4. For the Unit of Measurement, select Feet or Meters.  For Floor Plan Dimension, 

enter the Width and Length of the site map. Click Next. 

Note: “Floor Plan Dimensions” refers to the scale (in feet or meters)of the entire image 

area of the floor plan (including any white space margin included in the image). If you are 

not sure of the dimensions, you may or may not enter the approximate values here and 

then recalibrate the values more accurately later. Refer to Measuring and Calibrating the 

Floor Plan Scale. 

 

5. For Environment, select an option that resembles the site environment you are 

planning for. 

6. For Signal Propagation Assessment, do nothing (normally), since AirMagnet 

Planner can automatically assign the value according to the site environment you 

select. 

Note: AirMagnet Planner assigns the Signal Propagation Assessment value based on the 

estimate of the distance RF signals could travel in each of these typical site environments. 

Normally, AirMagnet recommends that you accept the default value the program assigns. 

However, if you want to set a value of your own, you must be aware that the value you 

enter will affect the way the program interpolates site data. 

7. For AP Default Power, do nothing (normally).  Click Next. The New Project Wizard 

view refreshes. 

8. In Enter Descriptive Text, type a brief description of the project. (Optional.) 

9. Click Finish. The newly created Planner project will automatically appear in the 

Project Window, and the site map will be displayed in the Map Window. 

Creating a Site Plan 

Now that you have imported your site map, you must draw up your planned office 

arrangement so you can analyze your AP setup. In this section, you will use AirMagnet 
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Planner’s drawing tools to design your ideal office and then determine how many APs you 

will need to realize that goal.  Click on the links below to view descriptions of each section. 

• Using the Wall Tool 

• Drawing Rectangular and Arbitrary Areas 

• Adding APs to the Plan 

• Using the Right-Click Menu 

Using the Wall Tool 

Your should first establish your office’s walls and doors. The steps below will walk you 

through the process of outlining your building. 

1. Select the Create Wall tool from the toolbar. 

2. You will see a drop-down list appear in the top-right corner of the Map Window. This 

list contains a number of pre-set wall types that come with inherent dB drop levels 

(the affect these walls will have upon your wireless network). Select the wall type 

that you wish to place. 

Note: In a Cisco Prime NCS/WCS Planner project, only Cisco NCS/WCS type walls will 

appear in the drop-down menu. 

 

3. Click the spot where you would like to start drawing the wall. Move your cursor to a 

corner or a point where the wall changes its angle, and click again. You can click 

several times along a wall, following its bends and curves. When you wish to 

conclude this portion of the wall, right-click, and the wall will be filled in. 

Note: If you click the wrong spot while drawing your wall, press Ctrl+Z on the keyboard. 

This function will reverse the last click, and will continue to back up as you press it 

repeatedly. To cancel drawing the wall, press Esc, and the wall will be erased. Your tool 

will then default to the cursor. 

4. Repeat step 3 until all of your walls are filled in. You may select different wall types 

(windows, doors, and so on.) from the drop-down list mentioned previously. 

Note: In general, you will want to draw straight walls at 45 or 90 degree angles to each 

other. To ensure that your drawing is straight, hold down the Shift key while lining up 

your wall tool. This locks the path to 45 and 90 degree angles, making drawing straight 

paths much easier. 
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Using Automatic Wall Extraction 

Automatic Wall Extraction (AWE) is a new Planner feature for importing walls from CAD 

files. This feature allows you to select what layer(s) contain walls, and automatically draw 

walls in Planner at those locations. This feature dramatically shortens design time when a 

CAD file is present. Using this method you can spend time on value-added activities 

(design) rather than just drawing lines. 

When to Use AWE 

Prior to starting a site plan, you should create a Planner project, which involves naming the 

project, importing a site map, specifying some physical properties of the site, and so on. 

This procedure is the same as for any Planner project, except that you must import a CAD 

drawing (extension of .dxf, .dwf) when you import your site map. 

Overview of Using AWE 

1.     Create a project using a CAD drawing. 

2.     Select the layers to use from the CAD drawing. 

3.     Create/modify your walls. 

4.     Place APs. 

5.     Do a Refresh to create a Heatmap. 

6.     Manipulate Walls and APs as desired. 

How to Use AWE 

Use this feature as follows: 

1. From the Main Menu of Planner or Display, select File>New Project…. The New 

Project Wizard appears. For more details, refer to To create a new Planner project. 

2. If you are not already in Planner (that is, you created your new project in Display) 

click the Planner tab. 

3. Select View>Show CAD Layers. A window similar to the following appears. This 

window allows you to decide which CAD layers you want to display on your map. 
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4. Click the Select all layers check box and then click it again.  This clears all of the 

check boxes. Now click the layers that you wish to appear on your map. 

Use the drop-down menu/check boxes as follows: 

• Layout:  Some CAD files may have multiple layouts within them.  Use the 

Layout dropdown box to select from available layouts in the CAD file. 

• Select all Layers: Selects/deselects all layers. 
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• View black and white: Some CAD files make use of color on various layers 

that may interfere with easy visibility of heatmaps.  To default all layers to 

display in black and white, select this option 

Note:  There can be many layers on a CAD drawing.  Try to limit your choices to those 

that contain elements that represent your actual walls, or those that will be valuable in 

working with your floorplan 

5.     When you have finished selecting your layers, click OK. 

6.     Select File>Extract Wall Objects from CAD…  A window similar to the following 

appears, displaying the layers that you have selected for viewing. 

 

7.     Select your layers by clicking the check boxes in the Layer column. 

8.     Click on the Wall Type in any row to open a drop-down menu that will allow you to 

select a wall type to use for that layer (the default is Brick Wall). 

The available selections are Dry Wall, Concrete Wall, Thick Wall, Metal Door, Heavy 

Door, Brick Wall, Light Door, Cinder Wall, Plasterboard Wall, Thin Window, Glass Wall 

with Metal Frame, Window Office. 

Click db Drop in any row to modify the db Drop value. 

9.     Select or deselect the following check boxes: 
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• Ignore line segments less than: Many CAD drawings contain short line 

elements that don't contribute to RF propagation, but constitute a large 

amount of "visual noise". This option provides you with a way of reducing this 

visual noise. 

• Combine parallel segments if within: Many CAD drawings represent walls 

with two parallel lines close to each other. If this option is disabled, you might 

end up with twice as many walls, doubling the attenuation. 

By using these, options, you can avoid importing artifacts from CAD files that aren’t 

true wall segments. 

10.     Click Overwrite Existing Planner Walls. A map appears, based on your selections, 

similar to the following. These options are for vertical and horizontal lines (not diagonal). 

 

Note: You can return later and add additional layers.  If you do this, you would click 

Append to Existing Plan.  Be careful not to append the same layer multiple 

times. 

11.     Select any wall or area type and right-click. A pop-up menu appears allowing you to 

Delete the wall segment or change the Properties of each segment.  For more information 

refer to  Using the Right-Click Menu. 

12.     Refer to the following sections in the Survey Pro User Guide for additional information 

on adding APs to create a heatmap or manipulating individual or group walls: 

• Using the Wall Tool (designing your ideal office and determining how many 

APs you will need to realize that goal) 

• Drawing Attenuation Areas (changing the decibel values of walls and other 

objects) 

• Adding APs to the Plan 

• 802.11 AP Options 
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• Using the Right-Click Menu (modifying or removing any placed objects) 

13.     You can also manipulate wall selection as follows: 

a. Press and hold the Ctrl key while selecting a wall to add it to a list of 

selected walls. 

b. Press and hold the Ctrl key and click the selected wall a second time 

to remove it from the selected wall list. 

c. Clicking somewhere without a wall selected will deselect all. 

d. Clicking some other type of Planner object (AP, attenuation area, and 

so on) deselects all walls 

e. Clicking without the Ctrl key on a wall that is selected or unselected 

makes that wall the only selected object in the list. 

f. With a group of walls selected, you can Delete, Move (as a group) and 

Change Properties. Resizing does not work when more than one wall is 

selected. 

g. If all the walls in a group do not have the same attenuation or type, 

the Wall Properties dialog entries for type and attenuation are blank.  

h. The Wall Properties dialog sets all to the selected attenuation value.  A 

warning notice in the Wall Properties dialog is displayed if all walls are not the 

same type or attenuation.  In this case, the type, "dB Drop" fields is empty. 

i. Hold the Shift key with the Select icon selected to create a rubber-

band effect on a mouse move from the initial selection point to a point where 

the mouse is released.  Any wall segment COMPLETELY inside the rubber 

band area are added to the selected wall list. This technique applies only to 

walls.  Any other Planner items (APs, attenuation areas, and so on) within the 

rubber-band area will not be selected. 

j. If any walls selected before the rubber-band selection, will NOT be 

selected again unless they are within the rubber-band area. If some other 

object was previously selected, it will be deselected. 

14. Click the  (Refresh) icon on the tool bar to generate a heatmap. 

Note: Extracted walls can be moved, modified and deleted just like user-drawn walls.  

Drawing Attenuation Areas 

After you have completed the wall layout, you can draw out the rectangular internal layout 

components of your office (cubicles, offices, and so on). The steps below will guide you 

through the process. 

Note: Both Wall and Area should not be used for the same attenuation space. For 

example, if you create a wall enclosing a small office, do not create an attenuation area 

inside the office. 

To draw rectangular areas: 

1. Select the Create Rectangular Attenuation Area tool from the toolbar. 
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2. As with the Wall Tool, you will see a drop-down list appear in the top right corner of 

the map view. This list contains different rectangular areas with pre-set attenuation 

indices. Select the area type you wish to place. 

 

Note: The numbers displayed above represent the built-in attenuation indices for each 

type of space. While this is similar to the dB value of walls, the attenuation index refers to 

the effect of an area on wireless coverage, whereas dB drop refers to an immediate 

decrease over a single spot.  For more information about the attenuation index, refer to 

Attenuation Index. 

3. Click the corner of an area you wish to designate. Move the mouse cursor to the 

opposite corner and click again to draw an area. 

4. Repeat step 3 for any further areas you wish to draw. 

Drawing Arbitrary Areas 

The arbitrary area tool works very much like the wall tool; however, instead of drawing a 

wall, you are defining a region similar to that defined by the rectangular area tool. If you 

have a cubicle or office area that is not a perfect rectangle, this tool will allow you to define 

it with precision. 

To draw an arbitrary region: 

1. Select the arbitrary region tool, and then pick your material from the drop-down list 

(same as for the rectangular area tool). 

2. Click once at the point you wish to start drawing from. Outline the area you wish to 

define in the same way you used the wall tool before. Right-click to stop drawing and 

define the area. 

Note: Just as with the wall tool, hold down Shift to ensure that your lines are straight 45 

and 90 degree angles from each other. 

3. Repeat step 2 for any additional irregular areas. 

Adding APs to the Plan 

After you have finished designing your office map, you can place APs where you expect to 

have them. Alternatively, you can just place one arbitrarily and then see what its coverage 

region is like so you can determine where the next one should go. This allows you to 

determine what number and placement of APs will give you the optimal coverage for your 

site. 
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To place APs: 

1. Click Create AP on the toolbar. 

2. Click the location you wish to place the AP. Place as many APs as are needed in this 

same manner. 

3. To change back to the normal cursor, click the Select tool or press the Esc key. 

4. Right-click one of the APs and select Properties…. The AP Properties dialog box 

appears. 

 

5. Enter an AP Name for the new AP. 
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6. You can save this particular set of configuration properties by giving this 

configuration an AP Model name and by saving the model . This is handy in 

order to give several APs the same basic configuration later on. You can also delete 

an existing model by selecting the model and clicking delete . 

7. The next section of the dialog box has two tabs: 2.4 GHz and 5 GHz. The two tabs 

control the settings for the associated media types. 

Note: The following table describes the items and related descriptions also found in the 

AP Properties dialog in Multi Floor Planner. 

Item Description 

Channel Enter the channel the device operates on. 

Enable 

Check this box to enable the current tab media type. If your device 

operates solely on one media type, disable the tab that is not 

applicable. 

MAC Address 
This field will have a default value entered. You may modify this as 

desired to identify virtual APs. 

Full Mac Address 
Multi Floor Planner only. Auto populates the field in the event APs on 

different floors have the same MAC address. 

IP Address 
Enter an IP, if desired, to identify a virtual AP. Not in Multi Floor 

Planner. 

SSID Enter the SSID, if desired, to identify a virtual AP. 

Transmit Power (mW) 
Enter the number that will closely match the true transmit power 

setting of the AP. 

Antenna 

This section enables you to customize the type of antenna your 

device uses. If your device appears in the drop-down list, select it, 

and your device’s coverage field will be shown in the diagram on the 

left. If it doesn’t appear, you may customize your antenna pattern 

(refer to the Antenna Manager for more information). After selecting 

your antenna, you can use the slider to change its orientation with 

respect to its surroundings. For Multi Floor Planner Antenna 

Properties, refer to Viewing Multi-floor Data. 

11n support 
AirMagnet Planner: Check this option to specify that the AP is 

802.11n-capable. Refer to 802.11n AP Options for additional details. 

Media Type 
Multi Floor Planner only. Based on 2.4 or 5 GHz tab, choose the 

desired option. 

Location 

Enter the height (in feet) that the AP will be at. The X and Y fields 

refer to your device’s location on the map. Specify these if your 

layout is in a grid format. 

Note Enter a description for the AP (optional). 

6. Click OK. Your AP will now be placed. Modify any others you placed earlier following 

this same procedure. 

7. Click  (Refresh) to see a heatmap view of the predictive Wi-Fi signal strength 

coverage. 

8. You may move the APs by selecting the cursor tool and dragging them where you 

wish. After making any changes, click Refresh to update the view. 
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Note: The AP icons placed on the site map vary in color based on their media type. 

802.11a/n APs appear blue, 802.11b/g/n appear orange, and APs that utilize both 

mediums appear half blue and half orange. 

AirMagnet Planner maintains a list of all APs currently in use on the site plan.  To access this 

list, click View>Show AP List.   

If the existing AP numbering has gaps that resulted from deleting APs during your design 

efforts, Survey can re-sequence the numbering of all APs placed on the map that fit the 

default numbering scheme (“AP-#”). Select the “Re-Sequence AP Numbering” option in the 

View menu to re-sequence your auto-numbered APs.  

More heatmap data types are available in the Display view. For more information about 

Display view data types, refer to About Display view. 

802.11 AP Options 

With 802.11n support, you can place, simulate, and assess coverage utilizing the latest 

wireless standard. 

1. In Planner view, right-click an AP and select Properties. 

2. Click the desired band tab (2.4 GHz or 5 GHz). 

3. Check 11n support and click Properties. 
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Refer to the table below for the selections that can be made in the 802.11n Properties 

dialog box. 

Option Description 

Max MCS 

The MCS (Modulation and Coding Scheme) is an integer value that can 

range from 0 to 76, although current 802.11n devices only support MCS 

values up to 31. The MCS selection corresponds to the maximum data 

transfer rate supported by the AP. 

Max Frame Size 

802.11n devices support frame sizes up to 64 KB, as opposed to the 4 KB 

maximum size supported by legacy devices. This process minimizes 

wireless overhead in the network by reducing the number of frames 

required per transmission. 

Expected Op. 

Mode 

802.11n devices have the capability of operating in what is known as 

Greenfield mode, which means that the deployment consists purely of 

802.11n-capable devices. This is a setting that is configured on the 

individual AP; an 802.11n AP that is set to Greenfield mode will be unable 

to service legacy (802.11a/b/g) clients.  

Note: After placing 802.11n APs on a Planner project, your selections 

for each AP’s Expected Operating Mode are checked when the data is 

processed (that is, when you check   ). If the system detects that 

you have placed a legacy device within range of an AP that is set to 

Greenfield mode, the AP List dialog box will appear in order to notify you 

that the Expected Operating Mode and actual operating mode do not 

match. In order to ensure optimal operation of 802.11n devices, you 

should not mix pure Greenfield devices with legacy APs. 

Protection 

Method 

If the Mixed Mode option is selected, you can specify the type of protection 

mechanism in use on the AP. 

Channel 

802.11n devices are capable of operating on 40 MHz channel widths, as 

opposed to the 20 MHz channels utilized by most standard legacy devices. 

In order to accommodate the 40 MHz width, you can set the AP to 

transmit over two 20 MHz channels. In this case, you can select the 

desired channel and then specify whether the secondary channel used is 

above or below the channel selected. 

Block ACK 

The 802.11n specification provides a new frame type called a Block ACK 

frame, which allows an AP to acknowledge blocks of multiple frames with a 

single ACK frame. In contrast, legacy devices are required to send an ACK 

frame for every frame received, resulting in significantly increased network 

overhead. With Block ACK capability, 802.11n devices reduce this traffic 

load and can consequently improve overall network performance. 

Short Guard 

Interval 

The Guard Interval refers to the period of time that passes between data 

transmissions; a shorter interval generally helps to prevent potential 

wireless hazards such as propagation delays, echoes, or reflections. The 

802.11n specification currently provides two guard interval options: 400 ns 

and 800 ns. This setting can be specified using the AP’s management 

interface. By default, most 802.11n devices are set to 800 ns. 

  

AP List 
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You can quickly view a list of all APs currently placed on the site plan by clicking 

View>Show AP List. This option opens the AP List window. 

Note: In Multi Floor Planner, the AP List table looks somewhat different although column 

descriptions are similar. Any differences between the two tables are noted in table 

descriptions. 

 

Note: The AP List shows two entries for each AP: one for 802.11a and one for b/g. This 

allows you to easily modify which media type is enabled on any given AP. The window 

contains several columns that provide details about the AP’s properties. 

Column Description 

Group Change 

Useful for batch changing Power and Antenna settings. Select the APs 

to batch change. Check Group Change. Make a change to an item in 

the table. All selected APs of the same type are changed. 

Select/Unselect All 

AP 
Use this option to select all or unselect all APs. 

 

A check in this field indicates that the AP is locked, and therefore it 

cannot be modified by Planner Advisor. 

AP Name The name of the AP. 

Channel The Channel that the AP is set to. 

Media The media type of the AP. 

Enabled A check in this field indicates that the AP is enabled on the plan. 

Power The power setting for the AP (in MiliWatts). 

Antenna The antenna currently used by the AP. 

Ch. Width The channel width in use by the AP.   

Config Op. Mode 

The Operating Mode specified in the AP’s properties: Greenfield: for 

802.11n devices only; Mixed: for deployments utilizing 802.11n and 

legacy devices together; Legacy, for a pure legacy (e.g., no 802.11n 

devices) implementation. Multi Floor Planner also includes Mixed VHT 

that includes 802.11ac. 

Actual Op. Mode 

When the deployment is configured optimally, the Actual Op. Mode 

field will mirror the values in the Config Op. Mode column. As shown in 

the figure above, when a device’s configured value conflicts with the 

actual setting (for example, when an AP is set to pure Greenfield mode 

when legacy devices are present in the environment), the Actual Op. 
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Mode will be highlighted in red text, indicating a conflict. Not in Multi 

Floor Planner. 

To modify an AP’s properties, just double-click it in the AP List to bring up the AP Properties 

window. 

Note: The AP List will automatically pop up when  (Refresh) is clicked if you have 

802.11n APs set to Greenfield mode in a deployment in which legacy APs are still 

present.  This is to notify you of potential conflicts due to the Greenfield restriction; 

Greenfield deployments cannot have legacy devices present, since the older devices can 

cause reduced data rates for the wireless network. 

Using the Right-Click Menu 

You may modify or remove a placed object at any time by just right-clicking on it and 

selecting the option you desire. 

 

Note: The Locked AP and Default AP options only appear if the user has right-clicked on 

an AP. 

Option Description 

Properties... 
Opens either the AP Properties or Wall/Area Properties dialog box, 

depending on the object selected. 

Delete Deletes the selected object. 

Locked AP 
Locks the selected AP. This ensures that Planner Advisor cannot modify 

any of the AP’s properties. 

Default AP 

Specifies the properties of the selected AP as Planner’s default AP 

settings. Any APs placed after selecting this reflect the current AP’s 

settings. 

Select 2.4 GHz AP 

or Select 5 GHz AP 

Depending on whether one or two channels are enabled for the AP, this 

option enables you to select one. It operates the same as selecting a 

single channel in the Data window. 

 

Using Planner Advisor 

AirMagnet Planner implements an advisor feature to help you optimize the layout of APs on 

site plans.  After drawing walls and areas on the site plan, you can specify two types of 

areas to narrow advisor’s focus: coverage areas and AP exclusion areas.  These areas can 

be drawn using their tools in the Toolbar. 
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Each tool has both a coverage (represented by a blue ‘+’) and AP exclusion (represented by 

a red ‘–’) area type. Coverage areas represent portions of the site plan that absolutely must 

have signal coverage and can contain APs; AP exclusion areas are those in which APs 

cannot be placed. 

Icon Name Description 

 

Create Rectangular 

Coverage/AP Exclusion 

Area 

Draws a rectangular coverage or AP exclusion area on the 

map. 

 

Create Arbitrary 

Coverage/AP Exclusion 

Area 

Draws an arbitrary coverage or AP exclusion area on the 

map. This tool works well for irregularly-shaped regions 

(that is. areas other than cubicles, offices, and so on.). 

 

Create Elliptical 

Coverage/AP Exclusion 

Area 

Draws an elliptical coverage or AP exclusion area on the 

map. This tool is useful for areas that cannot be drawn 

easily using straight lines. 

In order to use Planner’s Advisor, you must lay out the site plan as normal (draw out walls, 

cubicles, and so on.).  After the general areas are drawn, coverage and AP exclusion areas 

can be added in order to define the required signal coverage area.  Once all this is 

completed, you can generate Advisor's recommended AP layout. 

• Drawing Coverage/AP Exclusion Areas 

• Generating Advisor's Layout 

AP Coverage and Exclusion Areas 

This section describes how to set a site plan up in order to help Planner Advisor reach the 

most accurate results possible. It is important that you lay out their coverage and AP 

exclusion areas properly so that Advisor can generate the optimal layout. 

Note: Advisor’s results depend heavily on user input; therefore, the more detailed the 

plan layout, the more accurate the results. The only way to perfectly determine the 

optimal layout for a site is to test a setup and run a site survey using the AirMagnet 

Survey software. 

To draw coverage and AP exclusion areas: 

1. Select the coverage tool that will best fit the region to be drawn (rectangle, arbitrary, 

or ellipse).  Use the tool to define the intended region in the same manner as areas 

are defined. 

2. Repeat the process until all necessary areas are defined. 

3. Repeat steps 1-2 for any AP exclusion areas as well. 

4. The plan is now ready for Planner Advisor analysis. 

Generating an Advisor Layout 

Now that the site plan has been properly defined, Planner Advisor can generate its optimal 

AP layout. 

To generate an Advisor Layout: 
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1. Click the  (Advisor) button in the toolbar. The Advisor Criteria dialog appears. 

 

2. Make any desired changes to the dialog information.  

Field Description 

Minimum Signal 

Strength 

Coverage 

This field defines the minimum strength required at any point in a 

coverage area. The signal strength cannot drop below this value in 

areas that require coverage. 

Transmit Power This field defines the transmit power for the APs placed by Advisor. 

Band This field defines the band to be used by Advisor’s placed APs. 

Omni Antenna 

Gain 

This field defines each AP’s antenna gain. Note that Advisor’s APs will 

utilize omnidirectional antennas. 

AP Height 

The AP’s height directly affects its signal coverage; APs placed at 

higher elevations will not cover as wide an area as those at standard 

ceiling height. 

Max MCS 

802.11n Only: The Modulation Coding Scheme (MCS) is an integer 

value that can range from 0 to 76, although Planner only supports 

values up to 15. The MCS selection corresponds to the maximum data 

transfer rate supported by the AP. 

Frame Size 

802.11n Only: 802.11n devices support frame sizes up to 64 KB, as 

opposed to the 4 KB maximum size supported by legacy devices. This 

process minimizes wireless overhead in the network by reducing the 

number of frames required per transmission. 

Channels... 
This button opens the Channel Allocation dialog box, which enables 

you to specify precisely which channels the Planner Advisor function 



AirMagnet Survey User Guide 

113 

can use.  For more information, see more information below.  Note 

that a minimum of three channels must be selected for each band in 

use. 

Enable 802.11n 

Support 

Check this option to allow Advisor to place 802.11n devices. Note that 

802.11n support must be enabled in order to modify the Max MCS 

and Frame Size fields described above. 

Legacy to 

802.11n: One-

for-one 

Replacement 

Enabling this option ensures that Planner Advisor will replace the APs 

already present in a legacy site plan with 802.11n-enabled APs. 

Planner Advisor Channel Allocation 

The Channel Allocation dialog box allows users to easily specify the channels available to 

Planner Advisor. Using this function, Planner can be customized to eliminate specific 

channels for regions with restricted allocations to the 2.4 and 5 GHz bands.   

Note: To enable both 2.4 and 5 GHz bands, the 2.4/5 GHz option must have been 

selected in the Band drop-down in the Advisor Criteria dialog. 

 

The tabs at the top of the dialog box allow you to easily switch between the two major 

wireless bands. To specify the channels to be used, just check the "Usable" box for each 

desired channel.  Use the Enable All and Clear All buttons to quickly check and uncheck all 

channels. The Default button will automatically restore Planner's default settings; as shown 

in the image above, channels 1, 6, and 11 are checked by default for the 2.4 GHz band. For 

the 5 GHz band, channels 36, 44, and 52 are automatically selected. 

3. Click OK to close the Channel Allocation dialog. 

4. Click OK to start the Advisor. Advisor will begin processing the site data and testing 

AP locations. 
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5. After the process completes, APs are placed on the plan. Click  (Refresh) to 

view the site’s projected heatmap. 

 

Viewing Planner Reports 

AirMagnet Planner’s built-in reporting feature will automatically generate report data 

pertaining to your current site plan. This report will include screens displaying your planned 

signal coverage, AP locations, and a list of placed APs. The AP list also contains detailed 

information about each individual placed AP, including Name/MAC address, antenna type, 

and channel allocation. 

To generate Planner reports: 

1. After setting up your site plan, click Reports. 

2. From the Reports view, select Planner Report in the top left. 
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3. Navigate through the report pages by using the arrow buttons at the top. 

For more information, refer to Reports 

Multi Floor Planner 

Introduction 

Multi Floor Planner enables you to view how signal propagation occurs between floors in a 

multi-floor building. With Multi Floor Planner, you can create a new Building Project that 

consists of multiple floors. 

You can create a floor plan project for each floor within a Multi Floor Planner Building Project 

and you can also import individual AirMagnet Planner site plans for one or more floors as 

well. 

By creating a building project in this way, you can see predictive heatmap visualizations of 

how APs on one floor may, for example, propagate signal strength coverage to other floors 

or may produce channel interference. 

Multi Floor Planner includes support for 802.11a/b/g/n/ac/ax APs for predictive 

visualizations of signal strength, data rates, operating mode, MCS transmit rate and channel 

width. 
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Before You Begin 

With Multi Floor Planner, you can load and modify existing AirMagnet Planner site plans and 

you can also create and modify new AirMagnet Planner site plans for the individual floors 

that make up a multi-floor building project. 

When existing AirMagnet Planner site plans are imported into a Multi Floor Planner building 

project, they are added by reference (absolute directory path), therefore, it may be best to 

have all the source project folders containing site plans in a common directory. Any changes 

made and saved within Multi Floor Planner will update the source files. To avoid modifying 

existing planner projects, make a copy of original project folder to use for Multi Floor 

Planner. 

Note: Multi Floor Planner projects that include 802.11ac/ax are not backwards compatible 

with previous software versions of Multi Floor Planner that do not include 802.11ac/ax. 

Also, AirMagnet Planner project site plans are named 1.spi, 2.spi, and so on. You may want 

to determine the site plan name before beginning your multi-floor building project. To do 

this, open the .spi file in Notepad. The site plan name is the Name value (for example, 

Name=myproject). The site plan is located in the folder created for the Planner project. 

Note: AirMagnet recommends that site plans with similar dimensions in a single building 

use a similar Sampling Density value.  If you have modified your site plans to use a 

Sampling Density value other than the default, AirMagnet recommends you re-configure 
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the values so they are similar.  Refer to Sampling Density and Modifying a Floor Plan 

Project. 

  

Multi Floor Planner Building Project 

This topic describes how to create and edit a Multi Floor Planner Building Project. 

To create, export, import or edit a building project: 

Click Multi Floor Planner on the navigation Bar or from the File menu. The 

Multi Floor Planner window opens. 

• Create a new building project: Select New from the File menu to create a multi-

floor building. Configure the New Building options and click OK. 

• Export a building project: Select Export from the File menu. Browse to the 

desired directory location. A .zip file containing the building project files will be 

created. 

• Import a building project: Select Import from the File menu. Browse to the 

building project zip file. Note: The building project must have been previously 

exported (File>Export) to create the zip file. 

• Edit building properties: Click View> View Building Properties. 

 

Item Description 

Building Name Provide a name for the building project. 

Building Folder 
Set the directory location for the building project. Default is C:\program 

files\AirMagnet Inc\AirMagnet Surveyor\Building1 

Building 

Contact 
Contact information if desired. Any descriptive text may be added here. 

Unit of 

Measurement 

Option to use Feet or Meters for the project unit of measure. The unit type 

must match the type used for any imported site plans. 

Number of 

floors 

The total number of floors in the building project. Individual floors may be 

added or deleted later. 
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Floor Height 
A default floor to ceiling height. The height may be customized later on a 

floor-by-floor basis 

Interfloor 

height 

Based on the unit of measure, the distance between the floor and the ceiling 

of next lower floor. 

Interfloor dB 

Loss 

The amount of dBm attenuation resulting from interfloor obstruction to the 

RF signal. You may set this value or choose a preset from the drop-down 

menu. The resulting dBm loss value is the product of this value multiplied 

by the Interfloor height. 

To add and manage floors in a building project: 

Each floor (level) in the building includes a menu of options. To access the menu, click the 

chevron in the top right corner of the level. 

 

Item Description 

Create Plan  Creates a new floor plan project for this floor. 

Select Plan  Imports an AirMagnet Planner site plan to this floor. 

Remove Plan Removes the floor site plan from this floor. 

Add Floor Above Inserst a new floor above this floor. 

Add Floor Below Inserts a new floor below this floor. 

Delete Floor 
Deletes this floor from the building. Doing this will consecutively re-

number the floors. 

Edit Floor Details Opens a dialog containing floor details. 

Reset Alignment Resets the alignment of this floor to the default alignment. 
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View 2D Switches to 2D view. 

To configure each level in the building project: 

In the Building Tree, each level is listed beginning with Level 1 at the bottom.   

Adding an existing planner site plan to a level in the building project: On the desired 

level in the building tree, click the chevron drop-down menu and select Select Plan and 

navigate to the desired AirMagnet Planner site plan. A valid site plan has a .spi file 

extension. 

Creating a new project for a level in the building: On the desired level in the building 

tree, click the chevron drop-down menu and select Create Plan. 

Configure the new project options and click OK. 

 

Item Description 

Project Name Give a name to this new floor plan project 

Project Folder 
The default path where the project will be created is within the parent 

building project. 

Floor Plan 

You must add a floor plan image. Browse to a floor plan image. The 

image must be in one of the supported file formats. Refer to Supported 

Image File Formats.  

Note: The Visio format is not supported in Multi Floor Planner. 

Dimensions 

This refers to the scale (in feet or meters) of the entire image area of 

the floor plan (including any white space margin included in the image). 

If you are not sure of the dimensions, you may or may not enter the 

approximate values here and then recalibrate the values more 

accurately later in 2D view. Refer to Measuring and Calibrating the Floor 

Plan Scale. 

Propagation 

Like a regular AirMagnet Planner project, the Propagation value default 

is based on the estimate of the distance RF signals could travel in a 

typical site environments. Normally, AirMagnet recommends that you 
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accept the default value the program assigns. However, if you want to 

set a value of your own, you must be aware that the value you enter 

will affect the way the program interpolates site data. 

Environment Select an option that resembles the real world site environment 

Description Project description text can be added here. 

Each level in the building tree includes a summary of the information for that level as 

described in the following table: 

Item Description 

Floor Name Specify a name for this floor. 

Floor Height 
The distance from floor to the ceiling. This may be changed by editing the 

Floor Details. 

Interfloor 

height 

Based on the unit of measure, the distance between the floor and the ceiling 

of next lower floor. 

Interfloor dB 

Loss 

The amount of dBm attenuation resulting from interfloor obstruction to the 

RF signal. You may set this value or choose a preset from the drop-down 

menu. 

Floor Contact Contact information if desired. Any descriptive text may be added here. 

Plan The plan file for this floor along with its directory location. 

Floor plan 
The name of the floor plan image used for this floor along with its directory 

location. The browse option enables you to change the image if desired. 

Dimensions 
The width and length of the floor plan. This is based on the calibration scale. 

See "Project Configuration" table. 

Propagation Refer to "Project Configuration" table. 

Environment Select an option that resembles the real world site environment 

  

  

Floor Alignment 

By default, all levels in the building project are aligned vertically to their center point. Each 

level may be re-aligned based on common walls, elevators, stairwells, and so on. in order to 

create a more accurate representation of the building. 

1. Click Align Floors  or select Align Floors from the Tools menu. 

2. From the Select Floor to align drop-down above the top image, select the desired 

floor plan. 

3. From the Select Ref Floor drop-down above the bottom image, select the floor plan 

to which the plan above will be aligned. 

4. On the floor plan at the top, click the first point of alignment. A push pin icon will 

appear. Click the second point of alignment. A second push pin will appear. Between 

the push pins indicates the alignment edge. 

5. On the bottom floor plan, click the first point of alignment. An alignment line appears 

between two push pins that indicates the alignment edge to which the top plan will 

be aligned. The push pin highlighted in pink may be adjusted around the radius of 
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the other push pin. If desired, click-and-drag the highlighted push pin to move its 

position. 

6. Click Align. You may see the multi-floor view on the right readjust to account for 

any change in alignment. 

 

You may continue to align floors as desired with the following two exceptions: 1) 

Once a floor is used a reference floor, if it in turn is then aligned to a reference floor, 

any floors previously aligned to it will remain their current position. 2) Once a floor 

(e.g., floor 1) is used a reference floor (for example, floor 2 aligned to floor 1), it 

cannot be then aligned to a floor that was previously aligned to it (for example, floor 

1 aligned to floor 2).  

Note: You can choose to reset alignment to the default and start over by selecting Reset 

Alignment from the Tools menu. 

7. To save any alignment changes, click OK. To return to the Building Tree view without 

saving changes, click Cancel. 

 

  

Modifying a Floor Plan Project 

The default view in Multi Floor Planner is 3D view . To perform tasks such as 

recalibration, adding RF obstructions and APs to your project, switch to 2D view. To do this, 
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select a floor in the building tree and click View 2D . Refer to the "Planner Projects" 

section for details about using the various AirMagnet Planner tools available in this view. 

Note: Not all Planner tools are currently available in Multi Floor Planner. 

Viewing Multi-floor Data 

Once APs are included in to your building project (either as part of an imported AirMagnet 

Planner site plan or by adding them in Multi Floor Planner 2D view), the data may be 

processed to show a predictive, color-coded visualization of the Wi-Fi environment. 

To get started, click Refresh . The Map view will process the project to show a color-

coded heatmap display. The color-codes correspond to the legend at the far right. 

 

You can adjust various controls in the user interface to examine various predictive scenarios 

(refer to Data Filtering Examples). 

Editing AirMagnet Planner Site Plans 

If you imported a Planner site plan into a building project using the "Select Plan" option, the 

site plan was imported into Multi Floor Planner by reference. This means that if you modify 

the plan in Multi Floor Planner and save the building project, the original plan will be 
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modified to reflect the changes. It also means that if you open the original planner project 

in AirMagnet Planner and save any changes, when you re-open the Multi Floor Planner 

building project, it will reflect the changes. 

Building Tree Controls 

To select a single floor, click the floor in the building tree. To select all floors, click the 

parent Building Name at the top of the tree. 

Data Type Controls 

The Data Type drop-down in the top right of the Map view enables different ways data may 

be shown: Signal Strength, Channel Interference, Predictive PHY Data Rate Downlink and 

Throughput.  For more information about data analysis using these controls, see the 

"Performing Data Analysis" section. 

Data Tree Controls 

Use "Select APs From..." drop-down menu to control what AP information to display. This 

works in conjunction with checked options in the Channel and SSID tree. 

• All Floors: Using this option includes the data from all APs on all floors. 

• Floor __: This option includes only data from APs on the selected floor. 

• Bleedover: This option includes only data from all floors except the selected floor. 

The Data Tree on the bottom left will list the APs discovered on the site plans for each floor. 

APs will be listed by Channel in the Channel tab view and by SSID in the SSID tab view. 

A Channel listing indicates the Channel Number (for example, 36), Channel Width (for 

example, 40MHz) and Channel Span (for example, 36-40). 

Clicking an AP in the list displays a visualization of its location and floor height. 
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If a Data Tree option is unchecked, the data is filtered out of the color-coded Map view. Re-

checking an option will re-incorporate that data. 

Data Tree Controls 

Item Description 

Check All / 

Uncheck All 

Use these controls to "fast check all" or "uncheck all" associated channels 

and/or SSIDs listed in the Data Tree. 

Media Type 
Use the checkboxes to choose whether to view 2.4 GHz APs, 5.0 GHz APs 

or both 

Channels Click this tab to list APs by their corresponding channel setting. 

SSID Click this tab to list APs by their SSID 

AP list 
Use the checkboxes to include or exclude an AP in making heatmap 

calculations. The parent checkbox will enable or remove all children. 

Selected AP 

Count 
Total APs selected. 

Legend Controls 

The label at the top of the legend indicates the measurement type. The colors in the legend 

correspond to the associated numbered increments along the vertical axis. 

The top of the legend may be dragged down to filter out the top ranges of data. The bottom 

of the legend may be dragged up to filter out the lower ranges of data. 

The arrow button below the legend may be used to reverse the measurement direction of 

the legend. 

For more information about configuring the legend, refer to Configuring Legend Color 

Schemes. 



AirMagnet Survey User Guide 

125 

 

Overlap, Overall, Per Channel Controls 

 

Overlap: Selecting this option displays signal overlap or channel interference in the Map 

Window. 

Overall: Displays overall site RF signal coverage. This viewing option is active by default. 

Per Channel: Displays data by channel, SSID, or AP. 

For detailed information about using Overlap, Overall and Per Channel, see the "Performing 

Data Analysis" section. 

3D View 

3D View   is the default view and displays a three dimensional view of a building 

project including all levels. With the cursor over this view, drag the mouse to rotate the 

building on the associated axis (refer to Menu Reference). Selecting a level from the 

Building Project tree will focus on the selected level in the 3D view and dim the other levels. 

Thumbnail View 

Click Thumbnail view  to display thumbnail images of all the floors in your project. 

Double-click a single floor to open it in 2D view. 
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2D View 

Select a floor in the tree view and click 2D View   to display a two dimensional view of 

that floor. 

 

In 2D view, the options in the user interface correspond to similar options in Planner. Refer 

to the "Planner Projects" section for details about using these tools. 

Note: Right-click an individual AP to display a menu of AP options. To view AP details, 

select Properties from the menu. You can also delete the AP from the floor plan by 

selecting Delete from the menu. If you select Default AP from the menu, this AP's 

properties will become the default for the AP tool. If checked, un-checking Default AP will 

restore the default setting. 

Special 802.11ac Options 

802.11ac Data Types 

Multi Floor Planner includes some heatmap generation Data Type options for 802.11ac not 

available in Planner: Predictive PHY Data Rate Downlink; 802.11ac: Max MCS (AP Tx); and 

Channel Overlap. For explanations of these heatmap options, refer to Performing Data 

Analysis. 

802.11ac AP Configuration 
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Multi Floor Planner includes some AP configuration options for 802.11ac not available in 

Planner. For 802.11ac AP, Select the 5 GHz tab and choose 802.11ac from the Media 

Type drop-down. 

 

Item Description 

Spatial Stream Number Predictive MIMO support for up to 3 spatial streams 

Max MCS Predictive MCS support for index values 0-9. 

Predictive PHY Data Rate 
Calculation value based on spatial stream and MCS 

selections. 

Max Frame Size 
Frame size options are available for Aggregate MAC 

protocol data unit (A-MPDU) 

Primary Channel Indicates the Primary Channel selected for this AP. 

Channel Width 
Provides options for the selection of 20, 40, 80 and 160 

channel width 

Sec. Channel 

Options to choose whether the secondary channel 

should be A higher frequency (up) or lower frequency 

(down). 

Channel Summarizes the selections made for the channel. 

Block Ack 
Block Ack is checked by default to indicate it is enabled. 

It cannot be modified. 

Short Guard Interval Checked is enabled. Default is 400 ns. 

Special 802.11ax Options 

802.11ax Data Types 

Multi Floor Planner includes some heatmap generation Data Type options for 802.11ax not 

available in Planner: Predictive PHY Data Rate Downlink; 802.11ax: Max MCS (AP Tx); and 
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Channel Overlap. For explanations of these heatmap options, refer to Performing Data 

Analysis. 

802.11ax AP Configuration 

Multi Floor Planner includes some AP configuration options for 802.11ax not available in 

Planner. For 802.11ax AP, Select the 5 GHz tab and choose 802.11ax from the Media 

Type drop-down. 

 

Item Description 

Spatial Stream Number Predictive MIMO support for up to 8 spatial streams 

Max MCS Predictive MCS support for index values 0-11. 

Predictive PHY Data Rate 
Calculation value based on spatial stream and MCS 

selections. 

Max Frame Size 
Frame size options are available for Aggregate MAC 

protocol data unit (A-MPDU) 

Primary Channel Indicates the Primary Channel selected for this AP. 

Channel Width 
Provides options for the selection of 20, 40, 80 and 160 

channel width. 

Sec. Channel 

Options to choose whether the secondary channel 

should be A higher frequency (up) or lower frequency 

(down). 

Channel Summarizes the selections made for the channel. 

Block Ack 
Block Ack is checked by default to indicate it is enabled. 

It cannot be modified. 

  

Menu Reference 
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File Menu 

Item Description 

New Create a multi-floor building project. The file extension is .bml 

Open Open a multi-floor building project. The file extension is .bml 

Close 
Close the multi-floor building project. Includes an option to Save any 

unsaved changes. 

Save Save the currently opened multi-floor building project. 

Export 
Export the building project as a .zip file. Use this option to import the 

project on another machine running Multi Floor Planner. 

Import 
Import a building project from a .zip file.  Choose the .zip from File for 

Import.  Create the imported project in Import Location. 

Print Preview 

(Current View) 
Open a print preview of the current view. 

Recent Files List any previously opened files. 

Exit Quit Multi Floor Planner. 

View Menu 

Item Description 

View 3D Refer to Map View options. 

View 2D Refer to Map View options 

View Thumbnail Refer to Map View options 

View Building 

Properties 
Refer to Building Project 

View Legend If the Legend tool is closed (unavailable), this option restores the Legend. 

View AP List 
View a list of all APs currently placed on the site plan. Refer to Viewing a 

List of APs. 

Tools Menu 

Item Description 

Align Floors Refer to Floor Alignment 

Reset Alignment Reset the building levels to default center alignment. 

Copy View Copy the current site map view to the clipboard. 

Copy Current View 
For example, a zoomed-in view, this will capture the zoom area 

only. 

Configure Refer to Configuration. 

Configure Walls/Areas Refer to Wall / Area Object Manager. 

Help Menu 

Item Description 

View Help Open Help documentation 

Sample Project Open a sample Multi Floor Planner building project 
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About Multi Floor Planner 
Provide information about Multi Floor Planner such as the Multi 

Floor Planner version and build number. 

Map View options 

Item Description 

   

Camera 

3D view panning controls. Click the camera icon to reset the default view. 

Arrows control the associated panning direction. 

Zoom and 

Rotate 

While in 3D view, Right-click and drag in the desired direction to rotate the 

building in 3D space; left-click and drag up to zoom in or drag down to zoom 

out.  

Open   
Open a multi-floor building project 

View 3D 

Displays the floor plans in a 3D view that simulates width, length and floor 

height in three dimensional space. Clicking a floor in the building tree will 

highlight that particular floor. Clicking the parent Building Name will highlight 

all floors. 

View 2D  

Displays a flat length by width view of a floor plan selected in the Building 

Tree. Click a floor in the Building Tree and then click View 2D. Mouse over 

the floor to view a pop-up of data details. 

View 

Thumbnails  

Displays a 2D view of all the floors. 

Align 

Floors  

Opens the Alignment feature. 

Print  
Print the current view. 

Report 
Generate the Multi Floor Planner report. Refer to Multi Floor Planner Reports. 

  

Planner Configuration 

From the Tools menu, select Configure. 

Tab Item Description 

General     

  
Default Building 

Folder 
Directory path for the project. 

  AP Display Use either a user definable name or MAC address. 

  Bubble Help 
Choose to activate or deactivate bubble help text. 

Available in 2D view only. Check "Hide APs below 
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Threshold" to exclude APs in this range from Bubble 

Help. 

  Walls/Areas 
Choose to show or hide walls and areas added to the 

floor plan. 

  Grid Choose to display or not display the grid overlay. 

Floor Material   

Choose to add a new floor type to the list of options. 

Floor material determines the  db loss for the 

associated floor. It is calculated on a per foot or per 

meter basis. 

Sampling Density 

From the Tools menu, select Configure Plan. This dialog enables you to set the distance 

between predictive sampling points. A lower number (smaller distance) will produce a 

higher density of sampling points. Keep in mind that a higher density requires more 

computing power and may produce longer heatmap display processing time. 

 

  

  

Multi Floor Planner Reports 

To generate a report of the building project, click . The report will automatically be 

generated in the main view. 

Note: Data must be processed (Refresh ) in order for the Report option to be 

available. Report is not available from 2D view. 

The topics, floors and heatmaps contained in the report are related to the following factors: 

• If the "building" is selected in the tree view, information about all floors in the 

building are generated. If a specific level is selected, only information regarding that 

level is generated. 

• Information is generated according to the way the filters are set in the Data Tree 

(refer to Viewing Multi-floor Data). For example, if "bleedover" is selected, only 

information regarding bleed over will be generated. 

• Legend settings. 
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Note: If any of the above settings are changed, the report must be re-generated to 

reflect the changes. To re-generate the report, click . 

Information about the associated controls at the top of the Report window may be found in 

Report Window. 

General Information 

To view report information that may be modified, click . After modifying the properties 

desired, a preview of the report’s cover sheet by clicking "Preview Cover Sheet." To close 

the view and save any changes, click OK. To close the view without saving changes, click 

Cancel. 

 

Field Description 

Survey Title The title of the survey. 

Prepared for Recipient of the report. 

Prepared by Report preparer. 

Location Survey location. 

Time of Planning Date stamp that may be modified. 

Cover Sheet Picture 

Directory path to the picture that will be displayed on the cover sheet 

of the finished report. Recommended size is 650w x 400h pixels. If 

the width is larger then the image will be cut off. If the height is 

longer it may be displayed in new page. 

Corporate Logo 

If desired, users can specify a logo to be displayed in the lower-right 

corner of the cover page. Recommended size is 164w x 164h pixels. A 

larger width will cause the image to be cut off. A longer height may 

cause the image to be displayed in new page. 

Plan Description An option to include paragraph text. 



AirMagnet Survey User Guide 

133 

Report Page Header 

& Footer 

Running header and footer text may be added here. The text will be 

aligned to the left side of the page. In addition, a default page 

number is included at the bottom right corner of each page. 

Report Localization 

The report is generated based on the Windows language setting. In addition, the report may 

be generated in the following languages: English, Arabic, French, German and Russian. 

1. Click  to generate the report. 

2. From the language drop-down at the top of the report view, select the language of 

choice. 

3. Click   re-generate. 

4. You may also edit the General Information as described above. 

Data Filtering Examples 

The following data filtering scenarios provide some guidance for using the various data 

filtering controls in Multi Floor Planner. 

Signal Bleed-over throughout the Entire Building 

View how the signal strength of particular AP or set of APs may propagate to other floors: 

Select Signal Strength from the Data Type drop-down. Activate data filtering on all floors 

by selecting the parent Building Name in the Building Tree and selecting "All Floors" from 

the Data Tree drop-down. Make sure all APs are checked in Data Tree.    

Signal Bleed-over on a Single Floor 

View how the signal strength from other floors affects a selected floor: Select Signal 

Strength from the Data Type drop-down. Activate data filtering on a single floor by 

selecting the floor in the Building Tree. From the Select APs from drop-down, select 

Bleedover. This option filters out the data from the APs on the selected floor while 

including any bleed-over data from other floors. This may be easier to view in 2D view. 

Signal Propagation from the Selected Floor 

In 3D or Thumbnail view, see how the signal strength from one floor affects the entire 

buiding: Select Signal Strength from the Data Type drop-down. Activate data filtering on 

all floors by selecting the parent Building Name in the Building Tree. From the Select APs 

from drop-down, select a floor (for example, Floor 1). This option filters out the data from 

the APs on all floors except the selected floor. 

Signal Propagation by Channel or SSID 

In 3D or Thumbnail view, see how the signal strength is propagated by channel or SSID: 

Select Signal Strength from the Data Type drop-down. Activate data filtering on all floors 
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by selecting the parent Building Name in the Building Tree and selecting "All Floors" from 

the Data Tree drop-down. Click Per CH (below legend). To view by channel, click the 

Channel tab in the Data Tree. To view by SSID click the SSID tab in the Data Tree. Keep in 

mind that you can drill down to show data from all channels, individual channels or 

individual APs by selecting the desired parent or child listing in the Data Tree. 

Using Multi Floor Planner Advisor 

AirMagnet Planner implements an advisor feature to help you optimize the layout of APs on 

site plans.  After drawing walls and areas on the site plan, you can specify two types of 

areas to narrow advisor’s focus: coverage areas and AP exclusion areas.  These areas can 

be drawn using their tools in the Toolbar. 

Each tool has both a coverage (represented by a blue ‘+’) and AP exclusion (represented by 

a red ‘–’) area type. Coverage areas represent portions of the site plan that absolutely must 

have signal coverage and can contain APs; AP exclusion areas are those in which APs 

cannot be placed. 

Icon Name Description 

 

Create Rectangular 

Coverage/AP Exclusion 

Area 

Draws a rectangular coverage or AP exclusion area on the 

map. 

 

Create Arbitrary 

Coverage/AP Exclusion 

Area 

Draws an arbitrary coverage or AP exclusion area on the 

map. This tool works well for irregularly-shaped regions 

(that is. areas other than cubicles, offices, and so on.). 

 

Create Elliptical 

Coverage/AP Exclusion 

Area 

Draws an elliptical coverage or AP exclusion area on the 

map. This tool is useful for areas that cannot be drawn 

easily using straight lines. 

In order to use Multi Floor Planner’s Advisor, you must lay out the site plan as normal (draw 

out walls, cubicles, and so on.).  After the general areas are drawn, coverage and AP 

exclusion areas can be added in order to define the required signal coverage area.  Once all 

this is completed, you can generate Advisor's recommended AP layout. 

• Drawing Coverage/AP Exclusion Areas 

• Generating Advisor's Layout 

AP Coverage and Exclusion Areas 

This section describes how to set a site plan up in order to help Multi Floor Planner Advisor 

reach the most accurate results possible. It is important that you lay out their coverage and 

AP exclusion areas properly so that Advisor can generate the optimal layout. 

Note: Advisor’s results depend heavily on user input; therefore, the more detailed the 

plan layout, the more accurate the results. The only way to perfectly determine the 

optimal layout for a site is to test a setup and run a site survey using the AirMagnet 

Survey software. 

To draw coverage and AP exclusion areas: 
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1. Select the coverage tool that will best fit the region to be drawn (rectangle, arbitrary, 

or ellipse).  Use the tool to define the intended region in the same manner as areas 

are defined. 

2. Repeat the process until all necessary areas are defined. 

3. Repeat steps 1-2 for any AP exclusion areas as well. 

4. The plan is now ready for Multi Floor Planner Advisor analysis. 

Generating a Multi Floor Planner Advisor Layout 

Now that the site plan has been properly defined, Multi Floor Planner Advisor can generate 

its optimal AP layout. 

To generate an Advisor Layout: 

1. Click the  (Advisor) button in the toolbar. The Advisor Criteria dialog appears. 

 

2. Make any desired changes to the dialog information.  

Field Description 

Media Type 

This selection specifies the Wi-Fi standard supported by the Advisor-

placed APs. Note that the Media Type selection changes the available 

range of some of the settings below. 

Minimum Signal 

Strength 

Coverage 

This field defines the minimum strength required at any point in a 

coverage area. The signal strength cannot drop below this value in 

areas that require coverage. 

Transmit Power 

2.4 GHz 

This field defines the transmit power for the 2.4 GHz APs placed by 

Advisor. 
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Transmit Power 5 

GHz 

This field defines the transmit power for the 5 GHz APs placed by 

Advisor. 

Band This field defines the band to be used by Advisor’s placed APs. 

Channels 

This button opens the Channel Allocation drop-down menu, which 

enables you to specify precisely which channels that Advisor can use 

when placing APs.  Note that a minimum of three channels must be 

selected for each band in use. 

Channel Width 

The Channel Width setting specifies the channel width to be used by 

Advisor-placed APs. The 802.11n media type supports 20 MHz and 40 

MHz channel widths. 802.11ac and 802.11ax media types also include 

80 MHz and 160 MHz channel widths. 

Spatial Stream 

Number 

The Spatial Stream Number setting specifies the number of spatial 

streams to be used by Advisor-placed APs. The setting is used by 

802.11ac and 802.11ax media types and ranges from 1 to 8. 

Max MCS 

The Modulation Coding Scheme (MCS) setting specifies the MCS index 

used by Advisor-placed APs. The MCS setting corresponds to the 

maximum data transfer rate supported by the AP. The 802.11n media 

type settings range from 0 to 76. The 802.11ac media type settings 

range from 0 to 9. The 802.11ax media type settings range from 0 to 

11. 

Frame Size 

The Frame Size setting specifies the maximum frame size used by the 

Advisor-placed APs. This setting can range from 3839 to 4194303 

depending on the media type. Larger frame sizes minimize wireless 

overhead in the network by reducing the number of frames required 

per transmission. 

AP Height 

The AP’s height directly affects its signal coverage; APs placed at 

higher elevations will not cover as wide an area as those at standard 

ceiling height. 

Omni Antenna 

Gain 

This field defines each AP’s antenna gain. Note that Advisor’s APs will 

utilize omnidirectional antennas. 

  

3. Click OK to start the Advisor. Advisor will begin processing the site data and testing 

AP locations. 

4. After the process completes, APs are placed on the plan. Click  (Refresh) to 

view the site’s projected heatmap. 
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Configuration Options 

Configuration Dialog 

The Configuration dialog includes several tabs, each dedicated to a specific aspect of the 

program's settings. 

To access the Configuration dialog, do either of the following: 

• From the Main Menu, select File>Configure.... 

• From the Toolbar, click   (Configuration). 

By default, the Settings tab is selected when the dialog box opens. 
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Configuring Program Settings 

This option defines the way AirMagnet Survey collects and processes data. It also enables 

you to optimize certain attributes on the wireless network adapter in use to maximize its 

performance with the application. 

To configure settings: 

1. From the Main Menu, select File>Configure.... 

2. Make sure the Settings tab is selected. 

Parameter Description 

Ignore APs whose max 

discovered signal strength 

is less than 

Specify a threshold value for AP signal strength.  

Note: APs whose signal strengths fall below that value will be 

ignored. The value of signal strength ranges from 0 

(strongest) to -100 (weakest). 

Hide ignored Access Point 

If selected, APs whose maximum signal strengths fall below the 

threshold will not be shown in the Channel/SSID Tree in the 

Display view. 

Auto logging data period 

Enter a value in seconds. This option determines how frequently 

the application automatically logs data points during a site 

survey.  

Note: This allows you to set AirMagnet Survey’s automatic 

data sampling interval. The default value is once every three 

seconds. 

Beep when logging data 

If selected, AirMagnet Survey will beep each time it logs data.  

Note: It serves as an indicator that Survey is working 

properly. The frequency of the beeping depends on the data 

sampling interval specified above. 

Auto sampling through 

path 

If selected, AirMagnet Survey will automatically mark data 

sampling points on the site map, which are represented by the 

blue dots along the survey path.  

Note: The data sampling interval will be determined by the 

value you specified in Auto logging data period. See above. 
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Sampling on click only 

If selected, AirMagnet Survey will sample data only when you 

click on the site map.  

Note: When conducting a Click to Sample survey, it’s 

important to ensure that the application has had adequate 

time to complete a full scan cycle before clicking to record a 

sample and moving on.  Moving and clicking significantly faster 

than the scan pattern can result in decreased heatmap 

accuracy.  To aid in recording accurate data, a progress bar at 

the bottom of the survey screen continuously shows the 

progression through the configured scan pattern. Use it to 

verify that a full scan cycle has been completed before you 

click to record data.  Once the meter reaches 100%, a new 

scan is started and the meter resets to 0. However, this 

progress bar is only applicable when you use adapters that 

support user-defined scan patterns. 

Use maximum heatmap 

drawing resolution 

If selected, AirMagnet Survey will display smoother looking 

heatmaps for floor plans with less than 400 feet (122 meters) 

dimension.  

Auto position APs with 

signal strength greater 

than 

If selected, you may also need to set a signal strength value in 

the space below. AirMagnet Survey automatically places the APs 

that meet your specification in their optimal locations on the site 

map. 

Display MAC address only 

If selected, AirMagnet Survey will display all APs by MAC address 

alone, rather than attempting to display a vendor ID or custom 

name. 

Prompt for refresh after 

AP location change 

If selected, AirMagnet Survey will prompt you to refresh the view 

each time you reposition an AP. 

Enable Survey Range 

Indicator 

If selected, AirMagnet Survey will automatically mark the survey 

data sampling range (radius) as you click on the site map. 

Enable GPS port 

If selected, the Configure... button next to it will be enabled so 

that you can configure GPS settings. Refer to Conducting GPS-

Aided Site Surveys. 

Hide APs below legend 

threshold in Bubble 

Window 

If selected, APs placed on the floor plan (whether placed APs in a 

survey or placed APs in Planner) will not be included in the 

Bubble window listing. 

Configure GPS 
Opens the dialog to configure GPS integration for conducting a 

GPS survey. Refer to Configuring GPS COM Port. 

Channel Interference 

Opens the Interference dialog where you can configure the 

minimum values of AP signals that the program will take into 

account when calculating signal interference. 

Spectrum Integration 

Clicking this button will open the Spectrum Integration dialog 

box where you can choose to show or hide the Spectrum 

Integration window, which, if enabled, will appear below the Map 

Window on the Survey and Display screens. For information 
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about AirMagnet Spectrum Analyzer, refer to AirMagnet 

Spectrum Analyzer introduction. 

PHY Data Rate Map 
This is used when generating speed data for passive surveys. 

Refer to Calibrating Wireless Network Adapter Speed. 

3. Click OK. 

Specifying Interference Settings 

Definitions of signal interference and noise are rather subjective. They may vary from 

person to person, depending on an individual’s perception and level of tolerance. For 

instance, -67 dBm or -87 dBm may be considered as interference by some people, but may 

also be considered acceptable by others. 

The Ch Interference Setting… button allows you to specify the minimum value that the 

program should consider as interference when calculating these parameters. Once specified, 

any signal from an adjacent AP that falls below the value will not be considered as 

interference by the program. 

To specify interference settings: 

1. From the Main Menu, select File>Configure.... 

2. From the Settings tab, click Ch Interference Setting....  The Interference dialog 

box appears. 

 

2. Specify the desired values for interference and noise, and click OK. 
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Note: The first field specifies a setting for “Interfered APs”, or those that are experiencing 

interference from other sources. The second refers to “Interfering APs’, or those that are 

causing interference to others. 

Calibrating Wireless Network Adapter Speed 

The PHY Data Rate Map button in the Settings dialog brings up the PHY Data Rate Map 

table, which enables you to specify speed transmission information for the wireless network 

adapter in use. This is important for speed data calculated for passive or virtual surveys. 

The values displayed in the speed mapping table relate to the minimum signal strength 

required in order to transmit data at a given speed. For example, the default value for 

transmitting at 6 Mbps for 802.11g traffic is -86dBm. 

Note: The default values provided in the table are based on Receive/Radio sensitivity 

values for most wireless network adapters. You should only modify any values that do not 

match those of the wireless network adapter in use. Refer to the adapter’s technical 

specifications from the vendor’s website. 

To adjust speed settings on a wireless network adapter: 

1. Click File>Configure… 

2. From the Settings tab, click PHY Data Rate Map. The PHY Data Rate Map table 

appears. 
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Note: As shown above, the table has three tabs, each for a different media type 

(802.11a, 802.11b/g, and 802.11n).  The Vocera B2000 Badge Speed Map option is 

intended only for users surveying a Vocera deployment. When this option is enabled, the 

speed map values will be hidden. 

2. Click the tab that matches the media type in use. 

3. To modify a value, highlight the value and enter the new value. 

 

Note: The value you enter must lie between the values above and below the entry. 

4. Click OK to save the changes. 

To restore the default values: 

Click Restore to Default. 

Configuring AP Grouping 

AP Grouping allows you to set up specific names for single devices that utilize multiple 

SSIDs under different BSSIDs. The grouping helps identify instances where separate BSSIDs 

show up and appear to be several different devices when they actually belong to a single 

device. 

A few pre-defined rules are available. You may also create custom (New) rules. 

You can enable and use AP grouping as follows: 

• Choose to use “Any” (any vendor) either 2.4 or 5 GHz. This will group all MAC 

addresses where the last octet is 0-16, for example, xx.xx.xx.xx.xx.x0 

• Choose to use Ubiquity 2.4 or 5 GHz: Octet: First (1), consecutive mac address 16, 

starting bytes: 0 

• Choose to use Ruckus 2.4 or 5 GHz. This will group all MAC addresses where the last 

octet is 0-16, for example, xx.xx.xx.xx.xx.x0 

• Create "New" AP Grouping Rules as described below. 

Note: An enabled (checked) user defined rule (New) will take precedence over an "ANY" 

rule. 

AP Grouping Limitations 

AP Grouping is subject to the following limitations: 

• Automatic rules are not editable and do not show up in the "Group Rule Name" list 

and cannot be deleted or edited. 
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• No special name will be displayed if "Display Best Name" is selected in the filter view, 

for example, Name will be the same as if its MAC address is selected unless there is 

a known AP name. 

• The existing OUI to create grouping rules will not be modified. 

• AP grouping will not attempt to group dual radio APs into a single device. 

To configure AP grouping using pre-defined settings: 

1. From the Survey Configuration dialog box, select the AP Grouping tab.   

 

2. Check Enable auto grouping. 

3. Check the desired listings in the Group Rule Name table. 

4. Click OK. 

You can disable AP Grouping by unchecking Enable AP Grouping. 
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Viewing AP Grouping Rules 

You can view the details of the default settings. 

1. Select an AP Group rule. 

2. Click Detail. A dialog box appears showing all the attributes of that auto grouping 

rule. 

 

The table below briefly describes each of these fields. 

Parameter Description 

Vendor ID Specifies the name of the device vendor that the rule applies to. 

Band Specifies what media type is used on the device. 

MAC address order Indicates whether address is in ascending or descending order 

MAC address hexdigit 

starting from 
Indicates the hex digit used to start the grouping. 

Number of contiguous MAC 

address 

Indicates the number of consecutive addresses you wish to 

classify in the group. 

Creating New AP Grouping Rules 

The AP Grouping tab’s pre-configured auto group rules automatically incorporate a range of 

vendor IDs for devices from various manufacturers. These numbers are assigned to vendors 

by the IEEE, and as newer cards are released, new IDs are granted. 

The IEEE OUI file is located in c:\AirMagnet\Surveyor\OUI and the user can download the 

latest IEEE file from here: http://standards.ieee.org/develop/regauth/oui/oui.txt. Open the 

web page and from the browser File menu, select Save As. Save as a .txt format. 

Additionally, vendor names can be modified to abbreviate them or otherwise make them 

more meaningful as desired. For example, you may rename "Hewlett-Packard" to "HP". To 

make a change, open "oui_alias.txt" located here: C:\Program Files (x86)\AirMagnet 

Inc\AirMagnet Surveyor\OUI.    

Note: the vendor names drop-down in “AP Grouping” will either be the first word in the 

name or the first 16 characters (if the first name is longer than 16 characters). 

http://standards.ieee.org/develop/regauth/oui/oui.txt
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1. From the Survey Configuration dialog box, select the AP Grouping tab. 

2. Under AP Group Rules, click New. 

3. From the Vendor ID drop-down, select the desired vendor. 

4. Configure the grouping options as desired. 

5. Click OK. 

6. The newly added vendor ID can now be enabled as a AP Group Rule. 

You can delete an AP Grouping rule you created. To do this, check the desired rule and click 

Delete. You cannot delete a pre-defined rule. 

Current User Configured OUI(s) 

1. From the Survey Configuration dialog box, select the AP Grouping tab. 

2. Under Current User Configured, click New. 

3. Type the Vendor ID. 

4. Type the Vendor Name. 

5. Click OK. 

6. Select apply OUI change. 

The newly added vendor ID can now be used to create an AP Group Rule. 

Note: If you use the same vendor name for each new vendor ID, a grouping rule 

using that vendor name will apply to all the IDs associated with that vendor name. 

Alternatively, the ID may be created manually: 

1. Navigate to AirMagnet Survey’s installation directory (typically C:\Program Files 

(x86)\AirMagnet Inc\AirMagnet Surveyor). 

2. Open LanCardVendors.txt. 

3. Follow the instructions for creating a new entry. 

4. Save and close the text file. 

The new entry will be implemented when AirMagnet Survey is launched. 

Configuring Legend Color Settings 

This feature allows you to set and change the color settings on the Legend, which also 

affects the color scheme displayed in the Map Window on the view. 

To configure Legend color schemes: 

1. From the Main Menu, select File>Configure.... 

2. Click the Color tab. 
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2. Make the selections as described in the table below. 

Parameter Description 

Color Scheme 

Use the radio buttons to select a color scheme.  

Note: Each radio button represents a color scheme, which affects the 

overall color scheme of the Legend. Your selection will be automatically 

reflected on the Legend once you click OK. 

Outline Color 

Either change any of the color values (Red, Green, Blue) by highlighting it 

and then overriding it with a new one or click Select Color... to choose a 

color from the Color box.  
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Note: This option affects the color of the borderline around areas (that 

is, cells) covered by different APs. 

Automatic 

contrast 

adjustment 

If selected, the program will automatically adjust the color contrast as you 

drag the color box up or down the Legend. 

Granular color 

bar selection 

If selected, the program will change the color shade one grade at a time 

as you drag the color box up or down the Legend. 

AP icon size Select an AP icon size as desired. 

3. Click OK when finished. 

Configuring 802.11 Parameters 

In order to perform Active and Active Iperf surveys, the adapter needs to associate with the 

desired AP or SSID.  This likely requires establishing the authentication method and security 

password for the AP or SSID. This can be accomplished using Windows Wireless settings 

outside AirMagnet Survey or it can be set up in AirMagnet Survey using 802.11 

configuration. 

To configure 802.11 parameters: 

1. From the Main Menu, select File>Configure.... 

2. Click the 802.11 tab. 
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2. Click New to create a new profile. Provide a Name for the AP or SSID and click OK. 

3. With the SSID or AP name selected in the Wireless Networks drop-down, click 

Edit. 

4. Make the desired entries and/or selections in the Connections tab and Security tab 

as you normally would for a new Windows Wireless connection. 

5. Click OK. 

Note: The options available depend on the adapter and OS being used with AirMagnet 

Survey. Refer to the "Supported Adapters" section of the AirMagnet Survey web site at - 

https://www.netally.com/products/airmagnet-survey-pro/#SupportedAdapters   

Configuring Channel Scan 

Configuring channel scan settings allows you to specify the channels you want the wireless 

network adapter to scan and to set the frequency at which the scanning occurs. 

Note: In order for AirMagnet Survey to record data from the channels of interest, make 

sure that you have the scan feature enabled for those channels using this view. A 

https://www.netally.com/products/airmagnet-survey-pro#SupportedAdapters
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common reason that no data are recorded for a specific channel is that the scan feature 

on that channel is not enabled at all. 

To configure Scan parameters: 

1. From the Main Menu, select File>Configure.... 

2. Click the Scan tab.   

 

Note: When running in multi-adapter mode, a drop-down menu will appear at the top of 

the window allowing the user to select the desired device. 

2. Use the controls to enable the channel or channels to be scanned (checked channels 

are scanned). 

• Use the check boxes to enable (or disable) individual channels to be scanned. 

• Click Enable All to enable all channels so that all channels will be scanned. 

• Click Clear All to disable all the channels so that no channel will be scanned. 

3. Set the scan intervals: 

• Click the Period (ms) field, and select a scan frequency for the individual channels 

from the drop-down list. 

• Click Scan Time down arrow to select a time period, and then click Set All to apply 

the time period to all channels. 
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• Click Reset to restore the scan settings to the default, which is 250 ms. 

4. Click OK. 

Note: When an 802.11n card is in use, the Scan tab allows you to specify scanning on 

lower and upper portions of selected channels.  This is due to the use of 40 MHz channel 

settings; by default, AirMagnet Survey automatically configures these 

channels.  However, you can specify these channels manually by unchecking Enable 

automatic configuration of 40 MHz channels and checking the individual upper and lower 

channels desired. 

Configuring a Survey Profile 

The Profile tab allows you to store settings made in Survey’s configuration and reapply them 

for future surveys. These settings can be saved into an AirMagnet Profile (.apf) file and then 

uploaded onto another computer using AirMagnet Survey. This feature is particularly useful 

for users who survey different sites repeatedly. Profiles can be created for individual sites, 

making it easy to re-configure the scan settings as the site requires. 

To configure a Survey profile: 

1. From the Main Menu, select File>Configure. 

2. Click the Profile tab.   
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2. Click New. The New Profile dialog appears.   

 

3. Enter a unique name for the profile. (This will also be the profile’s filename, for 

example, “Profilename.apf”). 

4. Leave the Create New Profile radio button selected. 

Note: The “Copy From” button allows the user to duplicate the settings configured in an 

existing profile and apply them to the new profile. 

5. Click OK. The new profile appears in the profile list window. 

6. Enter any comments about the new profile in the Comments field below the Profile 

List (optional). 

7. Click OK. 

Note: The new profile is automatically selected as the active profile. Any changes made 

in Survey’s configuration are stored in the active profile. 
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RF Signal Adjustment 

About Signal Adjustment 

Consumers have a wide variety of 802.11 wireless network adapters to choose from for use 

with different applications. Since these adapters are designed and manufactured by different 

vendors, there is a possibility of manufacturing differences between the vendors leading to 

the possibility of different signal readings.   

View our “preferred” list of Wi-Fi adapters on the AirMagnet Website: 

https://www.netally.com/products/airmagnet-survey-pro/#SupportedAdapters 

How to Use Signal Adjustment Options 

AirMagnet Survey comes with a Signal Adjustment dialog box to make wireless network 

adapter adjustment fast and easy. You can bring up the dialog box by clicking 

File>Configure…>802.11>Adjust Signal…. 

Once you have brought up the Signal Adjustment dialog box, you should click the down 

arrow in the upper-left corner and select one of the following options: 

• No Adjustment 

• Pre-Defined Adjustment (This is the entry below No Adjustment, for example., 

AirMagnet 802.11 a/b/g/n Wireless PC card.) 

• Custom Adjustment 

No Adjustment 

No Adjustment means no adjustment offsets are applied by AirMagnet to the wireless 

network adapter. This option should be used when the user prefers to utilize the adapter 

manufacturer’s raw RF signal strength readings. 

To use a wireless network adapter’s default settings without adjustment, perform 
the following steps: 

1. From the upper-left corner of the Signal Adjustment dialog box, click the down arrow 

and select No Adjustment from the list menu. Refer to the figure below. 

https://www.netally.com/products/airmagnet-survey-pro#SupportedAdapters
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Note: When you have selected the “No Adjustment” option, all other controls in the 

Signal Adjustment dialog box will be grayed out (unavailable).   

2. Click the OK button to implement the selection. 

Pre-Defined Adjustment 

If the wireless network adapter you are using happens to be on the pre-adjusted list, then 

the AirMagnet application automatically recognizes the adapter and displays the pre-defined 

adjustment option. In other words, if your wireless network adapter is displayed as a Pre-

Defined Adjustment entry in the list menu, it means that you have the option to select and 

utilize the AirMagnet-adjusted values. In this case, you do not have to do anything other 

than select this entry. You still have the option to make changes to the settings of a pre-

adjusted wireless network adapter. In this case, you are customizing a pre-adjusted 

wireless network adapter, which will also be discussed below. 

All tests for defining the adjusted values for the wireless adapter were performed using 

adjusted spectrum analyzers in a professionally shielded isolation chamber to ensure the 

best possible accuracy. The adjustment first uses the spectrum analyzer to measure the 

down-link (from AP to station) radio signal strength from the Access Point at various 

attenuation points, with an attenuator placed in between the two. The attenuation is 

achieved by tuning down the radio signal power the attenuator receives from the AP.  For 

example, if the attenuator receives the signal strength of -20 dBm from the AP, it will tune 

it down to -30 dBm. As a result, the AP signal strength will be -30 dBm when received by 

the spectrum analyzers. The measurements are carried out at on all channels applicable to 

the 802.11 protocol used on the wireless network adapter being adjusted. Once the 

benchmark values are established using the spectrum analyzer, we then perform the same 

measurement procedures with an 802.11 wireless network adapter (for example, AirMagnet 

802.11 a/b/g/n Wireless PC Card) and adjust the values in reference to the benchmark 

values. 

Consider the following example: If at Attenuation Point A, the spectrum analyzer displays a 

radio signal power value of -20 dBm and the adapter being adjusted displays -30 dBm, 

AirMagnet adds 10 dBm to bring it to line up with the benchmark values. The pre-defined 

offsets are relative to the spectrum analyzer. In other words, the pre-defined adjustment 

patterns will make the target Wi-Fi adapter to report signal strength readings similar to 

those reported by professional grade spectrum analyzers. For the same wireless network 

adapter, this same procedure is repeated on every applicable channel/frequency. This is 

how the pre-defined adjustment values are derived. All adjustment data involving those 

pre-adjusted wireless network adapters are included in the application. 
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To use pre-defined adjustment, do the following: 

1. Click the down arrow and verify if your wireless network adapter appears as a pre-

defined adjustment entry.  Refer to the figure below. 

 

2. Select it (for example, AirMagnet 802.11 a/b/g/n/ USB Adapter Card as shown in the 

figure above) if the name of your wireless network adapter appears. 

3. Click OK. 

Note: These three steps are all you need to do if the wireless network adapter has been 

identified as pre-defined adjustment (by AirMagnet). No other action is needed. However, 

this does not mean that you cannot make any change to a pre-adjusted wireless network 

adapter. On the contrary, AirMagnet does allow you to make changes to a pre-adjusted 

wireless network adapter. In this case, you are actually making custom adjustment on 

the basis of a predefined adjustment. Any custom adjustment made in this way will not 

change any of the signal values that are dependent on the pre-adjustment settings. 

Instead, it updates the custom adjustment option with the new settings. The following 

paragraph explains how to make changes to settings of a pre-adjusted wireless network 

adapter. 

To make changes to a pre-defined adjustment, do the following: 

1. Repeat Steps 1 through 2 in the previous paragraph. 

2. From the upper-right corner, click the down arrow and select a channel of interest. 

3. Use the sliders to turn up or down the RF signal strength as desired. 

4. When the “Create a custom signal adjustment based on current settings?” 

message appears, click Yes. 

5. Continue to adjust the signal strengths with the sliders. 

6. Adjust the noise floor by entering a desire value in the noise floor adjustment box. 

7. Click OK to implement the change. 

Note: Custom signal adjustment on a pre-adjusted wireless network adapter must be 

done channel by channel, one at a time. This is because changes made to a particular 

channel apply to that channel only.  If you want to make changes to any other channels, 

you have to make the changes channel by following the same steps. 

Custom Adjustment 
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Custom adjustment can be used when you want to create your own adjustment table for 

your wireless network adapter from the Signal Adjustment dialog box. 

Custom adjustment patterns can be created to equalize the signal strength readings 

between any combination of Wi-Fi adapters. Begin by measuring (similar to the process 

defined in the pre-adjustment section) two different radios with zero offsets at varying 

distances, comparing the received signal strengths at each distance, then calculating the 

differences between Wi-Fi adapters and using the differences to set the offset of one radio 

in an effort to match the signal strength reading of the other Wi-Fi adapter. 

This feature allows you to adjust the RF signal strength and noise floor of the wireless 

network card in 5-dBm increments. This way you can normalize different Wi-Fi adapters to 

exhibit similar signal level readings. Without using this feature, the signal level readings 

may vary significantly between Wi-Fi adapters from different vendors, or even between 

different models from the same vendor. 

The horizontal numbers (-5 to -100) represent the signal strength levels received by a Wi-Fi 

adapter. At each signal strength level, an offset can be set (from -30dB to +30dB) by 

adjusting the sliders up or down. 

To custom-adjust a wireless network adapter’s RF signal power, do the following: 

1. From the drop-down list menu, select Custom Adjustment (The name of your 

wireless network adapter should be appended here, if it has not been pre-adjusted). 

Refer to the figure below. 

 

2. From the upper-right corner, click the down arrow and select a channel of interest. 

Note: Normally, signal adjustment is performed on a per-channel basis unless you want 

to apply the same adjustment to all channels. In this case, you should select All 

Channels from the channel list menu. 

3. Use the sliders to adjust the RF signal strengths. 

4. If you wish, highlight the number for the Noise floor adjustment box and type a new 

value over it. 

5. Click OK when completed. 
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Display View 

About Display view 

The Display view is designed for viewing, analyzing, and manipulating data. Normally, you 

use this view only after you have completed and saved a survey and/or site plan. To open 

the Display view, click  on the Navigation Bar. 
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By default, the Display view is selected when a project file (.svp) is opened. The view may 

show the site map only, without any data. To show data over the site map, you must open 

one of the data files listed under Survey Data in the Project Window by clicking the 

corresponding radio button. 

Some changes occur in the Display view when survey data are loaded. The Spectrum XT 

Window may appear if you are running AirMagnet Survey PRO, provided that this feature is 

enabled. Refer to Enabling Spectrum Analyzer. 

Display View Menu Options 

The Menu bar on the Display view also has three menu groups, each containing various 

menu options for viewing, analyzing, and manipulating survey data. Except for the Help 

menu whose content stays the same for all the screens, the File and View menus contain 

options that are specific to the Display view only. 

File Menu 

The figure below shows the File menu on the Display view. 
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Menu Option Description 

New Project… Opens the New Project Wizard where you can create a new project. 

Open Project… Opens an existing  project (.svp) file. 

Save 

Saves changes made to the current project.  

Note: This option is available only when changes are made to an opened 

project file. 

Save Project As… Allows you to save an existing project under a new file name. 

Close Project Closes the current project. 

Configure… 
Opens the Configuration dialog box which allows you to set up project 

parameters. 

Phonebook Configure a VoFi Phonebook. Refer to Configuring a VoFi Phone Book. 

Data Merge 
Opens a window containing all data files so that you can select the files 

you want to merge. 

Import Survey 

Path… 

Opens the Import Site Survey Path File dialog box where you can import 

the survey data file. Also see Import Path on the toolbar. 

Import Survey 

Data… 

Opens the Import Site Survey Data File dialog box so that you can 

import the data of an existing survey project. 
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Import Floor 

Image… 

Opens the Open Site Image dialog box so that you can import a site 

map. 

Export to Google 

Earth 
Enables you to export a GPS survey for viewing in Google Earth. 

Export AP Config… 
Opens the Export AP Config dialog box so that you can export AP 

configuration data in the Excel format. 

Cisco Prime 

NCS/WCS Export 

If a Cisco Prime NCS/WCS Planner or Survey project was imported and 

modified, it may be exported using these options. 

Print Prints the content of the Map Window. 

Print Preview 
Opens the Preview Window so that you can preview what is to be 

printed. 

Print Setup 
Opens the Print Setup window where you can set your printing 

preferences. 

Work in Display 

Only Mode 

Allows you to switch to Viewer mode. You will have fewer view options 

and no survey options. 

Recent Projects Allows you to quickly open projects that have been viewed recently. 

Multi Floor 

Planner 
Opens Multi Floor Planner 

Exit Exit the software application 

View Menu 

The figure below shows the View menu on the Display view. 
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Option Description 

Zoom In 
Enlarges the view of the current floor map in the map window. It works 

in the same way as  (Zoom In) on the toolbar. 

Zoom Out 
Reduces the view of current floor map in the map window. It works in 

the same way as   (Zoom Out) on the toolbar. 

Zoom to Fit 
Fits the current floor map to the map window. It works in the way 

as   (Zoom Fit) on the toolbar. 

Zoom to Actual 

Size 

Fits the current floor map to its actual print scale. It works in the same 

way as  Actual Size  on the toolbar. 

Set Zoom... 
Opens the Set Zoom dialog box where you can specify the specific ratio 

at which the view of the map can be increased. 
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Show CAD 

Layers... 

Allows you to select which layers of a CAD image to display and, if the 

image has multiple layouts, which layout to display. This feature is also 

available when you right-click on the image in Display View.  

Toolbars and 

Docking Windows 

Enables you to show (checked) or hide legend and/or status bar. If the 

default toolbar settings are modified, click Reset Toolbar to reset the 

toolbar to default setting. 

Show Rulers Allows you to show or hide the rulers along the edge of the map window. 

Show Grids Allows you to show or hide grids in the map window. 

Invert Legend 

Colors 
Flips the legend color scheme vertically. 

Filter APs 

Brings up the Data Filtering by AP dialog box which allows you to create 

a filtered survey data file which contains data only related to the selected 

APs. Refer to Creating Filtered Data Files. 

Overlap 
Allows you to show or hide signal overlap or channel interference in the 

Map Window. Make sure the Data Type selected is 1st AP. 

Overall Displays overall site RF coverage. This option is active by default. 

Per Channel Displays data by channel. 

Per SSID Displays data by SSID. 

Lock AP Location 
Allows you to lock APs to their respective locations on the site map. 

Note: This feature can help make your survey results more accurate. 

Project 

Properties... 

Opens the Project Properties window where you can adjust the physical 

properties of the floor map of the survey site. 

AP/Path Name 

Font... 

Opens the Font window where you can modify the font properties of APs 

and survey paths on the floor map. 

Measure Mode 
Sets Measure Mode so you can measure the distance between any two 

points on the site map. 

Throughput 

Simulator 
Opens the Throughput Simulator. Refer to About Simulation view. 

Refresh 
Refresh the heatmap display to reflect any changes. Same as 

Refresh   on the Toolbar. 

Project Window 

The figure below shows the Project Window on the Display view. 
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As shown in the figure above, the Project Window displays files in a Survey project in three 

folders: 

• Site Map: Shows all the site maps (floor plans) for the Survey project. To select a 

site map, put a check mark in the check box in front of the map file. The selected 

map will be displayed in the Map Window. By default, a site map is automatically 

selected and displayed when a new project is created, or when an existing project is 

opened. 

• Survey Data: Lists the data files available in this project, each file representing an 

individual survey. They contain data such as SSIDs, APs, signal strength, noise level, 

signal/noise ratio, etc. captured during the survey. File types are as follows: A 

(active survey), P (passive survey), I (Iperf survey), Ma (merge surveys), Ms 

(merged surveys), S (simulation survey), An (AirMapper™/AirCheck™ Survey) and 

  (VoFi survey), V (virtual survey). 

• Survey Path (this option applies to Survey projects and not to Planner projects): 

Shows all the survey paths recorded during a site survey. You can have as many 

survey paths in the folder as you recorded, and display as many of them as 

necessary. To display a survey path, put a check mark in the check box in front of 

the survey path file. 

You can show or hide any file (that is, site map, survey data, survey path) simply by 

checking or un-checking the corresponding radio button. Unlike the Project Window on the 

Survey view,  the Project Window on the Display view has a Survey Data folder instead of 

the AP folder. 

By default, the most recently opened site map is automatically selected and displayed when 

you switch to the Display view. If a project contains more than one site map, you may need 

to select the one you want to display if it is not already opened. Also, no survey data are 

displayed in the Map Window when you switch to the Display view. You need to select a 

survey data file to display it. 

Data File Conversion 

Beginning with Survey PRO/Planner version 8.8, the project data file extension was changed 

from .svd to .svdx. A project containing data files having the .svd extension may be opened 

in version 8.8 and higher; however, if the data file is selected in Display view (for example), 

you will be prompted to convert the file from .svd to .svdx.   

MultiFloor Planner projects are not affected by this change. 

During conversion, the old file is preserved and a new .svdx file is created. 

Survey PRO, Survey Express or Survey Planner version 8.7 or earlier cannot open projects 

that have the .svdx extension. 
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To Convert your Survey Data Files to .svdx: 

1. In the Display View, right click on the project, and select Convert Surveys to 

Current Version. 

 

 

2. Click Yes to confirm and start the conversion process. 

A progress window will show the files being converted. If you click Cancel during file 

conversion, the process will cancel after the current file completes and before the next file 

begins. 

  

Right-click Pop-up Menu 

The Project Window on the Survey view and Display view also includes a right-click menu. 

Some options are available in Survey view and others in Display view. Unavailable options 

are grayed-out. 

Right-click a survey data file to view the right-click menu options. 
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Menu Option Description 

Close Close this data file 

Delete Deletes the selected (right-clicked) item. 

Rename Rename this data file 

Data Merge... 

Allows you to merge two or more data files.  

Note: This option is available on Display view only. 

View Merged 

Source ... 
Shows the sources from which a merged data file was created. 

View Survey 

Properties ... 
Opens a window that displays information about the file. 

View Survey Properties 

From the Project Window, right-click a survey data file (.svdx), and select View Survey 

Properties from the pop-up menu. The Survey Properties dialog opens, as illustrated 

below.  

Note: This option replaces "View Raw Data" in Survey version 8.8 and higher. 

The Survey Properties dialog provides information about the selected survey data file. 
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View Survey Database 

The Survey Properties includes an option to view in-depth, database details included in the 

selected survey data file. 

To view the database, you will need a database viewer application such as "DB Browser for 

SQLite". This application may be downloaded at http://sqlitebrowser.org/ 

Click View Survey Database. You may be prompted by Windows to associate the database 

with the desired database viewer application. 

Right-Click to Show CAD Layers... 

From the Project Window, right-click a CAD image file, and select Show CAD Layers...  

http://sqlitebrowser.org/
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The Drawing Layers... dialog opens, as shown below.  

 

  

Displaying a Site Map 
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By default, the most recently opened site map is automatically selected and displayed when 

you switch to the Display screen. If a project contains more than one site map, you may 

need to select the one you want to display if it is not already opened. 

To select a site map: 

Select the check box in front of the site map. The selected site map appears in the Map 

Window. 

To deselect a site map: 

Do one of the following: 

• Uncheck the check box in front of the site map, or 

• Select another site map. 

Displaying Survey Data 

Each survey data file contains the RF data. By default, no survey data will be displayed in 

the Map Window when you switch to the Display screen. You need to select a survey data 

file to display it. 

To display a survey data file: 

Click the radio button in front of the data file. The data in the selected survey data file 

populates the Map Window once the file is loaded. The time it takes to open a data file 

depends on the size of the file. Some survey data files may take significantly longer to load 

mainly because of the enormous amount of data contained in those files. 

Displaying a Survey Path 

In order to have a better understanding of the survey data, Airmagnet recommends that the 

survey path be shown on the site map when analyzing survey data. This provides a physical 

context for the data. 

To display a survey path: Select the check box associated with the survey path. The 

selected survey path appears in the Map Window. 

To hide the survey path: Uncheck the check box in front of the survey path. 

Channel/SSID List 

The Channel/SSID List allows you to view the list of channels or wireless networks contained 

in a selected survey data file. You can make the selection by clicking either the Channel or 

SSID tab   at the bottom of the list. 

When a data file is selected in the Project list, the Channel/SSID List can be  expanded to 

show individual APs. The APs are organized by Channel or SSID depending on the tab 
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selection. The APs will display its associated 802.11a/b/g/n/ac/ax icon (for example, ). 

802.11ac/ax APs include the primary channel, channel width, and channel span. 

 

This part of the Display view contains the following control options for manipulating data 

display: 

Select All: This option enables you to select or de-select all the entries (that is, channels, 

SSIDs, APs, etc.) in the Channel/SSID tree with a click of the button. By default, all entries 

in the Channel/SSID tree are selected when a survey data file is loaded, meaning that all 

the data contained in the file will be shown in the Map Window. 

If you want to focus on data related to one or more specific channels, SSIDs, or APs, you 

can uncheck this option to clear all the selections. At this point you can manually select only 

those entries that concern you the most. These filter selections will be preserved when 

changing heatmap Data Type options. 

2.4 GHz: This option enables you to display or hide signal information for the 2.4-GHz 

(11b/g/n/ax) spectrum. This makes it easy to distinguish between 802.11b/g/n/ax data and 

802.11a/n/ac/ax on a map that contains both types. 

5 GHz: This option enables you to display or hide signal information for the 5-GHz 

(11a/n/ac/ax) spectrum. Enabling this option along with the 2.4GHz option described above 

displays all media types detected in an environment that utilizes both 802.11a/b/g/n/ac/ax 

devices. 

Note: You may also create a filtered survey data file which contains data only related to 

selected APs. Refer to Creating Filtered Data Files. 

Placing APs on the Floor Plan 

While in Display view, you may expand the Channel/SSID list to view APs contained in the 

survey data file. If desired, you can drag APs from this list to their location on the floor plan. 

There are a few benefits to doing this: 

• Showing the physical location of APs in reports 

• Modifying the AP power setting 
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• Using features such as Cisco Location-based services 

Note: Physical APs with more than one radio may be listed in the Channel/SSID list 

multiple times relative to the number of radios. If this is the case, you can place APs on 

top of each other on the floor plan. 

After placing the AP on the floor plan, you may modify a few of the properties of an AP. To 

do this, right-click the AP and select AP Properties. This opens the AP Properties dialog. 

A few options are editable. 

 

Alias Name: You may type an alias name to map a full MAC address to a user-friendly 

name. Alias Name is included in the AP information line in the Channel/SSID list. Select the 

drop-down menu next to Alias to apply the Alias name to the whole Project or only the 

currently opened survey. 
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The format for items in ‘MyAccessPoints.txt’ is as follows: 

MAC Address, alias 

For example: 

01:23:45:67:89:0A, My Favorite AP 

Original and Simulated Power Setting: You may also modify the power setting in 

milliwatts. Select Apply power setting, and check the Center on AP checkbox to apply 

the power setting around the AP. 

Click OK to save the changes. 

Note: For information about adding APs to the survey project (Survey view) and about 

deleting placed APs from the project and from individual data files, refer to Placing APs in 

the Survey. 

Overview Window 

In the lower left-hand corner of the Display view is the Overview Window, which provides a 

bird’s-eye view of the entire site map regardless of the viewing option used in the Map 

Window. It enables you to try different viewing options in the Map Window without “losing 

the big picture.”   

 

By default, the Overview Window is enclosed by a red box when a survey data file is 

opened, indicating that you are now focusing on the entire site (map). If you want to focus 

on a specific area of the site, you can click outside the red box to make it disappear and 

then click and drag a smaller box on the map. You can then drag this box to zoom in on any 

specific area on the map to get a close-up look at that section in the Map Window. 

Map Window 

The Map Window on the Display view allows you to view and analyze data contained in the 

selected data file. 
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Data at any location on the site (XY coordinates) may be viewed in two ways: Mouse hover 

and Measurement Details. In each case, the data displayed depends on the Data Type 

selection in the drop-down at the top of the Display view. 

Mouse hover: If you hover the mouse over a point on the heatmap, a summary of the 

current Data Type selected is displayed in a balloon tip. 

Measurement Details: You can view the Measurement Details of any location on the 

heatmap by clicking the desired XY coordinates on the heatmap. A dockable window will 

open to display the details data. A red push pin indicates the coordinates location selected. 

Click a column heading to sort data by column in ascending or descending order. 

From the dockable window, click Copy to copy the data details to the clipboard. 

You can also visualize and analyze the data using different color schemes and analytical 

tools. Refer to Performing Data Analyses for more information. 

 

Display View Toolbar 

The Toolbar on the Display view contains frequently used tools for presenting survey data. 

Some of these tools are identical to those on the File and View menus of the Display view. 

The following screen shot shows the toolbar undocked. The toolbar may be undocked by 

dragging its handle located on the far left. 



AirMagnet Survey User Guide 

175 

 

Icon Name Description 

 

Project 

Wizard 

Opens the New Project Wizard where you can create a new Survey 

project. Refer to File menu. 

 

Open Project Opens an existing Survey (.svp) file. Refer to File menu. 

 

Save Saves changes you’ve made in the current project. 

 

Configuration Opens Survey Configuration window. Refer to File menu. 

 

Print Prints what is shown in the Map Window. 

 

Site Image Opens the Import Site Image window so you can import a site map. 

 

Import Path 
Opens the Import Site Survey Path File dialog box where you can import 

the survey path of a survey data file.   

 

Import 

Survey Data 

Opens the Import Site Survey Data window so you can import site 

survey data (.svd or .svdx) files. 

 

Zoom In Enlarges the view of the site map. 

 

Zoom Out Reduces the view of the site map. 

 

Zoom Fit Fits the site map to the Map Window. 

 

Actual Size Displays the site image in a size as it is printed. 

 

Measure 

Mode 

Starts the Measure Mode so that you can measure the distance between 

any two points in the site map. Refer to Measuring Distance Between 

Locations. 

 

Toggle 

Outline 

Enables you to view an outline of where a heatmap transitions from one 

legend value to the next value. 

 

Create 

Comment 

Allows you to place a comment field anywhere on the displayed map. To 

do so, click the button and then click where the comment should be 

inserted. 

 

Refresh Generate and refresh the heatmap 

 

Overlap 
Show or hide coverage overlap in the Map Window. Available in Display 

view. Be sure 1st AP Data Type is selected. 

 

Filtering Filter AP data out of the Planner project. 

 

Tools Opens the Signal and DHCP tools. 

 

Calculator Opens the calculator tool. 

The Display view Toolbar also includes a drop-down menu with the following options: 

View Overall: Displays overall RF coverage in the Map Window. This option is active by 

default. 
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View Per Channel: Displays data by channel. The Channel tab in the Channel/SSID list 

must be selected. 

View Per SSID: Displays data by SSID. The SSID tab in the Channel/SSID list must be 

selected. 

  

Legend 

The right-hand side of the Display view shows the Legend which provides a variety of ways 

for displaying and analyzing survey data using different color schemes and patterns. 

Note: The colors gray and white may appear in a heatmap and not be indicated on the 

legend. White may indicate no coverage. Gray may indicate that a coverage requirement 

is not met. 

 

At the top of the Legend is the Data Type (including its unit of measure). It indicates the 

type of data being displayed in the Map Window and reflected in the Legend. It is identical 

to what is selected from the Data Type list menu on top the Map Window. 

You may set the upper and/or lower limit of RF data (signal, noise, interference, and so on.) 

to be shown in the Map Window by dragging up from the bottom of the Legend and/or down 

from the top of the Legend. 

The color scheme may also be adjusted. Refer to Configuring Legend Color Schemes. 

Measuring and Calibrating the Floor Plan Scale 
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An easy-to-use measurement tool enables you to measure distances on the floor plan 

relative to the floor plan scale.  It also enables you to recalibrate the scale of the floor plan 

(in feet or meters). 

When you create a new project and load a floor plan image, there is an option to enter the 

dimensions of the floor plan image in feet or meters (X and Y dimensions). Keep in mind 

that entering dimensions using this method includes any white space outside the perimeter 

of the building that may be included in the image. In most cases, it is probably more 

accurate to recalibrate the scale. In fact, if you leave the dimensions blank when creating a 

new project, you will be prompted at the conclusion of the project wizard to recalibrate the 

default scale. 

To recalibrate the scale of the floor plan: 

1. From the Toolbar, click the Measurement tool . A prompt is displayed to choose 

whether to measure or recalibrate. To recalibrate, click Yes. 

 

2. The idea is to click two points on the floor plan where you know the actual distance 

between the points. A rule of thumb is that a longer distance tends to be more 

precise than a shorter distance. 
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3. This opens the Recalibration dialog. 
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4. Enter the correct value for the "Actual distance" you measured, click Recalibrate, 

and then click OK. 

To measure a distance on the floor plan: 

1. From the Toolbar, click the measurement tool . A prompt is displayed to choose 

whether to measure or recalibrate. To measure, click No. 

 

2. Click the measurement beginning point. As you move the mouse, the distance is 

indicated in feet or meters depending on the unit of measure selected for the project. 

Click an end point to complete the measurement. 
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Data Type List Menu 

This option is available on the Display view only after data are loaded, that is, after a data 

file is opened from the Project Window. It allows you to select the type of data you want to 

display in the Map Window. You can access the options by clicking the down arrow. 

The data types presented here are related to the selection you make from the Channel/SSID 

Tree. It affects the content displayed in the Map Window and may also affect the options on 

the Color Legend and Analytical Tools. 

 

Using Context-Sensitive Pop-up Menu 

A context-sensitive pop-up menu can be accessed by right-clicking the Map Window. It is 

available on all major screens of the application. As the name suggests, the content of the 

pop-up menu depends on the view context. 

To access the context-sensitive pop-up menu: 
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1. Right-click any part of the map view. The context-sensitive pop-up menu appears. 

 

Option Description 

AP Properties 

Allows you to view the properties of the AP that you right-

clicked. This option is available only when you right click an AP in 

the Map Window. 

Project Properties Same as View Menu. 

AP/Path Name Font Same as View Menu. 

Show Rulers Same as View Menu. 

Show Grids Same as View Menu. 

Hide AP Icons 
Allows you to hide the AP icons from view so that they will not 

be displayed in reports. 

Disable Measurement 

Tooltip and Details 

Window 

Allows you to prevent tip screens from popping up when you 

mouse over the Map Window. 

Hide APs Below Legend 

Threshold 

Enabling this option will hide APs outside the threshold range set 

for the Legend. Keep in mind the ends of the Legend may be 

dragged toward the center to adjust the range. 

Smaller Survey Man 
Shrinks the icon of a person on the map.  This applies only to a 

site survey. 

Show Arrows in Path 

Enabling this option adds directional arrows to survey paths. This 

is helpful for indicating the beginning to end course of the path 

taken during the survey. Not applicable to Planner. 

Show Heatmap Disabling this option will remove heatmap from the view. 
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Delete location 

information for this AP 
Removes the location information of the selected AP. 

Set Zoom… 
Allows you to set the zoom level. Same as Zoom tools on 

Toolbar and View menu. 

Copy Same as View Menu. 

Copy Current View 

Allows you to copy and paste the content in the current Map 

Window to another application. It is especially useful for copying 

a zeroed-in area for detailed analysis. 

Print Current View 

Allows you to print the content in the current Map Window to 

another application. It is especially useful for printing a zeroed-in 

area for detailed analysis. 

Export to Google Earth Allows to export the data to Google Earth. 

Merging Survey Data 

Merging survey data means combining different survey data files into one file that includes 

all the data collected from the individual files. 

Note: If two data files contain placed APs having the same MAC address and any were 

moved, you are prompted that the location of APs was changed between surveys. 

To merge survey data files: 

1. Click File>Data Merge.... The Data File Merge window appears.   
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2. If the project contains data files generated by both an AirMagnet adapter and non-

preferred adapter, you can only merge files of the same type. In this case, under 

Data Files Generated By, select the desired adapter. Only data files created by 

that adapter type will be listed. 

3. Check the files you want to merge. 

4. In Save this merge to, type a name for the merged file. 

5. Click OK. The file-merge progress bar appears at the bottom of the Map Window, 

showing the progress of the merge operation. The newly merged file appears in the 

Project Window under Survey Data once the merge is completed. 

6. To display the merged file, click the radio button in front of it. 

Note: After a merged file is created, you can view the list of source files that were used 

to create the merged file, by right-clicking the file and selecting “View Merged Source” 

from the pop-up menu. 
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Creating Filtered Data Files 

You may create one or more data sub-set(s) of a Survey Data file (a filtered data file). The 

new filtered data file is added to list of survey data files. 

To create a filtered data file: 

1. Select the desired Survey Data File. 

2. From the Toolbar, click Filtering . The Data Filtering window appears.   
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3. You can use various controls to sort the AP listings: 

• Column headings sort by the column type. 

• All AP check box selects all listings. 

• 2.4 GHz check box selects only APs set to 2.4 GHz. 

• 5 GHz check box selects only APs set to 5 GHz. 

• SSID, AP Name, MAC drop-down: Select an option from the drop-down, type the 

desired name and check the box. Two wild cards are supported: Use * for incomplete 

name (e.g. 00*); Use ? to replace an unknown character (for example, Cisco-123?). 

Matches are case sensitive. 

4. Check the box to select the AP(s) of interest. 

5. In Save the filtered to: type a name for the filtered data file. 

6. Click OK. The newly created filtered file appears in the Project window under 

Survey Data. 
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Performing Data Analysis 

How to Evaluate Overall Site Signal Coverage 

To evaluate the overall RF signal coverage at the site: 

1. If your project includes more than one survey, you may choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. Click the SSID tab and select the SSID from the SSID List. 

4. From the Data Type drop-down menu, select Signal Strength. 

5. From the Toolbar drop-down, select View Overall. 

6. Use the colors on the Legend to determine the signal strength at different locations. 

7. Set the upper and/or lower limit of signal strength on the Legend. 

8. Move the cursor to different locations to view details of signal strengths from the 

pop-up view.   
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Note: Areas of different signal strengths are indicated by different shades of colors. Areas 

that fall out of the signal strength range are grey (as shown above). 

How to Identify Coverage Cells by Individual APs 

To identify the coverage cells by individual APs: 

1. If your project includes more than one survey, you may choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. Once the data are loaded, click the SSID tab and highlight an SSID from the SSID 

List. 

4. From the Data Type drop-down menu, select Signal Strength. 

5. From the drop-down on the Toolbar, select View per AP. Areas covered by different 

APs are shown in different colors.   
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How to Determine the Number and Placement of APs 

To determine the optimal number and placement of APs: 
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1. If your project includes more than one survey, you may choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. Once the file is loaded, click the SSID tab and select an SSID. 

4. Uncheck the APs that are of no interest to you. 

5. From the Data Type drop-down menu, select Signal Strength. 

6. From the drop-down on the Toolbar, select View per AP. This displays the APs in 

the color as they appear in the SSID List.   
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Note: The figure above shows two APs selected; the heatmap reveals that these four APs 

provide coverage for virtually the entire map. 

How to Determine Cell Overlap 

To determine a cell overlap: 

1. If your project includes more than one survey, you can choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. From the Channel/SSID Tree, click the SSID tab and highlight an SSID of interest. 

4. Make sure all APs under the SSID are checked. 

5. From the Data Type drop-down menu, select Signal. 

6. From Toolbar, click  (Overlap).   
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Note: The overlap areas of the AP coverage cells are shown in red. 

  

How to Identify Provisioned Bandwidth and Speed 

To identify the provisioned bandwidth and speed of an AP for an Active or Iperf 
survey: 

1. From the Project Window, select a data file. 

2. From the Channel/SSID List, select the SSID tab and highlight the SSID of interest. 

3. From the Data Type drop-down menu, select Measured PHY Data Rate Up/Measured 

PHY Data Rate Down (iperf Survey only). The Legend on the right changes to a color 

bar consisting of different color blocks, each representing a specific speed.  

4. Place the cursor at a spot on the site map to get detailed data from the tooltip. 

5. Click a location on the site map. The Measurement Details pane appears at the 

bottom of the screen, showing the details of the measurements. 
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Note: When using an 802.11ac adapter, the option changes to PHY Connection Rate. 

Choosing this option displays the single PHY data rate for the connection that is reported 

from the non-preferred adapter. 

  

 

How to Identify Predictive Downlink Bandwidth and Speed 

To identify the provisioned bandwidth and speed of an AP: 

1. From the Project Window, select a data file. 

2. From the Channel/SSID List, select the SSID tab and highlight the SSID of interest. 

3. From the Data Type drop-down menu, select Predictive PHY Data Rate Down and 

then Predictive PHY Data Rate Down (AP). The Legend changes to a color bar 

consisting of different color blocks, each representing a specific speed. The heatmap 

shows the predicted PHY Data Rate.  

 Note: If there are multiple APs covering a given location, the PHY rate for the AP with 

the strongest signal strength will be shown.  

The Measurement Details appear at the bottom of the screen, showing the details of 

the measurements. 

4. Place the cursor at a spot on the site map to get detailed data from the tooltip. 

5. Click a location on the site map. The Measurement Details pane appears at the 

bottom of the screen, showing the details of the measurements. 
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How to Identify Adjacent or Co-Channel Interference in Display Mode 

To identify adjacent channel or co-channel interference in Display Mode: 

1. If your project includes more than one survey, you may choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. From the Channel/SSID pane, click the Channel tab and select the channels 

adjacent to each other, such as Channels 1, 2, 3, or 4, 5, 6, and so on. 

4. From the Data Type drop-down menu, click Channel Interference. 

5. On the Legend bar, drag up from the bottom (weakest signal strength) to set the 

minimum interference level to be shown. This ensures that only areas that exceed a 

certain amount of interference are displayed.  
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How to View Current Channel Allocation 

To identify current channel allocation: 

1. If your project includes more than one survey, you may choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. From the Channel/SSID pane, select the Channel tab, make sure all channels are 

selected (checked), and highlight Channel at the top of the channel list. 

4. From the Data Type drop-down menu, select Signal Strength. 

5. From the Toolbar drop-down, select View Per Channel. Each of the channels that 

are selected are displayed in different a color. 
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Note: The channels in the Channel tab are color-coded; the colors in the Map Window 

indicate the channels in use. 

How to Identify Channel Noise 

To identify channel noise: 

1. If your project includes more than one survey, you can choose to merge the survey 

data files before performing data analysis. 

2. From the Project Window, select the desired data file. 

3. From the Channel/SSID pane, click the Channel tab. 

4. From the Data Type drop-down menu, select Noise Level. The Legend changes to 

a color bar consisting of different color blocks, each representing a specific noise 

level.  

5. Place the cursor at a spot on the site map to get detailed data from the tooltip. 

6. Click a location on the site map. The Measurement Details pane appears at the 

bottom of the screen, showing the details of the measurements. 

 

How to Evaluate Site Security Status 

This section helps you identify any unexpected or unidentified APs or stations in the current 

wireless environment. The presence of such devices could signify potential network attacks 

at worst and improperly configured network devices at best. 

To evaluate site security status: 
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1. From the Project Window, select a passive survey data file. 

2. Wait until the data are loaded and displayed in the Map Window. 

3. From the Data Type drop-down menu, select Signal Strength. 

4. From the Channel/SSID pane, click the SSID tab, look for any SSID marked 

"Unknown," and select it.   

  

How to Compare Surveys and/or Site Plans 

Note: The dimensions of projects (width and height) must identical to use this feature. 

Oftentimes you may wish to display multiple projects or data files (surveys and/or site 

plans) side-by-side in order to view the differences between them. This can be particularly 

useful in displaying changes made to a network environment over time. For example, a 

newly-conducted site survey or site plan can be compared with one taken months earlier to 

identify any new sources of interference or devices that have been added in the meantime. 

If the data files you intend to compare are in different projects, you must use the   

(Import Survey Data) button to import the data file from the project. 

Typically, you can compare the same data types; however, the Diff view enables the 

comparison of some different data types. If the data type is not available, the data type will 

revert to blank. 

For example, as shown in the following screen shot, you may compare 802.11ac actual 

uplink throughput in an Iperf data file to PHY Data Uplink Rate. In this case, you must 

choose Iperf Throughput Down in the bottom left (source) and PHY Data Downlink Rate in 

the bottom right (destination). 
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To compare the results of two data files: 

1. Open the project that contains the two data files for comparison. As noted above, if 

the data files are in different projects, open one project and import the data file into 

it. 

2. From the Navigation bar, click   (Diffview) to open the project in multiple 

frames.   

3. From the Project Window, click the ‘+’ sign to expand the Survey Data under Survey 

One, select to open the first data file. 

4. From the Project Window, click the ‘+’ sign to expand the Survey Data under Survey 

Two, select to open the second data file. Now data contained in the two files are 

displayed on the view.   

The top pane of the view now displays a heatmap that shows the difference between the 

two surveys at any given location on the site (map). Areas marked in red indicate that 

Survey One (bottom left pane) is stronger and areas marked in green indicate that Survey 

Two (bottom right pane) is stronger. 

You may use the data type drop-down in each bottom pane to view data by various data 

type options. In some cases you may be able to compare different data types. If the 

application permits the comparison, the choices will be accepted, otherwise unselected 

panes will show as blank in the data type drop-down. 

The blue border around a pane indicates it is the pane in focus. 
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Viewing Specific Signal Comparison Data 

You can compare the signal strength of any location on the heatmap in the selected data 

files using the DiffView window.  

1. Open the project that contains the two data files for comparison. As noted above, if 

the data files are in different projects, open one project and import the data file into 

it. 

2. From the Navigation bar, click  (Diffview) to open the project in multiple 

frames.  

3. In the bottom two panes (one for each project), select Signal Strength. While the 

bottom panes show data from two different survey projects, the top pane allows you 

to see the difference between the two. 

4. Place the cursor at a spot on the site map to get the measurement details of that 

location. 

 

How to View 802.11n/ac/ax Operating Mode 

In order to provide a better view of 802.11n/ac/ax information in the wireless network, 

Survey’s Display view provides an 802.11n/ac/ax AP Operating Mode heatmap selection. 

When you view this data type, the heatmap displays different colors for areas where APs are 

utilizing Legacy, Mixed, Mixed VHT, Mixed HE, or Greenfield operating modes. 

To view the 802.11n/ac/ax operating mode heatmap: 

1. From Survey’s Display view, load a data file with 802.11n, 802.11ac, and 802.11ax 

information. 

2. Use the Data Type drop-down to select AP Operating Mode.   
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3. Hover the mouse over any segment of the new heatmap to view the operating mode 

of the AP detected at that location. 

4. Click any spot on the heatmap to see the detailed measurements for that spot at the 

bottom of the screen. 

 

The heatmap indicates the signal strength of the strongest AP detected in the mode color. 

The table below describes the meaning of each color. 

Color Mode Description 

Blue Legacy 

Legacy mode represents areas where non-802.11n devices are operating. 

Blue portions of the map are regions where a “legacy” device 

(802.11a/b/g AP) is strongest. 

Purple Mixed 
Mixed mode contains both 802.11n and legacy devices. Purple portions of 

the heatmap indicate that an 802.11n AP is running in the mixed mode. 

Orange 
Mixed 

VHT 

Mixed VHT (Very High Throughput) mode is for 802.11ac APs only. The 

.11ac standard runs only in this mode. Orange portions of the heatmap 

represent regions where the strongest .11ac AP is running. 

Cyan Mixed HE 

Mixed HE (High Efficiency) mode is for 802.11ax APs only. The .11ax 

standard runs only in this mode. Cyan portions of the heatmap represent 

regions where the strongest .11ax AP is running. 

Green Greenfield 

Greenfield mode contains APs operating at High-Throughput (HT) transfer 

rates. These rates can be sustained by 802.11n devices. Green portions 

of the heatmap represent regions where the strongest AP is running at HT 

transfer rate. 

How to View 802.11n/ac/ax MCS Index Data 

During an Active, Active Iperf or Passive survey, AirMagnet Survey automatically records 

the Modulation Coding Scheme (MCS) detected from 802.11n/ac/ax APs. This number can 
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range from 0 to 31 for 802.11n APs, 0 to 9 for 802.11ac APs, or 0 to 11 for 802.11ax APs, 

with higher numbers corresponding to higher data transfer rates. 

You can view MCS information for both Tx (transmission rate) and Rx (receive rate) for 

detected APs. These data indicate the MCS for the AP with the strongest signal strength at a 

given point on the survey floor plan. 

To view MCS information: 

1. From the Display view, load a data file that contains 802.11n and/or 802.11ac APs. 

2. Select 802.11n, 802.11ac, or 802.11ax: Max MCS (AP Tx) or (AP Rx) data type. The 

heatmap refreshes.   

3. Hover over any point in the survey to see the tooltip of the exact MCS index for the 

strongest 802.11n, 802.11ac, or 802.11ax AP detected for that spot.  

4. Click any point in the heatmap to see the measurement details at the bottom of the 

screen.  
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How to View 802.11n/ac/ax Channel Width 

The Channel Width data type allows you to easily view the different channel width used by 

802.11n/ac/ax devices in the network environment. 

To view the channel width heatmap: 
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1. From the Display view, load a data file that contains 802.11n, 802.11ac, and/or 

802.11ax APs. 

2. Select the Channel Width data type. The view refreshes. 

3. Hover the mouse over any point in the heatmap to see the tooltip for the channel 

width at that spot.   

4. Click any point on the heatmap to see detailed measurements at the bottom of the 

screen. 

 

The heatmap displays the colors corresponding to the strongest AP's channel width color at 

the given point. 

The table below describes the color schemes for various channel widths. 

Color Width 

Blue 
20 MHz (channel width used by 802.11a/b/g or 802.11n APs operating at legacy 

speeds). 

Purple 20 MHz-HT (used by 802.11n/ac/ax APs operating at HT speeds). 

Green 

40 MHz (used by 802.11n/ac/ax APs).  

Note: 802.11n communications utilizing 40 MHz bands are also conducted at HT 

speeds. 

Orange 80 MHz (used by 802.11ac/ax APs operating at VHT/HE speeds). 

Light Blue 160 MHz (used by 802.11ac/ax APs operating at VHT/HE speeds). 

  

How to Identify 802.11ac Channel Overlap 
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While wider 802.11ac channels are capable of transmitting higher throughput rates, they 

are also more susceptible to RF issues such as channel interference, utilization, etc. If an 

802.11ac radio detects an issue, it can attempt to retransmit at a smaller available channel 

width in accordance to the 802.11ac specifications. 

Example: 

A 160 MHz channel can retry as a 80 MHz wide channel. 

A 80 MHz channel can retry as a 40 MHz wide channel.  

A 40 MHz channel can retry as a 20 MHz wide channel.  

An 802.11ac wide channel uses a specific 20 MHz channel as the primary channel. This 

primary channel will contain the Wi-Fi beacon information, for example. The remaining 20 

MHz channels used by an 802.11ac wide channel are referred to as secondary channels. 

If an 802.11ac radio retransmits at a smaller channel than originally allocated, this will 

affect overall throughput and performance. This reduction in throughput and performance of 

an 802.11ac wide channel is what the 802.11ac Channel Overlap heatmap conveys. 

To identify 802.11ac channel overlap: 

1. From the Display view, load a data file that contains 802.11ac information. 

2. From the data type drop-down menu, select 802.11ac Channel Overlap. 

3. Hover the mouse over any point in the heatmap to see the tooltip for the channel 

overlap information for that spot.   

4. Click any spot in the heatmap to see detailed measurements at the bottom of the 

screen. 
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Please note that for all of the following examples, AP #1 and AP #2 will have overlapping 

coverage. 

Red areas indicate overlapped primary channels. These are areas where overall 

performance will be significantly lower because two AP/Client connections cannot transmit 

simultaneously on the overlapping channel. 

Example: 

AP #1 is set to transmit an 802.11ac 80 MHz wide channel with the primary channel 

on channel 36 (36P + 40 + 44 + 48). 

AP #2 is set to transmit an 802.11ac 40 MHz wide channel with the primary channel 

on channel 36 (36P + 40). 

        or                          

Example: 

AP #1 is set to transmit an 802.11ac 80 MHz wide channel with the primary channel 

on channel 36 (36P + 40 + 44 + 48). 

AP #2 is set to transmit a 20 MHz channel on channel 36. 

Orange areas indicate overlapped secondary channels that cause fallback to a 20 MHz 

channel. These are areas where overall performance will be much lower because two 

AP/Client connections on overlapping 802.11ac wide channels must fallback to a slower 20 

MHz channel to transmit simultaneously. 

Example: 

AP #1 is set to transmit an 802.11ac 80 MHz wide channel with the primary channel 

on channel 36 (36P + 40 + 44 + 48). 

AP #2 is set to transmit an 802.11ac 40 MHz wide channel with the primary channel 

on channel 40 (36 + 40P). 

AP #1 reduces its transmitting channel to a single 20 MHz channel on channel 36. AP 

#1 is unable to use channels 40, 44, and 48. 

AP #2 reduces its transmitting channel to a single 20 MHz channel on channel 40. AP 

#2 is unable to use channel 36. 

Yellow areas indicate overlapped secondary channels that cause fallback to a 40 MHz 

channel. These are areas where overall performance will be slightly lower because two 

AP/Client connections on overlapping 802.11ac wide channels must fallback to a slower 40 

MHz channel to transmit simultaneously. 

Example: 

AP #1 is set to transmit an 802.11ac 80 MHz wide channel with the primary channel 

on channel 36 (36P + 40 + 44 + 48). 

AP #2 is set to transmit an 802.11ac 80 MHz wide channel with the primary channel 

on channel 48 (36 + 40 + 44 + 48P). 
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AP #1 reduces its transmitting channel to a 40 MHz wide channel on channels 36P and 

40. AP #1 is unable to use channels 44 and 48. 

AP #2 reduces its transmitting channel to a 40 MHz wide channel on channels 44 and 

48P. AP #2 is unable to use channels 36 and 40. 

Green areas indicate no significant channel overlap. These are areas where overall 

performance will not be impacted by channel overlap. An 802.11ac wide channel does not 

have a 20 MHz channel that is overlapped by any 20 MHz channels from other APs. 

Example: 

AP #1 is set to transmit an 802.11ac 40 MHz wide channel with the primary channel 

on channel 36 (36P + 40). 

AP #2 is set to transmit an 802.11ac 40 MHz wide channel with the primary channel 

on channel 48 (44 + 48P). 

Background 

 

In 802.11ac, a transmission initiator sends a Request to Send (RTS) message set with a 

channel bandwidth to use for a transmission; for example, 80 MHz. A transmission recipient 

sends a Clear to Send (CTS) message set indicating how much channel width is available 

and not currently utilized. This mechanism allows two APs with overlapping 80 MHz channels 

to transmit simultaneously by falling back to an available 40 MHz or 20 MHz channel, if the 

full 80 MHz channel is not available. An example of how this works is shown in the following 

diagram: 
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In each example, AP#1 and AP#2 have overlapping 80 MHz channels. The primary 20 MHz 

and 40 MHz channels are indicated by "P". Each example has a different level of potential 

performance impact due to the difference in primary channel assignments. 

Example 1 shows the situation highlighted in red in the Channel Overlap heatmap. Each AP 

has the same primary channel. Therefore, they cannot transmit simultaneously if any of the 

20 MHz sub-channels are in use. 

Example 2 shows the situation highlighted in orange in the Channel Overlap heatmap. Each 

AP has a different 20 MHz primary sub-channel, but the same 40 primary MHz sub-channel. 

Therefore, to transmit simultaneously, each AP can fallback to its 20 MHz primary sub-

channel to transmit, but not to a 40 MHz sub-channel. 

Example 3 shows the situation highlighted in yellow in the Channel Overlap heatmap. Each 

AP has a different 20 MHz primary sub-channel and a different 40 MHz primary sub-channel. 

Therefore, to transmit simultaneously, each AP can fallback to its 40 MHz primary sub-

channel to transmit.   

Tooltip Text Explanation 

  

The heatmap tooltip text for Overlapped Primary Channels is shown above. There are 

two APs with 80 MHz channels that overlap completely on channels 149, 153, 157, and 161. 

The primary channel of each AP is the same: 153. Therefore, these two APs cannot transmit 

simultaneously. 
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The heatmap tooltip text for Overlapped Secondary Channels with Fallback to 20 MHz is 

shown above. There are two APs with 80MHz channels that overlap completely on channels 

149, 153, 157, and 161. The primary channel of AP#1 is 149 and the primary channel of 

AP#2 is 153. A 40 MHz channel fallback for each AP would be on channels 149-153 which 

would overlap and prevent simultaneous transmission. Therefore, these two APs must 

fallback to their non-overlapping 20 MHz primary channels – 149 and 153 – to transmit 

simultaneously. 

  

The heatmap tooltip text for Overlapped Secondary Channels with fallback to 40 MHz is 

shown above. There are two APs with 80MHz channels that overlap completely on channels 

149, 153, 157, and 161. The primary channel of AP#1 is 149 and the primary channel of 

AP#2 is 157. AP#1 can fallback to a 40 MHz channel on 149-151, and AP#2 can fallback to 

a 40 MHz channel on 157-161, to transmit simultaneously. 

How to Use the Real-Time AP Locator 

Survey’s AP Locator feature uses collected survey data to calculate approximate locations 

for detected APs. Before starting to survey the desired location for a particular AP, you must 

perform the following steps to configure the feature and fine-tune the scanning 

process. These steps will ensure that the device is located with both precision and speed. 
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Note: These steps are directed towards users conducting a GPS survey; consequently, 

this information may vary slightly for users conducting AP Location surveys on non-GPS 

projects. 

To locate an AP: 

1. During project creation, import the map of the site to be surveyed; you must specify 

the type of environment in which the AP is located (that is, Restricted Closed Office 

for a standard office building) for the Survey Environment, as shown in the figure 

below. 

 

Note: If the site is a small portion of a larger GPS map, the image should be cropped just 

to cover the specific area to be surveyed. 

2. From the Settings tab of Survey’s Configuration dialog box, check Auto Position 

APs with signal greater than __ dBm and specify a minimum signal level to be 

used (if desired).  Click OK to save the changes. 

 

Note: If "Auto Position APs..." is enabled, the survey retract button will be grayed out 

(unavailable). 

3. Place the external antenna (outside) on the roof of the car. It is recommended that 

an omni-directional antenna be used for best results. 

4. Select the band (2.4 or 5 GHz) in which Survey should operate and the channel on 

which the device is located, if known. See the figure below. 
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Note: As shown in the figure above, the scan interval should be set to 250ms for best 

results. 

5. From the Survey view, select the Passive Survey option and use the drop-down list 

to select SSID or AP, as needed. See the figure below. 

 

6. If known, select the specific AP or SSID to be located from the drop-down list. Refer 

to the figure below. 

 

Note: If the user selects ANY from the SSID list, the Survey view will not be able to 

calculate AP placement until a specific AP is selected.  This can be done during the survey 

process by selecting the desired AP from the scrolling list in the passive survey window, 

as shown in the figure below.  After the selection has been made, the application will 

attempt to calculate the device’s location.  However, after the survey is completed, 

calculated positions of any additional APs detected will be shown on the Display view. 

 

7. Start the survey and drive slowly (between 5-10 mph) around the perimeter of the 

site. 

Note: After some data are collected, an icon ( ) representing the selected AP will 

appear on the site map in its calculated position.  This icon will move about during the 

course of the survey as its location is recalculated from new data.  The AP icon is color-

coded based on Survey’s confidence in the current location; the colors will progress from 

red (lowest confidence) through yellow, green, and finally, black (greatest 

confidence).  This confidence level is also displayed in the Passive Survey frame in place 

of the Signal/Noise ratio. 

8. When the survey is completed, stop the survey and save the data. 

9. View the data on the Display view to analyze the results of the survey. 
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Note: As shown in the figure above, the Display view automatically places all APs 

detected during the survey even though only one AP is shown on the Survey view. 
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VoFi Data 

Analyzing VoFi Survey Data 

Since it is far easier to troubleshoot and repair issues with a VoFi wireless deployment prior 

to supporting active users with it, users are strongly urged to conduct and analyze a VoFi 

survey before attempting to activate it in a real-world scenario. This process can be 

drastically different from deploying a standard data network simply because what would 

amount to a small issue for a wireless data installation (slight drop in signal strength, small 

wireless dead zone, and so on) can be a much greater problem when the deployment is 

intended to support voice traffic. A disconnect that lasts for two seconds would go largely 

unnoticed in a standard wireless deployment, but the same disconnect during a VoFi call can 

result in dropped calls and overall diminished call quality. 

The process of analyzing data collected from a VoFi survey is generally similar to that of a 

standard survey, but VoFi surveys contain additional data (such as roaming information) 

that can help users identify problem zones in their VoFi deployment coverage. 

• VoFi Data Types 

• Roaming Analysis 

• Troubleshooting Poor Call Quality 

VoFi Data Types 

The Data Type List Menu for VoFi-specific surveys contains selections that are unique to 

voice deployments, as shown below. 

 

Each selection provides information designed to help users troubleshoot and maintain VoFi 

deployments. 

• VoFi Signal Strength: shows the signal strength detected at each point along the 

survey path. Note that this selection provides data on transmissions from the AP to 

the phone. 

• Roaming Zone: displays the regions in which phones are most likely to roam. When 

this map is loaded, potential roaming zones are displayed in red. 

• Capacity: Number of Station(s) shows the number of stations detected on the AP 

during the survey. Note that “stations” can refer to other VoFi phones in addition to 

other wireless clients (such as notebooks or wireless-enabled desktops). Number of 

Active Call(s) shows the number of active calls detected during the survey. This 

value includes the call monitored during the VoFi survey process. 
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• Channel Utilization—displays the overall utilization on the current channel. Note 

that this value accounts for standard wireless traffic in addition to VoFi traffic on the 

channel. 

The AP -> Phone and Phone -> AP options each provide three additional display types. 

These selections provide data detected from transmissions between the AP and the VoFi 

phone. 

• WiMOS Score—much like the MOS score widely used to monitor the quality of wired 

communications, the WiMOS score provides a value to display the call quality at each 

point during the survey process. This value can range from 1 (poor) to 4.5 

(excellent). 

• PHY Data Rate—displays the data transfer rate detected during the survey. This 

value is measured in Mbps. 

• Packet Retry Rate—shows the percentage of packet retries over the course of the 

survey path. Excessive packet retries can indicate wireless hazards (such as 

interferers) in the surveyed environment. Note that this percentage is calculated as a 

percentage of retry packets transmitted over the past second. 

Roaming Analysis 

The fact that VoFi phones will inevitably roam in even the best of VoFi deployments renders 

this aspect of the survey analysis critical to ensuring that users can enjoy uninterrupted 

service during these roaming periods. AirMagnet Survey PRO allows the user to review 

roaming information captured during the VoFi survey process, including each instance in 

which the phone roamed, its location, and the time it took to re-associate to the new AP. 

These data can subsequently be used to determine potential hazards or holes in the VoFi 

wireless deployment. 

Note: Roaming events are displayed in real-time during the VoFi survey process. Refer to 

Conducting VoFi Surveys for more details. 

Survey’s VoFi Roaming Events tab provides a summary of all captured instances of roaming 

as well as the pertinent data associated with each event. 
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Each instance in which the VoFi phone roamed during the survey process is included in this 

tab and has a checkbox allowing the user to view the roam location on the map. By default, 

all roaming events are automatically checked when a VoFi data file is loaded. The roaming 

instances are displayed on the site map with icons that demonstrate where the roaming 

started and stopped, as shown below. 

 

The (Roaming Start) icon allows the user to identify the location at which the phone 

enters and exits the roaming state. You can hover the mouse over these instances to view 

additional data regarding the roam. 
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The bubble help pop-up allows the user to attempt to determine the reason that the phone 

roamed at this point on the map. The information is displayed for each AP involved in the 

roam (for example, the original AP and the one to which the phone roamed), as summarized 

in the table below. 

Column Description 

AP 

Displays the name for both APs in the roaming transaction. The original AP is 

listed first, followed by the new AP (for example, the one to which the phone 

roamed). 

Signal 

The signal strength detected from each AP at the roaming point. In most cases, 

the phone will attempt to roam from an AP with lower signal strength to one with 

a stronger signal. 

Channel The channel on which each AP is operating. 

WiMOS 
The WiMOS value for the call before and after the roam. A higher score indicates 

improved call quality. 

Utilization 
The percentage of available bandwidth on the channel being utilized at the time 

of the roam. 

Station(s) 
The total number of stations associated to each AP. Note that this value includes 

other phones, which are recognized as stations. 

Call(s) The number of active VoFi calls being supported by each AP. 

Results 
Displays whether the roaming attempt was successful or failed. Failed attempts 

result in the call being lost. 

Roaming 

Time 
The amount of time that passed while the phone was attempting to roam. 

  

Troubleshooting Poor Call Quality 

VoFi call quality can suffer due to various different factors in the wireless environment. This 

section is designed to help you identify the root cause of a problem detected during the VoFi 
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survey process. The MultiView   feature allows you to view up to four different 

data types for a VoFi survey data file at any given time. This can be extremely useful when 

attempting to identify and troubleshoot a region in which the WiMOS value unexpectedly 

drops on the map. The steps below illustrate the recommended method for diagnosing the 

root cause behind a low WiMOS. 

Refer to the MultiView View topic, starting with Map Window for instructions on using 

MultiView. 

To troubleshoot a region with low WiMOS: 

1. After identifying the problem area on the map, import the same project containing 

the VoFi data file into the MultiView window four times (Refer to MultiView File 

Menu).  

2. Select the same VoFi data file for each view pane. 

3. Make sure the Automatic Multi-Select option is off (Refer to MultiView Toolbar). 

4. Use the Data Type drop-down list to load the following heatmaps into the four panes: 

o Signal Strength (from AP -> Phone) 

o PHY Data Rate (from AP -> Phone) 

o Packet Retry Rate (from AP -> Phone) 

o Channel Utilization 

3. Assess the signal coverage at the region with a low WiMOS using the Signal Strength 

map. If the signal strength is low (for example, -67dBm or lower), the signal 

coverage provided by the deployment is insufficient to support a VoFi 

implementation.  Refer to Insufficient Signal. 

4. If the signal level is sufficient, look at the PHY Data Rate at that area. If it is lower 

than 24MBps, the conversation is not being transmitted at a high enough data rate 

for high quality conversation levels. Refer to Insufficient Signal. 

5. In the case where the speed is adequate for the conversation, the problem may lie in 

the Packet Retry Rate map. Excessive retries can mean that transmissions from the 

AP to the phone are not always going through, which can result in call information 

(i.e., the conversation) being lost. Refer to High Retry Rate. 

6. Finally, if the other three maps have been verified to be problem-free, the overall 

utilization of the channel may simply be too high. Any 802.11 deployment is 

inherently limited in the number of transactions that can be supported 

simultaneously, and as utilization climbs, traffic may be transmitted at slower speeds 

in order to give the infrastructure more time to process exchanges. Consequently, if 

you find that too much of the network is being utilized at a given time, the 

infrastructure may need to be upgraded with additional APs to support the volume of 

traffic detected. Refer to Low PHY Data Rate. 

Insufficient Signal 

Ensuring adequate signal coverage is a significant challenge for standard data network 

implementations; however, Voice-enabled deployments present unique challenges, not the 

least of which is the fact that a VoFi implementation requires a much higher signal level in 

order to ensure adequate call quality.  If you are finding that your signal coverage is 
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insufficient for either type of implementation, this can generally be caused by several 

different factors: 

• Insufficient infrastructure: Perhaps the easiest factor to diagnose (albeit not the 

easiest to remedy), if a deployment doesn't contain enough APs to ensure adequate 

signal coverage throughout the entire region, transmissions will suffer.  This is 

particularly noticeable for VoFi deployments, as voice traffic requires a strong signal 

in order to ensure that voice-quality transmission speeds are maintained. 

Although it may seem that adding more APs to the deployment should be the 

obvious answer to this problem, this is not always the case.  In some situations, this 

may be the best solution; however, due to the nature of the wireless spectrum, APs 

that are placed too closely to each other (both in physical proximity as well as in 

adjacent channels on the same band) can create interference for each other, causing 

additional problems.  In some cases, users may find it more helpful to rearrange the 

placement of the existing APs by sacrificing coverage in areas that do not require 

VoFi signal strengths (e.g., break rooms, lobbies, and so on) in order to maintain 

adequate signal in the most heavily-utilized areas. 

• Interferers: Network interference can come from two major sources: 802.11 and 

non-802.11 devices.  802.11 devices include all existing wireless devices currently 

active on the network, including APs, stations, VoFi phones, and so on.  Non-802.11 

sources can include a wide variety of common items, including cordless phones, 

Bluetooth devices, microwave ovens, or even fluorescent lighting. 

In cases where 802.11 devices are creating interference, this is most often due to 

APs on the same network operating on the same (or adjacent) channels.  Standard 

wireless practice recommends that APs placed in close proximity be configured to 

utilize channels that are at least five apart (common practice for the 2.4GHz band is 

to use channels 1-6-11, although standards may vary depending on 

country/region).  Non-802.11 interference can be reduced by ensuring that any APs 

be placed far from potential interferers, particularly microwaves or wireless 

cameras.  For advanced analysis, users can identify all sources of interference in the 

environment by using AirMagnet Spectrum XT, which can be purchased separately 

and integrated with the Survey software. 

• Obstacles: Large or dense physical objects in the middle of a wireless deployment 

can reduce signal coverage in their immediate vicinity, creating "holes" in the 

network's coverage.  These are most commonly pillars or thick walls, but can also be 

bodies of water, rooms full of equipment, etc. 

Since moving obstacles in the wireless environment is often unfeasible, the best 

solution for this issue is often similar to that for insufficient infrastructure; namely, to 

either add or rearrange APs within the deployment. 

Low PHY Data Rate 

The rates at which packets are transmitted through the wireless network can drastically 

affect the quality of service for users, most particularly during VoFi conversations.  This can 

be caused by a number of different factors, two of which are detailed below: 

• Mixed-mode devices: Wireless deployments that are designed to operate at high 

speeds (such as those provided by 802.11g or 802.11n devices) can have those 

speeds dramatically reduced when slower devices (such as those that operate on 

802.11b-only) are introduced into the environment.  Such "legacy" devices can cause 

traffic from all sources to be transmitted at lower rates due to the simple fact that 

they cannot operate at the higher rates. 

http://www.netally.com/products/airmagnet-spectrum-xt
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In these cases, eliminating the legacy devices is the easiest solution.  This can often 

be done simply by upgrading or replacing the older components, ensuring that the 

replacements can meet the higher speeds required for the deployment. 

• Interferers: Network interference can come from two major sources: 802.11 and 

non-802.11 devices.  802.11 devices include all existing wireless devices currently 

active on the network, including APs, stations, VoFi phones, etc.  Non-802.11 

sources can include a wide variety of common items, including cordless phones, 

Bluetooth devices, microwave ovens, or even fluorescent lighting. 

In cases where 802.11 devices are creating interference, this is most often due to 

APs on the same network operating on the same (or adjacent) channels.  Standard 

wireless practice recommends that APs placed in close proximity be configured to 

utilize channels that are at least five apart (common practice for the 2.4GHz band is 

to use channels 1-6-11, although standards may vary depending on 

country/region).  Non-802.11 interference can be reduced by ensuring that any APs 

be placed far from potential interferers, particularly microwaves or wireless 

cameras.  For advanced analysis, users can identify all sources of interference in the 

environment by using AirMagnet Spectrum XT, which can be purchased separately 

and integrated with the Survey software. 

• Insufficient signal coverage 

High Retry Rate 

Installations that experience high levels of packet retry attempts indicate that packets are 

being lost during transmission.  This can create problems for standard data networks (due 

to slower transmission rates), but can drastically impair the quality of voice transactions 

conducted on the same deployment.  Dropped packets can cause jitter or gaps in a 

conversation, quickly rendering a VoFi connection unintelligible.  High percentages of retries 

can be caused by: 

• Interferers: Network interference can come from two major sources: 802.11 and 

non-802.11 devices.  802.11 devices include all existing wireless devices currently 

active on the network, including APs, stations, VoFi phones, and so on.  Non-802.11 

sources can include a wide variety of common items, including cordless phones, 

Bluetooth devices, microwave ovens, or even fluorescent lighting. 

In cases where 802.11 devices are creating interference, this is most often due to 

APs on the same network operating on the same (or adjacent) channels.  Standard 

wireless practice recommends that APs placed in close proximity be configured to 

utilize channels that are at least five apart (common practice for the 2.4GHz band is 

to use channels 1-6-11, although standards may vary depending on 

country/region).  Non-802.11 interference can be reduced by ensuring that any APs 

be placed far from potential interferers, particularly microwaves or wireless 

cameras.  For advanced analysis, users can identify all sources of interference in the 

environment by using AirMagnet Spectrum XT, which can be purchased separately 

and integrated with the Survey software. 

• Excessive Devices: Deployments that are attempting to support more devices than 

they have the infrastructure for can result in transmission collisions, or ultimately, 

traffic being ignored in favor of devices with a better signal. 

Deployments that are utilizing large numbers of devices basically have two options: 

expand the infrastructure (that is, add APs) or reduce the total number of stations 

requiring service. 

http://www.netally.com/products/airmagnet-spectrum-xt
http://www.netally.com/products/airmagnet-spectrum-xt
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Simulation View 

About Simulation view 

The Simulation view allows network professionals to perform channel, SSID, and power 

simulation to see how the network would function in different scenarios. As such, you can 

explore various WLAN deployment plans without having to have the hardware devices 

actually installed. You can open the Simulation view by clicking  (Simulation) 

on the Navigation Bar. 

  

The Simulation view can be divided into the following sections: 

• Channel/SSID List (Before_Simulation) 

• Channel/SSID List (After-Simulation) 

• Map Window 
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• File Menu 

• View Menu 

• Toolbar 

• Legend (same as the one on Display view) 

File Menu 

The Simulation view includes an additional option on the File menu: Save Simulation opens 

the Save Simulation dialog box where you can save the simulated data as a file. 

View Menu 

The View menu on the Simulation view includes additional options: 

Menu Option Description 

Vertical View 

Compare 
Allows you to compare pre- and post-simulation data side by side. 

Horizontal View 

Compare 
Allows you to compare pre- and post-simulation data horizontally. 

Simulation Toolbar 

The following table describes additional tool available in the Simulation view. 

Icon Name Description 

 

Save Sim 
Same as File>Save Simulation. Enables you to save the simulation 

project. 

 

Vertical 

Compare 

Same as View>Vertical View Compare. Changes the Map view to vertical 

orientation. 

 

Horizontal 

Compare 

Same as View>Horizontal View Compare. Changes the Map view to 

horizontal orientation. 

 

Simulation 
Opens the Simulation window, which allows you to perform data 

simulations. 

 

Add 

Simulation 

AP 

Opens the New AP Properties window where you can specify the 

properties of the AP to be used in data simulation. 

 

Help Opens AirMagnet Survey’s Help window. 

 

Throughput 

Simulator 

Opens the Throughput Simulator tool, which allows users to view 

predicted throughput speeds and bandwidth consumption for a custom-

designed network. Refer to “Simulating Network Throughput” for more 

details. 

Setting Up Data Simulation 

Before conducting data simulation, you will need to place and "power" APs on the site map 

in the Display view at locations where the actual APs are located: 
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1. Create a survey project and conduct the survey. Refer to Creating an Indoor Survey 

Project. 

2. Navigate to Display view and Refresh the view. 

3. Expand the Channel or SSID list and drag an AP to its physical location on the site 

map. Continue to do this for all the APs in the list. This step primarily relates to APs 

under your management, although you may place any or all APs in the list. 

4. Right-click an AP you placed on the site map and select AP Properties. 

5. Check Apply Power Setting and set the Original Power mWatts. Use the setting 

that matches the setting for the AP. Click OK. 

6. Navigate to Simulation view. Now you may place simulation APs on the site map. 

On the toolbar, click Add Simulation AP. This opens the New AP Properties 

dialog. Modify any default settings (MAC Address, SSID and Original Power settings 

are required). When finished, click OK. 
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The AP is placed on the site map. You may drag the AP to the desired location. Click 

Refresh to view changes to the heatmap. 

Before-Simulation Channel/SSID List 

"Before Simulation" Channel/SSID List which appears on the upper-left part of the 

Simulation view. It lists the APs contained in the un-simulated data. You can view the APs 

either by channel or by SSID using the corresponding tab at the bottom of the list. 

After-Simulation Channel/SSID List 
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"After Simulation" Channel/SSID List appears in the lower-left part of the Simulation view. 

It lists the APs contained in the simulated data. You can view the APs either by channel or 

by SSID using the corresponding tab at the bottom of the list. 

Conducting Data Simulation 

The Simulation view allows you to test a number of what-if hypotheses using data collected 

from actual site surveys. Therefore, you must perform site surveys to collect the real data 

you need. Also, you need to open the data file on the Display view first before you switch to 

the Simulation view. Otherwise, the Simulation view will not be available. You can 

conducting two types of simulations: 

• Simulating Data Configuration 

• Simulating Channel Allocation 

Simulating Data Configuration 

To conduct data simulation: 

1. From the Display view, open a survey data file. 

2. From the Navigation Bar, click . The Simulation dialog box appears. 

 

3. Highlight the AP of your choice, and do any or all of the following: 

o Click the CH field and select a channel from the drop-down list. 

o Click the SSID field and select an SSID. 

o Drag the scale to set a Noise Simulation level. 

4. Click Refresh. The Loading Date File view appears. The graph refreshes once the 

simulation process is completed. 

5. Click Close. 
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Note: Make sure that the APs are placed in their exact locations and that the correct 

values of the original output power are used. APs placed on Survey‘s Display view are 

'display-only‘ by default. Consequently, you will be unable to modify the AP power 

settings for APs placed on the Simulation screen unless the APs are first changed to 

Power APs. Placing APs and enabling power can be done on the Display view. Refer to 

Channel/SSID List. 

Simulating Channel Allocation 

Simulating channel allocation enables you to find out the optimal channel assignment or 

distribution for the APs currently detected in the survey. It helps you make well-informed 

decisions on the number of APs needed on the network or at a certain part of the network: 

if multiple APs are covering the same area on the same channel, the chances are that not all 

of the APs may be necessary. 

Note: You can choose to simulate channel allocation on either the 2.4 or 5.0 GHz band by 

using their respective tabs across the top of the dialog box. 

To simulate channel allocation: 

1. From the Toolbar, click Simulation (not to be confused with Throughput 

Simulation). This opens the Simulation dialog. 

2. Click the Channel Allocation tab. The view refreshes. 

 

Note: All APs that are detected are identified by AP name, SSID, and (original) 

channel. 

3. Select the AP of your choice and click the down arrow to specify its new channel, if 

desired. 

4. Check the Lock CH box to lock the channel for the corresponding APs, if you want to 

ensure that the simulation process doesn’t alter that AP’s setting. 
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Note: 802.11ac/ax APs are automatically locked ("Lock CH" column is checked) in 

Channel Allocation. 

5. Check the Disable Redundant APs, if desired. 

Note: This allows the application to disable the APs it considers redundant. The 

slider allows you to configure the signal strength required for APs to be considered 

redundant. If all points meet the specified signal requirement, any APs below that 

level will be eliminated. Once the simulation is completed, Survey will 

automatically disable those APs that it considers redundant. 

6. Use the slider to set a minimum signal coverage value. 

7. Click Allocate. 
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Note: You can also add APs or relocate APs to certain areas on the site map and 

then use the Simulation tool to see how the changes will affect the signal coverage 

in the target areas. 

  

Simulating Network Throughput 

Survey’s Throughput Simulator allows you to set up theoretical network implementations 

and view the expected levels of traffic that the specified devices will experience. You can 

create entire simulated networks from scratch in order to test a planned implementation or 

use devices already detected in the current survey file in order to see how new additions to 

the environment will affect the overall performance of the existing infrastructure. 

The Throughput Simulator is a utility for calculating network, node and media throughput, 

utilization and overhead (as measured at the 802.11 Link Layer) under various network and 

node configurations. It allows you to add and configure up to fifty 802.11a, 802.11b, 

802.11g and/or 802.11n nodes on a “virtual channel”. The Simulator’s engine applies 

additional network and node parameters based upon the type and settings of the nodes 

present. The Simulator runs in a “perfect” environment, assuming that all nodes can “hear” 

each other (negating the possibility of packet collisions and frame retries) and that all nodes 

transmit as much (and as fast) as they possibly can (based upon their individual and overall 

network parameters). The result of such simulation provides a baseline measurement of the 

(somewhat theoretical) maximum link-layer throughput that can be achieved for a particular 

configuration. 

To use the WLAN Throughput Simulator: 

1. From the Simulation view, click   (Throughput Simulator). The Throughput 

Simulator window appears.   
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2. From the menu bar, click Add Device and select an option as described in the table 

below. 

Option Description 

Add 802.11x 

Device… 

Drop-down that enables you to select one or more devices to be added 

from the information contained in the current survey data file. 

802.11a Device… 

Opens the Device Configuration dialog box, which allows you to select 

a type of device to be added, as well as its physical data rate.  

Note: An AP must be added before the Throughput Simulator will 

allow a station to be created. 

802.11b Device… 

Opens the Device Configuration dialog box, which allows you to select 

a type of device to be added, as well as its physical data rate.  

Note: An AP must be added before the Throughput Simulator will 

allow a station to be created. 

802.11g Device… 

Opens the Device Configuration dialog box, which allows you to select 

a type of device to be added, as well as its physical data rate.  

Note: An AP must be added before the Throughput Simulator will 

allow a station to be created. 

802.11n Device… 

Opens the Device Configuration dialog box, which allows you to select 

a type of device to be added, as well as its MCS index. A series of 

checkboxes also allow you to specify the devices various configuration 

parameters, including Greenfield, channel width, etc.  

Note: An AP must be added before the Throughput Simulator will 

allow a station to be created. 

Note: To remove a device from the Throughput Simulator, right-click the desired device 

and select Delete Node. 

3. After the necessary devices have been added, click each station’s Associated AP 

column to select an AP to which it should associate. 

 

Note: You must associate at least one station to each AP in order to simulate network 

throughput. Note that APs with associated stations cannot be removed. 
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4. After all the necessary associations have been made, click Run to start the 

simulation.  For descriptions of the throughput simulation data fields, refer to 

Analyzing Simulated Throughput Data. 

Analyzing Simulated Throughput Data 

During network simulation, the Throughput Simulator window will update dynamically as 

new information is calculated. These data are displayed in three major portions of the view, 

as highlighted in the image below.   

 

Throughput Simulator Summary 

The Throughput Summary portion of the Throughput Simulator displays the simulated 

network throughput separated based on media type, allowing the user to see how much 

throughput is dedicated to each type of device. These data are described in the table below: 

Field Description 

Network 

The combined aggregate throughput of all wireless media (which may 

include 802.11a/b/g/n, depending on the frequency band selected, that is, 

2.4 GHz vs. 5 GHz). 

Average 
The average node throughput (that is, the network throughput divided by 

the number of nodes). 

Avg 802.11a 
The average node throughput for all 802.11a devices. Note that this 

column only appears when the 5 GHz band is selected. 

Avg 802.11b 
The average node throughput for all 802.11b devices. Note that this 

column only appears when the 2.4 GHz band is selected. 

Avg 802.11g 
The average node throughput for all 802.11g devices. Note that this 

column only appears when the 2.4 GHz band is selected. 

Avg 802.11n The average node throughput for all 802.11n devices. 
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Throughput Simulator Device Table 

The Device Table portion of the Throughput Summary displays the status of each device as 

the simulation proceeds. The data in this portion of the window are described in the 

following table: 

Column Description 

Device 

The name of the device. For actual detected devices, this name is 

provided by the survey data. For devices added manually, these names 

are numbered generic entries (for example, AP_1, STA_2). 

Associated AP 
The AP to which a station has been associated. APs will not have any 

information displayed in this field. 

Rate 
The rate at which the device is set to transmit. This number is specified 

by the user when devices are added. 

Tx Packets The number of simulated packets transmitted by the device. 

Tx Data Bytes The number of simulated data bytes transmitted by the device. 

Throughput The device’s throughput (in Mbps). 

Status 

The current operating state of the nodes which can be any of the 

following:  

• TX Data 

• Tx ACK 

• Random Backoff 

• Virtual Carrier Sense 

• Rx ACK 

• CCA 

Note: The Status column of the Device Table is color-coded as 

described by the color legend listed across the bottom of the 

Throughput Simulator window. 
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AirWISE View 

About AirWISE view 

The AirWISE view enables wireless LAN planners and administrators to make well-informed 

decisions regarding the requirements for their WLAN deployment and maintenance based on 

the actual data collected from site surveys. You can open the AirWISE view by clicking 

  on the Navigation Bar. 

 

AirWISE Summary 

The AirWISE Summary pane on the AirWISE view lists the default AirWISE requirement 

policy included with AirMagnet Survey. As described in this section, new policies may be 

created and the default requirements can be customized to conform to your particular 

needs. 



AirWISE View 

238 

 

The AirWISE Summary pane displays the following AirWISE information: 

• AirWISE Requirements: Lists each AirWISE Requirement policy. The list contains 

the default AirWISE requirements included with AirMagnet. 

• % of Good Area: Shows the status of the survey data in terms of compliance with 

requirement's configurable threshold value. For example, if the requirement 

threshold value is set to -67 and all the data is -67 or greater for this requirement, 

the percentage of good area will be 100%. N/A indicates that this particular 

requirement is not applicable to the type of survey data selected in the Display view. 

• Pass/Fail: A configurable value that indicates whether the "% of good area" is 

within an acceptable threshold. For example, if the Pass/Fail value is set to 100% 

and the "% of good area" is 80%, the Pass/Fail column will read "Fail." However, if 

the Pass/Fail value is set to 80% and the "% of good area" is 80%, the Pass/Fail 

column will read "Pass." 

In addition, by selecting an AirWISE Requirements listing, you can view the associated 

heatmap and policy explanation. 

Channel/SSID List 

The figure below shows the Channel/SSID List on the AirWISE view, which allows you to 

group the APs contained in the survey data either by channel or by SSID using the 

corresponding tab. 
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Also, if your survey includes simulated data (refer to About Simulation view), you may 

choose whether to use original data or simulated data by selecting "Use Simulated Data" 

from the View menu (checked is enabled). 

File Menu 

The File menu on the AirWISE view includes some additional options: 

Menu Option Description 

New AirWISE Policy… 
Opens the New Requirement Policy dialog box. Refer to Creating 

Custom Requirement Policies for more information. 

Save AirWISE Policy 

Saves any changes made to the current AirWISE policy.  

Note: If the current policy is one of the preconfigured policies 

packaged with Survey, an error message will be displayed 

prompting you to save under a different name. 

Save AirWISE Policy 

As… 

Brings up the Save As dialog box which allows you to save a current 

AirWISE Policy using a different file name. 

Import AirWISE 

Policy... 

Brings up the Open dialog box, which allows you to open a 

previously created AirWISE policy file into the current project. 

Export AirWISE 

Policy... 

Brings up the Save As dialog box which allows you to save a current 

AirWISE Policy using a different file name to a separate location (for 

example, to a USB external drive). Two files will be created: The 

.SAR file and .PCT file. Both of these files will need to be imported 

into another installation of AirMagnet Survey PRO. 

Remove AirWISE 

Policy... 

Opens the Remove Policy dialog box. Refer to Removing AirWISE 

Policies for more information. 

Load AirWISE Areas... 

Brings up the Open dialog box, which allows you to open an 

AirWISE Area (.saa) File. The file contains data regarding areas 

drawn on the AirWISE view to define requirement regions. 

Save AirWISE Areas Saves the current AirWISE areas. 

Save AirWISE Areas 

As... 
Saves the current AirWISE areas under a new file name. 
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View Menu 

The View menu of the AirWISE view includes the option to  "Use Simulated Data".  If your 

survey includes simulated data (refer to About Simulation view), you may choose whether 

to use original data or simulated data (checked indicates Use Simulated Data). 

Toolbar 

The following table provides description for additional Toolbar tools available in the AirWISE 

view. 

Icon Tool Name Description 

 

Reset 

AirWISE 

Requirements 

Same as the File>Reset AirWISE Requirements. 

Refer to the AirWISE File Menu topic.  

 

Load AirWISE 

Requirements 

Same as File>Load AirWISE Requirements. Refer 

to the AirWISE File Menu topic. 

 

Save AirWISE 

Requirements 

Same as File>Save AirWISE Requirements. Refer 

to the AirWISE File Menu topic. 

 

Rect Region 

Tool 

Allows you to mark and select a rectangular area 

on the site map in the AirWISE window. 

 

Arbitrary 

Region Tool 

Allows you to mark and select an area of any 

shape. 

 

Clear Last 

Region 

Allows you to remove the area selection mark 

you last made on the site map. 

 

Clear All 

Regions 

Allows you to remove all area selection marks 

you have made on the site map in the AirWISE 

window. 

Legend 

The figure below shows the Legend on the AirWISE view. It shows the level of compliance to 

AirWISE Requirements according to the threshold (signal value) you specify. Areas that 

meet the requirements are shown in green; areas that fail to meet the requirements are 

shown progressively in shades of yellow and red, reflecting the different levels of non-

compliance. The heavier the color, the worse the non-compliance. 

You can use the Refresh button on the toolbar to update the view after you have adjusted 

the threshold value. 
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AirWISE Content Window 

When you select an AirWISE Requirements listing in the AirWISE Summary pane, the 

AirWISE Content window displays a heatmap of the associated requirement. 
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As shown in the figure above, there are three tabs in the bottom-left corner of the Content 

Window view: 

• Requirement: This tab opens the AirWISE Requirements window, which 

summarizes all the AirWISE requirements and the compliance status of the WLAN 

site according to the data contained in the survey project file. 

• AirWISE: This tab opens the AirWISE Content window that shows the site map 

contained in the survey data collected. It allows you to customize certain parameters 

to see how the changes would affect compliance with AirWISE Requirements. 

• Description: This tab opens the Description window on the AirWISE view, which 

provides a detailed explanation about the selected AirWISE requirement and offers 

advice on how to comply with it. 
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Working in Requirement Window 

This section explains how to change a requirement threshold value in order to affect 

compliance to the related AirWISE Requirement. 

Note: In order to analyze survey data on the AirWISE view, you must first load the 

selected survey data on the Display view and then switch to the AirWISE view. The 

following explanation assumes that you have already loaded the data on the Display view. 

1. When AirWISE is opened, the default view shows a list of requirements and 

associated configurable threshold values in the right-side table. However, if a 

particular AirWISE policy is selected from the list of AirWISE requirements in the left-

side table, you can click the "Requirement" tab to display the table. 

 

2. Within the "Threshold" column, select a value to change and overwrite it with the 

new value.   

 

3. Then click   (Refresh). The change and its impact on the network’s compliance 

with the selected AirWISE Requirement are reflected instantly in the AirWISE 

Summary section of the view.   



AirWISE View 

244 

 

4. With the requirement selected, click the "AirWISE" tab in the lower-left corner of the 

Content Window to view how the change is reflected in the heatmap. 
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Configuring Pass/Fail Threshold Values 

Each requirement includes a Pass/Fail option. This is a configurable percentage value that 

indicates whether the "% of good area" is within an acceptable threshold. For example, if 

the Pass/Fail value is set to 100% and the "% of good area" is 80%, the Pass/Fail column 

will read "Fail." However, if the Pass/Fail value is set to 80% and the "% of good area" is 

80%, the Pass/Fail column will read "Pass." 

1. Click the Edit Pass/Fail Threshold icon . 

2. To select the type(s) of alarm you want, click the desired check box(es) to the left of 

the Alarm Type column. 

3. Edit the value in the Minimum % of coverage to pass column. 

4. Click Save. 
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Testing AirWISE Requirements Compliance on Site Map 

A change of threshold in signal coverage can significantly affect the size of the area with 

good signal coverage as can be seen graphically in the Content Window when you select the 

AirWISE tab. The AirWISE view offers a variety of troubleshooting features. This section 

shows how to visually test several what-if hypotheses you may have in relation to any of 

the AirWISE Requirements on a site map in the AirWISE view. 

Note: In order to analyze survey data on the AirWISE view, you must first load the 

selected survey data on the Display view and then switch to the AirWISE view. The 

following discussion assumes that you have already loaded the data on the Display view. 

To test AirWISE requirements on the site map: 

1. While you are on the AirWISE view, click Multiple AP Signal Coverage. The AirWISE 

view refreshes.   
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Note: The figure above shows a network’s compliance status to the Multiple AP 

Signal Coverage requirement based on the survey data collected. A large part of the 

site is in RED, which implies that the signal coverage there is bad. You can try to 

rectify this situation either by increasing signal strength of the existing APs or by 

removing one of the APs from the network. Steps 2 through 3 below are just for 

illustration purposes. 

2. From the bottom of the Content Window, reduce the minimum signal strength. 

3. Click  (Refresh). The AirWISE view refreshes.   
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Note: As shown above, the WLAN site is now 91.3% covered when the signal strength 

was decreased to -77dBm. Based on this result, you can probably use two APs to cover 

the entire site with a minimum signal strength of -77dBm. 

Determining the Number of APs Needed in an Area 

The AirWISE view not only enables you to easily determine the number of APs needed to 

provide adequate signal coverage for an entire WLAN site, but also allows you to quickly 

figure out on the view the optimal number of APs that are needed to cover a certain area of 

the site using a certain channel. As a result, you can save the resources that would 

otherwise have to be used in numerous trial-and-error attempts to find the best solution. 

Note: In order to analyze survey data on the AirWISE view, you must first load the 

selected survey data on the Display view and then switch to the AirWISE view. The 

following section assumes that you have already loaded the data on the Display view. 

To determine the number of APs needed for an area of the network: 
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1. While you are on the AirWISE view, click   (Rect Region Tool) on the Toolbar. 

2. On the site map, click a starting point and mark an area of interest by dragging a 

rectangular frame around it.   

3. Click   (Refresh). The AirWISE view refreshes.   

 

4. From the Channel/SSID pane, select the Channel tab. 

5. Click the Select All check box to deselect all entries in the Channel/SSID pane. 

6. Manually select the entries by checking the corresponding check boxes. 
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Note: The figure above shows that the marked area of the WLAN site is mostly not 

covered by the other APs. 

Getting AirWISE Advice 

If you need information about any of the AirWISE Requirements in question (shown on the 

view) or advice on what you need to do in order to comply with a certain AirWISE 

requirement, click the Description tab in the lower-left corner of the Content Window. You 

will get detailed information and advice related to the AirWISE Requirement.   
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Managing AirWISE Requirement Policies 

AirWISE Requirement Policies are designed to allow you to easily maintain multiple different 

requirement profiles, which can be applied as necessary to any existing Survey projects. 

This makes it easy to ensure compliance with various corporate requirements over different 

projects, or even in different areas of a single project. This can be particularly useful for 

organizations that must enforce two levels of wireless compliance, for example, if both 

wireless voice (VOIP) and data infrastructures are in place. Due to the potentially wide 

variations in requirements for voice traffic as opposed to standard data transmissions, these 

two implementations will require different minimum signal levels, AP placement, and PHY 

data rate information. 

The policy management portion of the view contains five main functions, as shown in the 

image below. These functions are described in more detail in the following sections. 

Note: AirMagnet Survey currently includes preconfigured policies for Cisco phone models 

7920, 7921, and 7925, as well as Vocera badges. Note that the policies included with 

Survey cannot be modified or removed. 

 

  

Selecting an AirWISE Requirement Policy 

The AirWISE policy selection drop-down list allows the user to specify the current profile in 

use. This list includes preconfigured policies as well as any user-defined profiles that have 

been created. To select a new profile, click the drop-down and make the desired selection 

from the list. 
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Note: Several policies are included with AirMagnet Survey by default; these policies 

cannot be modified or removed. 

Creating Custom Requirement Policies 

Although Survey includes several preconfigured policies designed for standard deployment 

types, many users prefer to customize their own policies tailored to their wireless 

environments. This section describes the basic steps for creating and modifying a custom 

policy. 

To create a new AirWISE policy: 

1. From the Requirement Policy window, click   (New policy). The New 

Requirement Policy window appears. 

 

2. Enter the desired name for the new policy. 

3. At this point, the user has two options: 

• Create the policy using the default values for all requirements—In this case, leave 

the Create New Policy option selected. 

• Create the policy by copying the values of another policy—Select Copy From: and 

use the resulting drop-down field to select the policy to be copied. 

Click OK to continue after making the desired selection. The new policy will be selected on 

the AirWISE view. 
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After the new policy has been created, the user can modify any of the thresholds as needed 

using the same steps described in Adjusting AirWISE Requirement Thresholds. 

Note: User-created policies can be deleted by clicking with the policy selected. 

Saving Changes to AirWISE Policies 

After changes have been made to a custom policy, you must save the changes in order to 

ensure that they aren’t discarded after the project is closed or navigates away from the 

AirWISE view. This can be performed by simply clicking  (Save policy). 

However, if you have made changes to one of the preconfigured policies, the changes must 

be saved under a different profile name. This operation can be performed using   (Save 

policy as…). 

Note: If unsaved changes exist when the user attempts to navigate away from the 

AirWISE view, a message will appear asking if the changes should be saved. 

Removing AirWISE Policies 

Clicking (Remove policy) opens the Remove Policy dialog box, which allows you to 

manage the attributes of the current project’s policies. 

 

As seen above, the Remove Policy window provides three major options for the policies: 

• Remove: Deletes the selected policy application. 

• Set Read Only: Sets the selected policy to Read Only, which ensures that the policy 

cannot be modified or removed. 

• Done: Closes the Remove Policy window. 

Verifying VoFi Network Compliance 
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With the implementation of preconfigured AirWISE profiles for various different VoFi phone 

types, you can conduct a standard survey of their wireless environment and assess the 

results to see if the deployment is ready for a VoFi implementation. This important step can 

help ensure that the VoFi deployment is prepared with minimal impact on the existing 

wireless activity. 

To assess VoFi compliance: 

1. After conducting a standard passive or active survey on the area, navigate to the 

AirWISE view. 

2. Use the Requirement Policy drop-down list to select the profile for the phone models 

to be used in the VoFi implementation. 

3. View the AirWISE Requirements listed and assess which aspects of the network don’t 

meet the standards for a VoFi implementation. Note that the Multiple AP Signal 

Coverage requirement is of particular importance as redundancy is a critical factor in 

a VoFi deployment. 

Note: This procedure can be performed both prior to deploying the VoFi installation (to 

verify that the network is ready) as well as after (to verify that the wireless infrastructure 

remains sufficient after VoFi activity is present). 
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AirWISE 

Channel Interference 

Threshold: Min Signal to Interference, Min Signal of interferer 

Default value: -75, -85 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Channel Interference are displayed 

in light green ( ).  Areas that do not meet the requirement are displayed according to the 

color code on the slider bar on the right-hand side of the view. Let the mouse hover over 

any point of the map to show additional details. 

Important Note: AirMagnet Survey measures interference from the point of view of a 

particular AP. Thus for a given AP, AirMagnet shows a cumulative view of all the various 

Wi-Fi sources that are interfering with that one AP. As a result, you should deselect all 

APs that are not the focus of investigation (using the device tree on the left). The signals 

from de-selected devices are still considered when determining interference to other APs. 

Background 

Interference represents a serious threat to the performance of a wireless network. The most 

common source of interference is co-channel interference, which is caused by wireless 

access points that are operating on the same channel or on an overlapping channel. 

Networks should be designed to avoid co-channel interference whenever possible. It is 

important to note that there are technically 11 or more channels in the 802.11b/g 

spectrum, that only 3 of those channels are non-overlapping. For this reason, most 

networks are designed to use an arrangement of Channel 1, Channel 6, and Channel 11 in 

order to minimize interference. 
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Site Surveyors should also note that interference is cumulative in nature. Several weak 

sources of interference can combine to create a large overall interference for a specific AP. 

For this reason, AirMagnet Survey always shows the total interference from the perspective 

of a single AP. By selecting an AP of interest, users can see the total distribution of 

interference for that single device. 

Channel Width 

Threshold: Allowed or Not Allowed 

Default values: 40, 80 and 160 MHz Allowed; 20 MHz and 20 MHz HT Not Allowed 

Pass/Fail default value: 100% 

Requirement Explanation 

This requirement allows you to view the various channel widths detected within the survey 

data file in use. For example, if the Wireless network being installed is required to only 

support 40 MHz channels, you would set the Thresholds to "Allowed" for the 40 MHz and 

"Not allowed" for 20 MHz, 20 MHz HT, 80 MHz, and 160 MHz. After loading the desired 

survey data, the AirWISE view would show you whether the data meets the 

requirements.  The heatmap shows a light green ( ) color for passing and red ( ) for 

failing. This requirement is pass or fail based. 

Background 

Legacy 802.11 systems operate on channels that are 20 MHz wide (actually the channels 

are 22 MHz wide even though they are generally referred to as 20 MHz). 802.11n defines 

both 20-MHz and 40-MHz-wide channel operation. When operating in 40-MHz mode, the 

capacity of the channel is effectively double that of legacy systems. One may liken this to 

“doubling the number of lanes on a freeway so that twice as many cars may pass through”. 

The fourteen 802.11 channels in the 2.4-GHz band (eleven usable channels in the US) are 

spaced 5 MHz apart, with center frequencies from 2412 MHz to 2477 MHz.   

 

RF channels do not have exact edges. The modulated portion of a (20-MHz) 802.11 RF 

signal “falls” into +/- 11 MHz of the center frequency (thus, it is 22 MHz wide); there is 

however some “bleed over”, or unmodulated RF energy that is present to about +/- 30 MHz 

of the center frequency (at relatively much lower power levels). The spectrum mask defines 

how much RF energy may be present outside the channel boundary of +/- 11 MHz.   
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An 802.11 transmission thus “takes up” 5 channels (the center, two left adjacent and two 

right adjacent channels). Depending on transmit power and receiver sensitivity, a 

transmission may even cause interference on several additional channels (up to 5 away 

from the center). 

For instance, a device transmitting on channel 6 will certainly cause significant interference 

on channels 5 and 7 and some interference on channels 4 and 8. It may even cause (usually 

negligible) interference on channels 2, 3, 9, and 10 as well. This is why, in FCC regulated 

domains, there are effectively just 3 simultaneously usable 802.11 20-MHz channels in the 

2.4-GHz band. A typical North American 802.11 b/g deployment will place APs on channels 

1, 6 and 11 to cope with “bleed over”. This channel deployment scheme allows APs in close 

proximity to each other to minimize interference with each other. 

Operating 40-MHz mode in the 2.4-GHz band exacerbates this problem significantly. As can 

be seen in the following figure, the 40-MHz spectrum mask (necessarily) allows higher 

signal energy to be present on adjacent channels.  See an illustration. 
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Thus, a 40-MHz 802.11 transmission in the 2.4-GHz band takes up 9 channels (the center, 

four left adjacent and four right adjacent channels). One may immediately see how 40-MHz 

transmission in the 2.4-GHz band may cause problems, where there are only 11 usable 

channels. Coexistence mechanisms help to address this, but it is difficult to design and 

deploy an efficient multi-user network where a single transmission may use more than 80% 

of the available spectrum in the band. 

Fortunately, 802.11n allows operating in both the 2.4- and 5-GHz bands, and 802.11ac 

operates exclusively in the 5-GHz band. In most regulatory domains, there are many more 

usable channels in the 5-GHz band and the channels are spaced 20 MHz apart. This provides 

for much more “room” for 40-, 80- and 160-MHz wide channel operation. Additionally, it 

should be noted that the 2.4-GHz band is much more crowded than the 5-GHz band, as 

stations operating in the 2.4-GHz band must also contend with Bluetooth devices, 

microwave ovens, and other common sources of 2.4-GHz interference, such as cordless 

phones. 

 

802.11n/ac/ax APs and STAs exchange information about what channel widths are 

supported using HT or VHT Information Element and HT, VHT, or HE Capabilities Element 

frame fields. APs operating a 40-MHz BSS must continuously monitor the environment for 

legacy or non-40 MHz capable HT STAs in both the primary and secondary channels. 
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Note: The scenario below describes some possible causes behind a network that is 

designed to implement 40 MHz operation but has other channel widths in use detected 

during the survey. 

Thresholds: 40 MHz Allowed, 20 MHz HT and 20 MHz Not Allowed 

Symptom: 40 MHz channel width is allowed but you are detecting 20 MHz HT or 20 MHz in 

use. 

Possible diagnoses: 

• Interference detected in the secondary channel by AP/STA: The APs (and/or 

STA) have determined that there is too much interference in the secondary channel 

to effectively use both the primary and secondary channels. You will need to 

determine which 802.11 devices may be causing this interference.  Using AirMagnet 

Spectrum Analyzer may also help to identify non-802.11 interference in the 

secondary channel. 

• Associated STAs do not support 40 MHz transmission: One or more Stations 

which are associated to the AP do not support 40 MHz operation, which causes 40 

MHz AP/STAs to use protection protocols for 40 MHz transmissions.  Review the 

survey data to determine exactly which APs are operating in 20 MHz mode. You can 

then examine the Stations around those APs to determine which station is causing 

the network to fall back into 20 MHz channel usage. 

• 40 MHz Intolerant announced: An AP or STA in this or a neighboring BSS has 

broadcasted "40 MHz Intolerant". An AP broadcasts this when it does not allow 40 

MHz transmissions in neighboring BSSs.  A STA broadcasts this to indicate to its 

associated AP that the AP is required to restrict the use of 40 MHz transmissions 

within its BSS. The AirMagnet WiFi Analyzer product can help to analyze the 40 MHz 

Intolerant announcements via the coexistence section of the Efficiency Analysis Tool. 

IPERF Throughput Up 

Threshold: Min Iperf throughput up 

Default value: 24.0 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Iperf throughput are displayed 

in light green ( ). Areas that do not meet the requirement are displayed according to the 

color code on the slider bar on the right-hand side of the view. This scale is shown in terms 

of Mbps. Let the mouse hover over any point of the heatmap to show additional details. 

Background 

Throughput provides a direct insight into how well the network will support a real-world 

end-user client. An Active Iperf Survey is required in order to obtain throughput data. A low 
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throughput rate directly translates to lower performance for an end-user. Consistently low 

throughput speeds are indicative of either insufficient signal coverage, interference, noise, 

or mis-configured wireless devices. 

The throughput speeds supported by each of the 802.11 protocols are listed below: 

802.11 

Standard 
Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 15.00, 

18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 30.00, 36.00, 39.00, 

40.50, 43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 

72.20, 78.00, 81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 120.00, 

121.50, 130.00, 135.00, 144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 

180.00, 195.00, 208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 

260.00, 270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 

450.00, 480.00, 486.00, 540.00, 600.00 

802.11ac 

6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 

32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 

81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 

130.0, 135.0, 144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 

200.0, 216.0, 216.7, 234.0, 240.0, 243.0, 260.0, 263.3, 270.0, 292.5, 

300.0, 324.0, 325.0, 351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 

433.3, 450.0, 468.0, 486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 

702.0, 780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0 

802.11ax 

8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 
137.6, 143.4, 144.1, 154.9, 172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 
275.3, 286.8, 288.2, 309.7, 324.3, 344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 
480.4, 481.8, 504.4, 516.2, 540.4, 542, 550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 
688.2, 716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 
963.5, 972.8, 1003.7, 1008.8, 1032.4, 1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 
1238.8, 1290.4, 1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3, 1651.8, 
1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 
2294.1, 2305.9, 2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 
3602.9, 3783.1, 3843.1, 3891.2, 4035.3, 4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 
5404.4, 5764.7, 6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 
9607.8  

End-user throughput speeds change automatically from a higher throughput rate to a lower 

one in response to a deteriorating connection quality.  The best method for determining the 

real-world throughput at a given location is to perform a VoFi Survey.  During a VoFi 

Survey, the surveyor “follows” the AP’s connection to the phone and actively collects real 

throughput data. 

IPERF Throughput Down 

Threshold: Min Iperf throughput down 

Default value: 24.0 
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Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Iperf throughput are displayed 

in light green ( ). Areas that do not meet the requirement are displayed according to the 

color code on the slider bar on the right-hand side of the view. This scale is shown in terms 

of Mbps. Let the mouse hover over any point of the map to show additional details. 

Background 

Throughput provides a direct insight into how well the network will support a real-world 

end-user client. An Active Iperf Survey is required in order to obtain throughput speed data. 

A low throughput rate directly translates to lower performance for an end-user. Consistently 

low throughput speeds are indicative of either insufficient signal coverage, interference, 

noise, or mis-configured wireless devices. 

The connection speeds supported by each of the 802.11 protocols are listed below: 

802.11 

Standard 
Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 15.00, 

18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 30.00, 36.00, 39.00, 40.50, 

43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 72.20, 78.00, 

81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 

130.00, 135.00, 144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 180.00, 

195.00, 208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00, 

270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 450.00, 

480.00, 486.00, 540.00, 600.00 

802.11ac 

6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 

32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 

81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 130.0, 

135.0, 144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 

216.7, 234.0, 240.0, 243.0, 260.0, 263.3, 270.0, 292.5, 300.0, 324.0, 325.0, 

351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0, 468.0, 486.0, 

520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0, 780.0, 866.7, 877.5, 975.0, 

1053.0, 1170.0, 1300.0 

802.11ax 

8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 137.6, 
143.4, 144.1, 154.9, 172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3, 
286.8, 288.2, 309.7, 324.3, 344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 480.4, 
481.8, 504.4, 516.2, 540.4, 542, 550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2, 
716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 963.5, 
972.8, 1003.7, 1008.8, 1032.4, 1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 1238.8, 
1290.4, 1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3, 1651.8, 1720.6, 
1729.4, 1801.5, 1806.6, 1835.3, 1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 
2305.9, 2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 3602.9, 
3783.1, 3843.1, 3891.2, 4035.3, 4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 
5764.7, 6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 9607.8  
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End-user connection speeds change automatically from a higher throughput rate to a lower 

one in response to a deteriorating connection quality.  The best method for determining the 

real-world throughput rate at a given location is to perform a VoFi Survey.  During a VoFi 

Survey, the surveyor “follows” the AP’s connection to the phone and actively collects real 

throughput data. 

802.11n MCS Index 

Threshold: Minimum Tx MCS Index required 

Default value: 15 

Pass/Fail default value: 100% 

Requirement Explanation 

This requirement allows you to view precisely which areas of the current survey data file 

meet the requirements specified by the Minimum Tx MCS Index required threshold.  Areas 

that meet the requirement are displayed in light green ( ), whereas regions that do not 

reach the required MCS are displayed in a color assigned by the color-codes on the 

legend.  Hover the mouse over any given point to view a bubble help pop-up that displays 

detailed information about the APs detected at that location. 

Background 

802.11n defines MCS (Modulation and Coding Scheme) which is an integer value (0 through 

76) which determines the modulation, coding rate, and number of spatial streams for a 

transmission. The following PHY data rate table illustrates the possible combinations of MCS, 

Channel Width, and Short Guard Interval (SGI) which determines the PHY data rate, for 

MCS 0-31. 

MCS 

Index 

Spatial 

Streams 

Modulation 

Type 

Coding 

Rate 

Data Rate (Mbit/s) 

20 MHz Channel 40 MHz Channel 

Non-SGI SGI Non-SGI SGI 

0 1 BPSK 1/2 6.50 7.20 13.50 15.00 

1 1 QPSK 1/2 13.00 14.40 27.00 30.00 

2 1 QPSK 3/4 19.50 21.70 40.50 45.00 

3 1 16-QAM 1/2 26.00 28.90 54.00 60.00 

4 1 16-QAM 3/4 39.00 43.30 81.00 90.00 

5 1 64-QAM 2/3 52.00 57.80 108.00 120.00 

6 1 64-QAM 3/4 58.50 65.00 121.50 135.00 

7 1 64-QAM 5/6 65.00 72.20 135.00 150.00 

8 2 BPSK 1/2 13.00 14.40 27.00 30.00 

9 2 QPSK 1/2 26.00 28.90 54.00 60.00 

10 2 QPSK 3/4 39.00 43.30 81.00 90.00 

11 2 16-QAM 1/2 52.00 57.80 108.00 120.00 

12 2 16-QAM 3/4 78.00 86.70 162.00 180.00 

13 2 64-QAM 2/3 104.00 115.60 216.00 240.00 
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14 2 64-QAM 3/4 117.00 130.00 243.00 270.00 

15 2 64-QAM 5/6 130.00 144.40 270.00 300.00 

16 3 BPSK 1/2 19.50 21.70 40.50 45.00 

17 3 QPSK 1/2 39.00 43.30 81.00 90.00 

18 3 QPSK 3/4 58.50 65.00 121.50 135.00 

19 3 16-QAM 1/2 78.00 86.70 162.00 180.00 

20 3 16-QAM 3/4 117.00 130.00 243.00 270.00 

21 3 64-QAM 2/3 156.00 173.30 324.00 360.00 

22 3 64-QAM 3/4 175.50 195.00 364.50 405.00 

23 3 64-QAM 5/6 195.00 216.70 405.00 450.00 

24 4 BPSK 1/2 26.00 28.80 54.00 60.00 

25 4 QPSK 1/2 52.00 57.60 108.00 120.00 

26 4 QPSK 3/4 78.00 86.80 162.00 180.00 

27 4 16-QAM 1/2 104.00 115.60 216.00 240.00 

28 4 16-QAM 3/4 156.00 173.20 324.00 360.00 

29 4 64-QAM 2/3 208.00 231.20 432.00 480.00 

30 4 64-QAM 3/4 234.00 260.00 486.00 540.00 

31 4 64-QAM 5/6 260.00 288.80 540.00 600.00 

An 802.11n STA is required to support MCS 0-7 in 20-MHz (non-SGI) mode; an 802.11n AP 

is required to support MCS 0-15 in 20-MHz (non-SGI) mode; all other MCS values and 

modes are optional. 

MCS 32 is defined as 40-MHz HT duplicate format (BPSK ½ on both halves of the 40-MHz 

channel). MCS 33 through 76 define Unequal Modulation MCS values, where the modulation 

type differs across spatial streams. For instance, MCS 33 defines a 2 spatial stream 

transmission with stream 1 modulated with 16-QAM and stream 2 modulated with QPSK. 

802.11ac MCS Index 

Threshold: Minimum Tx MCS Index required 

Default value: 9 

Pass/Fail default value: 100% 

Requirement Explanation 

This requirement allows you to view precisely which areas of the current survey data file 

meet the requirements specified by the Minimum Tx MCS Index required threshold.  Areas 

that meet the requirement are displayed in light green ( ), whereas regions that do not 

reach the required MCS are displayed in a color assigned by the color-codes on the 

legend.  Hover the mouse over any given point to view a bubble help pop-up that displays 

detailed information about the APs detected at that location. 

Background 
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Selecting a modulation and coding set (MCS) is much simpler in 802.11ac than it was in 

802.11n. Rather than the 70-plus options offered by 802.11n, the 802.11ac specification 

has only 10. The reason for the dramatic simplification is that 802.11ac separates the 

spatial stream number from the MCS number, and each spatial stream has the same MCS 

for 802.11ac radios. An MCS number for 802.11ac is really about the modulation scheme of 

a spatial stream. The first 8 (0-7) are mandatory, and most venders will support all 10 MCS 

options in all products they bring to market. The following table illustrates the possible 

combinations of MCS, Spatial Stream number, Short Guard Interval, and Channel Widths. 

Spatial 

Streams 

802.11ac 

MCS Index 

Guard 

Interval 

20 MHz 

Channel 

PHY Data 

Rate 

40 MHz 

Channel 

PHY Data 

Rate 

80 MHz 

Channel 

PHY Data 

Rate 

160 MHz 

Channel PHY 

Data Rate 

1 0 LGI 6.5 13.5 29.3 58.5 

1 0 SGI 7.2 15.0 32.5 65.0 

1 1 LGI 13.0 27.0 58.5 117.0 

1 1 SGI 14.4 30.0 65.0 130.0 

1 2 LGI 19.5 40.5 87.8 175.5 

1 2 SGI 21.7 45.0 97.5 195.0 

1 3 LGI 26.0 54.0 117.0 234.0 

1 3 SGI 28.9 60.0 130.0 260.0 

1 4 LGI 39.0 81.0 175.5 351.0 

1 4 SGI 43.3 90.0 195.0 390.0 

1 5 LGI 52.0 108.0 234.0 468.0 

1 5 SGI 57.8 120.0 260.0 520.0 

1 6 LGI 58.5 121.5 263.3 526.5 

1 6 SGI 65.0 135.0 292.5 585.0 

1 7 LGI 65.0 135.0 292.5 585.0 

1 7 SGI 72.2 150.0 325.0 650.0 

1 8 LGI 78.0 162.0 351.0 702.0 

1 8 SGI 86.7 180.0 390.0 780.0 

1 9 LGI not used 180.0 390.0 780.0 

1 9 SGI not used 200.0 433.3 866.7 

2 0 LGI 13.0 27.0 58.5 117.0 

2 0 SGI 14.4 30.0 65.0 130.0 

2 1 LGI 26.0 54.0 117.0 234.0 

2 1 SGI 28.9 60.0 130.0 260.0 

2 2 LGI 39.0 81.0 175.5 351.0 

2 2 SGI 43.3 90.0 195.0 390.0 

2 3 LGI 52.0 108.0 234.0 468.0 

2 3 SGI 57.8 120.0 260.0 520.0 

2 4 LGI 78.0 162.0 351.0 702.0 

2 4 SGI 86.7 180.0 390.0 780.0 

2 5 LGI 104.0 216.0 468.0 936.0 

2 5 SGI 115.6 240.0 520.0 1040.0 

2 6 LGI 117.0 243.0 526.5 1053.0 
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2 6 SGI 130.0 270.0 585.0 1170.0 

2 7 LGI 130.0 270.0 585.0 1170.0 

2 7 SGI 144.4 300.0 650.0 1300.0 

2 8 LGI 156.0 324.0 702.0 1404.0 

2 8 SGI 173.3 360.0 780.0 1560.0 

2 9 LGI not used 360.0 780.0 1560.0 

2 9 SGI not used 400.0 866.7 1733.3 

3 0 LGI 19.5 40.5 87.8 175.5 

3 0 SGI 21.7 45.0 97.5 195.0 

3 1 LGI 39.0 81.0 175.5 351.0 

3 1 SGI 43.3 90.0 195.0 390.0 

3 2 LGI 58.5 121.5 263.3 526.5 

3 2 SGI 65.0 135.0 292.5 585.0 

3 3 LGI 78.0 162.0 351.0 702.0 

3 3 SGI 86.7 180.0 390.0 780.0 

3 4 LGI 117.0 243.0 526.5 1053.0 

3 4 SGI 130.0 270.0 585.0 1170.0 

3 5 LGI 156.0 324.0 702.0 1404.0 

3 5 SGI 173.3 360.0 780.0 1560.0 

3 6 LGI 175.5 364.5 not used 1579.5 

3 6 SGI 195.0 405.0 not used 1755.0 

3 7 LGI 195.0 405.0 877.5 1755.0 

3 7 SGI 216.7 450.0 975.0 1950.0 

3 8 LGI 234.0 486.0 1053.0 2106.0 

3 8 SGI 260.0 540.0 1170.0 2340.0 

3 9 LGI 260.0 540.0 1170.0 not used 

3 9 SGI 385.2 600.0 1300.0 not used 

4 0 LGI 26.0 54.0 117.0 234.0 

4 0 SGI 28.9 60.0 130.0 260.0 

4 1 LGI 52.0 108.0 234.0 468.0 

4 1 SGI 57.8 120.0 260.0 520.0 

4 2 LGI 78.0 162.0 351.0 702.0 

4 2 SGI 86.7 180.0 390.0 780.0 

4 3 LGI 104.0 216.0 468.0 936.0 

4 3 SGI 115.6 240.0 520.0 1040.0 

4 4 LGI 156.0 324.0 702.0 1404.0 

4 4 SGI 173.3 360.0 780.0 1560.0 

4 5 LGI 208.0 432.0 936.0 1872.0 

4 5 SGI 231.1 480.0 1040.0 2080.0 

4 6 LGI 234.0 486.0 1053.0 2106.0 

4 6 SGI 260.0 540.0 1170.0 2340.0 

4 7 LGI 260.0 540.0 1170.0 2340.0 

4 7 SGI 288.9 600.0 1300.0 2600.0 

4 8 LGI 312.0 648.0 1404.0 2808.0 
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4 8 SGI 346.7 720.0 1560.0 3120.0 

4 9 LGI not used 720.0 1560.0 3120.0 

4 9 SGI not used 800.0 1733.3 3466.7 

5 0 LGI 32.5 67.5 146.3 292.5 

5 0 SGI 36.1 75.0 162.5 325.0 

5 1 LGI 65.0 135.0 292.5 585.0 

5 1 SGI 72.2 150.0 325.0 650.0 

5 2 LGI 97.5 202.5 438.8 877.5 

5 2 SGI 108.3 225.0 487.5 975.0 

5 3 LGI 130.0 270.0 585.0 1170.0 

5 3 SGI 144.4 300.0 650.0 1300.0 

5 4 LGI 195.0 405.0 877.5 1755.0 

5 4 SGI 216.7 450.0 975.0 1950.0 

5 5 LGI 260.0 540.0 1170.0 2340.0 

5 5 SGI 288.9 600.0 1300.0 2600.0 

5 6 LGI 292.5 607.5 1316.3 2632.5 

5 6 SGI 325.0 675.0 1462.5 2925.0 

5 7 LGI 325.0 675.0 1462.5 2925.0 

5 7 SGI 361.1 750.0 1625.0 3250.0 

5 8 LGI 390.0 810.0 1755.0 3510.0 

5 8 SGI 433.3 900.0 1950.0 3900.0 

5 9 LGI not used 900.0 1950.0 3900.0 

5 9 SGI not used 1000.0 2166.7 4333.3 

6 0 LGI 39.0 81.0 175.5 351.0 

6 0 SGI 43.3 90.0 195.0 390.0 

6 1 LGI 78.0 162.0 351.0 702.0 

6 1 SGI 86.7 180.0 390.0 780.0 

6 2 LGI 117.0 243.0 526.5 1053.0 

6 2 SGI 130.0 270.0 585.0 1170.0 

6 3 LGI 156.0 324.0 702.0 1404.0 

6 3 SGI 173.3 360.0 780.0 1560.0 

6 4 LGI 234.0 486.0 1053.0 2106.0 

6 4 SGI 260.0 540.0 1170.0 2340.0 

6 5 LGI 312.0 648.0 1404.0 2808.0 

6 5 SGI 346.7 720.0 1560.0 3120.0 

6 6 LGI 351.0 729.0 1579.5 3159.0 

6 6 SGI 390.0 810.0 1755.0 3510.0 

6 7 LGI 390.0 810.0 1755.0 3510.0 

6 7 SGI 433.3 900.0 1950.0 3900.0 

6 8 LGI 468.0 972.0 2106.0 4212.0 

6 8 SGI 520.0 1080.0 2340.0 4680.0 

6 9 LGI 520.0 1080.0 not used 4680.0 

6 9 SGI 674.1 1200.0 not used 5200.0 

7 0 LGI 45.5 94.5 204.8 409.5 
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7 0 SGI 50.6 105.0 227.5 455.0 

7 1 LGI 91.0 189.0 409.5 819.0 

7 1 SGI 101.1 210.0 455.0 910.0 

7 2 LGI 136.5 283.5 614.3 1228.5 

7 2 SGI 151.7 315.0 682.5 1365.0 

7 3 LGI 182.0 378.0 819.0 1638.0 

7 3 SGI 202.2 420.0 910.0 1820.0 

7 4 LGI 273.0 567.0 1228.5 2457.0 

7 4 SGI 303.3 630.0 1365.0 2730.0 

7 5 LGI 364.0 756.0 1638.0 3276.0 

7 5 SGI 404.4 840.0 1820.0 3640.0 

7 6 LGI 409.5 850.5 not used 3685.5 

7 6 SGI 455.0 945.0 not used 4095.0 

7 7 LGI 455.0 945.0 2047.5 4095.0 

7 7 SGI 505.6 1050.0 2275.0 4550.0 

7 8 LGI 546.0 1134.0 2457.0 4914.0 

7 8 SGI 606.7 1260.0 2730.0 5460.0 

7 9 LGI not used 1260.0 2730.0 5460.0 

7 9 SGI not used 1400.0 3033.3 6066.7 

8 0 LGI 52.0 108.0 234.0 468.0 

8 0 SGI 57.8 120.0 260.0 520.0 

8 1 LGI 104.0 216.0 468.0 936.0 

8 1 SGI 115.6 240.0 520.0 1040.0 

8 2 LGI 156.0 324.0 702.0 1404.0 

8 2 SGI 173.3 360.0 780.0 1560.0 

8 3 LGI 208.0 432.0 936.0 1872.0 

8 3 SGI 231.1 480.0 1040.0 2080.0 

8 4 LGI 312.0 648.0 1404.0 2808.0 

8 4 SGI 346.7 720.0 1560.0 3120.0 

8 5 LGI 416.0 864.0 1872.0 3744.0 

8 5 SGI 462.2 960.0 2080.0 4160.0 

8 6 LGI 468.0 972.0 2106.0 4212.0 

8 6 SGI 520.0 1080.0 2340.0 4680.0 

8 7 LGI 520.0 1080.0 2340.0 4680.0 

8 7 SGI 577.8 1200.0 2600.0 5200.0 

8 8 LGI 624.0 1296.0 2808.0 5616.0 

8 8 SGI 693.3 1440.0 3120.0 6240.0 

8 9 LGI not used 1440.0 3120.0 6240.0 

8 9 SGI not used 1600.0 3466.7 6933.3 

  

802.11ax MCS Index 

Threshold: Minimum Tx MCS Index required 
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Default value: 11 

Pass/Fail default value: 100% 

Requirement Explanation 

This requirement allows you to view precisely which areas of the current survey data file 

meet the requirements specified by the Minimum Tx MCS Index required threshold.  Areas 

that meet the requirement are displayed in light green ( ), whereas regions that do not 

reach the required MCS are displayed in a color assigned by the color-codes on the 

legend.  Hover the mouse over any given point to view a bubble help pop-up that displays 

detailed information about the APs detected at that location. 

Background 

802.11ax has a similar modulation and coding set (MCS) as 802.11ac with two additional 

modulations, 1024-QAM 3/4 and 1024-QAM 5/6. However, 802.11ax uses a fixed 0.8 µs 

Guard Interval for indoor environments. The following table illustrates the possible 

combinations of MCS, Spatial Stream number, and Channel Widths. 

802.11ax 

MCS Index 

Spatial 

Stream 

20 MHz 

Channel PHY 

Data Rate 

40 MHz 

Channel PHY 

Data Rate 

80 MHz 

Channel PHY 

Data Rate 

160 MHz 

Channel PHY 

Data Rate 

0 1 8.6 17.2 36 72.1 

1 1 17.2 34.4 72.1 144.1 

2 1 25.8 51.6 108.1 216.2 

3 1 34.4 68.8 144.1 288.2 

4 1 51.6 103.2 216.2 432.4 

5 1 68.8 137.6 288.2 576.5 

6 1 77.4 154.9 324.3 648.5 

7 1 86 172.1 360.3 720.6 

8 1 103.2 206.5 432.4 864.7 

9 1 114.7 229.4 480.4 960.8 

10 1 129 258.1 540.4 1080.9 

11 1 143.4 286.8 600.5 1201 

0 2 17.2 34.4 72.1 144.1 

1 2 34.4 68.8 144.1 288.2 

2 2 51.6 103.2 216.2 432.4 

3 2 68.8 137.6 288.2 576.5 

4 2 103.2 206.5 432.4 864.7 

5 2 137.6 275.3 576.5 1152.9 

6 2 154.9 309.7 648.5 1297.1 

7 2 172.1 344.1 720.6 1441.2 

8 2 206.5 412.9 864.7 1729.4 

9 2 229.4 458.8 960.8 1921.6 
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10 2 258.1 516.2 1080.9 2161.8 

11 2 286.8 573.5 1201 2402 

0 3 25.8 51.6 108.1 216.2 

1 3 51.6 103.2 216.2 432.4 

2 3 77.4 154.9 324.3 648.5 

3 3 103.2 206.5 432.4 864.7 

4 3 154.9 309.7 648.5 1297.1 

5 3 206.5 412.9 864.7 1729.4 

6 3 232.3 464.6 972.8 1945.6 

7 3 258.1 516.2 1080.9 2161.8 

8 3 309.7 619.4 1297.1 2594.1 

9 3 344.1 688.2 1441.2 2882.4 

10 3 387.1 774.3 1621.3 3242.6 

11 3 430.1 860.3 1801.5 3602.9 

0 4 34.4 68.8 144.1 288.2 

1 4 68.8 137.6 288.2 576.5 

2 4 103.2 206.5 432.4 864.7 

3 4 137.6 275.3 576.5 1152.9 

4 4 206.5 412.9 864.7 1729.4 

5 4 275.3 550.6 1152.9 2305.9 

6 4 309.7 619.4 1297.1 2594.1 

7 4 344.1 688.2 1441.2 2882.4 

8 4 412.9 825.9 1729.4 3458.8 

9 4 458.8 917.6 1921.6 3843.1 

10 4 516.2 1032.4 2161.8 4323.5 

11 4 573.5 1147.1 2402 4803.9 

0 5 43 86 180.1 360.3 

1 5 86 172.1 360.3 720.6 

2 5 129 258.1 540.4 1080.9 

3 5 172.1 344.1 720.6 1441.2 

4 5 258.1 516.2 1080.9 2161.8 

5 5 344.1 688.2 1441.2 2882.4 

6 5 387.1 774.3 1621.3 3242.6 

7 5 430.1 860.3 1801.5 3602.9 

8 5 516.2 1032.4 2161.8 4323.5 

9 5 573.5 1147.1 2402 4803.9 

10 5 645.2 1290.4 2702.2 5404.4 

11 5 716.9 1433.8 3002.5 6004.9 

0 6 51.6 103.2 216.2 432.4 

1 6 103.2 206.5 432.4 864.7 



AirWISE 

270 

2 6 154.9 309.7 648.5 1297.1 

3 6 206.5 412.9 864.7 1729.4 

4 6 309.7 619.4 1297.1 2594.1 

5 6 412.9 825.9 1729.4 3458.8 

6 6 464.6 929.1 1945.6 3891.2 

7 6 516.2 1032.4 2161.8 4323.5 

8 6 619.4 1238.8 2594.1 5188.2 

9 6 688.2 1376.5 2882.4 5764.7 

10 6 774.3 1548.5 3242.6 6485.3 

11 6 860.3 1720.6 3602.9 7205.9 

0 7 60.2 120.4 252.2 504.4 

1 7 120.4 240.9 504.4 1008.8 

2 7 180.7 361.3 756.6 1513.2 

3 7 240.9 481.8 1008.8 2017.6 

4 7 361.3 722.6 1513.2 3026.5 

5 7 481.8 963.5 2017.6 4035.3 

6 7 542 1084 2269.9 4539.7 

7 7 602.2 1204.4 2522.1 5044.1 

8 7 722.6 1445.3 3026.5 6052.9 

9 7 802.9 1605.9 3362.7 6725.5 

10 7 903.3 1806.6 3783.1 7566.2 

11 7 1003.7 2007.4 4203.4 8406.9 

0 8 68.8 137.6 288.2 576.5 

1 8 137.6 275.3 576.5 1152.9 

2 8 206.5 412.9 864.7 1729.4 

3 8 275.3 550.6 1152.9 2305.9 

4 8 412.9 825.9 1729.4 3458.8 

5 8 550.6 1101.2 2305.9 4611.8 

6 8 619.4 1238.8 2594.1 5188.2 

7 8 688.2 1376.5 2882.4 5764.7 

8 8 825.9 1651.8 3458.8 6917.6 

9 8 917.6 1835.3 3843.1 7686.3 

10 8 1032.4 2064.7 4323.5 8647.1 

11 8 1147.1 2294.1 4803.9 9607.8 

  

  

Measured PHY Data Rate Downlink Coverage 

Threshold: Min Downlink Data Rate Supported 
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Default value: 54.0 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Downlink Data Rate Supported 

are displayed in light green ( ). Areas that do not meet the requirement are displayed 

according to the color code on the slider bar on the right-hand side of the view. This scale is 

shown in terms of Mbps. Let the mouse hover over any point of the map to show additional 

details. 

Background 

Connection data rate provides a direct insight into how well the network will support a real-

world end-user client. An Active Iperf Survey is required in order to obtain connection speed 

data. A low connection PHY data rate directly translates to lower throughput and 

performance for an end-user. Consistently low connection speeds are indicative of either 

insufficient signal coverage, interference, noise, or mis-configured wireless devices. 

The connection speeds supported by each of the 802.11 protocols are listed below: 

802.11 

Standard 
Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 

15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 30.00, 36.00, 

39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 

65.00, 72.20, 78.00, 81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 

120.00, 121.50, 130.00, 135.00, 144.40, 150.00, 156.00, 162.00, 173.30, 

175.50, 180.00, 195.00, 208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 

243.00, 260.00, 270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 

432.00, 450.00, 480.00, 486.00, 540.00, 600.00 

802.11ac 

6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 

32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 

81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 

130.0, 135.0, 144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 

200.0, 216.0, 216.7, 234.0, 240.0, 243.0, 260.0, 263.3, 270.0, 292.5, 

300.0, 324.0, 325.0, 351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 

433.3, 450.0, 468.0, 486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 

702.0, 780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0 

802.11ax 

8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 
137.6, 143.4, 144.1, 154.9, 172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 
275.3, 286.8, 288.2, 309.7, 324.3, 344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 
480.4, 481.8, 504.4, 516.2, 540.4, 542, 550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 
688.2, 716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 
963.5, 972.8, 1003.7, 1008.8, 1032.4, 1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 
1238.8, 1290.4, 1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3, 1651.8, 
1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 
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2294.1, 2305.9, 2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 
3602.9, 3783.1, 3843.1, 3891.2, 4035.3, 4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 
5404.4, 5764.7, 6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 
9607.8  

End-user connection speeds change automatically from a higher connection data rate to a 

lower one in response to a deteriorating connection quality.  The best method for 

determining the real-world connection data rate at a given location is to perform a VoFi 

Survey.  During a VoFi Survey, the surveyor “follows” the AP’s connection to the phone and 

actively collects real connection data such as connection data rate. 

Measured PHY Data Rate Uplink Coverage 

Threshold: Min Uplink Data Rate Supported 

Default value: 5.5 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Uplink Data Rate Supported are 

displayed in light green ( ). Areas that do not meet the requirement are displayed 

according to the color code on the slider bar on the right-hand side of the view. This scale is 

shown in terms of Mbps. Let the mouse hover over any point of the map to show additional 

details. 

Background 

Connection data rate provides a direct insight into how well the network will support a real-

world end-user client. An Active Survey is required in order to obtain connection speed data. 

A low connection PHY data rate directly translates to lower throughput and performance for 

an end-user. Consistently low connection speeds are indicative of either insufficient signal 

coverage, interference, noise, or mis-configured wireless devices. 

The connection speeds supported by each of the 802.11 protocols are listed below: 

802.11 

Standard 
Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 15.00, 

18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 30.00, 36.00, 39.00, 40.50, 

43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 72.20, 78.00, 

81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 

135.00, 144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 180.00, 195.00, 

208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00, 270.00, 

288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 450.00, 480.00, 

486.00, 540.00, 600.00 
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802.11ac 

6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 32.5, 

39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 81.0, 

86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 130.0, 

135.0, 144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 

216.7, 234.0, 240.0, 243.0, 260.0, 263.3, 270.0, 292.5, 300.0, 324.0, 325.0, 

351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0, 468.0, 486.0, 

520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0, 780.0, 866.7, 877.5, 975.0, 

1053.0, 1170.0, 1300.0 

802.11ax 

8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 137.6, 
143.4, 144.1, 154.9, 172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3, 
286.8, 288.2, 309.7, 324.3, 344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 480.4, 
481.8, 504.4, 516.2, 540.4, 542, 550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2, 716.9, 
720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 
1003.7, 1008.8, 1032.4, 1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 1238.8, 1290.4, 
1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3, 1651.8, 1720.6, 1729.4, 
1801.5, 1806.6, 1835.3, 1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 2305.9, 
2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 3602.9, 3783.1, 
3843.1, 3891.2, 4035.3, 4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7, 
6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 9607.8  

End-user connection speeds change automatically from a higher connection data rate to a 

lower one in response to a deteriorating connection quality.  The best method for 

determining the real-world connection data rate at a given location is to perform a VoFi 

Survey.  During a VoFi Survey, the surveyor “follows” the AP’s connection to the phone and 

actively collects real connection data such as connection data rate. 

Multiple AP Signal Coverage 

Threshold: Min No. of AP, Min Signal 

Default value: 2, -67 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirements for AP coverage are displayed in light 

green ( ). This requirement contains two requirements. One requirement is based on the 

number of APs present in the area, and the second is based on the minimum signal required 

of the present APs. Both of these requirements must be met in order to be considered 

compliant. Either of these requirements can be shown for non-compliant areas of the map. 

To view problem areas in terms of AP count, click the Minimum Number of APs row in the 

thresholds area, just below the main view. To see how close the actual AP signal is to 

meeting your requirement, click the Minimum Signal row in the thresholds area. Let the 

mouse hover over any point of the map to show additional details. 

Background 

Wireless networks with stringent performance requirements should insure that all areas are 

served by at least two access points on non-overlapping channels. Each of these APs should 
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meet the minimum signal requirement for the network (typically between -67 dBm and -75 

dBm). In the 2.4-GHz band, only channels 1, 6, and 11 are considered non-overlapping. 

Corrective Actions 

Users have 3 basic options to insure coverage from multiple APs: 

• Increase the transmit power of existing APs 

• Reposition APs to improve overlapping cells 

• Add additional APs 

Increasing the transmit power of an AP is an option, but many APs transmit at their 

maximum power by default. Some APs support the use of external high-gain antennas 

which can also boost the strength of signal. However, use of these antennas is strictly 

regulated by the FCC, and you should be careful to stay within the boundaries of the law. 

Furthermore, high-gain antennas do not truly add any overall signal to the environment. 

You just compress the signal that is already available. As a result, a high-gain antenna may 

improve signal in location and worsen it to another. 

Properly positioning APs is also an important step. Ideally, APs should have a clear “line of 

site” to the areas that they will serve. Installing APs on the ceiling or high on walls is often a 

helpful option when trying to avoid physical obstructions. 

If the measures described above do not alleviate the problem, it may be necessary to install 

an additional AP. When an AP is added to the environment, users should configure that AP 

to use a Wi-Fi channel that does not overlap with the APs that are already deployed. 

Noise Level 

Threshold: Max Noise Level 

Default value: -90 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for noise are displayed in light green (

). Areas that do not meet the requirement are displayed using the color code on the 

slider bar on the right-hand side of the view. Noise levels are displayed in dBm with areas of 

highest noise shown in red. Let the mouse hover over any point of the map to show 

additional details. 

Background 

Any energy in the Wi-Fi spectrum that is not recognized as 802.11 traffic is considered 

noise. High levels of environmental noise will interfere with 802.11 signals and lead to 

serious performance problems for the wireless network. 

Noise is a very common problem especially in the 2.4 GHz band that supports 802.11b, 

802.11g, and 802.11n. The 2.4 GHz band is “unlicensed” and is commonly used by a variety 
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of technologies including Bluetooth, cordless phones, frequency hopping devices, wireless 

cameras, and more. Other devices such as microwave ovens can emit noise simply as a 

byproduct of their normal operation. 

Like signal, noise is measured in units of “dBm”, with a signal of 0 dBm being the strongest, 

and signals of -100 dBm and below being the lowest. The maximum acceptable noise will 

depend on the requirements of the network. As a general rule, a wireless network should 

aim to keep noise levels below -85 dBm. For normal data traffic, and under -90 dBm for 

networks that will support voice. 

Corrective Actions 

High environmental noise can be addressed either by removing the source of the noise, or 

avoiding it by moving 802.11 traffic to a less noisy portion of the Wi-Fi spectrum. However, 

avoidance of noise may not always be an option. To remove the source of noise, technical 

staff must identify the noise source. This is most reliably done with a tool such as the 

AirMagnet Spectrum Analyzer, which can analyze the waveform of the noise to pin down a 

unique source of the noise. 

Operating Mode 

Threshold: Allowed or Not Allowed 

Default values: Greenfield, Mixed VHT, and Mixed HE Allowed; Mixed and Legacy Not 

Allowed 

Pass/Fail default value: 100% 

Requirement Explanation 

The requirement is triggered by any 802.11n, 802.11ac, or 802.11ax networks that fall 

outside of the selected threshold settings. For example if the Wireless network being 

surveyed is designed to provide "Very High Throughput” (VHT), then the Threshold setting 

would be set to "Allowed" for the VHT Operating Mode and Not Allowed for the remaining 

thresholds. After completing the Survey by using the AirWise section one can determine if 

the desired network environment is actually in place. The heatmap shows a light green ( ) 

color for passing and red ( ) for failing.  This requirement is a pass or fail based threshold 

Background 

The PHY- and MAC-layer improvements introduced in the 802.11n amendment and 

extended in the 802.11ac and 802.11ax amendment brings Wi-Fi network performance to 

an unprecedented level in terms of range, throughput, and stability. However, given the 

current state of the Wi-Fi network infrastructure which is largely built upon the legacy 

802.11a/b/g standards, the new 802.11n protocols may have the potential of interfering 

with or even hampering the normal operation of legacy (i.e., 802.11a/b/g) networks. 

Like the present 802.11g networks that are backward-compatible to the 802.11b networks, 

the new 802.11n networks will and must be backward-compatible with stations that are 

built upon the legacy 802.11a/b/g standards. Towards that end, 802.11n wireless access 

points must be able to inter-operate smoothly in a mixed WLAN environment to the extent 
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that they can support both legacy 802.11a/b/g transmissions over 20-MHz channels and 

high-throughput transmissions over 40-MHz channels. 

To effectively address the backward compatibility and coexistence issue, 802.11n wireless 

access points must be able to automatically choose the appropriate operating mode as is 

dictated by the changing dynamics of the wireless environment in which they are operating. 

According to the 802.11n draft 2.0, 802.11n access points should be able to function in any 

of the following operating modes, depending on the real-time circumstances of the wireless 

network. 

Greenfield 

An 802.11n AP using HT (High Throughput) mode – also known as Greenfield mode – 

assumes that there are no nearby legacy stations using the same frequency band.  The 

highest performance of an 802.11n network is achieved in this mode, with only 802.11n 

stations in the network and no legacy devices within reach. If legacy stations or networks 

are present, 802.11n devices must communicate using protection mechanisms, which may 

reduce the efficiency of the 802.11n network.  HT mode is optional. 

 

HT Mixed 

The mandatory HT Mixed mode will be the most common 802.11n AP operating mode.  In 

this mode, HT enhancements can be used simultaneously with HT Protection mechanisms 

that permit communication with legacy stations.  HT Mixed mode provides backwards 

compatibility, but 802.11n devices pay significant throughput penalties as compared to 

Greenfield mode. 

 

Legacy 

An 802.11n AP using Non-HT (Non-High Throughput) mode - also known as legacy mode - 

sends all frames in the old 802.11a/b/g format so that legacy stations can understand 

them.  That AP must use 20-MHz channels and none of the new HT features.  All Wi-Fi-

certified 802.11n products on the market must support this mode to ensure backward 

compatibility, but an 802.11n AP using Non-HT delivers no better performance than 

802.11a/g. 
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Likewise, 802.11ac is designed to be backwards compatible with 802.11a and 802.11n 

stations in the 5 GHz band. The 802.11ac standard defines only one operating mode: Very 

High Throughput. 

VHT 

802.11ac simplifies WLAN networks by introducing one operating mode (VHT) that works for 

all 802.11 technologies in the 5 GHz band. By definition, VHT is mixed in that it supports 

new 802.11ac connections along with legacy 802.11a and 802.11n connections.  A VHT 

frame is transmitted with a legacy preamble that is recognized by 802.11a and 802.11n 

radios, followed by a VHT preamble. 

 

HE 

Like 802.11n/ac, the 802.11ax frame begins with the preamble. Within the preamble are 

legacy (non-HE) training fields followed by the HE preamble. The initial legacy segment 

includes L-STF, L-LTF and L-SIG, which legacy devices can decode, to support backwards 

compatibility. Only 802.11ax capable devices can decode the HE preamble portion. 

The image below shows the PPDU formats' overall composition and a breakdown of the field 

sections. 
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Predictive PHY Data Rate Downlink Coverage 

Threshold: Min Downlink Data Rate Supported 

Default value: 54.0 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Downlink Data Rate Supported 

are displayed in light green ( ). Areas that do not meet the requirement are displayed 

according to the color code on the slider bar on the right-hand side of the view. This scale is 

shown in terms of Mbps. Let the mouse hover over any point of the map to show additional 

details. 

Background 

Connection Rates provide a direct insight into how well the network will support a real-world 

end-user client. When doing a Passive survey the ability to see the actual Data rate is not 

available. In order to provide Data Rates while doing a Passive survey we use Signal 

Strength to Data Rate mapping table. Take the detected signal strength and map it to a 

known Data Rate. A low Data Rate connection directly translates to lower throughput and 

performance for an end-user. Consistently low connection Rates are indicative of insufficient 

signal coverage, interference, noise, or mis-configured wireless devices. 

The connection speeds supported by each of the 802.11 protocols are listed below: 



AirMagnet Survey User Guide 

279 

802.11 

Standard 
Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 14.40, 15.00, 

18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 30.00, 36.00, 39.00, 40.50, 

43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 72.20, 78.00, 

81.00, 86.70, 90.00, 104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 

135.00, 144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 180.00, 195.00, 

208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00, 270.00, 

288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 450.00, 480.00, 

486.00, 540.00, 600.00 

802.11ac 

6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9, 29.3, 30.0, 32.5, 

39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 58.5, 60.0, 65.0, 72.2, 78.0, 81.0, 

86.7, 87.8, 90.0, 97.5, 104.0, 108.0, 115.6, 117.0, 120.0, 121.5, 130.0, 135.0, 

144.4, 150.0, 156.0, 162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 

234.0, 240.0, 243.0, 260.0, 263.3, 270.0, 292.5, 300.0, 324.0, 325.0, 351.0, 

360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0, 468.0, 486.0, 520.0, 

526.5, 540.0, 585.0, 600.0, 650.0, 702.0, 780.0, 866.7, 877.5, 975.0, 1053.0, 

1170.0, 1300.0 

802.11ax 

8.6, 17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2, 108.1, 114.7, 120.4, 129, 137.6, 
143.4, 144.1, 154.9, 172.1, 180.1, 180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3, 286.8, 
288.2, 309.7, 324.3, 344.1, 360.3, 361.3, 387.1, 412.9, 430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 
516.2, 540.4, 542, 550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2, 716.9, 720.6, 722.6, 
756.6, 774.3, 802.9, 825.9, 860.3, 864.7, 903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 
1032.4, 1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 1238.8, 1290.4, 1297.1, 1376.5, 1433.8, 
1441.2, 1445.3, 1513.2, 1548.5, 1605.9, 1621.3, 1651.8, 1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 
1921.6, 1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 2305.9, 2402, 2522.1, 2594.1, 
2702.2, 2882.4, 3002.5, 3026.5, 3242.6, 3362.7, 3458.8, 3602.9, 3783.1, 3843.1, 3891.2, 4035.3, 
4203.4, 4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7, 6004.9, 6052.9, 6485.3, 
6725.5, 6917.6, 7205.9, 7566.2, 7686.3, 8406.9, 8647.1, 9607.8  

End-user connection speeds change automatically from a higher connection data rate to a 

lower one in response to a deteriorating connection quality.  The best method for 

determining the real-world connection data rate at a given location is to perform a VoFi 

Survey.  During a VoFi Survey, the surveyor “follows” the AP’s connection to the phone and 

actively collects real connection data such as connection data rate. 

RSSI Neighboring Cell Coverage 

Threshold: Min Signal 

Default value: -67 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas that meet the current RSSI neighboring cell coverage requirement are shown in light 

green ( ). Areas that do not meet the requirement are displayed using the color code on 
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the slider bar on the right-hand side of the view. The weakest signals are shown in red. Let 

the mouse hover over any point of the map to show additional details. 

RF Coverage Background 

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the 

basis for traditional networks. Each wireless client (such as an end-user) must receive 

adequate levels of RF signal from its Access Point in order to insure a reliable and well-

performing connection. 

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and 

signals of -100 dBm and below being the weakest. The minimum acceptable signal will 

depend on the requirements of the network and how it is used. As a general rule, voice 

clients should maintain a signal of at least -67 dBm. 

RF signals can be significantly affected by environmental factors. Solid objects will attenuate 

and reflect RF signals, which can cause RF “dead spots” in otherwise well-served areas. For 

this reason, it is important to carefully survey areas where wireless clients will need network 

service. Surveyors should pay special attention to the areas around, and in the line of site of 

physical obstructions. Typical obstructions include any solid metal object, solid walls, 

elevator shafts, and any shielded room such as an x-ray room. 

Corrective Action 

Insufficient signal can be addressed in 3 basic ways. 

• Increase the transmit power of the AP 

• Add additional APs to provided additional coverage 

• Reposition APs to avoid obstructions 

Increasing the transmit power of an AP is an option, but many APs transmit at their 

maximum power by default. Some APs support the use of external high-gain antennas 

which can also boost the strength of signal. However, use of these antennas is strictly 

regulated by the FCC, and users should be careful to stay within the boundaries of the law. 

Furthermore, high-gain antennas do not truly add any overall signal to the environment. 

They simply compress the signal that is already available. As a result, a high-gain antenna 

may improve signal in location and worsen it to another. 

Properly positioning APs is also an important step. Ideally, APs should have a clear “line of 

site” to the areas that they will serve. Installing APs on the ceiling or high on walls is often a 

helpful option when trying to avoid physical obstructions. 

If the measures described above do not alleviate the problem, it may be necessary to install 

an additional AP. When an AP is added to the environment, users should configure that AP 

to use a Wi-Fi channel that does not overlap with the APs that are already deployed. 

RSSI Serving Cell Coverage 

Threshold: Min Signal 

Default value: -67 
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Pass/Fail default value: 100% 

Requirement Explanation 

Areas that meet the current RSSI serving cell coverage requirement are shown in light 

green ( ). Areas that do not meet the requirement are displayed using the color code on 

the slider bar on the right-hand side of the view. The weakest signals are shown in red. Let 

the mouse hover over any point of the map to show additional details. 

RF Coverage Background 

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the 

basis for traditional networks. Each wireless client (such as an end-user) must receive 

adequate levels of RF signal from its Access Point in order to insure a reliable and well-

performing connection. 

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and 

signals of -100 dBm and below being the weakest. The minimum acceptable signal will 

depend on the requirements of the network and how it is used. As a general rule, voice 

clients should maintain a signal of at least -67 dBm. 

RF signals can be significantly affected by environmental factors. Solid objects will attenuate 

and reflect RF signals, which can cause RF “dead spots” in otherwise well-served areas. For 

this reason, it is important to carefully survey areas where wireless clients will need network 

service. Surveyors should pay special attention to the areas around, and in the line of site of 

physical obstructions. Typical obstructions include any solid metal object, solid walls, 

elevator shafts, and any shielded room such as an x-ray room. 

Corrective Action 

Insufficient signal can be addressed in 3 basic ways. 

• Increase the transmit power of the AP 

• Add additional APs to provided additional coverage 

• Reposition APs to avoid obstructions 

Increasing the transmit power of an AP is an option, but many APs transmit at their 

maximum power by default. Some APs support the use of external high-gain antennas 

which can also boost the strength of signal. However, use of these antennas is strictly 

regulated by the FCC, and users should be careful to stay within the boundaries of the law. 

Furthermore, high-gain antennas do not truly add any overall signal to the environment. 

They simply compress the signal that is already available. As a result, a high-gain antenna 

may improve signal in location and worsen it to another. 

Properly positioning APs is also an important step. Ideally, APs should have a clear “line of 

site” to the areas that they will serve. Installing APs on the ceiling or high on walls is often a 

helpful option when trying to avoid physical obstructions. 

If the measures described above do not alleviate the problem, it may be necessary to install 

an additional AP. When an AP is added to the environment, users should configure that AP 

to use a Wi-Fi channel that does not overlap with the APs that are already deployed. 
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Signal Coverage 

Threshold: Min Signal 

Default value: -67 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas that meet the current RF coverage requirement are shown in light green ( ). Areas 

that do not meet the requirement are displayed using the color code on the slider bar on the 

right-hand side of the view. The weakest signals are shown in red. Let the mouse hover 

over any area of the map to show additional details. 

RF Coverage Background 

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the 

basis for traditional networks. Each wireless client (such as an end-user) must receive 

adequate levels of RF signal from its Access Point in order to insure a reliable and well-

performing connection. 

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and 

signals of -100 dBm and below being the weakest. The minimum acceptable signal will 

depend on the requirements of the network and how it is used. As a general rule, data 

clients should maintain a signal of at least -76 dBm. Voice clients require a stronger signal 

and should maintain a signal of at least -67 dBm. 

RF signals can be significantly affected by environmental factors. Solid objects will attenuate 

and reflect RF signals, which can cause RF “dead spots” in otherwise well-served areas. For 

this reason, it is important to carefully survey areas where wireless clients will need network 

service. Surveyors should pay special attention to the areas around, and in the line of site of 

physical obstructions. Typical obstructions include any solid metal object, solid walls, 

elevator shafts, and any shielded room such as an x-ray room. 

Corrective Action 

Insufficient signal can be addressed in 3 basic ways. 

• Increase the transmit power of the AP 

• Add additional APs to provided additional coverage 

• Reposition APs to avoid obstructions 

Increasing the transmit power of an AP is an option, but many APs transmit at their 

maximum power by default. Some APs support the use of external high-gain antennas 

which can also boost the strength of signal. However, use of these antennas is strictly 

regulated by the FCC, and users should be careful to stay within the boundaries of the law. 

Furthermore, high-gain antennas do not truly add any overall signal to the environment. 

They simply compress the signal that is already available. As a result, a high-gain antenna 

may improve signal in location and worsen it to another. 



AirMagnet Survey User Guide 

283 

Properly positioning APs is also an important step. Ideally, APs should have a clear “line of 

site” to the areas that they will serve. Installing APs on the ceiling or high on walls is often a 

helpful option when trying to avoid physical obstructions. 

If the measures described above do not alleviate the problem, it may be necessary to install 

an additional AP. When an AP is added to the environment, users should configure that AP 

to use a Wi-Fi channel that does not overlap with the APs that are already deployed. 

Signal-to-Noise Ratio Coverage 

Threshold: Min Signal-to-Noise Ratio 

Default value: 25 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas that meet the current Signal-to-Noise (SNR) coverage requirement are shown in light 

green (  ). Areas that do not meet the requirement are displayed using the color code on 

the slider bar on the right-hand side of the view. The weakest SNR values are shown in red. 

Let the mouse hover over any area of the map to show additional details. 

SNR Background 

SNR is a key measurement of the quality of the wireless signal transmission. A good SNR 

value means that a higher modulation and coding scheme (MCS) can be used which will 

increase the data rates over the wireless connection. 

SNR is measured in units of “dB”, representing the difference in a signal level measurement 

in dBm and a noise level measurement in dBm. For example, a signal level of -40 dBm and 

a noise level of -65 dBm results in an SNR of 25 dB. The minimum acceptable SNR will 

depend on the requirements of the network and how it is used. As a general rule, an SNR of 

25 dB or more is desired for good data rates. To achieve the higher data rates available in 

802.11n, and SNR of 27 is desired. To achieve the even higher rates available in 802.11ac, 

an SNR of 32 is desired. Keep in mind that data rates also depend on other factors such as 

channel width and the number of spatial streams. 

SNR is affected by two factors: the signal level from the transmitting AP or client, and the 

background noise level including noise from interferers. Providing higher signal levels and/or 

lower noise levels will improve SNR. See the sections on Signal Coverage and Noise Level 

for more details on these. 

Corrective Action 

Insufficient SNR can be addressed in several ways. 

• Increase the transmit power of the AP 

• Add additional APs to provided additional coverage 

• Reposition APs to avoid obstructions 

• Select a different WLAN channel that has less noise and interference 
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• Mitigate interference sources (remove or relocate them) 

Throughput Downlink Coverage 

Threshold: Min Downlink Throughput Supported 

Default value: 5.5 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for Min Downlink Throughput Rate 

Supported are displayed in light green (  ). Areas that do not meet the requirement are 

displayed according to the color code on the slider bar on the right-hand side of the view. 

This scale is shown in terms of Mbps. Let the mouse hover over any point of the map to 

show additional details. 

Tips 

When designing your Planner/Advisor project keep in mind the type of wireless traffic your 

project is expected to support. For example if the Wi-Fi usage is intended to support video 

traffic, then the Frame size required would most likely be a larger frame size. This is will 

change your throughput calculation. The larger frames will have less overhead while 

transferring data. If you intend to support VoFi traffic then you would want to use a smaller 

frame size to emulate typical VoFi packets. Smaller frame will provide less throughput 

mostly due to the increased overhead required to transfer data packets. 

Throughput calculations can provide a direct insight into how well the network will support a 

real-world end-user client. When creating virtual Survey’s with Planner/Advisor the Physical 

Data Rates are calculated from an Signal Strength to Data Rate mapping table. Then, take 

this number with the Selected (Frame Size) and calculate the Throughput rate the client can 

expect to see. 

User Capacity 

Thresholds: Maximum Users Supported per AP, With Load Balancing 

Default values: 15, True 

Pass/Fail default 100% 

Requirement Explanation 

Intelligent capacity planning is required for any wireless network that demands high 

availability or provides access to critical applications. The end result of capacity planning is 

to ensure that all network users have access to an adequate amount of bandwidth, and that 

wireless access points are arranged in a way to logically share the client load. 

To perform a capacity plan, the site surveying engineer should first establish the bandwidth 

that each end user will require in order to meet his or her networking needs. Once the 
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average end-user requirements are established, the engineer can then calculate the 

maximum number of end-user clients that should associate with an access point based on 

the total throughput available from the AP. With these two pieces of information, users can 

use AirMagnet Survey to map out a scientific capacity plan using the following steps. 

Identify key end-user client areas. This can be easily done by selecting  (Rectangular 

Region Tool) from the Toolbar, and then drawing a box covering the area where end users 

will be supported. Enter the number of users that will need to be supported in this area, and 

enter the length and width of the area in terms of end-users. Repeat this process until you 

have accounted for all the end users that the network will support and all locations. The 

program will automatically tell you right away whether the users are all covered or not. 

Using the "With Load Balancing" Threshold 

Note: Load Balancing refers to a setting that can be enabled on certain APs that support 

this feature.  Consequently, users should only enable this setting if they know that their 

network operates with APs that support and use load balancing. 

If the AirWISE requirement for "With Load Balancing" is set to "True", the AirWISE display 

will attempt to distribute the users in the defined areas evenly amongst the APs that cover 

that area.  For example, if there are three APs that all provide coverage to a given block of 

cubes with six users in them, each AP will have two users assigned to it.  If the "With Load 

Balancing" field is set to "False", the user stations will be assigned to whichever AP provides 

the strongest signal in their respective areas. 

Each end-user area is automatically broken into equal-sized cells that represent the area for 

each user. Areas in green ( ) meet the capacity requirements set in the application, while 

a red area ( ) will indicate a client that will be connected to an overloaded AP. An area that 

is grey in color ( ) means that NO Service is available in that area. Let your mouse hover 

over any area of the map to see the strongest AP at that location and any other APs that are 

operating nearby. Use the simulation tool to simulate the result of relocating the APs, 

adjusting AP power, and adding additional APs to meet the capacity requirements.  

VoFi Packet Retry 

Threshold: Maximum percentage of packet retry allowed 

Default value: 10% 

Pass/Fail default value: 100% 

Requirement Explanation 

The WLAN RF spectrum is open, dynamic, shared, and subject to noise, interference, packet 

collisions, multipath, hidden node syndrome, etc. When there are errors caused by any of 

the above issues, the transmitter of the error frame would not receive an 802.11 control 

frame called an acknowledgement frame. When there is no acknowledgement observed, 

the transmitter, assuming that the receiver did not receive the frame successfully, would re-

transmit the unacknowledged frame with the Retry bit in the frame set to one. This 

indicates a re-transmission. The figure below illustrates the Retry field in the 802.11 frame 

header. 
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Background 

The VoFi packet retry policy takes rates recorded from transactions from the phone to the 

AP (uplink) as well as those from the AP to the phone (downlink) into account when 

displaying these data. As shown in the legend bar on the right-hand portion of the view, the 

data rate is color-coded to display the combined status of the two transmission directions: 

• Areas of the map in which both uplink and downlink retry rates are good are 

displayed in light green ( ). 

• Areas in which the uplink retry rate is good but the downlink retry rate is not are 

displayed in yellow. 

• Areas in which the downlink retry rate is good but the uplink retry rate is not are 

displayed in orange. 

• Areas in which both uplink and downlink retry rates are bad are displayed in red. 

Let the mouse hover over any point of the map to show additional details. 

VoFi PHY Data Rate 

Threshold: Minimum data rate required 

Default value: 24.0 

Pass/Fail default value: 100% 

Requirement Explanation 

The VoFi PHY data rate policy takes rates recorded from transactions from the phone to the 

AP (uplink) as well as those from the AP to the phone (downlink) into account when 

displaying these data.  As shown in the legend bar on the right-hand portion of the view, 

the data rate is color-coded to display the combined status of the two transmission 

directions: 

• Areas of the map in which both uplink and downlink rates are good are displayed in 

light green ( ). 

• Areas in which the uplink rate is good but the downlink rate is not are displayed in 

yellow. 

• Areas in which the downlink rate is good but the uplink rate is not are displayed in 

orange. 

• Areas in which both uplink and downlink rates are bad are displayed in red. 
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Let the mouse hover over any point of the map to show additional details. 

Background 

Connection data rate provides a direct insight into how well the network will support a real-

world end-user phone.  A VoFi Survey is required in order to obtain connection speed 

data.  A low connection PHY data rate directly translates to lower throughput and 

performance for an end-user phone.  Consistently low connection data rates are indicative 

of either, insufficient signal coverage, interference, noise, or mis-configured wireless 

devices. 

The connection speeds supported by each of the 802.11 protocols are listed below: 

802.11 Standard Supported Speeds (in Mbps) 

802.11b 1, 2, 5.5, 11 

802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 

802.11a 6, 9, 12, 18, 24, 36, 48, 54 

802.11n 

1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50, 

14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 28.90, 

30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00, 

57.80, 58.50, 60.00, 65.00, 72.20, 78.00, 81.00, 86.70, 90.00, 

104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00, 

144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 180.00, 195.00, 

208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00, 

270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00, 

450.00, 480.00, 486.00, 540.00, 600.00 

End-user connection speeds change automatically from a higher connection data rate to a 

lower one in response to a deteriorating connection quality.  The best method for 

determining the real-world connection data rate at a given location is to perform a VoFi 

Survey.  During a VoFi Survey, the surveyor “follows” the AP’s connection to the phone and 

actively collects real connection data such as connection data rate. 

VoFi Signal Coverage 

Threshold: Minimum AP signal strength required 

Default value: -67 dBm 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas that meet the current RF coverage requirement are shown in light green ( ). Areas 

that do not meet the requirement are displayed using the color code on the slider bar on the 

right-hand side of the view. The weakest signals are shown in red. Let the mouse hover 

over any point of the map to show additional details. 

RF Coverage Background 
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RF signals are the basis for Wi-Fi communication in the same way that copper wire is the 

basis for traditional networks. Each wireless client (such as an end-user) must receive 

adequate levels of RF signal from its Access Point in order to insure a reliable and well-

performing connection. 

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and 

signals of -100 dBm and below being the weakest. The minimum acceptable signal will 

depend on the requirements of the network and how it is used. As a general rule, data 

clients should maintain a signal of at least -76 dBm. Voice clients require a stronger signal 

and should maintain a signal of at least -67 dBm. 

RF signals can be significantly affected by environmental factors. Solid objects will attenuate 

and reflect RF signals, which can cause RF “dead spots” in otherwise well-served areas. For 

this reason, it is important to carefully survey areas where wireless clients will need network 

service. Surveyors should pay special attention to the areas around, and in the line of site of 

physical obstructions. Typical obstructions include any solid metal object, solid walls, 

elevator shafts, and any shielded room such as an x-ray room. 

VoFi-Specific Coverage Data 

In contrast to the general Signal Coverage requirement, the VoFi Signal Coverage 

represents the information gathered from the AP to which the VoFi phone is associated 

during the survey process.  Consequently, it should not be interpreted as representing all 

coverage detected on the VoFi deployment; other VoFi APs may be placed in the vicinity of 

the survey path but not displayed since the phone did not associate with them during the 

survey. 

WiMOS Coverage 

Threshold: Minimum WiMOS coverage required 

Default value: 4.0 

Pass/Fail default value: 100% 

Requirement Explanation 

Areas of the map that meet the current requirement for desired WiMOS Score are displayed 

in light green ( ). Areas that do not meet the requirement are displayed according to the 

color code on the slider bar on the right-hand side of the view. The lowest WiMOS scores 

are shown in red. Let the mouse hover over any ppint of the map to show additional details. 

Background 

VoFi call quality can be indicated by several different parameters, one of which is the 

Wireless Mean Opinion Score (WiMOS), a numerical measurement similar to the MOS value 

assigned to calls performed on wired networks. WiMOS scores are the most commonly used 

way by which respondents are asked to rate the quality of a call (that is, how it sounds) on 

a 1 (bad) to 5 (excellent) scale. Anything that is above 4 is considered excellent. However, 

such rating is in and of itself very subjective due to the lack of an objective and scientific 

methodology. 
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Lower WiMOS may lead to choppy audio, one-way conversations, and ultimately even calls 

getting dropped entirely. 

User Satisfaction WiMOS Score 

Unacceptable 1.0 ~ 1.9 

Mildly dissatisfied 2.0 ~ 2.9 

Slightly dissatisfied 3.0 ~3.9 

Completely satisfied 4.0 ~ 4.5 

Cisco Location-based Services 

Threshold: Number of placed APs required to provide coverage, AP signal strength required 

to provide coverage 

Default Value: 3, -75 

Minimum APs: 3, Maximum APs: 16 

Minimum signal strength: -85dBm, Maximum signal strength: 0 

Pass/Fail default value: 100% 

Requirement Explanation 

If three APs or more, that are placed on the floor plan, create a "convex hull" configuration 

(see diagram below) and meet the requirements for location-based services coverage 

(readiness), the convex hull area will be displayed as green. The non-compliant area 

(outside the hull) is displayed as pink. 

The creation of a convex hull requires at least three placed APs on the floor plan to form the 

hull. In addition, any location point within the hull must not have a signal strength weaker 

than the defined minimum signal strength value (based on the placed APs).  Both of these 

requirements must be met in order for the hull to be considered "ready" for location-based 

services. 

However, if signal strength drops below the minimum requirement and/or AP count drops 

below the requirement inside the hull, these locations will be color-coded as indicated by the 

legend. 

To view areas in terms of AP count, click the "Number of placed APs required to provide 

coverage" row in the thresholds area, just below this view. To see how close the actual AP 

signal is to your requirement, click the "AP signal strength required to provide coverage" 

row in the thresholds area. Let the mouse hover over any point of the map to show 

additional details. For the purpose of this requirement, any placed APs closer together than 

one meter are considered as one physical AP. 

The “% of Good Area” indicates the area of the floor plan that meets the requirements. To 

determine the percentage of good area within the convex hull you may use the “Arbitrary 

Region Tool” to outline the convex hull and create a region. 

Note: After conducting a survey, you must place all the APs intended for Cisco Location-

based services on the floor plan. Refer to Channel/SSID List. 
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Legend explanation 

Item Description 

Green 
Both the number of APs and signal strength threshold criteria are 

met. 

Pink Area outside the convex hull. 

Silver (gray) 
All the APs meet the signal strength threshold; however, the 

number of APs requirement is not met. 

With Signal Strength 

requirement selected. 

Colors besides green or gray inside the hull indicate the strongest 

signal strength in areas where the AP requirement and/or signal 

strength threshold are not met. 

With AP requirement 

selected. 

Colors (besides green) indicate areas where either the total 

number of APs making up the hull falls below the requirement or 

the number of APs providing the required signal strength coverage 

falls below the requirement. 

Background 

Location-based services generally involve determining the geographical location of assets or 

persons. Some applications of location-based services include RFID tracking solutions; 

location monitoring of Voice-over-Wi-Fi phones; and locating rogue access points. 

Proper placement of access points is an important consideration for planning location-based 

services (such as a location-aware Cisco Unified Wireless Network). 

This policy applies the "convex hull" technique for determining compliance. The convex hull 

technique involves establishing a perimeter of at least three placed APs in which one could 

imagine a rubber band wrapped around the "outside" APs. As you move an AP, the 

perimeter border (rubber band) adjusts accordingly. 

The interior area encompassed by this band can be considered as possessing high potential 

for good location accuracy. As tracked devices stray into the area outside the convex hull, 

accuracy can begin to deteriorate. 

 

Cisco recommendations 

This section contains an excerpt from "Best Practices—Location-Aware WLAN Design 

Considerations" Used by permission © Cisco, Inc. All rights reserved. 
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For Cisco "Location-aware" deployments, Cisco recommends that designs that make use of 

only clustered or straight-line access point placement should be augmented or redesigned in 

favor of those that combine center access-point placement with perimeter and corner 

placement. 

 

If possible, mount antennas such that they have an unencumbered 360º view of all areas 

around them, without being blocked at close range by large objects. For example, if 

possible, avoid placing access point antennas directly against large objects such as steel 

columns. One option is to mount the access point along with its antennas to a ceiling 

location (provided that this allows an acceptable mounting height). Another option is to use 

short, low loss cable extension to allow separation between antennas and such obstructions. 

In general, for access points deployed indoors at antenna heights of 20 feet or less, the 

range of any point on the floor to at least three detecting access points on that floor (one in 

each of at least three of the four quadrants surrounding it) is maintained within 

approximately 70 feet in an indoor environment. This is a general recommendation that is 

intended to assist designers in avoiding situations where excessive inter-access point 

distance may be a contributing factor to location inaccuracy. 

Corrective Actions 

Users have 3 basic options to insure location-based coverage readiness: 

• Increase the transmit power of existing APs 

• Reposition APs to meet requirements 

• Add additional APs 

Increasing the transmit power of an AP is an option, but many APs transmit at their 

maximum power by default. Some APs support the use of external high-gain antennas 

which can also boost the strength of signal. However, use of these antennas is strictly 

regulated by the FCC, and users should be careful to stay within the boundaries of the law. 

Furthermore, high-gain antennas do not truly add any overall signal to the environment. 

They simply compress the signal that is already available. As a result, a high-gain antenna 

may improve signal in location and worsen it to another. 
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Properly positioning APs is also an important step. Ideally, APs should have a clear “line of 

site” to the areas that they will serve. Installing APs on the ceiling or high on walls is often a 

helpful option when trying to avoid physical obstructions. 

If the measures described above do not alleviate the problem, it may be necessary to install 

an additional AP. When an AP is added to the environment, users should configure that AP 

to use a Wi-Fi channel that does not overlap with the APs that are already deployed. 
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MultiView View 

MultiView Map Window 

The MultiView map window displays the site maps for up to four different surveys at a 

time. When multiple surveys are loaded, each pane in the window acts individually, allowing 

the user to view different survey data files in each pane. The currently active pane is 

highlighted by a blue box, as shown below. 

 

Project Window 

The Project Window on the MultiView view displays all the survey projects that you have 

opened (imported), including the individual components in each project. 
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Note: AirMagnet Survey displays multiple survey projects in the order they are opened, 

with the one that is opened first placed on top of the list of projects in the Project 

Window. For this reason, the main project should appear on the top because it is 

supposed to be opened first. 

Channel/SSID Tree 

The Channel/SSID Tree on the MultiView view shows the APs and SSIDs detected in the 

current data file(s). The following figure illustrates how channels and SSIDs are organized 

under their respective projects. This makes it easy to view, check and uncheck APs and 

SSIDs as desired to see how changes are reflected in multiple surveys. 
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The Toolbar includes Automatic Multi Select . This feature enables you to turn the 

automatic selection feature on or off. With it turned on, data about the APs selected in one 

Map Window will automatically show up in the other Map Window(s) if its RF signals are also 

contained (collected) in the subproject(s). This enables you to easily visualize and compare 

how RF signals propagate across the floors. 

File Menu 

The File menu in MultiView includes the following options: 

Import MultiView Project: Use this option to import up to four projects for MultiView 

comparison. 

Close Subproject: Enables you to select a subproject file to close without closing the entire 

survey project. 

View Menu 

The View menu on the MultiView view includes the following options: 

Swap Left/Right Views: Toggles two images left and right. 

Swap Top/Bottom Views: Toggles two images up and down. 

MultiView Toolbar 

The toolbar contains the commonly used tools for analyzing multi-floor data. Most of these 

tools are identical to the options found in the File or View menus of the view. Some 

additional tools for Multiview are described in the following table: 
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Icon Name Description 

 

Open 

Subproject 

Allows you to select and open a subproject of a multi-floor survey 

project. 

 

Four View 
Displays the site maps used in a multi-floor project in four separate mini 

windows. 

 

Swap 

Left/Right 
Toggles two images between left and right. 

 

Swap 

Top/Bottom 
Toggles two images between up and down. 

 

Automatic 

Multi Select 

Turn the automatic selection feature on or off. With it turned on, data 

about the APs selected in one Map Window will automatically show up in 

the other Map Window(s). Refer to Channel/SSID Tree. 

Single Project in MultiView 

When you import additional project in MultiView, you may also choose to view a single 

project in the four different panes. 

To view a single project in multi-view mode: 

1. Open the Project Import view. 

2. Check the box for the file you wish to view (you may need to browse to find the 

project to import). 

3. Check the “Single Project Multi View” box at the bottom. 

4. Click Import. You will now see the single project you loaded displayed in all four 

panes. 



AirMagnet Survey User Guide 

297 

 

5. Click the radio buttons for the survey data you wish to load in each individual pane. 

Select your desired view options. 

Opening Multi-Floor Survey Projects 

The MultiView view is used for analyzing whether APs on a certain floor can provide RF 

signals strong enough to cover wireless stations on floors above and/or below and how APs 

on adjacent floors could interfere with one another in terms of channel allocation, service 

quality, network security, etc. However, in order to analyze RF data across multiple floors in 

a single building, you must collect data from each of the floors involved. This means that 

you first of all need to create a Survey project for each of the floors, perform the site 

surveys individually floor by floor, and save the survey data for each floor separately. Once 

data are collected, you need to open the one of the Survey projects first on the Display 
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view, and then bring up the MultiView view to open (import) the other survey projects. After 

all the projects are loaded on the MultiView view, you can use the tools on the view to 

analyze the data. 

The following procedures show how to open and analyze survey data involving multiple 

floors. 

To analyze multi-floor survey data: 

1. From the Display view, click File>Open Project.... The Open dialog box appears. 

2. Browse to a Survey project (svp) file and click Open. The project opens on the 

Display view. 

3. Click the radio button in front of the Survey Data file. The data loads. 

4. Click  on the Navigation bar. The MultiView view opens with the 

project displayed. 

6. To import additional floors, click File>Import Multi-Project…. The Project Import 

window appears. 

 

7. Click the check box(es) corresponding to the subproject file(s) you wish to import, 

and click Import. The selected project file(s) appear on the Multi View view. 

Note: A “main project” is the survey project that you first open on the Display view. Any 

survey project that is opened (imported) afterwards on the MultiView view is a 

“subproject”. AirMagnet Survey PRO allows you to display multi-floor survey data for up 

to four floors on the MultiView view at the same time.  For better data representation, it 

is recommended that you merge all the survey data for each floor to create a merged file 

and then compare the merged files on the Multi View view. 

The MultiView view can also help users compare several different surveys within a single 

project, using the Single Project Multi View function. 

Analyzing RF Data Across all Floors 

After all the data are opened on the MultiView view, the next step is to use the tools 

available on the view to analyze them, just as you do on the Display view. 
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Click a single map window to make it the focus. Any options are then applied to that Map 

window. 

Note: Analyzing survey data involving multiple floors basically uses the same tools and 

follows the same procedures as surveying a single floor. Therefore, you may want to see 

the Display view for ways to analyze survey data. 
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Reports 

Reports Introduction 

The Reports feature enables you to generate a report based on the data file selected in the 

Display view.   

A variety of pre-configured reports are available. The following options enable you to 

customize any report: 

• Edit an existing report by adding and/or removing sections. 

• Duplicate a report and modify the duplicate. 

• Start with a blank report and add desired sections. 

• Revise the text of any heading and/or section content. 

• Localize a report automatically to any of the following languages: English, German, 

French, Arabic, Russian, and Japanese. Additionally, manually revise any translated 

text. 

• Localize a report by manually modifying any or all text to the target language. 

• Customize the Title Page graphics 

• Customize to show/hide cover page, table of contents, header, footer, page number, 

and each section’s title and contexts. 

You can access the Reports view by clicking Reports on the navigation bar. 

Double-click a report to generate it. The generated report will be displayed in the main 

view. 
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File Menu 

The Reports File menu includes some options for managing and distributing survey data 

reports. 

Option Description 

Report 

configuration... 

Opens the General Information tab in the Report Template manager where 

you can modify aspects of the report, including logo, footer, and location. 

ACL... 

Opens the ACL (Access Control List) window where you can add APs to or 

delete them from the ACL table. This feature enables you to categorize 

access points discovered during a survey into two groups: those that you 

manage (ACL) and those that you do not manage. Non-ACL access points 

include those from your neighboring businesses and rogue access points.  

Click Add"to display a list of Access Points contained in the survey. Check 

the APs you want to include in ACL. Click OK. If the ACL feature is used, the 

report will sort the APs into these two groups. 

Print... Allows you to print the current report. 
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Print Setup... Allows you to configure the printing settings of the current report. 

View Menu 

The View menu on the Reports view provides an additional option: 

Landscape Orientation: Switch the report orientation from portrait to landscape. Once in 

Landscape orientation, the report may be changed back to Portrait orientation by 

unselecting Landscape Orientation. 

Report Template List 

The Report List displays the Report Templates. Each template is pre-configured to generate 

a report containing topics relevant to the title of the report (for example, Passive Survey 

Report). However, you may fully customize any report to meet your needs. 

Note: A report is based on the selected data file in Display view. Therefore, the report 

may only contain data included in that data file. For example, your report cannot contain 

VoFi information if the associated data file does not contain a VoFi survey. 

 

Within the Report List, the following actions are available: 

Item Description 

or right-click the "Reports" 

folder and select "New 

Custom Report Template" 

Add a new, blank template or copy an existing template. 

Type a name for the template. Choose "none" for a blank 

template or choose a listing from the drop-down to create a 

duplicate template. Click OK. 

or right-click and select 

Edit 
Edit the selected template. 
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or right-click and select 

Delete 

Delete the selected template. Once deleted, the template 

cannot be restored unless the product is re-installed. 

Right-click and select Rename Rename the selected template. 

Right-click and select Export 

Export the selected template. A browse dialog is opened to 

enable the export of the selected template in ZIP format to a 

desired directory location. 

Import 

Right-click the "Reports" folder, select "Import Custom 

Report Template" and browse to the desired ZIP file. Click 

Open. 

  

Customizing a Report Template 

If you choose to Edit or Create a report template (refer to Report List), the Create Custom 

Report Template manager opens with the Report Template tab displayed. 

• If you chose to Create a new template, the left-side of the manager will be empty. 

This enables you to build the template by adding the desired section from the 

Available Categories section. 

• If you chose to Edit a template, the left-side of the manager will contain the pre-

configured sections associated with the template title. You may choose to remove 

undesired sections from the Custom Report Template area on the left and/or you 

may add sections from the Available Categories list. 
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1. To subtract a section from the report, locate the desired section by expanding the 

Custom Report Template tree. Select the section. Click the right facing arrow to 

move the section to Available Categories. 

2. To add a section to the report, locate the desired section by expanding the 

Available Categories tree. Select the section. Click the left facing arrow to move 

the section to Custom Report Template. 

3. You may also modify any of the default description text associated with section. 

Select the section in the Custom Report Template tree. This will display the text (if 

any) in the description area at the bottom. Modify the text. 

4. Click OK to save changes 

General information 

Click the General Information tab to customize information such as the survey title, 

surveyor name, survey location, custom report header and footer, and so on. 

This tab also includes the Translation button that enables some additional translation 

features. Refer to Report Translation. 
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After modifying the properties desired, the user can preview a sample of the report’s cover 

sheet in the right-hand portion of the window by clicking Preview Cover Sheet. The table 

below describes the fields available for customization. 

Field Description 

Survey Title 

The title of the survey. Note that this differs from the name of the 

template in that the Survey Title will be printed on the cover page of 

the report itself. 

Surveyor Name The name of the person who conducted the survey. 

Location The location at which the survey was taken. 

Company The company for which the survey was conducted. 

Date The date of the survey. 

Cover Sheet Picture 

The picture that will be displayed on the cover sheet of the finished 

report. Recommended size is 650w x 400h pixels. This image will 

appear in the cover sheet of all reports. BMP, JPG, PNG and GIF are 

supported. When browsing for an image, be sure to select the correct 

image type desired from drop-down. 

Corporate Logo 

If desired, users can specify a logo to be displayed in the lower-right 

corner of the cover page. Recommended size is 164w x 164h pixels. 

This image will appear in the cover sheet of all reports. BMP, JPG, 

PNG and GIF are supported. When browsing for an image, be sure to 

select the correct image type desired from drop-down. 
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Individual 

Distribution 

This option allows the user to force the report to display a limited 

number of APs in each heatmap display.  In this manner, users can 

view fewer devices per page and get a better idea of each AP's 

coverage area.  This mechanism can be enabled for any or all of the 

heatmaps displayed within the report. 

Translation 
Enables report text to be localized to the language of choice. Refer to 

Report Translation. 

Report Page Header 

& Footer 

If desired, users can enter text to appear in the header and footer 

portions of the report. This will be displayed in addition to the default 

page number shown on all reports. 

Include Cover Page, 

Data Filename, Table 

of Contents, Section 

Headers and Text, 

Page 

Headers/Footers, and 

Page Number  

Check the corresponding boxes to include/hide different parts of 

report.  

  

Report Translation 

Within the Report Template manager, there are some options available for enabling you to 

localize a report to a desired language. 

By default, the Windows setting for "Display Language" is presented, so translation in this 

regard refers to editing text. 

Note: Before modifying a template, you may find it desirable to first duplicate a report 

template and include the desired language in the file name, for example, Passive Survey 

(German). 

• Default Report Language: This drop-down, located on the Report Template tab, 

enables you to view report text in the following languages: English, German, French, 

Arabic, Russian, and Japanese. After selecting a language option from the drop-

down, click Restore Default to apply the language to any sections in the Custom 

Report Template area of the template manager. 

• Manually edit any text: You may manually edit the text in any section by selecting 

the section and then editing the text that appears in the text editor area (the lower 

section of the template manager). 

• Manually edit any header text (category headers): right-click a heading in the 

Custom Report Template area of the template manager. Select Rename and type 

the desired text. 

• Incidental items on the report pages: Additionally, there is some incidental text 

in the report not included in the methods above. From the General Information 

tab, click Translation. Translate the items in the left column into the desired 

language using the fields in the right column. 
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Once translation is completed, click OK to save any changes and close the Report Template 

manager. 

  

Channel/SSID Tree 

This part of the Reports view allows you to tailor the content of the report. In general, the 

reports can be displayed by channel or by SSID. You can toggle between the two by clicking 

.  The image below shows all the APs on each available channel as well 

as the SSID and maximum RF signal level of each AP. 

 

As seen above, there are check boxes above the Channel/SSID Tree: 
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• Select All: This function enables you to select or deselect all entries on the 

Channel/SSID Tree with a click of the button. By default, all the entries in the 

Channels/SSID Tree are selected when the Reports view opens. It is a good idea to 

use this button to deselect all the entries and then manually select only the entries in 

which you are interested. In this way you can customize your survey data reports 

using data about the selected devices. 

• 2.4 GHz: This checkbox selects only the channels in the 2.4-GHz band. 

• 5 GHz: This checkbox selects only the channels in the 5-GHz band. 

Report Window 

The Report Window displays the report based on the options selected from the Report List 

and Channel/SSID Tree.  There are a number of tools across the top of the Report Window. 

They are specifically designed for viewing and sharing survey data reports, as described 

below. 

 

  

Icon Name Description 
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Export 
Brings up the Export dialog box which allows you to export the 

current report to a specific destination in a selected format. 

 

To First 

Page 
Allows you to move to the beginning of the current report. 

 

Back Allows you to return to the previous page of the report. 

 

Page 

Count 

Shows the total number of pages contained in the current report 

and the page you are viewing.  

Note: You can directly navigate to a specific page in the report by 

highlighting the current page number and then entering the page 

number of interest and pressing the Enter key on your keyboard. 

 

Forward Allows you to move to the following page of the report. 

 

To Last 

Page 
Allows you to move to the end of the current report. 

Toolbar 

The toolbar contains the commonly used tools for viewing and printing reports. Most of 

these tools are identical to the options found in the File or View menus of the view. 

Icon Name Description 

 

Zoom In Enlarges the size of the current report on the view. 

 

Zoom Out Reduces the size of the current report on the view. 

 

Zoom to Fit Fits the current report to the size of the Report Window. 

 

Actual Size Resets the current report to actual printing size. 

 

Refresh 

Report 
Refreshes the data in the current report. 

 

Report 

Information 

Opens the Report Configuration view, where you can specify or modify 

information that appears on the reports to be generated. 

 

ACL 
Opens the ACL window, where you can add or delete APs from the ACL 

table. 

 

Landscape 
Allows you to switch the orientation of the report on the view between 

portrait (default) and landscape. 

 

Print Allows you to print the current report. 

Viewing Survey Data Reports 

The following are the general procedures for viewing a data report: 

1. While in the Display view, open a survey data file. 
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2. From the Navigation bar, click . The Reports view appears. 

3. From the Report List, select a report. 

4. From the Channel/SSID Tree, click the Channel or SSID tab. 

5. Use the controls on the view to adjust your viewing options. 

The heatmap colors displayed in reports are somewhat dependent on monitor display 

settings.  

Printing Reports 

To print a survey data report: 

1. From the Report List Window, double-click to open a report. 

2. Click  (Print Report). The Print view appears. 

3. Make the selections and/or entries as shown on the view, and click OK. 

Exporting Reports 

You can export reports in more than a dozen electronic file formats and to a number of 

destinations. This makes it possible to share and back up your survey data with ease. 

To export a survey data report: 

1. Customize the report, if necessary, using the Channel/SSID Tree. 

2. Double-click the desired report from the Report List Window. 

3. Click   (Export Report). The Export view appears. 

4. Click the Format down arrow and select a file format from the drop-down list. 

5. Click the Destination down arrow and select a destination for the file to be 

exported. 

6. Click OK. The Export Options dialog box appears. 

7. Select one of the export options and click OK. 

Note: Depending on the option you select in Step 5, the report can be exported to a disk 

drive or sent out as an email attachment. You can then open and view the report in the 

format you have selected, provided that you have the application that supports it (file 

format). 
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Using WLAN Tools 

Main Topics 

This section describes the four important diagnostic tools AirMagnet Survey provides for 

evaluating and troubleshooting a WLAN.  All these tools can be accessed from the Tools 

window. 

• Signal Distribution 

• DHCP 

• Ping 

• GPS Information 

Signal Distribution 

The Signal Distribution tool is designed to enable WLAN professionals to detect RF signal 

problems (for example, signal multipath) by visually analyzing RF signal distribution 

patterns. The sample image below shows healthy signal distribution as indicated by the 

yellow dashed lines clustering within a single range. In case of multipath, the yellow dashed 

lines would be scattered all over the chart. 

To access the Signal Distribution tool: 

1. From the Toolobar, click   (Tools). The Tools window appears. By default, the 

Signal Dist. tab (Signal Distribution) is automatically selected when the Tools 

window opens. 
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2. Click the down arrow in the upper-left corner of the window to select AP or STA. 

3. Click the down arrow in the upper-right corner, and select the AP or STA to be 

analyzed. 

4. Click Logging Option. The Signal Distribution Option window appears. 

 

5. Make the desired selections and click OK. 

6. From the lower-right corner of the Tools window, select either or both of the 

following: 

o Signal 
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o Noise 

7. Click Go. The signal distribution pattern of the selected AP or STA will be plotted on 

the chart. 

Using the DHCP Tool 

WLAN connectivity problems can arise from 802.11 data link layer malfunction or IP network 

layer misconfiguration. In order to troubleshoot and pinpoint the cause of the problems, the 

interaction between the two network layers must be investigated. AirMagnet Survey’s 

embedded DHCP tool emulates a WLAN client acquiring IP-level connectivity beginning from 

the initial 802.11 client association procedure. 

To access the DHCP tool: 

1. From the Tools window, click the DHCP tab. The Tools window refreshes. 

 

2. From the top left corner of the Tools window, click the down arrow to select AP or 

SSID. 

3. From the top right corner of the Tools window, click the down arrow and select the 

AP or SSID from the drop-down list. 

4. Click Start. AirMagnet Survey will start associating with the selected AP or SSID and 

perform the tests. 
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Note: During the association, AirMagnet Survey uses the 802.11 configuration 

parameters for the AP or SSID, which can be accessed using File>Configure…>802.11. 

The associated AP or SSID will be shown on the view. An error message will pop up on 

the view if an unintended AP is associated or the intended association fails. This serves as 

a confirmation that a data link layer problem exists. 

5. Verify the DHCP acquisition of the IP address for the client service, default gateway, 

and DNS server. 

6. Click Renew to initiate the DHCP request once the association with the intended AP 

has been confirmed. The following IP-level configuration parameters will be filled in 

on the view if DHCP request/reply is successful: 

o Device IP address 

o Subnet mask 

o Default gateway 

o DNS server 

If it turns out that these parameters are NOT the ones you expected or if you received a 

DHCP failure message, the chances are that there is an error in the WEP key configuration. 

If the problem persists after you have verified the correct WEP key, there might be a 

problem with the DHCP server. 

Using the Ping Tool 

You can add a Ping test to DHCP test to verify end-to-end connectivity. It is used after all 

the IP configuration parameters are collected and confirmed using DHCP. 

To add a Ping test: 

1. From the Tools window, click the DHCP tab. 

2. Check the Ping option. 

2. Configure the following options: 

o AP/SSID 

o # Pings 

o Timeout 

o Delay 

o Length 

3. Enter the end node’s domain name, for example, www.yahoo.com. 

4. Click Go. Real-time Ping responses will appear on the view. 

Note: If the Ping test shows time-out, it means that the Ping connectivity with the local 

LAN has failed. In this case, you should check the health of the default gateway and the 

physical connection between the associated AP and the wired LAN. Enter a host name on 

your corporate network such as your internal Web server, for example, 

www.internal.My/computer.com, and click Go. 

Verifying GPS Information 
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This tool is used to verify if your AirMagnet Survey is receiving GPS signals. In order to use 

AirMagnet Survey to conduct large-scale, outdoor, GPS-aided site surveys, your Survey 

must be able to communicate with the GPS device it is connected with. When using GPS 

software in conjunction with AirMagnet Survey, the GPS software must receive GPS position 

data before the survey is started. 

Note: This feature is available only in Survey Pro and only when the GPS port is enabled. 

To verify GPS Information: 

From the Tools dialog box, click GPS Information. The Tools dialog box refreshes. 

 

Note: If your AirMagnet Survey is successfully connected to a GPS device, you will get a 

dialog box similar to the one shown above when you click the GPS Information tab. For 

more information, click here. 
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Calculating WLAN Parameters 

Calculating WLAN Parameters Introduction 

This section explains the calculation of some parameters critical to wireless network 

deployment, such as MilliWatt and dBm Conversion, System Operating Margin, Free Space 

Loss, Fresnel Zone, Downtilt Angle, and Downtilt Coverage. 

All the calculations are performed in the Calculator tool, which can be accessed by clicking 

 (Calculator) on the Toolbar. 

• Converting Between milliWatt and dBm 

• System Operating Margin 

• Free Space Loss 

• Fresnel Zone Clearance 

• Downtilt Angle 

• Downtilt Coverage 

Converting Between milliWatt and dBm 

The Milliwatts and dBm Conversion tab of the calculator provides two conversion operations: 

from dBm to milliWatt and from milliWatt to dBm. dBm is used to express an absolute value 

of power relative to a milliWatt.   
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To convert milliWatts to dBm: 

1. From the Calculator window, select the Milliwatts and dBm Conversion tab (if it 

not selected). By default, this tab is selected when the Calculator is launched. 

2. Under milliWatts to dBm, enter a value in milliWatts (from 0 to 1000). 

3. Click Calculate. The system will convert the value to dBm. 

To convert dBm to milliWatts: 

1. Under dBm to milliWatts, enter a value in dBm (from -100 to 100). 

2. Click Calculate. The system will convert the value to milliWatts. 

System Operating Margin 

System Operating Margin (SOM) is the difference between the signal a radio is actually 

receiving versus that which is needed for good data recovery (i.e, Receiver Sensitivity). It 

measures in dB the signal loss a system can sustain before it degrades to the error rate 

specified at the Receiver Sensitivity threshold. In another word, SOM takes into account all 

the gains and losses in the components (for example, transmitter power, type of antenna, 

distance, and so on.) that make up a wireless network system to make sure that the system 

has sufficient power to send radio signals to their destination. 

Normally, a minimum 20-dB SOM is recommended. However, due to factors such as 

inadequate Fresnel clearance, desensitization, and so on., many wireless network systems 

are designed with a 30 (or greater) dB SOM. SOM calculation assumes an interference-free 

open space. 
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To calculate System Operating Margin: 

1. Click the System Operating Margin tab. The Calculator window refreshes. 

2. Make the following entries: 

o Frequency 

o Power 

o Distance 

o Tx Cable Loss 

o Tx Antenna Gain 

o Rx Cable Loss 

o Rx Antenna Gain 

o Rx Sensitivity 

3. Click Calculate. The following values will be calculated: 

o Free Space Loss 

o Rx Signal Level 

o System Operating Margin 

Free Space Loss 

Free Space Loss refers to signal attenuation that would occur if all absorbing, diffracting, 

obstructing, refracting, scattering and reflecting influences were sufficiently removed to the 

extent that they have no effect on RF signal propagation. Free space loss is mainly caused 

by beam divergence, i.e., signal energy spreading over larger areas at increased distances 

from the source.   
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To Calculate the Free Space Loss: 

1. From the Calculator window, select the Free Space Loss tab. The Calculator 

window refreshes. 

2. Make the following entries: 

o Frequency 

o Distance 

3. Click Calculate. 

Fresnel Zone Clearance 

The line-of-sight condition between the transmitter and the receiver is crucial in high-

frequency radio communication. The Fresnel Zone is an elliptical-shaped area between two 

antennas where no obstacles may exist in order for radio signals to be transmitted. It 

defines how much clearance is needed for optimal radio transmission. By calculating the 

Fresnel Zone, you can determine antenna height so that radio signals can travel between 

the AP and the client stations without any obstacles.   
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To calculate Fresnel Zone: 

1. From the Calculator window, select the Fresnel Zone tab. The Calculator window 

refreshes. 

2. Make the following entries: 

o Distance 

o Frequency 

3. Click Calculate. The following values will be automatically calculated: 

o Fresnel Zone Radius 

o 60% Fresnel Zone Radius 

Downtilt Angle 

Antenna downtilt affects radio signals travelling between the transmitter and the receiver. 

As a rule of thumb, the higher the transmitter antenna and the shorter the distance, the 

more tilt is required. For instance, for a 30-meter high transmitting antenna, a 0.35-degree 

antenna tilt is required in order to reach a 12-meter high receiving antenna at a distance of 

3,000 meters.   
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To calculate the Downtilt Angle: 

1. From the Calculator window, select the Downtilt Angle tab. The Calculator window 

refreshes. 

2. Make the following entries: 

o Base Antenna Height 

o Remote Antenna Height 

o Distance 

o Angle 

3. Click Calculate. 

Downtilt Coverage 

Downtilt Coverage defines the area into which the antenna of an AP can beam.   
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To calculate the Downtilt Coverage: 

1. From the Calculator window, select the Downtilt Coverage tab. The Calculator 

window refreshes. 

2. Make the following entries: 

o Antenna Height 

o Downtilt Angle 

o Vertical Beam width 

3. Click Calculate. 
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Integrating Cisco Prime Infrastructure 

Introduction 

Whether you are enabling Cisco Prime Infrastructure to create a project from an AirMagnet 

Planner project or exporting the survey data as an XML file to export to Cisco Prime 

Infrastructure, this topic will help you easily integrate the two products. 

Note: To use Cisco Prime Infrastructure with AirMagnet Survey requires a Cisco 'Plus' 

license. 

AirMagnet Survey Project 

Step 1 - Applying a Cisco Patch for Cisco WCS 

This step explains how to create a new AirMagnet Survey project. 

Prior to creating a new AirMagnet Survey project, a mandatory Cisco WCS patch to allow 

AirMagnet Survey PRO integration with Cisco WCS must be applied. This patch is not 

required for Cisco Prime NCS. Once the patch has been applied, you will be able to generate 

a CSV file from Cisco WCS to be used to create a Cisco Prime Infrastructure Survey project 

in AirMagnet Survey. The patch and instructions to apply the patch are as follows: 

Note: Instructions are also located in the AirMagnet Survey installation folder under the 

folder Cisco-WCS. The filename is Cisco_WCS_Readme. 

1. On the system running Cisco WCS, go to the <WCS Install Dir> and unzip the file 

"patch.zip". 

2. Restart Cisco WCS. 

3. Login to Cisco WCS and go to the following URL: https://<WCS 

IP>/webacs/ncsDiag.do 

4. Click the <AirMagnet Query Tool> and follow instructions. 

Step 2 - Exporting the Cisco Prime Infrastructure Site 

You need to download an existing Cisco Prime Infrastructure site as a .tar file. Make sure 

the APs are placed in the correct location on the floor plan in the Cisco Prime Infrastructure 

site, as follows: 

1. Login to Cisco Prime Infrastructure and go the following URL: https://<WCS 

IP>/webacs/ncsDiag.do, where <WCS IP> is the IP address of the Cisco Prime 

Infrastructure. Note: The URL is case sensitive. 

2. Click AirMagnet Tool and use the drop-down menu to select the site, building and 

floor you would like to use. Click Export CSV.. 
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3. A window will appear. Save the .tar.gz folder. 

4. Unzip the .tar.gz file onto the local machine hosting AirMagnet Survey. 

5. Unzip the resulting .tar file onto the local machine hosting Airmagnet Survey. 

6. Export each floor to a separate folder. 

Step 3 - Creating a Cisco Prime Infrastructure Survey Project in AirMagnet Survey 

From the AirMagnet Survey application, do one of the following: 

1. From the Main Menu, select File>New Project, or 

2. From the Toolbar, click  (Project Wizard). 

The New Project Wizard view appears. See Figure below. 

 

3. Where it says "Specify Project Name", enter a unique name for the new project. 

4. Select the Cisco Prime Infrastructure Survey Project type. 

5. Save the project using one of the following options: 
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• To save the project to the default location, simply click Next. The New Project 

Wizard view refreshes. 

• To save the project to a location other than the default, click  to specify a 

location of your choice, and then click Next. The New Project Wizard view refreshes. 

By default, AirMagnet Survey automatically saves the project to the C drive on your 

computer, using the name you specify. Check "Set as default project directory" to ensure 

that subsequent AirMagnet Survey projects are saved to the same location, if desired. If you 

go inside a directory to create a project, it will not work. You need to browse and select a 

directory (folder) that AirMagnet Survey will create inside the folder you choose. 

 

6. Click  to locate and import the unzipped Cisco Prime Infrastrucure site folder 

location. 

Note: Be sure to select at the folder level and not the individual extracted file. It will 

contain a floorplan and a .csv file. 
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7. Once located, click Select. 

8. The wizard then populates the unit of measurement and floor plan dimensions info 

into the UI. 

9. Click Next. The New Project Wizard view refreshes. Refer to the figure below. 

 

10. For Survey Environment, select an option that resembles the site environment 

where the survey is to be conducted. 

11. For Signal Propagation Assessment, do nothing (normally), since AirMagnet 

Survey can automatically assign the value according to the site environment you 

select. 

AirMagnet Survey assigns the Signal Propagation Assessment value based on the estimate 

of the distance RF signals could travel in each of these typical site environments. Normally, 
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AirMagnet recommends that you accept the default value the program assigns. However, if 

you want to set a value of your own, you must be aware that the value you enter will affect 

the way the program interpolates site data. 

12. For AP Default Power, do nothing (normally). 

If you know the value of the AP power, enter it now. The value will be used when 

conducting data simulation. 

13. Click Next. The New Project Wizard view refreshes. 

 

14. In the Enter Descriptive Text field, type a brief description of the project. 

(Optional.) 

Note: Cisco Prime Infrastructure requires a minimum of 150 data points and at least 50 

distinct locations for calibration. In addition, each distinct location needs to be at least 8 

feet apart. Therefore, when performing AirMagnet surveys, be sure you have at least 150 

data points and 50 distinct locations (where each location is at least 8 feet apart) for the 

AP that was placed in the Cisco Prime Infrastructure site. When exporting survey data 

(Cisco Prime Infrastructure Export> Survey Export) the total number of data points 

exported will be displayed. 

15. Click Finish. The newly created AirMagnet Survey project automatically appears in 

the Project Window, and the site map is displayed in the Map Window. 

Note: AirMagnet Survey will not show the location of the imported APs in the survey or 

display pages (or any other page). Also, APs you manually placed within AirMagnet 

Survey will be ignored when doing the export back to Cisco Prime Infrastructure. 
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Note: You can create as many projects as needed by following the same procedures 

outlined above. By default, a new project will automatically open on the Display view as 

soon as it is created. 

Step 4- Performing Surveys 

You can now perform surveys. Once you have performed your survey, you can export them 

from AirMagnet Survey and then import them into Cisco Prime Infrastructure. 

Step 5- Exporting out of AirMagnet Survey 

To export the collected survey data as an XML file: 

1. Open the Cisco Prime Infrastructure AirMagnet Survey project. 

2. On the navigation bar, select the Display view. 

3. Load the data file you wish to export. 

4. Click File, then select Cisco Prime Infrastructure Export.  

5. Click Survey Export. The Survey Export Folder view appears. 
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5. Click  to choose the folder to where you would like the survey data exported.  

6. Enter a name for the zip file. 

7. Click OK. 

The survey has now been exported. The zip file contains the folder xmlDir. This is the file 

you will use to import into Cisco Prime Infrastructure. 

Step 6- Importing into Cisco Prime Infrastructure 

1. Log onto Cisco Prime Infrastructure. 

2. Select Monitor> Maps [for NCS select Site Maps] from the Navigation bar on the 

top of the page. 

3. Select Import Maps from the drop-down menu on the right of the page and click 

GO. 

4. Select XML format, then click Next. 

5. Browse to .zip file containing the exported survey data. 

6. Click Next. The following error message may appear "images not found in imported 

file". This is expected behavior. Click OK. 

7. Scroll to the bottom of the page and click Next. 

8. Click OK. 

 

Import Maps Error Page 

Important: When importing the XML file into Cisco WCS: If the calibration model doesn't 

exist, the calibration model will be created, however, the data points will not get 

imported. To overcome this limitation: Import the XML file again. After validation is 

completed, choose the overwrite option. Doing this will create the data points. The 

calibration model will then automatically reference the floor (based on the floor reference 

provided in the XML file. This is not required for Cisco Prime NCS. 
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9. Select RF Calibration Models from the Monitor Maps page [for NCS select Site 

Maps]. 

10. Click GO. 

11. Click the AirMagnet Survey link. 

 

12. Select Calibrate. Click GO. 

Once completed, status shows Calibrated. 

 

13. Select Apply to Maps -> Click GO. This will apply AirMagnet Survey results to Cisco 

maps. 

14. Select Floor Area in the "Apply to" field. 

15. Select Campus (in example is AirMagnet Sunnyvale). 
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16. Select Building (in example is Engineering). 

17. Enable the map by checking the line item (for example, lobby). Refer to the figure 

below. 

 

18. Click Apply. 

19. When completed, the following window displays. -> Click OK. 

 

20. From Maps Tree View, expand the project (AirMagnet Sunnyvale) to the floor level 

and select the Floor Level (in example is Lobby) 

21. The heatmap displays. 

AirMagnet Planner Project 

Step 1 - Creating a new Cisco Prime Infrastructure Planner Project within the 
AirMagnet Survey application 

Note: You may see an error in Cisco WCS when importing a Cisco WCS Planner project 

which uses a CAD image.  In this case, refer to the Cisco WCS Version 7.0 MR1 Release 

Note for the workaround. 

1. From the AirMagnet Survey application, do one of the following: 

• From the Main Menu, select File>New Project, or 

• From the Toolbar, click (Project Wizard). 

The New Project Wizard view appears. 



Integrating Cisco Prime Infrastructure 

336 

 

2. Where it reads Specify Project Name, enter a unique name for the new project. 

3. Select the Cisco Prime Infrastructure Planner project type. 

4. Save the project using one of the following options: 

• To save the project to the default location, simply click Next. The New Project 

Wizard view refreshes. 

• To save the project to a location other than the default, click  to specify a location 

of your choice, and then click Next. The New Project Wizard view refreshes. 

By default, AirMagnet Survey automatically saves the project to the C:\ drive on your 

computer, using the name you specify. Check Set as default project directory to ensure 

that subsequent AirMagnet Survey projects are saved to the same location, if desired. If you 

go inside a directory to create a project, it will not work. You must browse and select a 

directory (folder) that AirMagnet Survey will create inside the folder you choose. 
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5. Locate the Floor Plan image by clicking on . 

6. Select Unit of Measurement and fill in Floor Plan dimensions. You must also select 

the Unit of Measurement (Feet or Meters). Click Next. 

Note: Dimension refers to the entire area covered by the site map. It may or may not be 

the same as the dimension of the facility that resides on the site. If you are not sure of 

the exact width and/or length, you may enter the approximate values and then let 

AirMagnet Survey recalibrate the values for you later. Refer to the message on the view 

for more information. 

7. Click Next. The New Project Wizard view refreshes. Refer to the figure below. 

8. For Survey Environment, select an option that resembles the site environment 

where the survey is to be conducted. 

9. For Signal Propagation Assessment, do nothing (normally), since AirMagnet 

Survey can automatically assign the value according to the site environment you 

select. 

Note: AirMagnet Survey assigns the Signal Propagation Assessment value based on the 

estimate of the distance RF signals could travel in each of these typical site environments. 

Normally, AirMagnet recommends you accept the default value the program assigns. 

However, if you want to set a value of your own, you must be aware that the value you 

enter will affect the way the program interpolates site data. 

10. For AP Default Power, do nothing (normally). 

If you know the value of the AP power, enter it now. The value will be used when 

conducting data simulation. 
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11. Click Next. The New Project Wizard view refreshes. 

 

12. In the Enter Descriptive Text field, type a brief description of the project. 

(Optional.) 

13. Click Finish. The newly created AirMagnet Planner project automatically appears in 

the Project Window, and the site map is displayed in the Map Window. 

14. The default is the Survey view, so Click Planner on the Navigation bar. See Figure 

below. 
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Note: You can create as many projects as needed by following the same procedures 

outlined above. By default, a new project will automatically open on the Display view as 

soon as it is created. 

Step 2- Creating a site plan 

When planning multi-floor deployment, create individual site plans for each floor. After 

creating the project, you will need to create a site and arrange components necessary to 

properly project signal coverage for an area (refer to Chapter 17 on how to create a site 

plan). Once complete, you can use the Planner Export option to export out of AirMagnet 

Planner and import into Cisco Prime Infrastructure (refer to section below). 

Note: After the site plan is created, you do not need to process the data as only AP 

location and certain AP properties along with wall information will be exported from 

AirMagneSurvey. Be sure to save the project before going to the display view. 

When importing an AirMagnet Cisco Prime Infrastructure Planner project into Cisco Prime 

Infrastructure , the following areas do not get imported: Coverage Areas, Exclusion Areas or 

Attenuation Areas. The Cisco Prime Infrastructure Planner functionality supports only the 

unit of measure "feet". Planner projects created in meters in AirMagnet Survey will be 

converted to feet when imported into Cisco Prime Infrastructure. When importing an 

AirMagnet Cisco Prime Infrastructure  Planner project into Cisco Prime Infrastructure, the 

following AirMagnet Planner AP settings get imported: AP Name, Transmit Power (mWatt) 

and Antenna. The following Planner AP settings do not get imported: Channel, MAC Address, 

IP Address, SSID, Antenna Angle or Height, 11n Support. 

Step 3 - Exporting from AirMagnet Planner 
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The following section details how to export an AirMagnet Cisco Prime Infrastructure Planner 

project to Cisco Prime Infrastructure. Once you export the project, you can import the 

project into Cisco Prime Infrastructure. 

To export a completed AirMagnet Cisco Prime Infrastructure Planner project: 

1. Open the AirMagnet Cisco Prime Infrastructure Planner project. 

2. On the navigation bar, select the Display view. 

3. Click File, then select Cisco Prime Infrastructure Export. 

4. Click Planner Export... The Export Planner to Cisco Prime Infrastructure view 

appears. 

 

5. Fill in all required fields. The number of floors/basements must be between 0 and 

100. For Floor/Basement Height Units, select Feet or Meters. 

6. Click on Add Floor/Basement... to add floors and basements. Click on the  icon 

and select the site plan to be used. 

Note: Make sure you select the appropriate site plan for the selected floor. If you are 

unsure of the site plan, view the .spi file within the project folder to get the site plan 

name to floor plan name mapping. 
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7. Enter all required information in the fields. Enter a floor count between 0 and 100 in 

the level field. Or if Basement is enabled, enter a basement count between 0 and -

100. 

8. Once complete, click OK. 

9. Click Add Floors/Basements to add more floors/basements. 

10. The exported folder (AMPlanner.zip) is placed in the folder specified on the view 

under the Export folder field. 

11. Click OK to export. 

12. A zip file containing folders, images and xmlDir gets created. This is the file you will 

use to import into Cisco Prime Infrastructure. 

Step 4- Importing into Cisco Prime Infrastructure 

1. Log on to Cisco Prime Infrastructure. 

2. Select Monitor> Maps [for NCS select Site maps]. 

 

3. From the drop-down menu on the Monitor>Maps page [for NCS select Site Maps], 

select Select a command - Import Maps. 
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4. Select GO. 

5. Select XML format, then Next. 

6. Select Browse [for NCS select Choose File] and browse to .zip file that was created 

with Cisco Prime Infrastructure Export\Planner Export. 

 

7. Below the file field, click Next. 

8. On the Map Import Validation Result view, scroll to the bottom and click Next. 

 

9. On the Import Map Result view, scroll down to the bottom left hand corner and 

click OK. Please make note of the status information in the right hand column of the 

results view. 

10. Expand the Site Name (which has just been imported) from the Maps Tree View in 

the upper left hand corner and select the desired floor. 

11. From the drop-down menu on the ... Select a command - Planning Mode and 

click GO. 

12. The APs will be displayed on the floor plan. 

13. Select the Map Editor to view walls. 
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Note: AP type defaults to AP 1250. 
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Working with Spectrum XT 

Introduction to Spectrum XT Integration 

Note: This feature is available only on AirMagnet Survey PRO. AirMagnet Survey supports 

integration with AirMagnet Spectrum XT, AirMagnet Spectrum Analyzer, and Cisco 

Spectrum Expert. 

This section describes AirMagnet Survey’s ability to integrate with supported spectrum 

analyzers. This integration brings AirMagnet Survey to a new level by allowing you to view 

RF traffic across the entire wireless spectrum. Spectrum Analyzers display potential sources 

of wireless interference detected during a survey. This can help users identify (and thereby 

eliminate) RF hazards in the wireless environment as soon as they are detected. 

Note: To use this feature, you must have AirMagnet Survey PRO, a supported spectrum 

analyzer installed and the associated spectrum analyzer adapter enabled on their laptop. 

  

Enabling Spectrum Analyzer 

To enable a spectrum analyzer: 

1. From the Survey view, click File>Configure…. The Survey Configuration view 

appears. 

2. Click . The Spectrum Analyzer dialog box appears. 

 

3. Check Enable Spectrum Integration and select one of the Max Hold Reset 

options.  

Option Description 

Never Reset If selected, the Max Hold value will never be reset. 

Manually 

Reset 

If selected, the Max Hold value will be reset each time you click on the site 

map as you move along the survey path. 
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Automatically 

Reset 

If selected, the Max Hold value will be automatically reset each time or at 

each point data are collected or logged. 

4. Click OK to finish.  You must restart the application for the new settings to take 

effect. 

Collecting Spectrum Data 

The integrated Spectrum Analyzer Window appears below the Map Window on the Survey 

view, provided that a supported spectrum analyzer adapter is installed (inserted) and that 

this option is enabled in AirMagnet Survey.  A close-up look at the Spectrum Analyzer 

Window is provided below. 

 

The Spectrum Analyzer Window displays the FFT (Fast Fourier Transform) plot which 

contains three types of data represented by the line charts in distinctive colors. The table 

below briefly describes each of these data. If you wish to have more information on 

AirMagnet Spectrum XT, refer to the AirMagnet Spectrum XT User Guide or the Help file 

within the stand-alone AirMagnet Spectrum XT software application. 

Color 
Data 

Type 
Description 

Yellow 
Max 

Hold 

The maximum power value detected at any time since the plot was initiated. 

Max Hold means that the plot holds onto the maximum power value up to 

the present. 

Red Max 
The maximum power value detected during the most recent measurement 

interval. 

Green Average 
The average power value detected during the most recent measurement 

interval. 

Viewing Spectrum Data 

With spectrum analyzer integration, you can see the integrated spectrum analyzer Window 

on the Display view if they have this featured enabled. You can also display and analyze 

spectrum data by mousing over any data point along the survey path. 
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Note: When you mouse over a point on a survey path, you not only see a tip view 

showing the 802.11 data collected at that spot but also a pushpin that is related to what 

you see in the Spectrum Analyzer Window below. In other words, the Spectrum Analyzer 

Window reflects the spectrum data collected at the spot indicated by the pushpin. With 

spectrum data on the view, a tip view will pop up if you mouse over any spot on the FFT 

plot in the Spectrum Analyzer Window. This tip view shows more spectrum data about 

that spot. 
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Spectrum integration allows you to identify non-802.11 devices that cause interference with 

the wireless deployment (henceforth known as “interferers”). Click here for more details. 

You can also use Spectrum XT to display a spectrum heatmap to help locate major sites of 

spectrum traffic. 

Spectrum Heatmap Display 

In order to provide a more comprehensive and user-accessible means of viewing spectrum 

data, Survey implements a spectrum heatmap option when spectrum analyzer integration is 

enabled. This allows you to view all RF traffic in the entire spectrum, including both Wi-Fi 

(APs, stations, and so on) and non-Wi-Fi (Bluetooth devices, microwaves, and so on) 

sources. The spectrum heatmap displays the average spectrum level for each channel at 

any given point on the map. The color-coded display makes it easy to determine areas of 

unusual spectrum traffic, allowing you to quickly troubleshoot problem spots. 

To view the spectrum heatmap: 

1. From the Display page, load the spectrum data file. 

2. Click the data type drop-down list in the map window and select Spectrum. The 

heatmap refreshes, displaying spectrum data. 
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You can narrow the displayed spectrum to a specific channel, allowing you to identify 

unusual traffic at the particular frequency of interest. Depending on the card used when 

conducting the survey, this can include both 802.11a and 802.11b/g channels. 

Note: The heatmap displays an overview of spectrum information. You can still mouse 

over a point on the survey path to view specific spectrum data for that exact location. 

The spectrum heatmap can be particularly useful when you want to determine the optimal 

channel for a new AP. By viewing the heatmap on the desired channel, you can see whether 

there is excessive spectrum traffic at that location. If the spectrum traffic level is high, you 

must change the environment to eliminate interferers or select a new location. 

Spectrum Interferers 

Interferers can be viewed in a list and as detected in the deployment by using the interferer 

heatmap provided on the Display view. The interferer power heatmap shows the power 

levels for any such devices detected during the survey process and also provides a list of 

the devices found. This can be useful for identifying potential interference sources that may 

not be picked up by a standard 802.11 survey. 
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After gathering interferer data, you can view the interferers detected listed in the Categories 

tree towards the left of the view. 
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Bold categories indicate that devices that match that particular category were detected 

during the survey (that is, in the first figure above, the system detected interference from 

Bluetooth devices, cordless phones, and both continuous and fixed-frequency devices over 

the course of the survey). You can identify the location of the devices by selecting the 

desired type; the heatmap will refresh to highlight only the location(s) in which that device 

was detected. 

All interferers detected across the entire survey path are displayed in the bottom pane of 

the window, below the spectrum graphs. This table provides various data regarding the 

detected interferers, including the Type, Name, a brief description, and its center frequency 

(if known). 

 

  

Generating Spectrum Analyzer Reports 

AirMagnet Survey not only enables you to collect and analyze the enormous amount of 

spectrum data in the airwave over your WLAN site, but also allows you to convert these 

valuable data into reports, making it convenient to share, archive, and further analyze the 

data. 

However, in order to generate and view spectrum analyzer reports, you must make sure 

that first of all spectrum data are being collected during the site survey. To do so, you have 

to make sure that the following requirements are met at the time of the survey: 

1. You have AirMagnet Survey PRO installed on your laptop; 

2. You have the associated spectrum analyzer adapter inserted in your system; 

3. You have the Spectrum Integration feature enabled on AirMagnet Survey, which can 

be done by selecting File>Configure…>Spectrum Integration>Enable 

Spectrum Integration. 

If these three requirements are met, you should be able to see the Spectrum Analyzer 

Window with spectrum data in it at the bottom of the Survey view when you are doing the 

survey. 

Once spectrum data are collected, the next step is to open the data file on the Display view 

and mark the spectrum data collection points on the survey path. This is equally important 

because even though spectrum data are collected, no Spectrum Analyzer report will show 

up on the Reports view unless spectrum data collection points are marked on the survey 
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path. Otherwise, you will encounter an error message when you are trying to open the 

Spectrum Analyzer Report on the Reports view. To see how to mark spectrum data 

collection points along the survey path on the Display view, click here. 

Once you have marked all the spectrum data collection points on the Display view, 

AirMagnet Survey will automatically generate the Spectrum Analyzer Report which can be 

viewed from the Reports view just as with any of the other reports.  For instructions, click 

here. 

Marking Spectrum Data Collection Points 

To mark spectrum data collection points: 

1. From the Display view, click to open the data file that contains the spectrum data. 

2. Right-click inside the Map Window. A right-click pop-up menu appears. 

 

3. From the right-click menu, select Mark Spectrum Data Mode. 

Note: A check mark appears in front of Mark Spectrum Data Mode when this feature is 

activated. 

4. In the Map Window, click to select the spectrum data collection points along the 

survey path. 
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Note: Pushpin icons appear where you click. They are automatically numbered in the 

order they appear. As you click along, spectrum data will also appear in the Spectrum 

Analyzer Window. Be sure to click along the survey path. Otherwise, you will see no 

pushpin icons, meaning that no spectrum data point is marked. 

Viewing AirMagnet RF Spectrum Reports 

To view the RF Spectrum Report: 

1. Click  on the Navigation bar to switch to the Reports view 

2. From the Report List Window, select RF Spectrum Report. 

3. Navigate through the report using the tools on the view. 

Note: Normally, the number of pages contained in a report depends on the amount of 

data in the data file selected. However, in the case of the RF Spectrum Report, the length 

of the report is determined by the number of data collection points (you have marked), 

which in turn determine the amount of data contained in the report. 
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License & Copyrights 

GENERAL TERMS AND CONDITIONS 

(v01-Oct-19) 

These General Terms and Conditions ("General T&Cs") are by and between the legal entity 

set forth in the applicable Order (“Company”), as further defined below, and sets forth the 

terms, conditions, rights and restrictions for which LinkRunner, LLC d/b/a NetAlly, and any 

of its subsidiaries and affiliates (collectively or individually referred to as "NetAlly") is willing 

to sell devices ("Hardware") and license NetAlly’s proprietary software, as well as any 

firmware residing on such Hardware, ("Software") (The Hardware and Software may be 

collectively referred to as the "Product(s)"), and provide maintenance and technical support 

services ("Maintenance"), to Company. Unless otherwise governed by a signed contract 

between Company and NetAlly, only these General T&Cs will apply to any Orders made for 

NetAlly’s Products. NetAlly’s provisioning of Products, Maintenance or any other services to 

Company is expressly contingent upon Company’s acceptance of these General T&Cs, “AS 

IS”.     

Receipt without return of any Products from NetAlly by Company shall be deemed as 

acceptance of this Order and shall also constitutes Company's confirmation that the 

Products descriptions, quantities, term, and prices set forth in the Order accurately 

represent Company's intended purchase. All additional and conflicting terms and conditions 

presented with or in any communication, including but not limited to those set forth in any 

P.O., except with respect to price, quantity, and location are hereby rejected, and shall be 

deemed null and void. 

1. Definitions.   

“API(s)” means the software application interfaces and workflow methods made generally 

available by NetAlly in certain Products to enable integration, implementation, and 

interoperability with third party hardware and software. 

“Company” means a valid legal entity, in good standing, which has entered into a 

commercial agreement with NetAlly, allowing for the licensing or re-licensing of Software or 

distribution, sale, or resale of Products and Service.   

“Company Data” means information that Company uploads or uses in conjunction with 

Company’s use of the Products. 

“Data Protection Act” means the Health Information Portability and Accountability Act 

(HIPAA) (29 U.S. Code § 1181, et seq.), Gramm Leach Bliley Act (GLBA) (15 U.S Code § 

1681), General Data Protection Regulation (GDPR) (EU 2016/679), and other applicable 

regulations which seek to protect the processing and storage of personal information. 

“Documentation” means any installation guides, reference guides, operation manuals and 

release notes provided with the Product in printed, electronic, or online form. 

“Evaluation Product” means software that contains a license key, which disables the 

Software after 30 days, or other term as agreed to by the parties, and which will render the 

Product unusable. 
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“Order" means the combination of Company’s P.O., a Quote issued by NetAlly or a NetAlly 

Company, and these General T&Cs. 

“Personal Data” means any information relating to an identified or identifiable natural 

person (hereafter a “Data Subject”); an identifiable person is one who can be identified, 

directly or indirectly, in particular by reference to an identification number or to one or more 

factors specific to his physical, physiological, mental, economic, cultural or social identity. 

“P.O.” means a purchaser order or document, in tangible or intangible form (e.g. .rtf, .pdf, 

formats, etc.), issued by Company indicating Company’s acceptance of the Quote and these 

General T&Cs, without regards to any conflicting terms and conditions presented therein, 

except with respect to price, quantity, and location of Products or Services. 

“Quote” means the document under which NetAlly offers for sale and licenses its Products, 

Maintenance, and other services. 

“Services” means Maintenance as well as any other services offered by NetAlly to Company 

from time to time.    

2. Shipment & Delivery Terms. NetAlly ships all Products hereunder FOB Origin. Unless 

otherwise agreed to by the parties, all shipments will be made using the carrier designated 

by Company. If Company does not designate a carrier, NetAlly reserves the right to choose 

a carrier at Company's expense. For Software available for electronic download, delivery will 

be deemed to have occurred once NetAlly has made the Software available for download by 

Company or Company’s designate agent or representative. Unless otherwise stated 

conspicuously on the face of the applicable Order, NetAlly reserves the right to fulfill Orders 

via multiple shipments. For all Products shipped internationally, Company will be the 

importer of record. Company agrees that it will not remove any NetAlly General T&Cs or 

other agreement from the NetAlly Product(s), and/or associated packaging.    

3. License Grant and Restrictions. Subject to payment of the applicable license fee and the 

terms set forth in an applicable Order, NetAlly grants Company a limited, non-exclusive, 

non-transferable, revocable license to use the Software and the Documentation for 

Company’s own internal business purposes.   

(a) Evaluation License: NetAlly hereby grants Company a temporary, non-exclusive, 

non-transferable, revocable license to use the Evaluation Product set forth in the 

applicable NetAlly Evaluation Request Form solely for internal testing, evaluation, or 

demonstration purposes. If Company chooses not to purchase a license for the 

Evaluation Product, the Evaluation Product must be removed from Company’s 

system(s) and all permitted copies of such Evaluation Product immediately destroyed. 

A Return Materials Authorization number (“RMA #”) for any Hardware Evaluation 

Product must be obtained prior to return of such Product.    

(b) Pre-Released Products. If the Product Company has received with this license is 

not yet commercially available ("Pre-Released Product"), then NetAlly grants Company 

a temporary, non-exclusive, non-transferable, revocable license to use the Pre-

Released Product and the associated Documentation, if any, as provided to Company 

by NetAlly solely for internal evaluation purposes. NetAlly may terminate Company’s 

right to use the Pre-Released Product at any time at NetAlly’s discretion. Company’s 

use of the Pre-Released Product is limited to thirty (30) days unless otherwise agreed 

to in writing by NetAlly. Company acknowledges and agrees that (i) NetAlly has not 

promised or guaranteed to Company that the Pre-Released Product will be announced 

or made available to anyone in the future; (ii) NetAlly has no express or implied 
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obligation to Company to announce or introduce the Pre-Released Product; (iii) 

NetAlly may not introduce a product similar to or compatible with the Pre-Released 

Product; and (iv) any use of the Pre-Released Product or any product associated with 

the Pre-Released Product is entirely at Company’s own risk. During the term of these 

General T&Cs, if requested by NetAlly, Company will provide feedback to NetAlly 

regarding use of the Pre-Released Product. Company will not disclose any features or 

functions of any Pre-Released Product until NetAlly makes the Pre-Released Product 

publicly available. 

(c) API License. NetAlly grants Company a limited, non-exclusive, non-transferable 

revocable license to use the API, together with applicable documentation, any sample 

code, and any sample applications provided with the API, solely in connection with the 

Products for Company’s internal business purposes; provided that Company may not 

use the API in connection with developing a product or service that competes with 

Products.   

(d) License Restrictions. Except as required by law, Company will not, and will not 

cause or permit others to, derive the source code of the Software, or reverse 

engineer, disassemble, or de-compile the Products. Company may not (i) create 

derivative works of the Software, (ii) lend, rent, lease, assign, sublicense, and/or 

make available through timesharing or service bureau the Software, or (iii) transfer 

the Software or provide third party access to the Software. 

(e) Third-party Technology. The Products may contain embedded third-party 

technology (“Third-party Materials”). Such Third-party Materials are licensed for use 

solely with the Product. Third-party Materials are provided subject to the applicable 

third-party terms of use (“TOU”). Company agrees to abide by the TOU and/or to 

obtain any additional licenses that may be required to use the Third-party Materials. 

(f) Ownership. NetAlly and its third-party licensors retain all right, title, and interest in 

and to the Products, Third party Technology and/or APIs. Company retain all right, 

title and interest in and to the Company Data. 

4. Acceptable Use. Company specifically agrees to limit the use of the Products and/or 

Services to those specifically granted in these General T&Cs. Without limiting the foregoing, 

Company specifically agrees not to (i) attempt to reverse engineer, decompile, disassemble, 

or attempt to derive the source code of the Software or any portion thereof; (ii) modify, 

port, translate, localize or create derivative works of the Software; (iii) remove any of 

NetAlly’s, or its vendors, copyright notices and proprietary legends; (iv) use the Products to 

(a) infringe on the intellectual property rights of any third party or any rights of publicity or 

privacy; (b) violate any law, statute, ordinance, or regulation (including but not limited to 

the laws and regulations governing export/import control, unfair competition, anti-

discrimination and/or false advertising); or (c) propagate any virus, worms, Trojan horses 

or other programming routine intended to damage any system or data; and/or (v) file 

copyright or patent applications that include the Product or any portion thereof. 

5. Company & Personal Data. During the Term, Company may provide to NetAlly Company 

Data. NetAlly may use Company Data in connection with the performance of its obligations 

under these General T&Cs. Company hereby agrees to strictly comply with any and all 

applicable Data Protection Acts with regards to the transfer, handling storage and 

processing of Personal Data. Company acknowledges and agrees that should Company 

transfer such Personal Data to NetAlly, or other third-parties, Company will serve as such 

Personal Data’s “Controller”, as set forth in the applicable Data Protection Acts. Further, in 

the event of a breach of Personal Data, attributed to Company’s actions or inactions in 
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furtherance of these General T&Cs, in violation of the Data Protection Acts, Company shall 

promptly (i) take all necessary steps to curtail such breach; (ii) undertake all necessary 

actions to mitigate damages; (iii) provide the necessary notification and remediation, as set 

forth in the applicable Data Protection Act; and (iv) aid and assist in NetAlly’s efforts to do 

the same, at Company’s sole cost and expense. 

6. Term and Termination. These General T&Cs shall continue unless terminated pursuant to 

this Section; provided, that the applicable subscription term for any licenses purchased 

hereunder shall continue for the period of time specified in the applicable Quotation. Either 

party may terminate these General T&Cs immediately upon providing written notice of 

breach to the other party, if such other party materially breaches any of its obligations 

hereunder but fails to cure such breach within a period of thirty (30) days following receipt 

of such written notice. Upon any termination of these General T&Cs (i) all licenses granted 

hereunder shall immediately terminate, (ii) Company will either return the Software, 

Documentation, and Copies or, with NetAlly's prior consent, destroy the Software, 

Documentation, and Copies. 

7. Confidentiality. “Confidential Information” shall mean any and all non-public technical, 

financial, commercial or other confidential or proprietary information, Services, Product 

roadmaps, pricing, software code, Documentation, techniques and systems, and any and all 

results of benchmark testing run on the Products. Neither party will disclose Confidential 

Information to any third party except to the extent such disclosure is necessary for 

performance of these General T&Cs, or it can be documented that any such Confidential 

Information is in the public domain and generally available to the general public without any 

restriction. Each party will use the same degree of care to protect Confidential Information 

as Company uses to protect Company’s own confidential information but in no event less 

than reasonable care. 

8. Warranties. NetAlly warrants, for Company’s benefit alone, (i) that the Hardware will be 

free from material defects for a period of twelve (12) months following the date of shipment 

of the Hardware ("Hardware Warranty Period"); and (ii) the Software, will conform 

materially and substantially to the Documentation for a period of ninety (90) days 

following the date when first made available to Company for download (“Software Warranty 

Period”). The warranties set forth herein do not apply to any failure of the Software or 

Hardware caused by (a) Company’s failure to follow NetAlly's installation, operation, or 

maintenance instructions, procedures, or Documentation; (b) Company’s mishandling, 

misuse, negligence, or improper installation, de-installation, storage, servicing, or operation 

of the Product; (c) modifications or repairs not authorized by NetAlly; (d) use of the 

Products in combination with equipment or software not supplied by NetAlly or authorized in 

the Documentation; and/or (e) power failures or surges, fire, flood, accident, actions of 

third parties, or other events outside NetAlly's reasonable control. NetAlly cannot and does 

not warrant the performance or results that may be obtained by using the Products, nor 

does NetAlly warrant that the Products are appropriate for Company’s purposes or error-

free. If during the Software Warranty Period or Hardware Warranty Period, a nonconformity 

is reported to NetAlly, NetAlly, at its option, will use commercially reasonable efforts to 

repair or replace the non-conforming Software or Hardware. THIS REMEDY IS CUSTOMER’S 

SOLE AND EXCLUSIVE REMEDY, AND NETALLY’S SOLE LIABILITY FOR A BREACH OF 

WARRANTY. EXCEPT FOR THE EXPRESS WARRANTIES STATED IN THIS SECTION 8, 

“WARRANTIES” NETALLY DISCLAIMS ALL WARRANTIES ON MERCHANDISE SUPPLIED 

UNDER THIS AGREEMENT, INCLUDING, WITHOUT LIMITATION, ALL IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.   
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9. LIMITATION OF LIABILITY. NETALLY SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE 

UNLESS SUCH LOSS OR DAMAGE IS DUE TO NETALLY’S GROSS NEGLIGENCE AND/OR 

WILLFUL MISCONDUCT. IF NETALLY IS FOUND LIABLE, THE AMOUNT OF NETALLY’S 

MAXIMUM LIABILITY FOR ANY AND ALL LOSSES AND/OR DAMAGES (IN CONTRACT, TORT, 

OR OTHERWISE) SHALL NOT EXCEED THE TOTAL AMOUNT OF ALL LICENSE FEES ACTUALLY 

PAID TO NETALLY FOR THE RELEVANT NETALLY PRODUCT(S) OR SERVICE(S) WITHIN THE 

PRIOR SIX (6) MONTHS FROM WHICH SUCH CLAIM ARISES.   

10. EXCLUSION OF CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL EITHER PARTY BE 

LIABLE TO THE OTHER OR ANY THIRD PARTY FOR ANY CONSEQUENTIAL, INDIRECT, 

SPECIAL, PUNITIVE, AND/OR INCIDENTAL DAMAGES, WHATSOEVER, INCLUDING BUT NOT 

LIMITED TO LOST PROFITS OR LOSS OF DATA, EVEN IF SUCH PARTY HAS BEEN ADVISED 

OF THE POSSIBILITY OF SUCH POTENTIAL LOSS OR DAMAGE. 

11. ESSENTIAL PURPOSE. THE LIMITATION OF LIABILITY AND EXCLUSION OF CERTAIN 

DAMAGES STATED HEREIN SHALL APPLY REGARDLESS OF THE FAILURE OF ESSENTIAL 

PURPOSE OF ANY REMEDY. BOTH PARTIES HEREUNDER SPECIFICALLY ACKNOWLEDGE 

THAT THESE LIMITATIONS OF LIABILITY ARE REFLECTED IN THE PRICING. 

12. Indemnification. For any claims based on Company’s breach of Section 3, “License Grant 

and Restrictions”, 4. “Acceptable Use”, 5 “Company & Personal Data”, 7 “Confidentiality”, 8 

“Warranties”, 14.4 “Compliance & Export Controls”, 14.6 “Anti-Corruption and Anti-Bribery” 

and/or Company use of Product(s), Company hereby agrees to indemnify, defend, and hold 

NetAlly harmless against such claim(s) at Company’s expense and pay all damages that a 

court of competent jurisdiction finally awards, provided that NetAlly (i) promptly notifies 

Company in writing of the claim(s); (ii) allows Company to control the defense or any 

related settlement negotiations; and (iii) cooperates with Company in the defense of any 

such claim(s); provided, that, Company will not affect any settlement unless such 

settlement provides NetAlly with a full release. 

13. Relationship with Third parties. The relationship between the parties established by 

these General T&Cs is that of independent contractors, and nothing contained in these 

General T&Cs shall be construed to: (i) give either party the power to direct or control the 

day-to-day activities of the other; (ii) constitute the parties as partners, joint ventures, co-

owners or otherwise as participants in a joint or common undertaking or franchise; (iii) 

allow Company to create or assume any obligation on behalf of NetAlly for any purpose 

whatsoever; or (iv) allow any customer, End-User, or other person or entity not a party to 

these General T&Cs to be considered a third-party beneficiary of these General T&Cs. 

14. General Provisions. 

 14.1 Entire Agreement T&Cs & Integration. These General T&Cs and all Exhibits referencing 

these General T&Cs represent the entire agreement between the parties on the subject 

matter hereof and supersede all prior discussions, agreements and understandings of every 

kind and nature between the parties. Neither party shall be deemed the drafter of these 

General T&Cs. No modification of these General T&Cs shall be effective unless in writing and 

signed by both parties. All additional and conflicting terms and conditions presented with or 

in any communication, including but not limited to Company’s P.O., except with respect to 

price, quantity, and location specified in a P.O., are hereby rejected, and shall be deemed 

null and void. 

 14.2 Severability & Survival. The illegality or unenforceability of any provision of these 

General T&Cs shall not affect the validity and enforceability of any legal and enforceable 

provisions hereof. Should any provision of these General T&Cs be deemed unenforceable by 



License & Copyrights 

360 

a court of competent jurisdiction then such clause shall be re-construed to provide the 

maximum protection afforded by law in accordance with the intent of the applicable 

provision. Any provision contained herein, which by its nature should survive the 

termination of these General T&Cs shall survive, including, but not limited to, Section 7 

“Confidentiality”, 9 “Limitation of Liability & Exclusion of Consequential Damages”, 12 

“Indemnification”, and 14 “General Provisions”. 

 14.3 Assignment. Neither party may assign any rights or delegate any obligations 

hereunder, whether by operation of law or otherwise, except in the case of a sale of either 

party’s business whether by merger, sale of assets, sale of stock or otherwise, or except 

with the prior written consent of the other party, which consent will not be unreasonably 

withheld. These General T&Cs binds the parties, their respective participating subsidiaries, 

affiliates, successors, and permitted assigns. 

 14.4 Compliance & Export Controls. Company shall comply fully with all applicable laws, 

rules, and regulations including those of the United States, and any and all other 

jurisdictions globally, which apply to Company’s business activities in connection with these 

General T&Cs. Company acknowledges that the NetAlly Products and/or NetAlly Services are 

subject to United States Government export control laws. Company shall comply with all 

applicable export control laws, obtain all applicable export licenses, and will not export or 

re-export any part of the Products and/or Services to any country in violation of such 

restrictions or any country that may be subject to an embargo by the United States 

Government or to End-Users owned by, or with affiliation to, such countries embargoed by 

the United States Government.   

 14.5. U.S. Government Use Notice. The NetAlly Software is a “Commercial Item”, as that 

term is defined at 48 C.F.R. § 2.101, consisting of “Commercial Computer Software” and 

“Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. § 

12.212 and 48 C.F.R. § 227.7202, as applicable. Consistent with 48 C.F.R. § 12.212 and 48 

C.F.R. § 227.7202-1 through 227.7202-4, the Commercial Computer Software and 

Commercial Computer Software Documentation are being licensed to U.S. Government End-

Users (a) only as Commercial Items and (b) with only those rights as are granted to all 

other End-Users pursuant to the terms and conditions herein. For some components of the 

Software as specified in the Exhibit, Attachment, and/or Schedule, this Software and 

Documentation are provided on a RESTRICTED basis. Use, duplication, or disclosure by the 

United States Government is subject to restrictions set forth in Subparagraphs (c) (1) and 

(2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as 

applicable. 

 14.6 Anti-Corruption and Anti-Bribery. Company will not make or permit to be made any 

improper payments and will comply with the U.S. Foreign Corrupt Practices Act, the UK 

Bribery Act, the Organization for Economic Co-operation and Development (“OECD”) 

Convention on Anti-Bribery, and other applicable local anti-bribery laws and international 

anti- bribery standards. Company represents and warrants that it will not pay any 

commission, finder's fee, or referral fee, or make any political contribution, to any person in 

connection with activities on behalf of NetAlly. 

 14.7 Applicable Law & Disputes. The parties specifically agree that the U.N. Convention on 

the International Sale of Goods, the Uniform Computer Information Transactions Act 

(“UCITA”), and the International Commercial Terms issued by the International Chamber of 

Commerce (“Incoterms”) shall not apply to any and all actions performed by either party 

hereunder in furtherance of these General T&Cs. These General T&Cs and all resulting 

claims and/or counterclaims shall be governed, construed, enforced and performed in 

accordance with the laws of the State of Colorado, United States of America, without 
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reference and/or regard to its conflicts of laws principles. The parties hereto specifically 

agree that the exclusive jurisdiction for any and all resulting claims and/or counterclaims 

arising out of these General T&Cs shall be the federal and local courts of Denver, Colorado. 

 14.8 Force Majeure. Neither party shall be liable for any failure or delay in performing 

Services or any other obligation under these General T&Cs, nor for any damages suffered by 

the other or an End-User by reason of such failure or delay, which is, indirectly or directly, 

caused by an event beyond such party’s foreseeable control including but not limited to 

strikes, riots, natural catastrophes, terrorist acts, governmental intervention, or other acts 

of God, or any other causes beyond such party’s reasonable control. 

 14.9 Waiver. Each party agrees that the failure of the other party at any time to require 

performance by such party of any of the provisions herein shall not operate as a waiver of 

the rights of such party to request strict performance of the same or like provisions, or any 

other provisions hereof, at a later time. 

 15. Notices. All notices under these General T&Cs shall be in English and shall be in writing 

and given to the address indicated upon the cover page and may be sent either by (i) 

registered airmail; (ii) overnight delivery through a reputable third-party courier; or (iii) via 

electronic mail (email) sent “read receipt” and “delivery receipt”. With respect to NetAlly’s 

receipt of electronic notice set forth in (iii) above such notice shall only been deemed 

received once Company receives a confirmation of “read receipt” and “delivery receipt” and 

such notice shall only be valid if sent to legal@netally.com. 

  

See also https://www.netally.com/web-legal/. 

Iperf2 Copyright 

Copyright (c) 1999-2007, The Board of Trustees of the University of Illinois 

All Rights Reserved. 

Mark Gates 

Ajay Tirumala 

Jim Ferguson 

Jon Dugan 

Feng Qin 

Kevin Gibbs 

John Estabrook 

National Laboratory for Applied Network Research 

National Center for Supercomputing Applications 

University of Illinois at Urbana-Champaign 

http://www.ncsa.uiuc.edu 

mailto:legal@netally.com
https://www.netally.com/web-legal/
http://www.ncsa.uiuc.edu/
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Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software (Iperf) and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, modify, 

merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 

persons to whom the Software is furnished to do so, subject to the following conditions: 

•        Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimers. 

•        Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimers in the documentation and/or other materials 

provided with the distribution. 

•        Neither the names of the University of Illinois, NCSA, nor the names of its contributors 

may be used to endorse or promote products derived from this Software without specific 

prior written permission. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE 

CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 

OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 

DEALINGS IN THE SOFTWARE. 

iPerf3 Copyright 

Copyright (c) 2014-2020, The Regents of the University of California, through Lawrence 

Berkeley National Laboratory (subject to receipt of any required approvals from the U.S. 

Dept. of Energy). All rights reserved.  

https://iperf.fr/  

iPerf3 is a new implementation that shares no code with the original iPerf and is also not 

backwards compatible. iPerf3 is principally developed by ESnet (https://www.es.net/) / 

Lawrence Berkeley National Laboratory (https://www.lbl.gov/). iPerf3 is released under a 

three-clause BSD license.  

D. Young Copyright 

Copyright (c) 2003, 2004 David Young. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that the following conditions are met: 

1        Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 

2        Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

https://iperf.fr/
https://www.es.net/
https://www.lbl.gov/
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3        The name of David Young may not be used to endorse or promote products derived from 

this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY DAVID YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 

EVENT SHALL DAVID YOUNG BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 

OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

A. Onoe & S. Leffler Copyright 

Copyright (c) 2001 Atsushi Onoe 

Copyright (c) 2002-2005 Sam Leffler, Errno Consulting 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that the following conditions * are met: 

1        Redistributions of source code must retain the above copyright *    notice, this list of 

conditions and the following disclaimer. 

2        Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3        The name of the author may not be used to endorse or promote products derived from 

this software without specific prior written permission. 

Alternatively, this software may be distributed under the terms of the GNU General Public 

License (“GPL”) version 2 as published by the Free Software Foundation. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 

EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 

OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

S. Leffler Copyright 

Copyright (c) 2002-2005 Sam Leffler, Errno Consulting 
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All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that the following conditions are met: 

1        Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 

2        Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3        The name of the author may not be used to endorse or promote products derived from 

this software without specific prior written permission. 

Alternatively, this software may be distributed under the terms of the GNU General Public 

License (“GPL”) version 2 as published by the Free Software Foundation. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 

EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

ROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 

OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

B. Paul Copyright 

Copyright (c) 1997, 1998, 1999 

   Bill Paul <wpaul@ctr.columbia.edu>. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that the following conditions are met: 

1        Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 

2        Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3        All advertising materials mentioning features or use of this software must display the 

following acknowledgement: 

This product includes software developed by Bill Paul. 

4        Neither the name of the author nor the names of any co-contributors may be used to 

endorse or promote products derived from this software without specific prior written 

permission. 
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THIS SOFTWARE IS PROVIDED BY Bill Paul AND CONTRIBUTORS “AS IS” AND ANY EXPRESS 

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 

NO EVENT SHALL Bill Paul OR THE VOICES IN HIS HEAD BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 

ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 

THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

GraphCtrl Source Codes 

Copyright (c) 2001 N2G Systems, Inc. All rights reserved. 

No part of this source code may be copied, used, or modified without the express written 

consent of N2G Systems, Inc. 

Graph.cpp - Version 3.0 (Brian Convery, May, 2001) 

LineChartCtrl Source Codes 

Copyright (c) 2001 N2G Systems, Inc. All rights reserved. 

No part of this source code may be copied, used, or modified without the express written 

consent of N2G Systems, Inc. 

LineChartCtrl.h : header file 

Written by Yuheng Zhao (yuheng@ministars.com)  

http://www.ministars.com 

The original idea and part of the code from Ken C. Len's CHistogramCtrl // 

http://www.codeguru.com/controls/histogram_control.shtml 

Copyright (c) 1998. 

This code may be used in compiled form in any way you desire. This file may be 

redistributed unmodified by any means PROVIDING it is // not sold for profit without the 

authors written consent, and providing that this notice and the authors name is included. If 

the source code in  this file is used in any commercial application then a simple e-mail 

would be nice. 

This file is provided "as is" with no expressed or implied warranty. 

The author accepts no liability if it causes any damage whatsoever. 

It's free - so you get what you pay for. 

Hyperlinks Source Codes 

Hyperlinks.cpp 
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Copyright 2002 Neal Stublen All rights reserved. 

http://www.awesoftware.com 

Iperf2 Source Code 

Copyright (c) 1999-2007 

The Board of Trustees of the University of Illinois 

All Rights Reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software (Iperf) and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, modify, 

merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 

persons to whom the Software is furnished to do so, subject to the following conditions: 

▪ Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimers. 

▪ Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimers in the documentation and/or other materials 

provided with the distribution. 

▪ Neither the names of the University of Illinois, NCSA, nor the names of its 

contributors may be used to endorse or promote products derived from this Software 

without  specific prior written permission. 

iPerf3 Source Code 

Copyright (c) 2014-2020  

The Regents of the University of California, through Lawrence Berkeley National Laboratory 

(subject to receipt of any required approvals from the U.S. Dept. of Energy).  

All rights reserved.  

1. Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3. Neither the name of the copyright holder nor the names of its contributors may be used 

to endorse or promote products derived from this software without specific prior written 

permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
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ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE 

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE. 

GridCtrl Source Codes 

Copyright (c) 2001 N2G Systems, Inc. All rights reserved. 

No part of this source code may be copied, used, or modified without the express written 

consent of N2G Systems, Inc. 

CellRange.h: header file 

MFC Grid Control - interface for the CCellRange class. 

Written by Chris Maunder <cmaunder@mail.com> 

Copyright (c) 1998-2001. All Rights Reserved. 

This code may be used in compiled form in any way you desire. This // file may be 

redistributed unmodified by any means PROVIDING it is // not sold for profit without the 

authors written consent, and providing that this notice and the authors name and all 

copyright notices remains intact.  

An e-mail letting me know how you are using it would be nice as well.  

This file is provided "as is" with no expressed or implied warranty. // The author accepts no 

liability for any damage/loss of business that // this product may cause. 

For use with CGridCtrl v2.20+ 

ODBCRecordset Source Codes 

FILE: ODBCRecordset.cpp 

Author:  Stefan Tchekanov  (stefant@iname.com) 

Description: CODBCRecordset and CDBField classes implementation 

Created By : Stefan Tchekanov 

Copyright(c) 1998, 1999, 2000 Stefan Tchekanov (stefant@iname.com) 

This code may be used in compiled form in any way you desire. This file may be 

redistributed unmodified by any means PROVIDING it is not sold for profit without the 

authors written consent, and providing that this notice and the authors name is included. If 

the source code in this file is used in any commercial application then a simple email to the 

author would be nice. 
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This file is provided "as is" with no expressed or implied warranty. 

The author accepts no liability if it causes any damage. 

OpenGL Source Codes 

jpeglib.h 

Copyright (C) 1991-1998, Thomas G. Lane. 

This file is part of the Independent JPEG Group's software. 

For conditions of distribution and use, see the accompanying README file. 

Visit the website at: http://www.ijg.org/ 

This file defines the application interface for the JPEG library. 

Most applications using the library need only include this file, and perhaps jerror.h if they 

want to know the exact error codes. 

Parser Share, Common, Util Source Code 

Copyright (c) 2001 N2G Systems, Inc. All rights reserved. 

No part of this source code may be copied, used, or modified without the express written 

consent of N2G Systems, Inc. 

Copyright (c) 1993, 1994, 1997  

The Regents of the University of California.  All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 

permitted provided that: (1) source code distributions retain the above copyright notice and 

this paragraph in its entirety, (2) distributions including binary code include the above 

copyright notice and this paragraph in its entirety in the documentation or other materials 

provided with the distribution, and (3) all advertising materials mentioning features or use 

of this software display the following acknowledgement: 

"This product includes software developed by the University of California, Lawrence Berkeley 

Laboratory and its contributors." Neither the name of the University nor the names of its 

contributors may be used to endorse or promote products derived from this software 

without specific prior written permission. 

THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 

OF  MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

@(#) $Header: /AIRMAGNET-WF9.1-SRV8.2/common/Parser/ParseLLC.h 1     7/08/11 

11:21a Airbuild $ (LBL) 

ProgressCtrlX Source Code 
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Class CProgressCtrlX 

Author:  Yury Goltsman 

Email:   ygprg@go.to 

Page:    http://go.to/ygprg 

Copyright © 2000, Yury Goltsman 

This code provided "AS IS," without warranty of any kind. You may freely use or modify this 

code provided this Copyright is included in all derived versions. 

ZipArchive 

ZipArchive.h: interface for the CZipArchive class. 

ZipArchive 1.5.1, March 2001 

Copyright (C) 2000 - 2001 Tadeusz Dracz 

Permission is granted to anyone to use this software for any purpose and to alter it and 

redistribute it freely, subject to the following restrictions: 

1. Using this software in commercial applications requires an author permission. The 

permission will be granted to everyone excluding the cases when someone simply 

tries to resell the code. 

2. The origin of this software must not be misrepresented; you must not claim that 

you wrote the original software. If you use this software in a product, an 

acknowledgment in the product documentation would be appreciated but is not 

required. 

3. Altered source versions must be plainly marked as such, and must not be 

misrepresented as being the original software. 

4. This notice may not be removed or altered from any source distribution. 

You can contact me at: tdracz@artpol-software.com 

For new versions check the site: http://www.artpol-software.com 

ZLib 

Version 1.2.2, October 3rd, 2004 

Copyright (C) 1995-2004 Jean-loup Gailly and Mark Adler 

This software is provided 'as-is', without any express or implied warranty.  In no event will 

the authors be held liable for any damages arising from the use of this software. 

Permission is granted to anyone to use this software for any purpose, including commercial 

applications, and to alter it and redistribute it freely, subject to the following restrictions: 
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1. The origin of this software must not be misrepresented; you must not claim that 

you wrote the original software. If you use this software in a product, an 

acknowledgment in the product documentation would be appreciated but is not 

required. 

2. Altered source versions must be plainly marked as such, and must not be 

misrepresented as being the original software. 

3. This notice may not be removed or altered from any source distribution. 

Jean-loup Gailly        Mark Adler 

jloup@gzip.org         madler@alumni.caltech.edu 

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 

to 1952 in the files http://www.ietf.org/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate 

format) and rfc1952.txt (gzip format). 

 


